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Introduction

Thank you for choosing the leading terminology management system TRADOS MultiT'erm ’95 Plus!
This User’s Guide tells you everything you need to know about the two versions of MultiTerm, the
Professional Edition and the Lite Edition. MultiTerm Professional is intended primarily for larger
translation services, whereas Multilerm Lite is designed more for the needs of freelance translators.
However, since the two versions have many things in common, this manual will cover both versions,
pointing out differences as necessary.

We would like to begin by giving you a brief overview of the main characteristics of MultiTerm '95
Plus so that you can get an idea of what you can expect from your new terminology management
system.

. MultiTerm is a specialized database program that is particularly helpful in creating, managing,
and presenting your terminology. However, you can also use MultiT'erm for storing documents
or addresses, since it supports the management of all kinds of textual information.

. MultiTerm is based on free-format text entries. Each entry can be up to 32,000 characters long
and contain up to S00 fields. Each field can be up to 4096 characters long. MultiTerm Lite can
store up to 8192 entries, while MultiTerm Professional can store an unlimited number of
entries.

. One entry always corresponds to one concept, that is, one language-independent abstraction of
an idea. This means that an entry contains all the terms that describe the concept, together with
any additional information associated with the concept (a definition, for instance). This is why
terminologists call MultiTerm "concept-oriented." As an example, for the English homonym
"plane," you would create at least two entries: one for airplane, and one for the tool used to
create a smooth surface on wood.

. For each concept, you can specify terms in up to 20 languages. Since the concept-oriented
approach means that all terms in an entry represent a single concept, the database can be
searched in any language direction. Terms are therefore stored in index fields, which can be
optionally sorted according to a user-defined sequence. This is why MultiTerm refers to terms
as index terms.

. Besides terms, MultiTerm also offers free-format zext fields for entering additional descriptive
information, for instance definitions, contexts, examples, and usage notes.

. Attribute fields allow classification of entire entries or of individual items in entries. For instance,
you can add attributes to identify the source, subject area, or customer name particular to an
entire entry, or to a term or definition. Attributes are stored in a user-defined list of possible
values, which ensures the consistency of the data in the database.

. The Professional Edition of MultiTerm 95 Plus allows you to attach illustrative graphics to
entries. All common graphic formats are supported.

. Powerful search functions let you quickly find the information you’re looking for. The wildcard
* can be included anywhere in the search term; even multiple wildcards within a search term are
allowed. This lets you find all terms ending in ing, for instance. The Professional Edition goes
one step further by allowing fuzzy searches. Fuzzy searching can find terms even if the search
criterion is transposed or misspelled. For example, fuzzy searching will find the entry "Interior
Ministry" even if you search for "Ministry of the Interior" or "Interir Minstry."

. The /log function lets you press a key to make a record of terms that were not found in
MultiTerm. The terms are added to a list that you can use later during terminology research.
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. Cross references let you link entries with other entries. A mouse-click jumps to the related entry.
MultiTerm keeps track of up to 10 entries to which you can return after calling a series of cross
references.

. The appearance of an entry can be fully adapted to your preferences via the /zyour function.

Each item in the entry can have its own format.

. The DDE Interface makes the data stored in MultiTerm available to other Windows applications.
Special macros are provided for accessing MultiTerm from WinWord 2.0 and higher,
WordPerfect 6.1, and Ami Pro 3.x. These macros allow you to highlight a term in your word
processor, click a button to look up the term in MultiTerm, and click another button to paste the
translation (or other information) back into your document. If you like, you can modify the
predefined macros to better fit your needs, or you can use MultiTerm’s DDE capabilities to
develop links to other Windows applications.

. MultiTerm’s import and export functions support the ever-increasing need to exchange
terminological information with other applications. The powerful filter function lets you ensure
that you import only the information that you want to add to your database, or that you export
only the information the information that you want to pass on to others. The import function
supports sophisticated merging of terminological data, whereas the export function lets you
define the format to match the requirements of publishing programs or other databases.

. MultiTerm provides extensive werwork support. Up to 100 users or user groups can access a
database. Their access can be controlled down to the entry level via eight entry classes. The
auto-refresh feature keeps all users who are logged on up to date.

What’s New in MultiTerm '95 Plus?

MultiTerm ’95 Plus’s enhancements with regard to its predecessor MultiTerm ’95 can be summarised
as follows:

. The program now uses standard Windows dialogs for opening and creating files, for example
when saving new databases, loading export and layout definitions, and so on.

. Filters can now be saved in the same manner as export and layout definitions.

. All external definitions (export, layout, filter, and input model definitions) now have their own
file name extensions.

. All dialogs now have buttons for closing or cancelling the operation.

. You can now also handle languages that need a so-called “double-byte” character set, for
example Japanese, Chinese, or Korean. The number of characters in these languages largely
exceeds the dimensions of conventional Windows fonts such as Arial, Times New Roman or
CyrillicHlv. Usually, 255 characters “fit” into one Windows character set. Double-byte
languages, however, need a much larger reservoir. If you want to manage these languages under
Windows in such applications as MultiTerm, you need special character sets—so-called
“Double-Byte Character Sets” (DBCS). These character sets go beyond the 255 character
limit. You can now use these sets in MultiTerm for all field types.

. Edit mode has seen some fundamental changes: so-called “input models” now allow much
greater control of creating and editing entries, and the keyboard functions have been enhanced
so that creating entries is much easier and more intuitive than before.

For further information on all these enhancements, please refer to the corresponding chapters in this
manual.
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Copyrights

MultiTerm was developed by Iko Knyphausen. This User’s Guide was written by Katrin Ohse,
Daniel Brockmann, and Jérg Thon, and was translated from German to English by Mark Berry. All
rights to the software (excluding ann.dll) and documentation, including the online documentation,
belong to Trados GmbH, Stuttgart, Germany. Neither the software nor the documentation may be
wholly or partially duplicated or reproduced in any form without the express written permission of
Trados GmbH. The “fuzzy retrieval”, referred to in this document, is based on ANN.DLL from
connex software. ANN.DLL © 1993-1995 by connex software GmbH, Hildesheim, Germany.

Software use is restricted to the terms of the Soffware License Agreement included with the software. If
the License Agreement is misplaced or missing, a new copy can be requested from Trados GmbH.

Trademarks

Product names are generally trademarks or registered trademarks of their respective owners. They are
used without representation as to their release for general use.

Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation.
WordPerfect is a registered trademark of Novell, Inc.
Lotus and Ami Pro are registered trademarks of Lozus Development Corporation.

Other product and company names are trademarks or registered trademarks of their respective
owners.

System Requirements

MultiTerm runs under Windows 3.1, Windows 95, Windows NT, or Win-OS/2. In addition, under
Windows 3.1, the DOS program SHARE must be loaded.

Windows is best implemented on a powerful PC. We therefore recommend as a minimum
configuration a PC AT with an 80486/33 processor, 8 MB of RAM, and a fairly large VGA color
monitor.

MultiTerm runs on any network that supports standard DOS calls from version 3.3 or higher (for
instance, Windows N'T', Novell NetWare or IBM LAN Manager).

If you want to work with double-byte character sets (DBCS), you either need a Windows add-on
package such as Japanese Partner or Chinese Partner from TwinBridge or a localized Windows version
such as the Japanese or Chinese version of Windows 95.

Support Hotline

If you don’t find the answers you need in this User’s Guide or in the online Help, Trados is glad to be
of service to its direct customers

Tuesday through Thursday from 14:00 to 18:00 CE'T at
@ +49 (0)711-16877-20
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Customers who have a Corporate Support Contract are not restricted to these hours; Trados is
available to Corporate Support customers at any time during normal business hours. A Corporate
Support Contract offers not only unrestricted access to the Trados hotline, but also discounts on
upgrades and training. To find out more, please contact us at the number above.

Trados can also be reached via email at support @r ados. com

If you purchased MultiTerm through one of our distributors, please contact that distributor for
information on support options.

About This User’s Guide

This User’s Guide has been written to help you learn to use MultiTerm in your daily work as quickly
and simply as possible. Once you have learned the program’s basic functions, this User’s Guide will
serve as a reference where you will quickly find Help when MultiTerm questions arise. The
individual chapters are structured as follows. At the beginning of each chapter, we present a brief
introduction to the topics that will be discussed in that chapter. The subsequent sections in the
chapter give you complete step-by-step instructions on how to perform the corresponding tasks. Since
most people learn better by doing, we recommend that you carry out the instructions on your PC as
you read them.

Since MultiTerm is a Windows program, basic functions like selecting commands from a menu are
probably already familiar to you from other programs, such as your word processor. If Windows is still
new to you, please take some time to learn the basic functions with the Help of your Windows User’s
Guide or the Windows tutorial. Our instructions assume you have a basic knowledge of Windows.

As with most Windows programs, MultiTerm lets you perform operations using the mouse “B or the
keyboard & . These two symbols point to the corresponding parts of the instructions.

In some cases, the keyboard method is faster; in others, the mouse method. Those functions where
one is clearly better than the other will be mentioned explicitly.

We enclose keys that you must press in square brackets, for example [Alt]. A plus sign + means that
you should press two keys simultaneously; a comma between key names means that you should press
one key, then the other. A letter in square brackets means that you should press the key for that
letter. For example, [D] doesn’t mean press [Shift]+[D] to crate a capital D; just type the letter d.

Special key combinations that abbreviate a series of commands, for instance ([Ctrl]+[O]) to open a
database, are shown at the appropriate place in parentheses. You will find a summary of all available
key combinations in “Appendix I: MultiTerm ’95 Plus Reference.”
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Note

To those customers upgrading from a previous version of MultiTerm to MultiTerm 95 Plus:
before you begin the installation, please read carefully the section titled “Upgrading from Earlier
MultiTerm Versions to MultiTerm 95 Plus,” starting on the next page.

An installation program installs MultiTerm 95 Plus on your hard disk. The program files are
contained in compressed files on two installation diskettes (“MultiTerm ’95 Professional Edition,
Program Disk” or “MultiTerm ’95 Lite Edition, Program Disk”). These diskettes also contain sample
databases to give you some ideas for designing your own databases. The final diskette, “Macros and
Tools,” contains all the files that MultiT'erm needs for communicating with your word processor
(Microsoft Word, WordPerfect, or Ami Pro). For additional information, refer to the “Integrating
MultiTerm 95 Plus with Other Windows Applications” chapter.

The installation program can only be started under Windows. Depending on whether you are using
Windows 3.1 or Windows 95, follow one of these procedures:

. Under Windows 3.1, from the Program Manager’s File menu, select the Run... menu item. The
Run dialog appears. You are prompted for a Command Line. Type a: set up in the input
field (where a@: is the drive containing the installation diskette; if this is drive b: on your
machine type b: set up instead). Now click the OK button or press the [Enter] key to confirm
your input.

. Under Windows 95, click on the Start button. The Start menu opens; select the Run... menu
item. The Run dialog appears. In the Open input field, type a: set up (where a: is the drive
containing the installation diskette; if this is drive b: on your machine type b: set up instead).
Now click the OK button or press the [Enter] key to confirm your input.

The installation program starts and guides you through the installation process. By default,
MultiTerm ’95 Plus is installed in the C:\ TRADOS\ MTWPLUS directory/folder. We recommend

accepting this default; otherwise, you will have to adjust the graphic file paths for the demo databases.

The installation program also lets you decide into which program group the MultiTerm ’95 Plus icons
should be added. The default is to create a group called Trados fine translation tools, but you can
select any group from the list. The installation program will later add the icons to the group you
specify. The icons allow you to select among user interfaces in various languages. Note that these
icons refer to the language of MultiTerm’s menus and Help file, not the languages of the
terminological data. At press time, MultiTerm ’95 Plus could be accessed in English, German, or
French.

This concludes the installation. Keep your original diskettes in a safe place.

If, after a Windows 3.1 installation, you want to use Program Manager to add your own MultiTerm
icons to the MultiTerm 95 Plus program group, be sure to specify the directory where you installed
MultiTerm (C: \ TRADOS\ MTWPLUS by default) as the Working Directory. Under Windows 95, the
same applies to creating shortcuts: specify the installation directory in the Start in input field.
Alternatively, you can add the MultiTerm directory to the PATH statement in your AUTOEXEC. BAT
file.

The installation program copies the DLL (Dynamic Link Library) files that MultiTerm needs to the
Windows system directory, C: \ W NDOWNB\ SYSTEMby default. At press time, the following files were
copied to the Windows system directory: TRADOS. DLL, ANN. DLL, CTPW N. DLL, | MAGEMAN. DLL,
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and CTL3DV2. DLL. In addition, the TRADCS. LRC file is also copied to the Windows system
directory.

In order to run MultiTerm ’95 Plus under Windows 3.1, the DOS program SHARE must be loaded.
(Windows for Workgroups 3.11 and Windows 95 automatically load this program, so you don’t have to
follow the procedure below if you’re working with these operating systems.) The SHARE program
controls multiple access requests against the same MultiTerm database. This is not only important in
a network environment; it is also useful on stand-alone PCs. If SHARE is not already in your
AUTOEXEC. BAT file—Microsoft Word 6.0 also uses SHARE—please add the following line to your
AUTOEXEC. BAT:

LH C \ DOS\ SHARE. EXE / F: 9182 /L: 500

If your AUTOEXEC. BAT file contains a line to automatically start Windows 3.1 (usually W N on a line
by itself), the command the loads SHARE must appear before the command that loads Windows.

Installing the Macros and Tools Diskette

For information on installing the Macros and Tools diskette, please refer to the '"Integrating
MultiTerm 95 Plus with Other Windows Applications" chapter.

Upgrading from Earlier MultiTerm Versions to MultiTerm '95 Plus

If you are upgrading from a previous MultiTerm version to MultiTerm ’95 Plus, please read the
following section de¢fore you install the program as described above.

Note

To those customers upgrading from a previous version of MultiTerm to MultiTerm 95 Plus: wnder
no circumstances should you use your old MultiTerm version simultaneously with the new
MultiTerm ’95 Plus. That is, the old and new versions of MultiTerm should 7ever be run at the
same time. This could lead to unforeseen problems, since MultiTerm ’95 Plus behaves differently
than earlier versions when creating and editing entries. You should therefore be sure to delete your
old MultiTerm version once you have verified that the new version is working properly.

Upgrading from MultiTerm ’95 to MultiTerm '95 Plus

MultiTerm ’95 Plus is 7oz installed in the same directory as your old version (C. \ MTW 95), but rather
in a new directory called C: \ TRADOS\ MTWPLUS. This ensures among other things that nothing can
happen to your old MultiTerm version or your old databases during the installation. The simplest
thing is to accept the default installation directory. Once you’ve successfully installed MultiTerm, you
can delete your old version manually by following these steps:

1. Install MultiTerm as described above, accepting the default directory C: \ TRADOS\ MTWPLUS.
2. Make sure that the new MultiTerm runs correctly on your computer.
3. If necessary, copy or move any MultiTerm databases you want to keep from the old

C.\ MTW 95 program directory to the new C: \ TRADOS\ MTWPLUS directory, or to any other
directory you choose.
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Depending on whether you are using Windows 3.1 or Windows 95, follow one of these
procedures to delete the old MultiT'erm "95 program group:

. Under Windows 3.1, open the program group containing your old MultiTerm version and
delete the old icons by selecting the Delete command from Program Manager’s File menu
or by pressing the [Delete] key.

. Under Windows 95, click the Start button with the right mouse button, and choose the
Open command from the context menu. The Start Menu folder opens in a new Explorer
window. To open the Programs folder, double click its icon. This folder contains the old
MultiTerm '95 program group. You can now select this group and use the mouse to drag
the old icons to the Recycle Bin. Alternatively, select the Delete command from the File
menu or press the [Del] key to mov the old icons to the Recycle Bin.

Keep your original diskettes in a safe place.

Now you can delete your old MultiTerm version using the File Manager (Windows 3.1) or
Windows Explorer (Windows 95).

Upgrading from MultiTerm for Windows 1.06 or MultiTerm Professional 1.5

MultiTerm ’95 Plus is nof installed in the same directory as your old version (C:\ MT4W N or
C:. \ MTWPRO), but rather in a new directory called C: \ TRADOS\ MTWPLUS. This ensures among other
things that nothing can happen to your old MultiTerm version or your old databases during the
installation. The simplest thing is to accept the default installation directory. Once you’ve successfully
installed MultiTerm, you can delete your old version manually by following these steps:

1.

Install MultiTerm as described above. The simplest thing is to accept the default directory
C: \ TRADCOS\ MI'WPLUS.

Make sure that MultiTerm runs correctly on your computer.

If necessary, copy or move any MultiT'erm databases you want to keep from the old program
directory (C: \ MT4W N or C: \ MTWPRO) to the new C: \ TRADOS\ MTWPLUS directory, or to any
other directory you choose.

Put the original diskette from your old MultiTerm version into the a: or b: drive. Make sure
that it is #oz write-protected.

Click on the icon labelled “Move License to Diskette.” This moves the license from your hard
drive back to the original diskette.

Depending on whether you are using Windows 3.1 or Windows 95, follow one of these
procedures to delete the old MultiTerm program group:

. Under Windows 3.1, open the program group containing your old MultiTerm version and
delete the old icons by selecting the Delete command from Program Manager’s File menu
or by pressing the [Delete] key.

. Under Windows 95, click the Start button with the right mouse button, and choose the
Open command from the context menu. The Start Menu folder opens in a new Explorer
window. To open the Programs folder, double click its icon. This folder contains the old
MultiTerm '95 program group. You can now select this group and use the mouse to drag
the old icons to the Recycle Bin. Alternatively, select the Delete command from the File
menu or press the [Del] key to mov the old icons to the Recycle Bin.

Keep your original diskettes in a safe place.

You can now delete your old MultiT'erm version from your hard drive.
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Upgrading from MultiTerm for Windows 1.01 - 1.05

MultiTerm 95 Plus no longer requires a hardware dongle.

To make sure that nothing can happen to your old MultiTerm version and databases during the
installation, MultiTerm ’95 Plus is #nor installed in the same directory as your old version
(C:\ MT4W N), but rather in a new directory called C: \ TRADOS\ MTWPLUS. The simplest thing is to
accept the default installation directory. Once you’ve successfully installed MultiTerm 95 Plus, you
can still delete your old version manually by following these steps:

1. Install MultiTerm as described above. The simplest thing is to accept the default directory
C: \ TRADOS\ MI'WPLUS.

2. Make sure that MultiTerm runs correctly on your computer.
3. If necessary, copy or move any MultiTerm databases you want to keep from the old
C.\ MT4W N program directory to the new C: \ TRADOS\ MTWPLUS directory, or to any other

directory you choose.

4.  Delete your old MultiTerm software and save your old original diskette if you like. Please
return your hardware dongle to the vendor from whom you acquired MultiT'erm.

Installing MultiTerm '95 Plus on a Network

Note

To those customers upgrading from a previous version of MultiTerm to MultiTerm *95 Plus: If you
are using a network, wunder no circumstances should you use your old MultiTerm version
simultaneously with the new MultiTerm ’95 Plus. The old and new versions of MultiTerm should
never be run at the same time. This could lead to unforeseen network problems, since
MultiTerm ’95 Plus behaves differently than earlier versions when creating and editing entries in a
network environment.

You therefore need to make sure that after the installation every user who has access to centrally-
stored MultiTerm databases can oz/y run the new version and doesn’t have an older version
available “somewhere.”

Installing MultiTerm on a network is the same as installing it on a local PC except that when the
installation routine asks where to install the program, you must specify a network drive.

As with a local installation, the installation routine then copies the all the program files to the
directory you specify as the installation directory. The only exception here are the DLL (Dynamic
Link Library) files. These are program files that MultiT'erm must access during execution, and they
are copied to the Windows system directory (C. \ W NDOWNB\ SYSTEM by default). At press time, the
following files were copied to the Windows system directory: TRADGCS. DLL, ANN. DLL,
CTPW N. DLL, | MAGEMAN. DLL, and CTL3DV2. DLL. In addition, a file named TRADGCS. LRC file is
also copied to the Windows system directory. If the Windows system directory is not kept on a
network server in your organisation, but is instead found on each local PC, you have several options
for preparing your network so that MultiT'erm will run correctly:

. You can copy the DLLs listed above as well as the TRADCS. LRC file to the local Windows
system directory of each user who is to have access to MultiTerm.

. If you want to spare yourself this work, you can keep the DLLs listed above and the
TRADCS. LRC file in the MultiTerm installation directory. The installation routine copies these
files to the MultiTerm installation directory as well as the Windows system directory, except
with the extension *.DL_ and *.LR_. So after the installation, you’ll find the files
TRADCS. DL_, ANN.DL_, CTPWN.DL_, I MAGEMAN.DL_, and TRADOCS.LR_ in the
MultiTerm installation directory on your network. You can rename these files—with the
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exception of TRADOS. LRC—so that they have the extension *. DLL. Rename TRADCS. LR_ to
TRADCS. LRC. Once you have renamed the files and made sure that MultiTerm starts correctly,
you can delete the TRADOCS. DLL, ANN.DLL, CTPWN.DLL, | MAGEMAN. DLL, and
TRADCS. LRC files from your Windows system directory. When creating a fuzzy index,
TRADCS. DLL always looks for the TRADCS. LRC file in the current directory. If TRADOS. LRC
cannot be found, you will receive an error message (“File missing/corrupted - Could not open
TRADCS. LRC”). In this case, please be sure that both the TRADOCS. DLL and the TRADOS. LRC

files are in the same directory.

The only exception is the CTL3DV2. DLL file. This file must be present in the local Windows
system directory of each MultiTerm user so that MultiTerm can be started correctly. If
Windows is started from the network, you can of course copy this file to the corresponding
network directory. Please note that other applications may also use this DLL; it is very
important that only one copy of this file be present on your network or on each local PC.

Assigning Network Access Rights

After installing MultiTerm, you must give all users who need to access MultiTerm «// rights to
directories containing MultiTerm databases. This is for example necessary so that the fuzzy index can
be created correctly—see the “Getting Started” and “Searching for Entries” chapters. If you keep
your databases in directories other than the MultiTerm installation directory, you can configure the
MultiTerm installation directory as Read Only to keep it from being accidentally deleted or
overwritten. If your databases are in the MultiTerm installation directory, you can still assign Read
Only rights to the .EXE and .DLL files.

For more information on using MultiTerm on a network, see the chapter “Using MultiTerm ’95 Plus
in a Network Environment”.
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Getting Started

Now that you’ve installed MultiT'erm on your computer, you will no doubt want to spend some time
getting to know the program. This chapter will walk you through your first steps with MultiT'erm,

explaining the most important functions along the way. We recommend that you work along on your
computer as you go through this chapter.

Starting MultiTerm '95 Plus

MultiTerm runs under the Windows graphical user interface. If Windows is not running, please start
it.

In Program Manager (Windows 3.1) the MultiTerm program group looks like this:

g Program Manager H=] E3
File  Options  Window  Help
HH Main M[=] S || 55 Microsoft Word O]
=] i
Prirters Control Panel  Windows Microzaft “Word Dialag  Word Setup
Explorer Word E ditar

e

mM5-D0S File t anager Word Readme
Prompt

Help

BH TRADOS fine translation tools  [El[=] E3 || 65 Accessanes i ] 55
ey, "
= om @ | oo

i8] MultiTermn "95+ MultiT erm 359+

Wordad Paint

Character Map
[German] [French)

%7

Uningtall Motepad Calculator Orline
Registration
HuyperTerminal  Phone Dialer DiaI-L||_: j

Figure 1: Program Manager with the Trados Fine Translation Tools Program Group

Under Windows 95 and Windows N'T' 4.x, the MultiTerm program group is integrated into the Start
menu as depicted below:
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dowsOb

Accessories »
mf_twindows 4.1 3
Microsoft Developer Metwork,  *
Microsoft Wizual C++ k
Faint Shop Fro 3
StartUp »

TRADOS fine translation tools fee] MUItT erm '35+ [English)
@ Microzoft Exchange FAUIGT erm 'S5+ (French)
TF Microsoft wiord FAUIGT erm '35+ [German)
fi 15-005 Prompt B Uninstal

The Microzoft Metwark
@ Windows E=plorer

Programs b

Documents 4
Settings 4
Eind 4
Help

Run...

Wi

CORERC Rk =0

Shut Do,

E % Paint Shop Pro |

Figure 2: Start Menu with the Trados Fine Translation Tools Program Group

If you have accepted the installation default, MultiTerm’s installation routine has automatically
created the Trados fine translation tools program group with the MultiTerm 95 Plus icons in
Program Manager (Windows 3.x) or the Start menu in the Programs folder (Windows 95 or N'T 4.x).

Follow these steps to start MultiT'erm, depending on the operating system you use:

Windows 3.1

Find the Trados fine translation tools program group in Program Manager. At press time, this
program group contained three icons that allow you to select among three different user
interface languages, namely English, French, and German. Note that these icons refer to the
language of MultiT'erm’s menus and Help file, not the languages of the terminology data.

Move the mouse pointer to the MultiT'erm icon corresponding to the user interface language
you prefer, and start the program by double-clicking with the left mouse button. The
MultiT'erm window opens.

Windows 95, Windows NT 4.x

1.

Click the Start button. The Start menu opens.
Move the mouse pointer on the Programs item and wait a moment. The Programs menu opens.

Move the mouse pointer on the Trados fine translation tools program group and wait a
moment again. The Trados fine translation tools group opens. At press time, this program
group contained three icons that allow you to select among three different user interface
languages, namely English, French, and German. Note that these icons refer to the language of
MultiTerm’s menus and Help file, not the languages of the terminology data.

Move the mouse pointer to the MultiTerm icon corresponding to the user interface language
you prefer, and start the program by clicking the icon with the left mouse button. The
MultiT'erm window opens.
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Opening a Database

The first time you start MultiTerm, an empty window appears on your computer. T'o use MultiT'erm,
you need to either open an existing database or create a new one. To familiarize yourself with the
program, we recommend opening one of the sample databases by following these steps:

1. From the File menu, select the Open Database... command ([Ctrl]+[O]) as follows:

Menus

Sclected menu
(File) ‘ ‘
wiew Search Help

—— | Open Database... Ctrl+0
—— [Chanae [Matabase [Wefintian...
— Helease Lozked Entries

Commands

and options it
— [Wefie Exmart.,. [Strl+E
— Erpmart T Entry [t
— Erpart Al Entries..
— [Create Fuzey | hdes [t
L | Ext Alt+F4

Figure 3: The File Menu
. Move the mouse pointer to the File menu, and click on it with the left mouse button. The

menu opens.

. Move the mouse pointer to the Open Database... command, and click on it with the left
mouse button.

2. The standard Windows Open (Windows 95, NT 4.x) or Open File (Windows 3.1) dialog
appears.
Open
File name: Eolders:
= = QK
ISAMPLE_MTW c:\tradoshmiwpluz _
C |
ECOLOT MTw EER |
FIREERT MThwf
GUIDEMO.MTw/ (= TRADOS

= MTWPLLS

=

-]

List files of bype; Dirives:

lMuItiTerrn a5 J | o M5-DOS_6 j

Figure 4: The Open Dialog

3. In the File Name list, click on the sample database SAMPLE. MTW and confirm your selection

by clicking on OK.

4. MultiTerm asks whether you want exclusive access to the database; answer Yes. If you are on a
network, please refer to the notes in the chapter “Using MultiTerm ’95 Plus in a Network
Environment.”

Note

If you have difficulty selecting menu commands or working with dialogs, please refer to your
Windows User’s Guide or tutorial.
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MultiTerm '95 Plus’s Screen Layout

Once you’ve started the program as described above, the MultiTerm window appears on your screen.
This window is similar to windows in other Windows programs that you may have seen.

Title bar

System menu

Menu bar File

‘ “Maximize” button ‘

“Minimize” button ‘

t| TRADOS MultiTerm *95 Plus! - SAMPLE MTW <View:
Edit “iew Search Help

Index IEninsh

Target IDeutsch j

= -]

Dialog bar .
agriculture | apple |
Entry Humber 52 =
Hote This is a bilingual entry containing an English term and its fo
German equivalent.
agriculture
Deutsch
Landwirtschaft

k

Message line Sort Term

/

:

Scroll bar J

Figure 5: MultiTerm’s Screen Layout

Title Bar

System Menu Field

“Minimize” Button

“Maximize” Button

The title bar shows which database you have open in
MultiTerm. In addition, MultiT'erm informs you in which mode
you are at the moment (for example, “View” or “Edit”).

If you move your mouse pointer to the title bar and hold down
the left mouse button, you can move your MultiT'erm window
around on the screen.

Double-clicking on the title bar maximizes the MultiTerm
window to the size of your screen. Double-clicking again returns
MultiTerm to its normal size.

If you click on the system menu field, the so-called system menu
opens from which you can Restore, Move, Size, Minimize, or
Maximize the window, Close the application, or Switch To
another application (the last command is only available under
Windows 3.1). Double-clicking on this button will end
MultiTerm.

Clicking on this button shrinks your MultiTerm window to an
icon. A double-click (Windows 3.x) or simple click (Windows 95,
NT 4.x) on the icon restores MultiTerm to its previous size.

Clicking on this button expands your MultiTerm window to
cover the entire screen. When the MultiTerm window is
maximized, this button becomes a Restore button; clicking the
Restore button returns the MultiTerm window to its original
size.
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Menu Bar

Dialog Bar

Entry Window

Message Line

Scroll Bar

The menu bar displays MultiTerm’s menus. When no database
is open, some menus are not accessible; their names are
displayed in gray.

You select a menu by clicking on the menu with the mouse or by
holding the [Alt] key and typing the letter that is underlined in
the menu name.

The menu opens and you see a list of options. Once again, you
can use the mouse or the keyboard to select any option displayed
in black type (that is, options that are not grayed out).

The dialog bar, also called the index dialog, is the basis for your
“dialog” with MultiTerm. There are two kinds of dialog bars
depending on whether you are viewing or editing an entry. The
two dialog bars are described in detail in the appropriate chapters
of this User’s Guide.

The actual terminological entries are displayed in the entry
window. The first item in the window is always a term in the
current source language and any additional information relating
to this term. The next item is the term is the current target
language term with any related information.

The message line displays various notes about the contents of
your database or about functions you have just performed. These
messages are described in detail in the corresponding chapters of
this User’s Guide. To remove a message from the message line,
click on the message line with the left mouse button.

To the right of the entry window is a scroll bar, which is used to
move up and down in longer entries.

B Clicking on the arrows at the top and bottom of the
scroll bar moves the entry up or down one line at a time. You can
move through long entries more quickly by “dragging” the
square button in the scroll bar up or down.

With the keyboard, you can move the entry up or down
one screen at a time by pressing the [Page Up] or [Page Down]
buttons. The cursor keys [P] and [¥] move the entry up or
down one line at a time. Press [Ctrl]+[End] to go to the end of an
entry, and [Ctrl]+[Home} to go to the beginning.

Now that you’ve become familiar with MultiTerm’s screen layout, we would like to introduce
MultiTerm’s basic functions and walk you through your first use of the program. However, you
should by all means feel free to explore your new program on your own.

Multi'T'erm ’95 Plus, © 1995-97 by TRADOS GmbH



24

Getting Started

Searching in MultiTerm '95 Plus

Browsing the Database

You can browse through a MultiT'erm database exactly as you would in a dictionary:

“Browse Backward” button

‘ current sort term ‘

“Browse Forward” button

&) TRADOS MultiTerm "35 Plus! - SAMPLE_MTW <View>

File Edit View Seach Help

Index IEn%Iish

Target I Deutsch

1 =

| agricutture I apple | apricot
Entry Humber 1
Subject Fruit
Hote This is an entry containing terms in four languages and a
cross-reference to a proverb.
Englizh
apple
Hote see also: The apple never falls far from the tree.
Deutsch
Apfel
Frangais pomme
Espafiol manzana
| |Sor1 Term

Figure 6: Buttons for Browsing

. To move to the next entry in the database, click on the “Browse Forward” button or press the
[F5] function key. The “Browse Forward” button shows you the headword of the next entry.

. To move to the previous entry, click on the “Browse Backward” button or press the [F4]
function key. The “Browse Backward” button shows you the headword of the previous entry.

Simple Search

Of course, you can also look up specific entries in your MultiTerm database. To do so, type the
phrase to look for into the search field as follows:
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Global Search

scarch field

te| TRADOS MultiTerm '35 Plus! - SAMPLE. MTW <¥iew>

File Edit View Seach Help

Index IEnglish J L ! j| Target II]eutsch =

| agricutture I apple | apricot I
Y
Entry Humber 1 j
Subject Fruit
Hote This is an entry containing terms in four languages and a
cross-reference to a proverb.
English
apple
Hote see also: The apple never falls far from the tree.
Deutsch
Apfel
Frangais pomme
Espariol manzana
-
| |Sor1 Term

Figure 7: The Search Field

1. Click the mouse in the search field. The cursor starts to blink.

2. Type your search term into the search field and press the [Enter] key. If you are using our
sample database, we suggest searching for a kind of fruit, vegetable, or grain, for instance
blackberry, radish, or wheat. If the database contains an entry that corresponds to the search term,
this entry is displayed. Otherwise, the message “Not found” appears in the message line.

When searching for a specific term, you need not type in the entire search term; typing in the first few
characters of the search term is more than enough. Try your search again, this time typing blackb, rad,
or /e, for example. As you see, MultiT'erm still locates the corresponding entries.

Sometimes you may not know exactly what you are looking for, or you don’t want to type in a long
search term. MultiTerm lets you use the asterisk (*) as a placeholder for any string of characters. You
can put the asterisk before, after, or in the middle of individual character strings. Since the asterisk is
used by many programs as a “wildcard,” this kind of search is also referred to as a “wildcard search.”

Let’s assume you want to know what kinds of berries are included in the sample database. To find
out, you can search for all entries whose headwords end in erry as follows:

1. Type *berry into the search field and confirm by pressing the [Enter] key. A so-called hit list
appears showing all entries in the sample database that end in ervry.

2. You can view the individual entries by double-clicking on the corresponding term in the hit list.
The hit list remains on the screen, and the selected entry is displayed behind it. To get a better
look at the entry, you can move the hit list aside by clicking on its title bar and holding down
the left mouse button while you drag the hit list to the desired place on the screen.
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=] TRADDS MultiTerm 95 Plus! - SAMPLE MTW <View>
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Subject Fruit
English | Help | | OK |
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Figure 8: An Entry Selected from a Hit List

3. You can also select an entry by clicking on it once and clicking on OK, or by using the cursor
keys to move the cursor bar to the desired term and pressing the [Enter] key. The hit list is
closed.

. If you want to re-display the hit list later, select the Show Hit List... command from the
Search menu, or press the [F12] function key. The hit list from the previous wildcard
search reappears, and you can select another entry.

You can use the asterisk * at multiple locations in the search string. For example, if you type
*berry*, the hit list will show all entries that contain the word 2erry, regardless of whether derry
appears at the beginning, in the middle, or at the end of the entries’ headwords. The hit list now
displays the term strawberry milkshake in addition to the terms found above.

As mentioned earlier, you can also use the asterisk as a placeholder between various strings. For
example, you could find the term strawberry milkshake by typing strawm | k*, *str*m *, or
*awrsh*.

Fuzzy Searching (Only in MultiTerm 95 Plus Professional Edition)

When you use a fuzzy search, you don’t even need to know how to spell a portion of the search term.
Fuzzy searching can find transposed or even misspelled search terms. This feature is only available in
MultiTerm Professional.

The prerequisite for performing a fuzzy search is that a “fuzzy index” must have been created for the
current database.

1. To create a fuzzy index for our sample database SAMPLE. MT'W select the Create Fuzzy Index
command from the File menu, or press [Ctrl]+[Z]. After confirming the following request with
Yes, MultiTerm reads through the current database and creates “fuzzy” images of the terms in
the database. These images are stored in a separate fuzzy index outside the database. Once
MultiTerm displays the message, “Fuzzy index successfully created,” fuzzy searching is
available.
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2. To perform a fuzzy search, simply type a pound sign # before the search term. For example, try
searching for #grape bunch or #bunsh of prapes. MultiTerm finds the entry for bunch of grapes in

spite of the transposed or misspelled words.

Jumping to a Cross Reference

You can jump to cross-referenced entries with the click of a mouse, and jump back to your original
entry just as quickly. Text items identified as cross-references appear in green by default. You can try
out the cross-reference function right from the bunch of grapes entry as follows:

1. Move the mouse pointer to the green cross-reference text grape. As you see, the mouse pointer

becomes a hand.

2. Click on the green cross-reference text. The cross-referenced entry for grape is displayed.

3. To return to the original bunch of grapes entry, click on the message line at the bottom of the

MultiTerm window with the 7/ght mouse button.

Setting the Source and Target Languages

So far, you’ve always accessed the entries in the sample database via the English terms. The
corresponding German terms have been displayed immediately below the English terms. Of course,
MultiTerm lets you select any language present in the database as the source or target language. Each
language in a MultiTerm database has an index which is stored either alphabetically or according to a
user-defined sort sequence. Selecting a source language activates the corresponding index so you can

access terms in a flash. Follow these steps to change the source and/or target language:

source language /
active index

button for opening the
drop-down list

target
language

drop-down
list

5] TRADDS MultiTerm '35 Plus! - SAMPLE MTW <View>

Fil=  Edit “igw Search Help

Index |Deutsch

=0

Apfel

Target

Deutsch I j

English

Entry Humber
Subject

Hote

Deutsch

Apfel

English

Frangais

Espafiol

1
Fruit

Frangais
Espariol

This is an entry containing terms in four languages and a

cross-reference to a proverh.

apple
Hote see also: The apple never falls far from the tree.

pomme

manzana

Source langua

Figure 9: Fields and Buttons for Changing the Source and Target Language

1. To set the source language, click on the button containing the arrow symbol next to the Index

field. A drop-down list opens showing the languages present in this database.

2. Click on the desired source language in the drop-down list of index fields. MultiTerm goes to
the first entry in the corresponding language and dynamically reformats the entry with the new
source language at the top.
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3. Follow the same approach to select the target language in the Target field. The layout is once
again dynamically reformatted. This time, the new target replaces the old target, directly below
the source language. The source and target each assume special font and color characteristics.

As you saw, this method of changing the source and target languages always returns to the beginning
of the new source language. You can also change the source language within an entry without
returning to the beginning of the index:

Press and hold the [Shift] key, and click on a term in the current entry corresponding to the desired
source language. The are two possible cases:

. If you click on a term in the currently selected target language while pressing the [Shift] key,
the source and target languages are inverted. For example, let’s assume that German is the
source language, English is the target language, and you are on the term Apfe/. Clicking on the
English term apple will change the source language to English and the target language to
German.

. If you click on a term in a language other than the currently selected target language while
pressing the [Shift] key, the language of the term you click on becomes the new source
language, and the target language remains unchanged. If you click on the Spanish term manzana
in our sample entry, Spanish becomes the new source language, and German remains the target
language.

Filtering Entries

The filter function allows you to search for entries in your database that match one or more user-
defined criteria. For example, you can filter to find all the entries belonging to a certain subject area,
or that were created on a certain date or within a range of dates, or that contain terminology that is
preferred by one of your clients. You can combine different criteria, for example to search for all the
entries that have at least one French term and belong to one or more subject areas.

To search for entries according to one or more criteria, you need to tell MultiTerm what the criteria
are. To do this, you must first define a “filter” with the desired criteria; then, you must activate the
filter. For example, let’s assume you want to find all entries with the subject Fruit in our sample
database. Follow these steps to define the filter:

1. From the View menu, select the Define Filter... command ([Ctrl]+[F]). The Filter Definition
dialog appears on your screen. As you can see, the filter list is empty.

2. You therefore need first to click on the Add... button. Another dialog window, Select Field or
Field Group, opens. You use this dialog to select the fields that contain the information you
want to filter on. The meaning of the individual fields is explained in detail in the “Filtering
Entries” chapter. For our example, only two fields are relevant: Entry Number in the left list and
Subject in the right list. The field Ewntry Number is located in the header of each entry and is
automatically generated by MultiTerm. It is therefore considered to be one of the “system
fields.” MultiTerm gives each entry its own Entry Number, so the Entry Number uniquely
represents the entry. Attributes that apply to the entire entry, for example an attribute
designating the subject area, are therefore assigned to the Entry Number and are called global
attributes. The filter criterion we want to define, for the Sudject Fruit, is such a global attribute.
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Select Field or Field Group

System/Index Field  Text Field Attribute Field
[ Any Field [ Any X Mone [ Any [ Mone

Creation Date - Definition :Subject a

Created By Source
Change Date Context Type of Relation

Changed By Related Words Usage Label

Entiy Class Grammar Regional Label

Graphic Mote Style Label

Client
Gender

Project Code

Sort Term 57

~Explanation
You have selected the attribute field Subject
for the system field Entry Number

| |Entry Mumber -> Subject

Figure 10: The Select Field or Field Group Dialog

Select the field Entry Number in the left list box and Swéject in the right list box by clicking on
them with the mouse. The Explanation field shows the effects of your selections. Click the
OK button. You are returned to the Filter Definition dialog. So far, you've told MultiTerm
that you want to filter on the Sufject attribute, which is assigned to the field Entry Number. Now
you must specify the actual criterion, Fruit.

Filter D efinition
Field or Field Group Criterion
Entry Number -> Subject Fruit
Delete I
[~ Only Use Matching Fields Criterion IFruitl Or... I

Figure 11: The Filter Definition Dialog

In the Criterion field of the Filter Definition dialog, type the criterion Fruit, and confirm your
entry by clicking on Close. This concludes the filter definition. You’ve told MultiTerm to
search for all entries containing the Subject Fruit. Now that you’ve defined the filter, in order for
it to take effect, you must activate it.

To do so, from the View menu, select the Filter Active option ([Ctrl]+[A]). A check mark (v')
appears next to the Filter Active option, indicating that it is active. The message line displays
the message “Filter is active.”

Now, when you browse in the database, entries that don’t match the filter, that is, entries whose
subject is not Fruit, appear with a gray background. To browse among only those entries with
this subject, from the Search menu, select the commands Next Filtered Entry ([Ctrl]+[F5]) or
Previous Filtered Entry ([Ctrl]+[F4]).

If you perform a global search now, the entries found will be restricted to those matching the
filter. You can try this out by once more searching for *berry*, as described in the section
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“Global Search” above. As you see, the hit list displays all the different types of berries in the
database, but not the strawberry milkshake entry.

You can also display all the entries matching the Fruit filter at once. Simply type an asterisk * by
itself in the search field, and you get a hit list of all the filtered entries.

If you want to be able to search for all the entries in the database again, you must deactivate the
filter as follows.

7. Once you’ve finished your filtered search, select the Filter Active option in the View menu
again. The check mark (v') is removed. You can also use the key combination [Ctrl]+[A]. The
filter is now deactivated; a global search will now access all entries.

MultiTerm Fields

As you saw in the Select Field or Field Group dialog while defining a filter, MultiTerm entries are
made up of different types of fields. We want to illustrate these field types using the sample entry
brussels sprout:

System ficld tx] TRADOS MultiTerm '35 Plus! - SAMPLE MTW <View>
Entry Number File Edit “iew Seach Help
l}ll;tlizrentry Index IEninsh j hrussels sprout j Target IIJeutsch j

| black-skinned plum I brussels sprout | bunch of grapes I
Attribute field
Subject as a Entry Humber 2% =
global attribute T Subject Vegetables I'ext ficlds Definition | —

English and Source
Logical ficld
Sort Term brussels sprout

Definition A bflss avegetable like a very small
cabbage whi .

Logical field source Calling Cobyj - -
Target Term Attribute field Gender

Deutsch as a term attribuee
Index ficlds Rosenkohl e . o . . .
English Definition Koh)/mit einem hohen Stengel, um den die Blatter in
Deut }’1 Faorm wan klginen kugeligen Raschen angeordnet sind.
F::nzz.l; Source Duden, Deutsches Universalwidrterbuch, Mannheim 1983

Frangais chou de Bruxelles
Tield group Espafiol col de Bruselas £ =
Any Term
| | Sor Terrmn -+ Definition

Figure 12: MultiTerm Field Types

Entry Header Fields These fields are automatically created and maintained by MultiTerm,
and are therefore called system fields. In particular, these fields are
Creation Date, Created By, Change Date, Changed By, and Entry Number.
The other two entry header fields, Graphic and Entry Class, are created
and maintained by the user. In our sample entry, the only entry header
field visible is Entry Number. All other system fields are usually hidden.
However, they can be made visible at any time by changing the layout
definition as described in the next section.

Index Fields Index fields are fields that allow quick access to entries. They are
therefore best suited for storing the actual terms in the database. The
terms for each language are placed in a their own index, which allows
sorting alphabetically or according to a user-defined sort sequence. So a
separate index field is defined for each language. When you define a
database, you can specify which languages you want to manage with
MultiTerm and what you call them. For example, the brussels sprout
entry contains the index fields English, Deutsch, Frangais and Espaiiol.
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Text Fields

Attribute Fields

Logical Fields

Field Groups

Text fields contain free-format information that further describes the
individual entries or terms. Text fields are best suited for information
like definitions, source references, or notes. Text fields that apply to an
entire entry are called global text fields, while text fields that apply to
individual terms are called term-level text fields. Just like index fields,
you can define text fields according to your requirements. Our sample
entry contains the text fields Definition and Source. Note that the same
text field, Definition, is used at the term level beneath both English and
Frangais.

Attribute fields allow detailed classification of terminological
information. Typical attribute fields specify subject, client, language
level, or gender. Attribute fields that apply to an entire entry are called
global attributes, while attribute fields that apply to individual terms are
called term attributes. Attributes can also apply to text fields, in which
case they are called text attributes. Our sample entry contains the
attribute Subject Vegetables which applies to the whole entry and is
therefore a global attribute. The entry also contains the attribute Gender
MultiTerm, which only applies to the German term and is therefore a
term attribute. As with index and text fields, you define attribute fields
when defining the database.

Logical fields are fields associated with a specific function as opposed to
a specific content. For example, the logical field Sort Term always
contains the current sort term, regardless of which language is set as the
source language. In our sample entry, brussels sprout is the current Sort
Term, since the source language is set to English. However, if you invert
the language direction, German (Deutsch) becomes the new source
language and Rosenkoh! the new Sort Term.

Finally, a Field Group refers to all the fields of a similar type. For
example, the field group Any Term refers to all the index fields other
than those referenced by Sort Term and Target Term. In our sample
entry, Any Term would refer to Frangais and Espaiiol. As with logical
fields, if you change the source or target language, the index fields
referred to by Any Term will change accordingly. We will discuss
additional field groups in the following sections.

Changing the Layout of the Entry Window

MultiTerm lets you format entries exactly according to your needs and preferences. For instance, you
can change the font of individual fields and field groups in your entries to make them larger or
smaller, bold, italic, or different colors. And, if there is some terminological information that you don’t
need at a certain time, you can hide individual fields or field groups so that only the field name is

displayed on the screen.

Let’s assume that you want to display the current sort term in a larger, italic font and in green.

1. From the View menu, select the Define Layout... command ([Ctrl]+[L]). The Layout
Definition dialog appears on your screen.

2. Inthe Field or Field Group list field, select the logical field Sorz Term. The current settings for
character and paragraph formatting appear in the lower portion of the dialog. Separate formatting
is defined in three horizontal rows, Name, Hidden and Field. In the Name row, you can
define the formatting of the field name. In the Hidden row, you can define the formatting of
the field name when the field contents are hidden. Finally, in the Field row, you can define the
formatting of the field contents themselves.
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Layout Definition

Field or Field Group Default Appearance

Creation Date Invisible
Created By Invisible
Change Date Invizible Help
Changed By Invisible Co =

Entry Class Invisible [ Load...
Entry Humber Vizible with name — Add
Entry Number -> Any Attribute ¥izible with name | Save...
Entry Humber -> Anyp Text VYisible with name Delete
Entry Number -> Any Text -> Any Attribute Yizible without name —
Sort Term VYizible with name

Default Appearance I\I’isihle with name J

= Cloze

i
Jididh.

| Bemove._..

-

Hew

. . Spacing/
Size Color = Break Margin Relative Para Line

Name (g ~llGray x| ® [7 [ [ [pefore x[10 zfo x]10 zfo =]
Hidden [g ~|Red =X [ X [ [gefore z[10 o =10 z]0 =]
Field {12 =||[Red ]| ® [0 [ T [gefore z[10 zfo =]o =]o =]

Figure 13: The Layout Definition Dialog

We want to change the appearance of the field contents, so in the bottom row, Field, set the
Size to 24 and the Color to Green, and activate the Italic check box. Confirm your selections by
pressing Close. As you see, the Sort Term is now considerably larger, and is shown in green,
italic type.

Now let’s assume that you want to only work with two languages, so you want to hide all languages
except the currently selected source and target languages.

From the View menu, select the Define Layout... command ([Ctrl]+[L]) again. The Layout
Definition dialog appears on your screen once more.

In the Field or Field Group list field, select the field group Any Term. As explained earlier, this
field group refers to all the index fields other than those currently referenced by Sort T'erm and
Target Term. The current settings for the field group Any Term appear in the lower portion of
the dialog.

From the drop-down list Default Appearance, select Hidden with name, and press Close. As
you see, the index fields that are not currently source or target fields are “hidden,” that is, only
an underlined field name is visible, but not the field contents. If you want to view a hidden
field, you can open and close it at any time by clicking on the field name with the 7ight mouse
button.

Feel free to try changing the formatting or the Default Appearance of other fields or field groups,
observing how the layout of the entries changes. You can find further information on defining layouts

in the corresponding chapter of this User’s Guide.

Note

Definition dialog and pressing Close.

You can return to the standard layout at any time by selecting the New button in the Layout

Adding an Entry

So far, you've learned about MultiTerm’s diverse search functions, seen how to filter certain entries
out of a database, and tried changing the layout of entries. Now you would no doubt like to find out

how you can create your own entry.
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Let’s assume that you want to create an entry for the term orange. Such an entry can be globally
categorized as belonging to the subject “fruit.” The first task is therefore to create a global attribute
for the Subject Fruit as follows:

1. From the Edit menu, select the Add Entry option, or press the [F3] function key. MultiTerm
changes to edit mode, and an empty window appears on your screen.

iis) TRADOS MultiTerm '35 Plus! - SAMPLE MTW <Add>

File  Edit “iew Seach Help

| |Entry Murnber

Figure 14: Empty Entry Window in Edit Mode

2. Press the [A] key for Attribute. The Attribute Fields dialog opens. From this dialog, you can
select attribute fields and values from those defined for this database.

Entry Humber -» Subject 1]
Attribute Fields Attribute ¥alues
| Subject [ Ty = ok |
Category ] Trees =
Type of Relation Cereals
Usage Label Wegetables =
Regional Label T
g::'"letl‘ahd Heawy Engineering
en Electronics
Een_dml Eor [T Mandatory
quivalence Medicing [T Multiple
Lamwy
Business Administration I Read-Only
Economics ;I [T Automatic

Figure 15: The Subject Attribute Field with Attribute Values

3. From the list of attribute fields, select Sudject. From the list of attribute values, select Fruit.
Confirm your selections by pressing OK. You have just created the global attribute Subject Fruit.
It now appears at the top of the entry window.

Now that you have specified that the new entry’s subject is fruit, follow these steps to enter the
English term orange and the German translation Apfelsine in the corresponding index fields:
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1. Type an [I] to enter an index field. The Insert Index Field dialog appears on your screen. This
dialog lists the languages defined for the current database.

Inzert Index Field [ %]

Deutsch
Francais
E gpaiiol

LCancel

Help

i

Figure 16: The Insert Index Field Dialog

2. We'll add English first. Select English and confirm your choice by pressing OK. The input field
English opens. This is where you enter the English term.

English [ ]

orange| =] | [1].9 I

[T Mandatory
[T Multiple
[T Dnce per Index

;l [ Read-Only

Figure 17: The English Input Field

3. Type the English term orange into the English input field, and confirm by pressing OK. The
field English orange appears in your entry.

4. Now, to enter the German term Apfelsine, press [I] to open the Insert Index Field dialog again.
This time, select Deutsch. The input field Deutsch appears on your screen.

5. Type Apfelsine and confirm by pressing OK. You are returned to your entry, where the term
Apfelsine now appears.

Now, you may want to add additional information like an English and a German definition. This kind
of free-format information is kept in text fields. Follow these steps to add definitions to the terms:

1. To enter an English definition, move the pointer to the field English orange by pressing the [2]
and [€] keys to jump between fields. Of course, you can also use the mouse.

2. Type a [T] to enter a text field. The Insert Text Field dialog appears on your screen. From
this dialog, you can select the text field you want to add, Definition, from those defined in this
sample database.
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Insert Text Field 1]

Source -
Context

Related Words Lancel
Grammar Help
Mote l—_

Project Code

Figure 18: The Insert Text Field Dialog

Note

Although you want to insert the definition affer the English term, the pointer should be on fop of
the field name English when you press [T]. If you position the pointer after the field, you may
accidentally add the definition to the wrong term. The MultiTerm status line always tells you
which field you are currently pointing to.

3. Select Definition from the list and confirm by pressing OK. The input field English-> Definition
opens.

4. Now, type in the definition (for example, T7e fruit of orange trees, having a yellowish-red bitter rind
and segmented juicy flesh), and confirm by pressing OK. You are returned to the entry, where the
Definition field has been inserted below the English term.

5. To add a German definition, use the [2] and [€] keys, or use the mouse, to move the pointer
to the Deutsch Apfelsine tield.

6.  Type a [T] again to open the Insert Text Field dialog and select the field Definition. Confirm
by pressing OK, and the Deutsch—>Definition field opens.

7.  Type in the definition (for example, Ritlichgelbe, runde Zitrusfrucht mit  saftreichem,
wohlschmeckendem Fruchifleish und dicker Schale), and confirm by pressing OK. Your entry appears
again with the new Definition field under the German term.

As a last item, you might like to add a gender designation to the German term Apfelsine. As mentioned
carlier, the best way to do this is to use a so-called term attribute to further describe an individual
term. Follow these steps to add the appropriate term attribute:

1. Again, use the [2] and [€] keys, or use the mouse, to move the pointer to the field Deutsch
Apfelsine. This is the term to which you want to add the attribute.

2. Type an [A] to enter an attribute field. The Attribute Fields dialog opens. From this dialog,
you can once again select from the attribute fields and values defined in the database.
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Attribute Fields

Attribute ¥alues

Deutsch -> Gender 1]

Subject
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Figure 19: The Gender Attribute Field with Attribute Values

3. Select the Gender attribute field and the value f for “feminine.” Confirm your selection by
pressing OK. Your entry now appears as follows:

iiz) TRADOS MultiTerm '35 Plus! - SAMPLE MTW <Edit>

File  Edit “iew Seach Help

Cancel

| Entry Header I

Subject

English

Deutsch

Fruit

orange

Definition The fruit of orange trees, having a yellowish-red bitter

tind and segmented juicy flesh

Apfelsine Gender F

Definition Rétlichgelbe, runde Zitrusfrucht mit saftreichem,
wohlschmeckendem Fruchtfleisch und dicker Schale

| | Deutsch -= Definition

Figure 20: Your New Entry in Edit Mode

4. When you are finished with your entry, click on the Save button or press [S]. MultiTerm saves

your entry and returns from edit mode to display mode.

Note

Your new entry is saved as soon as you exit edit mode with the Save command. It is not necessary
to save the entire database at the end of a MultiTerm session.

As you have seen, you create entries in MultiT'erm by selecting fields from lists of possible field
names. These lists are not fixed; rather, they are completely user-definable. The chapter “Creating a
Database” describes how to create custom lists for your own database.
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Using the Online Help

When you need more information on how to do something in MultiTerm, you can access the online
Help at any time by pressing the [F1] key. The online Help is context sensitive, so it automatically
gives you information about the function you are using at the moment.

The online Help works exactly like the Help in other Windows applications. If you want more
detailed information about using the Help function, start Help by pressing [F1], then select How to
Use Help from the Help menu.

Note

You can also start the online Help for all those menu functions and commands that don’t open a
dialog. To achieve this, select the corresponding menu item with the mouse, hold down the left
mouse button, and press the function key [F1].

Exiting MultiTerm '95 Plus

To exit MultiTerm 95 Plus, follow one of these procedures:

. From the File menu, select the Exit command

o Use the mouse to double-click on the minus sign (- ) (Windows 3.1) or the small MultiTerm icon
(Windows 95, N'T 4.x) to the left of the title bar.

. Click the X button at the right of the title bar (only available in Windows 95 or N'T 4.x)
. Press the key combination [Alt] + [F4].
If you want to close the current database and open another, you don’t need to exit first; simply open

the next database as described in the section “Opening a Database” carlier in this chapter. The
currently open database is automatically closed.
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Creating a Database

Before you can use MultiTerm 95 Plus to create, manage, and output terminology, you must first
create a database. This chapter first describes what a database is, then examines the structure of the
terminological entries you will store in your database. Finally, detailed instructions are given for
creating your own database.

Database Structure

A database is analogous to the card index with which translators have traditionally managed their
terminology. However, unlike a card index, which only allows sorting by a single criterion, MultiTerm
gives you many possible ways to access your database entries. You’ll find details in the chapters
“Searching for Entries” and “Filtering Entries.”

In order for MultiTerm to be able to quickly locate the information contained in your database, you
must define a database structure. This means that you must specify which data categories your
database should contain. You may have already used such categories in your card index, for example
German, English, Source, Context, Definition, Subject, and so on.

Which categories you define depends on what kind of information you want to collect and manage in
your database. The following instructions pertain to terminological entries, but in principle, you could
use MultiT'erm to store any kind of data.

MultiTerm’s diverse search and filter functions make it suitable for managing all your terminology in
one database. To make full use of the various search and filter options, however, it is important that
you carefully and consistently classify your terminology. Depending on your own requirements,
“classification” could means specifying the subject, project, and client for your entries. For example,
if you consistently classify entries by translation project, you can use MultiTerm to filter out all the
entries relating to one or more translation projects, and at the same time avoid having duplicate
entries in different project databases.

Since the number of entries in the Lite Edition of MultiTerm ’95 Plus is limited to 8192, if you are
using this program, it may be necessary to work with several databases. Just how you do this is
described in the section “Working with Multiple Databases” in the chapter “Searching for Entries.”

The Entry Structure

To make it easier for you to define the structure of your database, we would like first of all to explain
the hierarchical structure of a MultiTerm entry. To help you understand this structure better, we’ll
begin with a few theoretical observations about terminology.

Terminologists distinguish among the following basic elements:
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Concept

Term

Additional Descriptive
Information

Additional Classifying
Information

A concept is an intellectual abstraction of a tangible or intangible object.
For example, you have a cognitive image of a potato consisting of a set of
characteristics that define the concept “potato” and under which you
summarize all potatoes. Such an abstract concept is not bound to one
language; however, it may be influenced by a certain cultural backdrop.

A term is the linguistic description of a concept. A concept can have
several terms in one language, different terms in different languages, or
even the same term in different languages. For example, the term
“potato” is called Kartoffel, Erdapfel or Grumbeere in German, potato in
English, and pomme de terre in French. However, the term pommes frites
(French fries) is used in both French and German.

Additional descriptive information is individually formulated and

provides a better understanding of a concept, a term, or of other

information. Additional descriptive information can be added to the

following:

¢ Concepts, for example general notes

e Terms, for example definitions and context notes

¢ Additional information, for example to specify the source of a
definition

Additional classifying information consists of information that repeats
itself and therefore allows a classification of concepts, terms, or other
information. Additional classifying information can be added to the
following:

* Concepts, for example subject specifications

¢ Terms, for example grammatical notes

e Other information, for example to specify the text type of a
contextual note

Entry Information

Example Representation in MultiTerm

Concept

additional descrip- tuber

food

tive information vegetable ———

additional classi- -I
fying information Text Field
for additional descrip-
tive information
Attribute Field
for additional classi-
fying information
Picture Specification, if any

"General Image of a
Potato"

Entry Header

Attribute Field
for additional classi-
fying information

pomme

Term Kartoffel Erdapfel Grumbeere potato de terre Index Field
additional descrip- f. m. m Attribute Field
tive information preferred South Ger- ~ Southwest Ger- for additional classi-
additional classi- High German mandialect man dialect fying information
fying information Source: xyz  Source: abc  Source: jk )
Text Field
for additional descrip-
tive information
Attribute Field
for additional classi-
fying information
Figure 21: Hierarchical Structure of the Basic Terminological Elements and

Their Representation in MultiTerm

These basic terminological elements form a hierarchical structure of information that can also be

represented in MultiT'erm.
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The following four MultiTerm field types are available for representing this hierarchical structure:

Entry Header Fields

Index Fields

Text Fields

Attribute Fields

You create exactly one MultiTerm entry for each concept.
Terminologists therefore refer to MultiT'erm as concept-oriented.

If a term is used for more than one concept, that is, if the term is
polysemantic, the term must be added to several entries according to its
different meanings. For example, the English term monitor would be
stored in four entries according to its meanings, “student,” “observer,”
“TV or computer monitor,” and “monitor lizard.” On the one hand, this
approach allows data to be searched in any language direction. On the
other hand, it avoids confusion among various translations of the terms,
for example the German terms Schiiler, Uberwacher, Monitor, and Waran.

Each entry has exactly one entry header containing the system fields
Entry Number, Creation Date, Created By, Change Date, and Changed By.
MultiTerm automatically fills these fields with the appropriate
administrative information when you create or change an entry. This
means you don’t need to be concerned about creating and maintaining
these administrative fields yourself. The entry header also contains the
fields Graphic File and Entry Class, which will be explained later.

Index fields generally used to store terms. The terms for each language
are placed in a their own index, which allows them to be sorted
alphabetically or according to a user-defined sort sequence. So a
separate index field is defined for each language. You can define up to
20 index fields for up to 20 languages in your database definition. It’s
completely up to you to choose names for these index fields. Typical
field names are German, English, French, Japanese and so on.

To store synonyms, you use the corresponding index field multiple
times within the same entry. The advantage of this approach is that
synonyms are automatically taken into account during a search and
when you change the language direction. It is therefore neither
necessary nor desirable to create a separate index field for synonyms.

Text fields are used to store additional descriptive information about
concepts and terms. Typical text fields are Note, Definition, Context,
Source, and so on. However, which fields you define and what you call
them is up to you. You can create up to 62 text fields per database.

Finally, attribute fields are used to store additional -classifying
information about concepts and terms. Associated with each attribute
field is a list of possible attribute values, the so-called pick list. This
guarantees consistent classification; values cannot by typed incorrectly
or typed differently by different people. Typical attribute fields and
values are Swbjecr (Biology, Computers, Electronics, Electrical
Engineering, Mechanical Engineering, Medicine, Commerce, and so
on), Gender (m, f, n, mpl, tpl, npl), Customer (VW, GM, Honda, and so
on), and Language Region (Great Britain, Ireland, Canada, Northern
Germany, Austria, Switzerland, Southern Germany, USA, and so on).
Depending on your needs, you can define up to 30 attribute fields per
database; each pick list can contain up to 1024 characters. In addition,
pick list values can be defined to allow the input of so-called “variable
text.” For more information, please refer to both the “Allowing Free-
Format Text Input in Attribute Fields” section below, and to the
“Editing Entries” chapter.

You can find further examples of index, text, and attribute fields in Appendix III. How you define
your database depends entirely on how you want to use it. However, the more detailed you make
your database structure, the more specific can be the information you filter out of the full database.
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Creating a Database Definition

Now that you’ve become familiar with the hierarchical structure of a concept-oriented entry and have
seen how this structure is represented in MultiT'erm, we would like to show you how you can create a
database structure customized to your needs.

When you want to create a new database, MultiTerm automatically copies the database definition of
the currently open database as a template, which you can then change according to your needs.

This is the easiest way to create a new database definition, since you don’t have to completely re-
invent the database structure. Instead, you adapt an existing structure to your individual requirements
by adding new fields and deleting fields you don’t need. The original database from which you
copied the structure remains unchanged.

Selecting a Database Definition as a Template

The best approach is therefore to look at the structures of the various sample databases, as described
below, and determine which one comes closest to what you have in mind. You will also find a brief
overview of the characteristics of the sample databases in Appendix II, “Sample Databases Included
with MultiTerm.”

Let’s assume you want to look at the definition of the SAMPLE. MIT'Wdatabase so you can decide if you
want to copy the definition. If this database is not already open, open it as follows:

1. From the File menu, select the Open Database... command ([Ctrl]+[O]). The standard
Windows Open file dialog appears on your screen.

2. In the Open dialog, select the SAMPLE. MTWdatabase from the File Name list and confirm
your selection by pressing OK.

3. If MultiTerm asks whether you want exclusive access to the database, answer Yes.
To look at the definition of the open database, and possibly copy and change it, proceed as follows:

. From the File menu, select the option Create New Database ([Alt]+[F], [C]). The Database
Definition dialog opens. In this dialog, you see a copy of the database definition of the
previously opened database (SAMPLE. MIT'Win our example). This dialog contains list boxes with
index, text, and attribute fields already defined. To view the pick lists for the different
attributes, click on each attribute field.
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Database Definition
Field Name [Subject | add. |[Nework. || ok |
Default Font |F\ria| j| | Delete I | Help I | Cancel I
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rangais o ontex
E spanol 3 Related Words
Grammar
g Hote
5 Project Code

Pick List Path for Graphic Files

Architecture - c:\mtwplus
Trees
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Type of Relation I |

Uszage Label Vz;e;:bles

Regional Label Eruit [-a-]

Style Label N [-e-]

Client Hesry E.ng|neer|ng [-d

Gender Electronics - [-e] LI
Figure 22: Database Definition Based on the Sample

Database SAMPLE. MTW

If the current database definition bears no resemblance to what you have in mind and you would
rather look at other database structures, simply abort this database definition and follow the same
procedure described above to look at different databases.

To abort the database definition, click the Cancel button or press the [Esc] key. You are asked
if you want to abort defining the database; answer Yes.

Let’s assume that you want to adapt a copied database to your requirements, changing some field
names, deleting others, and adding some of your own. Keep the following in mind when you are
defining your database:

Notes

Within a database definition, index, text and attribute fields need only be defined once. They
can then be used any number of times, even at several different locations within an entry. For
example, once you’ve defined the field Sowrce, you can use it after your index fields like
Deutsch, English, or Frangais, as well as after text fields like Definition or Conzext. It is therefore
not necessary to create separate fields like Sowurce Deutsch, Source English, Source Frangais, Source
Definition and so on. This is also the reason that MultiTerm does not allow you to create
duplicate field names.

Since MultiTerm automatically generates the fields Entry Number, Creation Date, Created By,
Change Date, and Changed By in its entry header, you need not create these fields when defining
your database. If, however, you would like to manage such information not only at entry level,
but also at field level (for example, for each index field), please refer to the “Customising
Database Definitions for Input Models” section below.

To change field names, delete entire fields, or add new fields, follow the instructions in the
appropriate section below.

Changing the Names of Index, Text, and Attribute Fields

You may want to change the name of an index, text, or attribute field, for example so that the index
field for Spanish is no longer called Espaiio/ but Spanish. Follow these steps to change a field name:
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1. Use the mouse to click on the field name that you want to change. This highlights the field
name, and simultaneously causes it to appear in the input field Field Name.

2. Click the mouse in the input field Field Name. The cursor starts blinking in this field.

3. Change the field name. As you see, the field name is changed in the list box at the same time.

Deleting Unnecessary Index, Text, and Attribute Fields

Follow these steps to delete index or text fields, or to delete attribute fields together with their
attribute values:

1. Use the mouse to click on the field name of the field you want to delete from your database
definition.

2. Click on the Delete button or press the key combination [Ale]+[D].

Adding Index Fields

To add a new index field like [7aliano or Portugués to your database definition, follow these steps:

1. In the Index Fields list box, click on the index field after which you want to insert the new
index field. The field name is highlighted.

2. Click on the Add button or press the key combination [Alt]+[A]. The cursor starts blinking in
the Field Name field.

3. Inthe input field Field Name, type the name of the new index field.

4. To define the font in which the index field will be displayed in your entries, click on the arrow
to the right of the Default Font field. A drop-down list opens showing the available fonts.

5. From the Default Font drop-down list, select the desired font.

6.  To specify the sequence in which the individual terms in the index field are to be sorted, you
have two options: You can either use the default alphanumeric sort order for Latin-script
languages, or your can change the sort order according to your own requirements.

. To use the default sort order, simply click on the Default Sort Order button.

. To change the sort order, click in the list box containing the sort sequence and change the
sequence like you would any text. To insert a new line, press the key combination
[Ctrl]+[Enter]. Note that all characters appearing on the same line are sorted together; in
the default sort order, uppercase and lowercase letters appear on the same line, so sorting is
case-insensitive. Characters omitted from the list are not considered when sorting; in the
default sort order, punctuation characters are omitted and thus ignored during sorting.

Your new index field is now defined. If you want to add additional index fields, repeat the above
steps.

If you want to work with languages like Greek or Russian that require special character sets, please
read the instructions in the section “Defining Databases Containing Special Characters” in the “Tips
& Tricks” chapter.

Adding Index Fields for Double-byte Languages

When defining your database, you can also add index fields for languages that use a so-called “double-
byte” character set, such as Japanese, Chinese, or Korean. The number of characters in these
languages largely exceeds the dimensions of conventional Windows fonts such as Arial, Times New
Roman or CyrillicHlv. Usually, 255 characters “fit” into one Windows character set. Double-byte
languages, however, need a much larger reservoir. If you want to manage these languages under
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Windows in such applications as MultiTerm, you need special character sets—so-called “Double-
Byte Character Sets” (DBCS). These character sets go beyond the 255 character limit.

Note

If you want to work with double-byte character sets (DBCS), you either need a Windows add-on
package such as Japanese Partner or Chinese Partner from TwinBridge or a localized Windows
version such as the Japanese version of Windows 95.

You have to tell MultiTerm which index fields use a DBCS font. To add a DBCS index field, follow
these steps:

1.

~

In the Index Fields list box, click on the index field after which you want to insert the new
DBCS index field. The field name is highlighted.

Click on the Add button or press the key combination [Alt]+[A]. The cursor starts blinking in
the Field Name field.

In the input field Field Name, type the name of the new index field, for example Japanese.

To define the DBCS font in which the index field will be displayed in your entries, click on the
arrow to the right of the Default Font field. A drop-down list opens showing the available
fonts.

From the Default Font drop-down list, select the desired DBCS font.

Check the DBCS Font check box. With this, you tell MultiTerm that the index field will
contain terms from a DBCS language.

If the sort table is empty, click the Default Sort Order button to fill it with characters. In
contrast to all other index fields, however, the sorting is irrelevant for DBCS index fields;

MultiTerm automatically applies the correct (binary) sorting for these languages.

Repeat the steps 2-7 for all index fields that use a DBCS font.

Databaze Definition

Field Name [Japanese Add.. | Nework.. | ok |
Default Font 1,1 = p =</ ?j‘ Delete | Help | Cancel |
DBCS Font [
Default Sort Order
Index Fields — | Text Fields
Swedish | ln - Definition
Finnish 1 Accelerator Key
Morwegian o Accelerator Key Est
Hungarian 3 Accelerator Key Cyr
Polish 2 Hote
Czech Japenese Definition
Russian .
¢ hd
Attribute Fields Pick List Path for Graphic Files
Source rm - e:\._.\japanese
Subject i
Grammar s L1
W
adj [-a-]
adw [-c-]
[-d-]
b [-e-]

Figure 23: Adding a DBCS Index Field
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Adding Text and Attribute Fields

Follow these steps to add text fields like Explanation or attribute fields like Level of Equivalence to
your database definition.

1. Inthe Text Field or Attribute Field list box, click on the field after which you want to insert a
new field. The field name is highlighted.

2. Click on the Add button or press the key combination [Alt]+[A]. The cursor starts blinking in
the Field Name field.

3. Inthe input field Field Name, type the name of the new text or attribute field.

4.  To define the font in which the field will be displayed in your entries, click on the arrow to the
right of the Default Font field. A drop-down list opens showing the available fonts.

5. From the Default Font drop-down list, select the desired font. You can also choose fonts
containing double byte character sets in order to later be able to add Japanese or Chinese text in
these fields.

This concludes defining the new text or attribute field in your database. If you want to add additional
text or attribute fields, repeat the steps above.

If you want to work with languages like Greek or Russian that require special character sets, and if
you want to use these character sets in text or attribute fields, please read the instructions in the
“Defining Databases Containing Special Characters” section in the “Tips & Tricks” chapter.

Adding, Changing, or Deleting Attribute Values in a Pick List

MultiTerm treats attribute va/ues as normal text. This allows you to make additions, changes, or
deletions to attribute values by simply typing in the pick list. For example, if you want to change or
delete attribute values in the Sudject attribute field, or if you want to add a new attribute value like
chemical engineering, tfollow the steps below. The procedure is the same if you want to add new
attribute values to a new attribute field, for example, adding Complerely Equivalent and Partly
Equivalent to the Level of Equivalence attribute field.

1. In the Attribute Fields list box, click on the attribute whose pick list you want to modify or
create. The pick list for this attribute field with the corresponding attribute values appears in the

Pick List list box.

N

Click in the pick list with the mouse. The cursor starts to blink. You can now move around in
the pick list as in any word processing software. You can add text, or delete and change text. To
create a new line, press [Ctrl]+[Enter]; to delete an empty line, press the [Del] key.

Allowing Free-Format Text Input in Attribute Fields

As already described in the section titled “The Entry Structure” above, the pick list of each attribute
field can contain a maximum of 1024 characters. For example, you can add a Swéject attribute field
whose pick list contains 100 items, each consisting of 10 characters on average.

In some cases, you might want to go beyond this limit. For this reason, you can configure the pick list
of each attribute field in such a way that you get an additional input field for free-format text when
editing entries. You can use this input field to add descriptive information for the corresponding
attribute value. Let’s look at an example to clarify this functionality.

Let’s assume you don’t want to manage source specifications as free-format text in a dedicated text
field. Instead, you want to classify the sources to ensure their consistent use across the database.
That’s why you decide to add a Source List attribute field. You fill its pick list with pre-defined source
specifications as described in the previous section. This procedure is perfectly admissible but has one
decisive disadvantage: if you want to add information to a source, such as the year in which it
appeared or a page specification, you have to update the pick list, which will soon run out of room. In
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this case it would be useful to be able to append descriptive, free-format text information, such as p.
1234, to a pre-defined source from the pick list, such as Webster’s 1996.

T'o achieve this, you can add a colon (:) at the end of the attribute value Webster’s 1996. Later, when
adding entries, as soon as you or another user selects the attribute value Webster’s 1996: from the pick
list, MultiT'erm ’95 Plus automatically shows an input field called Variable Text where you can add
the page specification, p. 71234.

The figure below shows the Sowurce List attribute field with two sorts of attribute values. On the one
hand, there are values allowing free-format text input, ending with a colon (for example, Webster’s
1996:, The Guardian:). On the other hand, there are conventional attribute values that you select from
the pick list as usual, without being able to add descriptive information of any kind (for example,
Invention).

N ————
Database Definition [ %]
Field Name ISuume List | Add.... I | Metwork I | 114 I
Default Font |F\ria| j| | Delete I | Help I | Cancel I

DBCS Font [
Default Sort Order .
Index Fields | = I Text Fields
Englizh 0 - D efinition
Deutsch 1 Source
Francais 2 Context
Espaiiol 3 Related Words
4 Grammar
M Note
e Project Code
Attribute Fields Pick List Path for Graphic Files
Type of Relation a | |vebsters 1996 - c:\tradozimtwplus
Hsage LIBEEL ' The Guardian:
egional Labe The E it
E"e“‘ b Miller
ender s S 'lhl
Equivalence . =l
-

Figure 24: Attribute Values With and Without Colons

As soon as you or another user selects any attribute value ending in a colon from the Sowrce List
attribute field when editing entries, MultiTerm ’95 Plus will automatically show the Variable Text
input field, allowing the user to add descriptive information to the attribute value. As the user types
text into this field, the free-format text information is appended to the attribute value from the pick
list.

EESSSS—————_—m—m—m—
Englizh -> Source List 1]

Attribute Fields Attribute ¥alues
Category B The Guardian;
Type of Relation The Econamist;
Usage Label Irvertion =
Hegional Label M. Mill
Stpte Label M. S
Client ’
Een_dml [T Mandatory
Euwa ence [T Multiple
[ BRead-Dnly
[T Automatic

Yariable Text Ip. 1234|

Figure 25: Free-Format Text Input in Attribute Fields
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As you can see, this feature allows you to combine the primary advantage of an attribute field (the
consistent use of terminological data) with the main advantage of text fields (free-format text input of
any length).

How to add free-format text to attribute values is described in the “Editing Entries” chapter.

Customising Database Definitions for Input Models

In contrast to all previous MultiTerm versions, MultiTerm ’95 Plus gives you the option of using so-
called “automatic” attribute fields with input models. (For information on input models, see the
“Input Models” section in the “Editing Entries” chapter of this document.) Automatic attributes are
specially-defined attribute fields used to store administrative information in entries. These attributes
have the following characteristics:

. They contain information about who added or changed something in an entry and where the
change was made. This information is in addition to the system fields Creation Date, Created By,
Change Date, and Changed By, which are stored at the entry level. This means that whenever
necessary, you can find out where a field was last added or changed in an entry and who did it.

. Since these fields can be placed anywhere in an entry, it is now possible, for example, to find
out who was the last person to change a term or definition. This was not possible with earlier
MultiTerm versions, because the system fields mentioned above were only maintained at the
entry level, not the field level.

. MultiTerm 95 Plus maintains and updates these fields automatically as long as they are present
in the input models being used.

Of course, for MultiTerm ’95 Plus to be able to use automatic attribute fields in input models and
when creating and changing entries, it has to be able to recognise them as such. This means that if
you want to use this new feature, you must add new attribute fields to your database definition.
These attribute fields must follow certain rules as defined below:

. You can use almost any name for the attribute field names. For example, you can create fields
called Initial Date or Edited By. However, be sure not to use names that are already used by MultiTerm
as system field names. In the English version, the reserved field names are Creation Date, Created
By, Change Date, and Changed By. You should also avoid field names used in the German and
French versions, namely Anlagedatum, Angelegt von, Aﬂdemﬂgsdatum, Gedindert von, Date de création,
Cré¢ par, Date de modification, and Modifié par. Otherwise, you could encounter unforeseen
problems when importing data into or exporting data from MultiTerm ’95 Plus.

. The pick list of each automatic attribute field must contain one or more of the following
attribute values. (The same abbreviations are used as in the TRADOS T'ranslator’s Workbench
export format.)

. CrD (stands for Creation Date)
. CrU (stands for Creation User)
. ChD (stands for Change Date)
. ChU (stands for Change User)

In contrast to other attribute value pick lists, MultiTerm ’95 Plus always uses on/y one of the values in
the automatic attribute field’s pick list and assigns it to the field to which the automatic attribute field
is related. If you plan to assign several automatic attribute fields to a field in an input model, for
example to track who change a field and when, you must first add a corresponding number of
automatic attribute fields to the database definition.

Let’s assume that you want to track all four of the administrative fields listed above for the index field
English. This means that you must add four attribute fields to your database definition, for example
Initial Date, Initial User, Edit Date, and Edit User. The pick list of each field should then contain only
one item, namely the corresponding abbreviation from the above list (CrD, CrU, ChD, and ChU,
respectively). You will find further information on this topic in the section “Using Automatic
Attribute Fields in Input Models” in the “Editing Entries” chapter.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



Creating a Database Definition

49

Follow these steps to add automatic attribute fields to your database definition:

Open the database to which you want to add automatic attribute fields, if it is not already open.

From the File menu, select the Change Database Definition... command. The Database
Definition dialog appears.

Database Definition

Field Hame "{F nglish [ add. |[Nework. |[ oK
Default Font |Ptrial j| | Delete I | Help I | Cancel I
DBCS Font [~
Default Sort Order .
Index Fields | — I Text Fields
0 0 - Definition

Deutzch 1 Source
Frangais o Context
E spafiol 3 Related Words

4 Grammar

M Mote

Project Code

5] -
Attribute Fields Pick List Path for Graphic Files
Subject Architecture - c:\trados\mtwplus
Ealegof'-"'n lati Trees

ype of Relation Cereals

Usage Label \egetables
Regional Label Eruit
g:i',:thahel Heary Enginesting
Gender Electranics -

Figure 26: The Database Definition Dialog for the SAMPLE. MTWDatabase

In the Attribute Fields list box, click on the field after which you want to insert new fields.
The field name is highlighted.

Click on the Add button or press the key combination [Alt]+[A]. The cursor starts blinking in
the Field Name input field.

In the Field Name input field, type in the name you want to use for the automatic attribute
field, for example Initial Date, Edit User, or Admin Info.
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Database Definition
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Project Code
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Attribute Fields Pick List Path for Graphic Files
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Client
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Initial Date -

Figure 27: The Attribute Field “Initial Date” with the Pick List Value “CrD”

6. Click in the pick list for the newly created attribute field, or press the key combination [Alt]+[P]
to get to the pick list. Add the desired combination of pick list values CrD, CrU, ChD, and ChU,
one to a line. T'o add a new line to the pick list, press the key combination [Ctrl]+[Enter].

7. To define the font in which the field will be displayed in your entries, click on the arrow to the
right of the Default Font field. A drop-down list opens showing the available fonts. From the
Default Font drop-down list, select the desired font.

8. Repeat steps 4-7 for all automatic attribute fields that you want to use later in input models and
entries. As mentioned earlier, it’s up to you to decide how many automatic attribute fields you
add to your database—from a minimum of one to a maximum of four. It depends entirely on
how much administrative information you later want to have MultiTerm ’95 Plus automatically
maintain, keeping in mind that each automatic attribute can hold exactly oze value at any given
location in an entry. You will find further information and screen shots under the title “Using
Automatic Attribute Fields in Input Models” in the “Input Models” section of the “Editing
Entries” chapter.

Specifying the Path for Graphic Files

When working with MultiTerm Professional, you can illustrate the content of your entries with
graphics.! To use this feature, when defining the database, you must specify the Path for Graphic
Files, that is, the directory in which the graphics for the current database are stored. The default path
is C: \ TRADOS\ MTWPLUS. You specify the names of the individual graphic files later, when creating
or changing the entry. The name is part of the entry header.

MultiTerm Professional can display graphics with the following formats:

File Name Format

*. BWP Bitmap format

* . WWF Windows Metafile format

*, PCX Paintbrush format

*TIF Tagged Image File format

* . EPS Encapsulated Postscript format
*. PS Postscript format

*AF Graphic Image File format

MultiTerm Lite can only show the name of the graphic file; it cannot display the graphic itself.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



Saving or Aborting a Database Definition 51

Note

All graphics belonging to a database must be stored on the same drive and in the same directory. If
you have graphics in other programs that you want to use in your MultiTerm database, you have
two options. You can either copy the graphic files into the directory specified as the MultiTerm
graphic file path, or you can create a common graphics directory on your computer which can be
accessed by MultiT'erm Professional as well as other applications.

Setting Network Options

Please refer to the chapter “Using MultiTerm 95 Plus in a Network Environment” for instructions on
specifying user names and passwords in your database definition.

Specifying a Password

Even if you aren’t using a network, you can use the network options to protect your database with a

p
u.

assword. T'o do so, you define a password for the user super as described below. Super stands for super
ser. If you are using MultiTerm on a network, this is the user ID of the system administrator; if you

are using MultiTerm stand-alone, this is your user ID. You must access the database as super to

c

xecute commands that only the network system administrator can execute. (Note that if you don’t

define a password, you are automatically logged on as super whenever you open the database.) Follow
these steps to define a password.

In the Database Definition dialog, click on the Network... button. The Network Options
dialog appears on your screen. The super user is already highlighted in the User List field.

Click in the input field Password. The cursor in this input field starts blinking.

Type in the desired password. The password can be up to nine characters long. Confirm your
entry by pressing Close. You are automatically returned to the Database Definition dialog.

From now on when you open your database, you will be prompted for your user ID and password.
Type the user ID super and the password you defined in the database definition. The password is not
displayed on your screen. Note that the user ID and password are case-sensitive.

Saving or Aborting a Database Definition

Note

Since it is somewhat more complicated to change an existing database definition, before saving
your database definition, please consider whether there are additional fields that you would like to
add, change, or delete.

Once you have completed your changes, save the new database definition as follows:

1.

In the Database Definition dialog, click on the OK button. The Save As dialog appears on
your screen. You use this dialog to specify the path and database name where your new database
is to be stored.
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Figure 28: The Save As Dialog

2. By default, databases are stored in the MultiTerm installation directory,
C. \ TRADOS\ MTWPLUS. This is the name above the Folders list field (or Directories under
Windows 3.1). However, you can specify another drive and/or directory in the Save As dialog.
If the drive you want to use is not already displayed, select the desired drive from the Drives
list. To select a directory, start by double-clicking on the drive letter (C:\ in our example) in
the Folders (or Directories) list. All the available folders/directories on the corresponding drive
are displayed. Select the desired folder/directory by double-clicking on its name. Select any
subfolders desired by further double-clicking.

3. Finally, to enter the name of your new database, click in the File Name input field. The
standard extension for MultiTerm databases, * . MTW is already displayed in this field.

4. Type in a name for your new database. Your database name can be up to eight characters long
and may not contain special characters. MultiTerm automatically adds the *. MTWextension if
necessary. Confirm by clicking on OK. Your new database definition is now stored under this
new name.

Note

Be careful not to enter an existing database name so that you do not inadvertently overwrite
(delete) an existing database. Be particularly careful not to enter the name of the database from
which you just copied the definition!

As you are working, you may decide that you would rather not define a new database after all. Or you
may want to start over. In this case, you can of course abort defining the database. To do so, proceed
as follows: in the Database Definition dialog, click on the Cancel button or press the [Esc] key.
MultiTerm asks whether you want to cancel defining the database; answer Yes.

Changing a Database Definition

If you need to make extensive changes to the structure of an existing database, particularly deleting or
changing existing index, text, or attribute fields, you will need to use MultiTerm’s export and import
functions. See the section “Global Changes” in the “Tips & Tricks” chapter for instructions.

However, you can make the following changes to your database definition without using the export
and import functions:

o Add new index, text, or attribute fields

. Add, change, or delete individual attribute values

. Change the default font of individual fields

. Change network options
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T'o make these kinds of changes, proceed as follows:

. From the File menu, select the Change Database Definition... command. The Database
Definition dialog appears on your screen.

Note

You can only select the Change Database Definition... command if you have exclusive access to
the database. When you open a database with the super user ID, MultiTerm asks you whether you
want exclusive access to the database. Answer Yes if you want to change the database definition.

Adding Index, Text, or Attribute Fields

o To add index, text, or attribute fields to your database definition, follow the steps in the
preceding section, “Creating a Database Definition.” Note however, that new fields can only be
added to the end of the field list.

Adding, Changing, or Deleting Attribute Values in a Pick List

Adding, changing, or deleting attribute values in your database definition is easily accomplished, since
MultiTerm ’95 Plus treats these items as normal text.

o To add, change, or delete attribute values in your database definition, follow the instructions in
the preceding section, “Creating a Database Definition.”

Please note, however, that attribute values that you have already used in your database remain in the
individual entries even when you change or delete them in the database definition. For instructions
on making global changes to attribute values that you have already used, refer to the “Global
Changes” section in the “Tips & Tricks” chapter.

Changing the Default Font

Follow these steps to change the default font of an index, text, or attribute field:
1. Click on the field for which you want to change the default font. The field is highlighted.

2. Click on the arrow to the right of the Default Font field. A drop-down list opens showing the
available fonts.

3. From the Default Font drop-down list, select the desired font. If the corresponding font is a
double byte font, activate the DBCS Font check box. For further information on DBCS fonts,
please see the “What’s New in MultiTerm 95 Plus” section in the “Introduction” chapter or
refer to the “Adding Index Fields for Double Byte LLanguages” section above.

Changing Network Options

You can change network options at any time. Please refer to the chapter “Using MultiTerm "95 Plus
in a Network Environment.”

Saving Changes or Aborting the Database Definition

. To save the changes to your database definition, click on the OK button. You are asked whether
you want to save the changed database definition; answer Yes. The changed database definition
is now stored.

. If you want to abort your changes without saving, click on the Cancel button or press the [Esc]
key, and confirm the abort by answering Yes.
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Editing Entries

Once you have created your own database definition as described in the “Creating a Database”
chapter, you can start creating entries and building your terminology database.

Each of your entries can be up to 500 fields long and contain 32,000 characters, or about 16 pages.
Each field can contain up to 4000 characters. However, each entry does not take up this much space
on your disk; only the actual length is stored.

MultiTerm considers even an entry with only one index field to be a complete entry. If for the time
being you only have one term in one language, it is completely acceptable to store only this term in an
entry. You can add a term in another language or additional information later. You can use a filter to
find these entries and complete them; this operation is described in the “Changing Entries” section
later in this chapter.

If you are not familiar with how MultiTerm uses index, text, and attribute fields to create a
hierarchical structure, please refer to the section titled “The Entry Structure” in the “Creating a
Database” chapter.

Note

Many people will find creating and editing entries faster using the keyboard method. This chapter
therefore describes both the keyboard and the mouse methods.

Creating a New Entry

To create a new entry, from the Edit menu, select the Add Entry command, or press the [F3]
function key. MultiTerm changes to edit mode, and an empty window appears on your screen.

itz TRADOS MultiTerm "95 Plus! - SAMPLE MTW <Add>

File  Edit wiew Seach Help

LI

| |Emr3,r Murnber

Figure 29: Empty Entry in Edit Mode

Multi'T'erm ’95 Plus, © 1995-97 by TRADOS GmbH



56 Editing Entries

Adding an Index Field for a Term

To add terms in various languages to your entry, you add them as index fields in the various
languages. Follow these steps:

Keyboard Method

1.  Typean [I] to enter an index field. The Insert Index Field dialog appears on your screen. This
dialog lists the languages (index fields) defined for the current database. The following
illustration shows the index fields for the sample database SAMPLE. MTW

Inzert Index Field [ %]

Deutsch
Francais
E gpaiiol

LCancel

Help

i

Figure 30: The Insert Index Field Dialog

2. Use the cursor keys [V] and [M] to select the desired field name. You can also type the first
letter of the field name. Confirm your selection by pressing [Enter]. The input field opens for
the language in which you want to add a term. The title bar shows you which index field you
selected. The following illustration shows an input field for the language Deursch.

N
[

;|| OK |

[T Mandatory
[T Multiple
[T Dnce per Index

;l [ Read-Only

Figure 31: The Input Field for “Deutsch”

3. Type the term into the input field, and confirm by pressing [Enter]. The new field immediately
appears in your entry.

To add additional terms in the same language or in a different one, repeat the above steps.
Y Mouse Method

1. Press the right mouse button. A list of field types appears on your screen.

N

Select the Index Field field type. A list of the languages (index fields) defined in your database
appears on your screen.

3. Double-click to select the desired language. The input field for the corresponding language
opens.

4. Type in the desired term and confirm by clicking on OK. The new field immediately appears in
your entry.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



Creating a New Entry

T'o add additional terms in the same language or different one, repeat the above steps.

Adding a Text Field for Additional Descriptive Information

If you want to add free-format information like definition or source to your entry, you enter this in the
corresponding text fields. The hierarchical entry structure allows you to assign additional descriptive
information to individual terms or to the entire entry. Follow these steps:

Keyboard Method

Move the pointer to the field to which you want to assign the additional descriptive information
by pressing the [2>] and [€] keys to jump from field to field. You can also use the [V] and [N
keys to jump directly from index field to index field.

. If you want to make the text subordinate to a term, move the pointer to the corresponding
index field. The message line shows the name of the index field where the pointer is
currently located.

. If you want to make the text global to the whole entry, move the cursor to the very top of
the entry. When the pointer is at the top of the entry, the message line displays the name
of the Entry Number system field.

Type a [T] to enter a text field. The Insert Text Field dialog appears on your screen. From
this dialog, you can select the text field you want to add from those defined in your database.
The following illustration shows the text fields for the sample database SAMPLE. MTW

Inzert Text Field [ %]

Source
Context Cancel
Related Words —
Grammar Help
Gram [ tob ]

Project Code

Figure 32: The Insert Text Field Dialog

Use the cursor keys [\] and [M] to select the desired text field name. You can also type the first
letter of the field name. Confirm your selection by pressing [Enter]. The corresponding input
field opens.

Type in the text you want to add. You can insert line breaks by pressing [Ctrl]+[Enter]. (If you
accidentally press the [Enter] key without pressing [Ctrl], the window closes and the
information you have entered so far appears on your screen. You can re-open the window by
pressing [E] for edit and then pressing [Enter].)

Confirm your entry by pressing [Enter]. You are returned to the entry; the new text field has
now been inserted.

Mouse Method

Use the mouse to move the pointer to the field to which you want to assign the additional
descriptive information.

. If you want to make the text subordinate to a term, move the pointer to the corresponding
index field. The message line shows the name of the index field where the pointer is
currently located.
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. If you want to make the text global to the whole entry, move the cursor to the very top of
the entry. When the pointer is at the top of the entry, the message line displays the name
of the Entry Number system field.

Press the 7ight mouse button. A list of field types appears on your screen.
Select the Text Field field type. The Insert Text Field dialog appears on your screen.
Double-click to select the desired text field. The corresponding input field opens.

Type in the text you want to add. You can insert line breaks by pressing [Ctrl]+[Enter]. (If you
accidentally press the [Enter] key without pressing [Ctrl], the window closes and the
information you have entered so far appears on your screen. You re-open the window by clicking
on the text field with the left mouse button.)

Confirm your entry by clicking on OK. You are returned to the entry; the new text field has now
been inserted.

Adding an Attribute Field and Value for Additional Classifying Information

If you want to add additional classifying information like subject, language level, customer, or text
type to your entry, it’s best to use an attribute. MultiTerm’s hierarchical entry structure allows you to
assign attributes to the entire entry, to an individual term, or to a text field.

Attributes like subject that apply to an entire entry are called global attributes.

Attributes specifying language level or grammatical information apply to individual terms and are
called zerm attributes.

Attributes like text type that apply to textual information are called rext attribuzes.

Follow these steps to assign an attribute to an entire entry, to a term, or to a text field:

Keyboard Method

Move the pointer to the field to which you want to assign the attribute by pressing the [2] and
[€] keys to jump from field to field. You can also use the [\/] and [N keys to jump directly
from index field to index field.

. If you want to create a global attribute that applies to the whole entry, move the cursor to
the very top of the entry. When the pointer is at the top of the entry, the message line
displays the name of the Entry Number system field.

. If you want to make the attribute subordinate to a term, move the pointer to the
corresponding index field. The message line shows the name of the field where the
pointer is currently located.

. If you want to make the attribute subordinate to a text item, move the pointer to the
corresponding text field. The message line shows the name of the field where the pointer
is currently located.

Press the [A] key for Attribute. The Attribute Fields dialog opens. From this dialog, you can
select attribute fields and values from those defined for the current database.

Press the key combination [Alt] + [F] to go to the Attribute Fields list. Use the cursor keys [V]
and [] to select the desired attribute field. You can also type the first letter of the attribute
field. The pick list of corresponding attribute values appears. The dialog in the following
illustration is from the sample database SAMPLE. MTW As you can see, the title bar shows both
the name of the field to which you are assigning the attribute as well as the selected attribute
field.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



Creating a New Entry

59

Entry Humber -» Subject 1]

Attribute Fields Attribute ¥alues
Architecture =
Category Trees

ax I
Type of Relation Cereals
Usage Label Wegetables =

Regional Label iFrLt
g:}'letLabEI Heavvy Engineering
Ien Electronics
Een_derl i [T Mandatory
quivalence Medicine [T Multiple
Lanny e
Business Administration [ Bead-Only
Economics ;I [T Automatic

Figure 33: The Subject Attribute Field with Attribute Values

4. Press the key combination [Alt] + [V] to move to the pick list, and select the desired attribute

value. Use the cursor keys [\V] and [M] to select the desired attribute field. You can also type
the first letter of the attribute field. The value is automatically highlighted. There are two ways
to select multiple attribute values simultaneously:

o Hold down the [Ctrl] key and click on the additional individual attribute values you want
to select. (This requires use of the mouse.)

o To select several adjacent items in a list at once, use the [\V] and 1] keys to select the
first item as described above, then hold down the [Shift] key and move the cursor keys
until the last desired item is highlighted.

If the selected attribute value ends with a colon, MultiT'erm automatically opens the input field
Variable Text as depicted below. If desired, use this input field to add descriptive information
as free-format text to the attribute value. This is useful, for example, when inputting source
specifications: if sources are managed via pick lists in your database, you can use the Variable
Text input field to append such information as page numbers or date of publication to the
source attribute value.

English -> Source List 1]

Attribute Fields Attribute ¥alues
Category i The Guardian;
Type of Relation The Econarmist;
Uszage Label Invention =
Regional Label P il
Sigte Label . Snih
Client ’
Een_derl [T Mandatory
Euwa ence [T Multiple
[~ Read-Only
[T Automatic

Variable Text Ip- 1234

Figure 34: Free-Format Text Input in Attribute Fields

To remove the highlight from an attribute value that you inadvertently selected, hold down the
[Ctrl] key and click on the attribute value. The highlight is removed.

Finally, confirm your selections by pressing [Enter]. The new attribute appears in your entry.
Y Mouse Method

1. Use the mouse to move the pointer to the field to which you want to assign the attribute.
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. If you want to create a global attribute that applies to the whole entry, move the cursor to
the very top of the entry. When the pointer is at the top of the entry, the message line
displays the name of the Entry Number system field.

. If you want to make the attribute subordinate to a term, move the pointer to the
corresponding index field. The message line shows the name of the field where the
pointer is currently located.

. If you want to make the attribute subordinate to a text item, move the pointer to the
corresponding text field. The message line shows the name of the field where the pointer
is currently located.

Press the 7ight mouse button. A list of field types appears on your screen.

Select the Attribute Field field type. The Attribute Fields dialog opens. From this dialog, you
can select attribute fields and values from those defined for this database.

Click on the desired attribute field in the list on the left. The pick list listing the corresponding
attribute values appears.

Select the desired attribute value by clicking on it. If necessary, you can highlight several
attribute values as follows:

. Hold down the [Ctrl] key and click on the additional individual attribute values you want
to select.
. To select several adjacent items in a list at once, click on the first item, hold down the

[Shift] key, and click on the last item you want to select.

If the selected attribute value ends with a colon, MultiT'erm automatically opens the input field
Variable Text as depicted below. If desired, use this input field to add descriptive information
as free-format text to the attribute value. This is useful, for example, when inputting source
specifications: if sources are managed via pick lists in your database, you can use the Variable
Text input field to add such information as page numbers, date of publication to the source
attribute value itself.

To remove the highlight from an attribute value that you inadvertently selected, hold down the
[Ctrl] key and click on the attribute value. The highlight is removed. Finally, confirm your
selection by clicking on OK. The new attribute appears in your entry.

Changing Field Contents

Follow these steps to change or add to individual fields in your entry:

Keyboard Method

Move the pointer to the field you want to change by pressing the [2] and [€] keys to jump
from field to field. You can also use the [\] and [M] keys to jump directly from index field to
index field.

Press the [Enter] key. If you selected an index or text field, the corresponding input window
containing the existing text opens. If you selected an attribute field, the Attribute Fields dialog
opens, showing the currently selected attribute values.

Make the desired changes and confirm by pressing [Enter]. You are returned to the entry, which
now contains the changes you made.

Mouse Method

Click on the field that you want to change. If you selected an index or text field, the
corresponding input window containing the existing text opens. If you selected an attribute
field, the Attribute Fields dialog opens, showing the currently selected attribute values.
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2. Make the desired changes and confirm by clicking on OK. You are returned to the entry, which
now contains the changes you made.

Deleting Unnecessary Fields

Fields you no longer need can easily be deleted so that they don’t unnecessarily take up disk space.
Follow these steps:

Keyboard Method

1. Move the pointer to the field you want to delete by pressing the [->] and [€] keys to jump from
field to field. You can also use the [V] and [N] keys to jump directly from index field to index
field.

2. Press the [Delete] key. Answer Yes to the question of whether you really want to delete the
field. The field and any subordinate fields are deleted.

‘B Mouse Method

1. Move the mouse pointer to the field you want to delete.

2. Press the left mouse button. A menu appears from which you can select either Edit Field or
Delete Field.

3. Select the Delete Field command. A submenu appears from which you can select either Don’t

delete or Delete....

4. Select the Delete... command, and answer Yes to the question of whether you really want to
delete the field. The field and any subordinate fields are deleted.

Note

MultiTerm’s hierarchical entry structure offers an advantage when deleting fields. If you delete the
highest-level field that you no longer need, all subordinate fields are automatically deleted. For
example, if you delete an index field, all text and attribute fields that are subordinate to that index
field in the hierarchy are also deleted. This means that you can delete an entire term structure in
one step.

Creating Cross References

Cross references allow you to jump from one entry to another with one mouse click, to review the
entry, and if desired, to return to the original entry. You can use cross references, for example, to
instantly access superordinate, subordinate, or related terms, or false cognates. In order for MultiTerm
to find the target entry, the cross-reference text in the originating entry must be identical to the term
in the target entry.

Let’s assume that your database contains entries for brussels sprouts and the superordinate term cabbage,
and that you would like to add a cross reference from one entry to the other. If your brussels sprouts
entry already has a definition in which the word cabbage appears, you can define the cross reference
directly in the corresponding text. Otherwise, you could add a separate text field with the note See a/so
cabbage and define the cross reference in this note. Follow these steps:

1. Add a new text field as described above, or if you have already created the text field with the
corresponding cross-reference text, open this text field for editing.

2. This step depends on whether you would like to create a cross-reference in a text field using a
conventional font or a double byte character set (DBCS) font:
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. In the conventional (non-DBCS) text field, add a caret character () before and after the
term you want to define as a cross reference. (If you are using an international keyboard
layout, you may need to press a space after typing the [A] key to make it appear on its
own.) The input box for our example might look like this:

Englizsh -> Definition

A type of “cabbage™ with leaves wrapped around & lang ﬂ | oK I

stem in the form of a small spherical rose.

[T Mandatory

[~ Multiple

[T Once per Index
LI [ Read-Dnly

Figure 3S: Input Text with Cross Reference

. If a double-byte character set font has been selected for the text field in the database
definition (for such languages as Japanese, Chinese, or Korkean), add a double quotation
mark (") before and after the term you want to define as a cross-reference.

Confirm your entry. The term defined as a cross reference is now highlighted in green in your
entry. The cross reference is available as soon as you save your entry (see below for instructions
on saving the entry).

Notes

MultiTerm can only jump to a cross reference if the cross reference is identical to the index
field it refers to.

Cross references need not be limited to single words; they can also refer to multi-word terms.
The only requirement is that the multi-word term exist as an index field in another entry.
Otherwise, MultiTerm will not be able to make the jump.

Cross references can jump between languages. For example, you can put a cross reference to a
German term in a text field that is subordinate to an English term. To the English term faébric,
you might add a note with a cross reference to the German word Fabrif: “not to be confused
with AFabrikA.”

Specifying the Entry Class

Entry classes are primarily intended for use in a network environment; they control which users or
user groups have read and write rights to a given entry. Please refer to the chapter “Using
MultiTerm '95 Plus in a Network Environment” for more information. However, you can also use
Entry Classes to classify entries, for example according to their quality.

Follow these steps to specify the Entry Class of an entry:

Click on the Entry Header button or press the [H] key. The Entry Header dialog appears on
your screen.

From the Entry Class drop-down list, select the desired Entry Class. If you are working on a
network, only those Entry Classes to which you have write access are available.
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Entry Header

Entry Humber ||] Entry Class

Eln

i IE- 1

Creation Date |1 2.12.1996 - 18:36:52 Graphic File

Created By: Isupe[ I

Change Date |1 212.1996 - 18:36:52 camera.hif
carseat. tif

Changed By: Isupe[ covermt_hif
covermta.ti

Figure 36: The Entry Header Dialog with a Drop-Down List

of Available Entry Classes

3. Confirm by clicking on Close. The Entry Class is defined. Since the Ensry Class system field is

located in the entry header, it is not displayed in the default entry layout. Please refer to the
chapter “Defining Layouts” for instructions on how to make the Entry Class tield visible.

Attaching Graphic Files

Users of the Professional Edition of MultiTerm 95 Plus can illustrate the content of their entries with
graphics. Follow these steps:

1. Click on the Entry Header button or press the [H] key. The Entry Header dialog appears on
your screen.

2. Select the desired graphic from the Graphic File list box and confirm by pressing Close. The
graphic immediately appears in your entry. (If you are working with the Lite Edition of
MultiTerm ’95 Plus, only the name of the graphic file appears in your entry.)

cz| TRADOS MultiTerm *35 Plus! - SAMPLE_ MTW <Edit>

Eiler Edit wiew Seach Help
ST |

-
English single lens reflex j
camera

Dewtsch Spiegelreflexkamera
Definition Kamera
mit eingebau- tem
Spiegel, der das vomn
Objektiv erfaiite Bild
auf eine Mattscheibe
witft, =0 dafll im
Sucher ein genaues
Abbild won dem
erscheint, was das
Objektiv einfangt.
Source Duden

Entry Number I?z Entry Class 1 j

| CreationDate  [12121556 - 182628 | grohic Fiie Help |
Created By: Isuper |[camera.tif
K
Change Date |12.12.1995 - 18:26:28 -
carseat.tif
Changed By: ISUPEI covermt_tif
covermta.tif fad |
English
Figure 37: The Entry Header Dialog with a Graphic File.

Background Shows the Entry in Edit Mode.
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Keep the following rules in mind:

MultiTerm always looks for the graphic file in the graphic directory specified in the database
definition. This means that all graphic files for a database must be located on the same drive and
in the same directory.

If you specify a file name that doesn’t exist, only the name will be displayed.

The Professional Edition of MultiTerm ’95 Plus can display graphics with the following formats:

File Name Format

*. BWP Bitmap format

* . WWF Windows Metafile format

*, PCX Paintbrush format

*TIF Tagged Image File format

* . EPS Encapsulated Postscript format
*. PS Postscript format

*AF Graphic Image File format

Saving the New Entry

When you are satisfied with your entry, click on the Save button, or type an [S] for Save, or press the
[F4] function key. MultiT'erm saves your entry and returns from edit mode to display mode.

The following sections describe a few “tricks” that should make editing entries easier. At the end of
the chapter, you will find a detailed description of the input model function. You can use input
models to simplify creating and editing entries, and especially in a network environment, to control
how entries are created and edited.

Moving or Copying Field Contents

You can use the Windows clipboard to move or copy all or part of the contents of a field like
Definition or Context as follows:

If the entry from which you want to move or copy a text passage is not already on your screen,
search for the entry.

If you are not already in edit mode, change to edit mode by selecting the Edit Entry command
from the Edit menu or by pressing the [F2] key.

Click on the field from which you want to move or copy a text passage and select the Edit Field
command from the menu that appears. The corresponding input window opens showing the text
that has already been entered.

Highlight the text that you want to copy or cut, using the same technique as in a word processor.

Press [Ctrl]+[C] to copy the highlighted text or [Ctrl]+[X] to cut it. (Under Windows 95 or
NT 4.x, you can also click the 77ght mouse button and choose the Copy or Cut command from
the Context menu.) This places the highlighted text into the Windows clipboard. Click OK or
press [Enter] to leave the input window.

Now click on the field where you want to insert the copied or cut text, and select the Edit Field
command from the menu that appears. Or add a new field as usual by typing [I] for an Index
field or [T] for a Text field. The corresponding input window opens.

Press [Ctrl]+[V] or, under Windows 95 and NT 4.x, click the right mouse button and choose
Paste from the Context menu. The text you cut or copied is now inserted from the Windows
clipboard into this field. Change the field contents if you like, and then confirm your input by
pressing OK or [Enter].
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Continue editing the entry if you want, for example to delete unneeded fields. Save the entry as
usual by clicking on the Save button, by typing an [S] for Save, or by pressing the [F4] function
key.

You can use the same procedure for copying field contents from one entry to another. To do so,
simply cut or copy the text to the Windows clipboard, save the entry, and edit the entry where you
want to insert or copy the text.

Copying Text from the Word Processor

Of course, you can also use the Windows clipboard to copy text from a word processor to MultiTerm.

N

Highlight the text you want to copy in your word processor and put it in the Windows clipboard
using the Copy command from the Edit menu, or by pressing the [Ctrl]+[C] key combination.

Switch to MultiTerm and search for the entry where you want to insert the text, if the entry is
not already shown on your screen.

If you are not already in edit mode, change to edit mode by selecting the Edit Entry command
from the Edit menu or by pressing the [F2] key.

Now click on the field where you want to insert the copied text from the Windows clipboard,
and select the Edit Field command from the menu that appears. Or add a new field as usual by
typing [I] for an Index field or [T] for a Text field. The corresponding input window opens.

Press [Ctrl]+[V] or, under Windows 95 and NT 4.x, click the right mouse button and choose
Paste from the Context menu. The text you copied is now inserted from the Windows
clipboard into the field. Change the field contents if you like, and then confirm your input by
pressing OK or [Enter].

Continue editing the entry if you want, then save the entry as usual by clicking on the Save
button, by typing an [S] for Save, or by pressing the [F4] function key.

Copying an Entire Entry

To copy an entire entry within MultiT'erm, you can use the program’s internal buffer. Note that this
buffer is 7ot the same as the Windows clipboard. Follow these steps:

Keyboard Method

N

Search for the entry that you want to copy if it is not already displayed on your screen.
Press the key combination [Ctrl]+[Insert]. The currently displayed entry is copied to the buffer.

Add a new entry by pressing the [F3] function key, or edit the entry to be changed by pressing
the [F2] function key.

Press the key combination [Shift]+[Insert]. The entry in the buffer is pasted into the entry
currently being edited. If you want, you can now change the entry as described above.

Save the entry as usual.
Mouse Method
Search for the entry that you want to copy if it is not already displayed on your screen.

From the Edit menu, select the Copy Entry to Buffer command. The currently displayed
entry is copied to the buffer.
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3. From the Edit menu, select the Add Entry command to add a new entry, or select the Edit
Entry command to change an existing entry.

4. From the Edit menu, select the Paste Buffer into Entry command. The entry in the buffer is
pasted into the entry currently being edited. If you want, you can now change the entry as
described above.

5. Save the entry as usual.

Recognising Duplicates

When you add or change index fields, MultiTerm automatically checks whether the term you enter
already exists in the database. This function is called dup/licate recognition. When MultiTerm detects a
duplicate entry, a message appears on your screen. MultiTerm tells you that the term already exists
and asks whether you want to abort editing the current entry and look at the other entry. The
following two cases can be distinguished:

Case One: You are currently creating an entry for a homonym and are aware that this term already
exists in another entry. In this case, you can ignore the message by pressing No and continuing to
edit your entry.

Case Two: You were not aware that this term already exists in your database. You would like to look
at the other entry to decide whether you should continue creating the current entry or abort it. Follow
these steps:

1.  Answer Yes to the question of whether to abort the current edit and look at the other entry.
The information you have created so far is automatically stored in the so-called insert buffer. It
remains available for you to use later.

2. The other entry in which the term already exists appears on your screen. The entry appears in
edit mode so that you can immediately continue editing. The message “Cross reference to a
homonym entry” appears in the message line.

5| TRADDS MultiTerm '35 Plus! - SAMPLE MTW <Edit>

Eile Edit wiew Zearch Help

T |
Subject Furniture ﬂ

English bench
Definition & long seat for two or mare persons
Source Webster's New Encyelopedic Dictionary, Mew York 1993

Deutsch Bank
Definition Sitzgelegenheit aus Holz, Stein 0.4, die mehreren
Personen nebeneinander Platz bietet
Source Duden, Deutsches Universakwiarerbuch, Mannheim 1939

Figure 38: The German Term Bank as an Example of Homonym Recognition

Now you can decide whether your new entry is in fact a duplicate or whether it is really a new entry
for a different concept.

Case One: You determine that an entry already exists for this concept and that this entry already
contains all the desired information.
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. Abort editing the current entry by clicking on the Cancel button or pressing the [Esc] key. You
are returned to display mode.

Case Two: You determine that there is already an entry in your database for the concept, and you
want to add fields that may have been created in the entry you were working on.

1.  From the Edit menu, select the Paste Buffer into Entry option, or press the key combination
[Shift]+[Insert]. The fields already created are added to or combined with the current entry.

2. If your entry is now complete, save it by clicking on the Save button, by pressing [S] for Save,
or by pressing the [F4] function key.

Case Three: You determine that the term is in fact a homonym, that is, a term that is written the
same way but that describes a different concept. In this case, you want to continue editing the source
entry, which is still available in the input buffer.

1. Abort editing the homonym entry by clicking on the Cancel button or pressing the [Esc] key.
You are returned to display mode.

2. Create the new entry by selecting the Add Entry command from the Edit menu or by pressing
the [F3] function key. An empty entry window appears on your screen, and MultiTerm reminds
you in the message line that you still have data in the insert buffer.

3. From the Edit menu, select the Insert Buffer into Entry option or press the key combination
[Shift]+[Insert]. The contents of the insert buffer are inserted into the entry and you can
continue editing the original entry.

4. If your entry is now complete, save it as usual by clicking on the Save button, by pressing [S]
for Save, or by pressing the [F4] function key.

Special Linguistic Cases

How do | handle synonyms?

MultiTerm automatically stores all terms for a concept at the same level in an entry. Synonyms
therefore do not need any special identification. If an entry contains multiple terms in one language,
it is implicitly clear that they must be synonyms. If the various synonyms represent different language
levels or regional usages, you can use attributes to classify them accordingly.

o] TRADOS MultiTerm "95 Plus! - SAMPLE MTW <View>

File Edit “iew Seach Help

Index IEnglish J IE jl Target Ineutsch j
|

carrot | cauliflower I

| car

Entry Humber 15 =
Subject Vegetables —
English

carrot

Deutsch

Mohrriibe proforable
Deutsch

yelbe Riibe Siddemtschiand

Deutsch
Mahre

| |Target Synonym

Figure 39: Example of German Synonyms
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How do | specify the preferred term among the synonyms?

In MultiTerm, you can specity the preferred term among several synonyms even without using
attributes. To achieve this, the only thing you have to do is make sure that you enter the preferred
term as the fopmost term in edit mode in the corresponding language. This is done by placing the
mouse pointer somewhere above of the first index field of the corresponding language, if any, and
then entering the desired preferred term.

By default, when searching entries, MultiT'erm displays the search term as the first term in the
current source language (see the “Searching for Entries” chapter). This means that when you look for
a synonym, this search term—which is not necessarily the preferred term—will be located at the top
of the entry. To have MultiTerm behave differently, that is, to have the program always display the
topmost term of a given index first, from the View menu, select the Display Fields option and
activate the Don’t Sort Synonyms command. This causes the main source term to be located at the
top of the entry even if you search for one of its synonyms. For more information on this topic, please
refer to the “Changing the Sequence of Fields in Display Mode” section in the “Defining Layouts”
chapter.

How do | handle multi-word terms?

Multi-word terms are terms consisting of more than one word. A typical multi-word term is for
example the term [ndian corn as a synonym for maize. Multi-word terms also include phraseological
and idiomatic expressions, for example The apple never falls far from the tree, as well as linguistic
constructions like Batteries not included. Storing multi-word terms in a database raises the question of
which headword they should be stored under.

When searching for multi-word terms for idiomatic expressions in your database, it does not matter
under which headword the multi-word terms are stored; MultiTerm offers several options for
searching for entries based on any word or string in the term. For information on searching, refer to
the sections “Global Searching” and “Fuzzy Searching” in the “Searching for Entries” chapter.

On the other hand, when creating a printed dictionary from your database, when pasting terms into a
word processor, and when browsing in your database, it does make a difference which word of a multi-
word term appears first in the index field. For example, the term corn, Indian would appear under C
in your printed dictionary, whereas Indian corn would appear under I. When pasting a multi-word
term into a word processor, you would of course like the term appear in the form in which you need it
in your text, in this example Indian corn instead of corn, Indian. 1t is therefore worthwhile, in spite of
MultiTerm’s various search functions, to choose and consistently apply one of these two approaches.

tg] TRADOS MultiTerm *95 Plus! - SAMPLE MTW <View>

File Edit “iew Search Help
Index IEninsh j @ j| Target II]eutsch j
| horse-radish I indian corn | kohlrabi I
-
Entry Humber 35 —
Subject Cereals —
English
indian corn
English
maize preferable
Deutsch
Mais preferable
Deutsch
Kukuruz Osterreick
b
| |Snr‘[ Term

Figure 40: Example of Multi-Word Terms
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How do | handle homonyms?

Homonymy occurs when a term that is spelled the same refers to more than one concept. A typical
homonym is the German word Sc//of}, which refers to a lock on a door as well as to a castle.

In a regular printed dictionary, such homonyms are stored in one entry, so that for example in a
German-English dictionary, the two target-language equivalents /ock and castle would appear together
in one entry.

MultiTerm, on the other hand, stores each concept in its own entry, which is why MultiTerm is called
concept-oriented. This would mean, for example, that you would create two entries for the German
word Schlof, one for Schlof in its meaning as a door lock, with the English equivalent /oc#, and one for
Schloff in its meaning as a residence for nobility, with the English equivalent cast/e. This approach
allows you to search for terms in any language direction. Note that MultiT'erm’s export function gives
you the option of combining the homonyms under one headword when preparing a printing
dictionary.

Changing Entries

If you want to add additional information to an entry that you already created, or if you want to edit or
delete existing information, follow these steps to edit an entry:

1. Search for the desired entry in your database if the entry is not already displayed on your screen.

2. From the Edit menu, select the Edit Entry option, or double-click on the current search term
under the search field, or press [F2]. MultiT'erm changes to edit mode.

You can now edit your entry using the functions described in the section “Creating a New Entry”
earlier in this chapter.

Note

If you are working on a network and you try to edit an entry to which you do not have write access,
you will not be able to edit the entry, and you will receive the message “You do not have write
authorisation for this Entry Class.” For further information on access rights, refer to the chapter
“Using MultiTerm ’95 Plus in a Network Environment”

Searching for “Incomplete” Entries

At times you may want to systematically review your data and fill in any missing information.
MultiTerm allows you to display all entries that do not yet have a term or a definition in a certain
language, for example. To do this, you use MultiT'erm’s powerful filter function as described in the
following examples. If you are not yet familiar with this feature, please refer to the chapter “Filtering
Entries.”

Example 1: Finding All Entries without Terms in a Certain Language
Let’s assume that you want to find all the entries that do not yet have an English term. Let’s further

assume that you have named the English index field English.

1. Start a filter definition by selecting the Define Filter... option from the View menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.
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Filter Definition
Field or Field Group Criterion
Delete
[ Only Use Matching Fields Criterion Or...

Figure 41: The Filter Definition Dialog

If filter definitions are already present in this dialog, delete them by clicking the Delete button
or by pressing [Alt]+[D] until the list is empty.

Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

Select English from the list of index fields and confirm by clicking on OK or pressing [Enter].
This informs MultiTerm that the filter definition applies to the index field English. You are
returned to the Filter Definition dialog, where the selected field English appears.

Type in “!I*” as the criterion. This tells MultiTerm to search for all entries in which the index
field English is not present.

Filter D efinition

Close
Field or Field Group Criterion

Load...

Bemove. ..

Delete

[ Only Use Matching Fields Criterion I!x| Or

ddafdladag

Figure 42: Completed Filter Definition

Confirm your filter definition by clicking on Close or pressing [Enter]. This concludes your
filter definition.

Now, activate the filter by selecting the Filter Active option from the View menu or by
pressing [Ctrl]+[A]. A check mark (v) appears before the Filter Active option, and the message
“Filter is active” appears in the message line. Entries that do not match the filter now appear
with a gray background until you deactivate the filter. You can deactivate the filter by again
selecting the Filter Active option from the View menu, so that the check mark before the
option disappears.
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8. While the filter is active, if you press [Ctrl]+[F5] to browse forwards or [Ctrl]+[F4] to browse
backwards, only the entries that match the filter are displayed.

You can now edit the “incomplete” entries and add the missing English terms.

Example 2: Searching for All Entries without a Definition in a Certain Language

Let’s assume that you want to find all the entries that do not yet have a definition in a certain
language so that you can complete them. The following steps assume further that the language is
German and that the corresponding fields in your database definition are called Deutsch and Definition:

1. Start a filter definition by selecting the Define Filter... option from the View menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.

2. If fileer definitions are already present in this dialog, delete them by clicking the Delete button
or by pressing [Ale]+[D] until the list is empty.

3. Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

4. Select the field Deutsch from the list of index fields, and the field Definition from the list of text
fields; confirm your selections with OK or [Enter]. This informs MultiTerm that your filter
definition applies to the text field Definition for the Deutsch index field. You are returned to the
filter definition where the field group Deutsch 2Definition appears.

5. Type in “!*” as the criterion again. This tells MultiTerm to search for all entries containing the
index field Deutsch but without the text tield Definition.

Filter Definition
Field or Field Group Criterion
Deutzch -> Definition 1=
Delete
[ Only Use Matching Fields Criterion I!*l Or...

Figure 43: Completed Filter Definition

6.  Confirm your filter definition by clicking on Close or pressing [Enter]. This concludes the filter
definition.

7.  Now, activate the filter by selecting the Filter Active option from the View menu or by
pressing [Ctrl]+[A]. A check mark (v') appears before the Filter Active option, and the message
“Filter is active” appears in the message line. Entries that do not match the filter now appear
with a gray background until you deactivate the filter. You can deactivate the filter by again
selecting the Filter Active option from the View menu, so that the check mark before the
option disappears.

8. While the filter is active, if you press [Ctrl]+[F5] to browse forwards or [Ctrl]+[F4] to browse
backwards, only the entries that match the filter are displayed, that is, all entries containing the
index field Deutsch without a definition.

Multi'T'erm ’95 Plus, © 1995-97 by TRADOS GmbH



72

Editing Entries

Now you can edit the incomplete entries and add the missing definitions.

Deleting Entries

Finally, you can completely delete entries, for example those that have become outdated, as follows:

1.

2.

Search for the corresponding entry in your database. The entry appears on your screen.

From the Edit menu, select the Delete Entry option. When asked for confirmation, answer
Yes.

Input Models

What are Input Models?

Input models are special entries that enable consistent and controlled yet flexible entry of
terminological data. Among many things, input models allow you to do the following:

specify one or more basic structures for all your terminological entries
pre-define default values for fields

determine whether, how often, and in what sequence index, text, and attribute fields may or
must occur in new or changed entries

in a network environment, determine who can edit which fields and which fields can only be
read

have MultiT'erm automatically record when a field was last changed and by whom

So input models are templates that allow you to create and change entries quickly, flexibly, and yet
consistently.

The following sections describe the functionality and possibilities of input models in detail.

Basic Rules for Input Models

When creating input models, a few different scenarios are possible, especially when MultiTerm is
used in a network environment.

The MultiTerm system administrator (user ID swper) can create any input model for himself or
herself and for other users. Once input models have been defined, the s#per user can choose to
use them or not to use them. When MultiTerm is used stand-alone (not on a network), the user
is always the system administrator, so this rule applies to stand-alone MultiTerm users as well.
The system administrator therefore functions as the “architect” of input models, defining the
templates that others are required to follow when creating entries.

In a network environment, one of two cases applies to the “normal” MultiTerm user:

. If the system administrator has already defined input models, the “normal” user must use
these models. The “normal” user can also create private input models, but these must be
based on pre-defined input models. Mandatory fields cannot be deleted from the private
input model, and fields allowed to occur only once cannot be converted to fields allowing
multiple occurrences.
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. If the system administrator has not defined any input models, the “normal” user can
choose whether to work with input models or not.

A further important rule is that you must include #// fields in the input model that you may want to
use later in your entries. For example, if you want all text fields to be available under every index
field, when creating the input model, you must attach each text field to every index field. This is
explained in more detail later in this section.

Finally, keep in mind that input models are not entry-specific. An entry created with one input model
may be edited using another model, provided that

o the user has both entry-level write access (as defined using Entry Classes);

. the user has access to an input model that allows editing fields in this entry.

This allows, for example, a translator to add entries in with a Status attribute of “unreviewed” using
one input model, and a terminologist to check the entry and change the Status to “approved” using
another input model.

When input models are used in databases, the databases are said to be “protected” or *
input models.

‘secured” by

Creating Input Models as the MultiTerm System Administrator (“super”)

As mentioned above, the system administrator (the user with the user ID s#per) can create and use any
kind of input model for himself or herself as well as for all other users. This section described how to
create input models, what kinds of controls are available and what they mean, and so on.

Follow these steps to create a new input model:

1. Open the database for which you want to create input models, if it is not already open.

2. From the Edit menu, select the Input Models... command ([Ctrl] + [F3]). The Input Models
dialog appears on your screen. The first time you access this dialog, the list of input models is of

course empty.

Input Models

Current Model:

Cancel

e

Edit

Bemove

Deactivate

I L e

Figure 44: First Call of the Input Models Dialog

3. Now, to create a new input model, click on the New... button. The Please enter a new model
name dialog appears on your screen. Type in the desired name and confirm by clicking on OK.
The following naming conventions apply:

. If desired, you can assign one or more input model names to each user. The name of the
input model must begin with the same string as the corresponding user’s ID in the
Database Definition Network Options dialog. This ensures that the user oz/y sees the
input models defined specifically for him or her. For example, if you want to define input
models for the user ID Meyer, you can specify model names Meyer01, Meyer02, Meyer
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German-English. and Meyer German with Definition. For the user with 1D Jo/nson, you can
assign corresponding model names beginning with the string Joknson. These are called
“personal” input models.

. If instead of personal input models, you want to define generalised input models, make
sure that none of the model names coincidentally begins with a user ID specified in
Network Options dialog. Generalised models are also called “public” input models. If
only public input models are defined, all users always see all the available public input
models.

. Of course, you can combine these two rules in any way you like, for example specifying
personal models for some of the users and allowing the rest access to all public models.

4.  Now you are asked whether you would like to search for existing models on disk first. If you are
creating input models for the first time, you can answer No to this question. Later on we will
see that input models can also be stored on disk so that they can be used with other databases as
necessary.

5. You are now placed in edit mode, and the entry window appears in gray. The word “<Design>”
appears in the MultiTerm title bar, along with the model name you assigned in step 3.

is| TRADOS MultiTerm ‘35 Plus! - SAMPLE _MTW <Design> My First Input Model M=l E3

File  Edit “iew Seach Help

s ] |

| |Entry Murnber

Figure 45: Empty Input Model in Edit Mode

The following sections detail how to add index, text and attribute fields, which options are available,
and how to use them.

When editing input models, the same keyboard and mouse functions are available as in “normal” edit
mode. You will find a list of all functions in “Appendix I: MultiTerm ’95 Plus Reference.”

Adding Index Fields to an Input Model
Follow these steps to add index fields to an input model for the various languages defined in your
database:

Keyboard Method

1. Press the [I] key for index field, or press [Insert] and then press the [I] key to select the Insert
Index Field command from the context menu. The Insert Index Field dialog appears on your
screen. This dialog lists the languages available in your database along with any other index
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fields you have defined. The following illustration shows the index fields for the sample
database SAMPLE. MTW

Insert Index Field 1]
Enﬂlish | oK I
Frangais C 1
Espaﬁnl %
Help

Figure 46: The Insert Index Field Dialog

2. Use the cursor keys [V] and [] to select the desired field name. You can also type the first
letter of the field name. Confirm your selection by pressing [Enter]. The input field for the
corresponding language opens. The title bar shows you which index field you selected. The
following illustration shows an input field for Deutsch.

T
=]

[C Mandatory

[~ Multiple

[T Once per Index
;I [ Bead-Only

Figure 47: The Input Field for Deutsch

3. You can now define the following characteristics for this index field in the input model:

If the field can appear once in each entry, but is not required, do not activate any check
boxes.

If the field must appear once and only once in each entry, press the key combination [Alt] +
[M] to activate the Mandatory check box.

If the field must appear af least once in each entry, press the key combinations [Alt] + [P]
and [Alt] + [M] to activate the Multiple and Mandatory check boxes.

If the field can appear multiple times in each entry, but is not required, press the key
combination [Alt] + [P] to activate the Multiple check box.

If the field should be available solely on a read-only basis and not be changeable, press the
key combination [Alt] + [R] to activate the Read-Only check box.

Confirm your selection as usual by pressing the [Enter] key. The corresponding index field
immediately appears in the entry. If you activated one of the check boxes, a special character
appears showing which characteristics you selected. You will find a list of these special
characters and their meanings later in this chapter, in the section titled “Special Characters in
Input Models.”

To add additional index fields to your input model, repeat the steps listed above. Note that index
fields that are already defined in the input model cannot be selected again.
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“® Mouse Method
1. Press the right mouse button. The field type context menu appears on your screen.

2. Select the Insert Index Field command. A list of the languages (index fields) defined in your
database appears on your screen.

3. Double-click to select the desired language. The input field for the corresponding language
opens. You can now define the following characteristics for this index field in the input model:

. If the field can appear once in each entry, but is not required, do not click on any check
boxes.

. If the field must appear once and only once in each entry, click on the Mandatory check
box.

. If the field must appear at Jeast once in each entry, click on both the Multiple and

Mandatory check boxes.

. If the field can appear multiple times in each entry, but is not required, click on the
Multiple check box.
. If the field should be available solely on a 7ead-only basis and not be changeable, click on

the Read-Only check box.

Confirm your selection as usual by clicking on OK. The corresponding index field immediately
appears in the entry. If you activated one of the check boxes, a special character appears showing
which characteristics you selected. You will find a list of these special characters and their meanings
later in this chapter, in the section titled “Special Characters in Input Models.”

Adding Text Fields to an Input Model

MultiTerm’s hierarchical entry structure allows you to assign text fields to individual terms (index
fields) or to the entire entry. Follow these steps to add text fields to an input model:

Keyboard Method

1. Move the pointer to the field to which you want to assign the additional descriptive information
by pressing the [2] and [€] keys to jump from field to field.

. If you want to make the text field subordinate to an index field, move the pointer to the
corresponding index field. The message line shows the name of the index field where the
pointer is currently located.

. If you want to make the text global to the whole entry, move the cursor to the very top of
the entry. When the pointer is at the top of the entry, the message line displays the name
of the Entry Number system field.

2. Press the [T] key for text field, or press [Insert] and then press the [T] key to select the Insert
Text Field command from the context menu. The Insert Text Field dialog appears. Here, you
can select the text field you want to add from those defined in your database. The following
illustration shows the text fields for the sample database SAMPLE. MTW
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Insert Text Field 1]

Source -
Context

Related Words Lancel
Grammar Help
Mote l—_

Project Code

Figure 48: The Insert Text Field Dialog

Use the cursor keys [\] and [/] to select the desired text field name. You can also type the first
letter of the field name. Confirm your selection by pressing [Enter]. The corresponding input
field opens.

You can now define the following characteristics for this text field in the input model:

. If the field can appear once in the current structure (either under the index field or the
Entry Number), but is not required, do not activate any check boxes.

. If the field must appear once and only once in the current structure, press the key
combination [Alt] + [M] to activate the Mandatory check box.

. If the field must appear a7 Jeast once in the current structure, press the key combinations

[Alt] + [P] and [Alt] + [M] to activate the Multiple and Mandatory check boxes.

. If the field can be optionally selected once per language, press the key combination [Alt] +
[O] to activate the Once per Index check box. This is useful, for example, if you want to
specify that the text field Definition can only appear under one term in a language, but not
under the synonyms in the same language.

. If the field can appear multiple times in the current structure, but is not required, press the
key combination [Alt] + [P] to activate the Multiple check box.

. If the field should be available solely on a read-only basis and not be changeable, press the
key combination [Alt] + [R] to activate the Read-Only check box.

Besides these characteristics, you can also use the input model to specify default text for a text
field. When you use the input model, this text automatically appears when you create a new
entry. For example, in the text field Source attached to the Deutsch index field, you could specify
Duden 1995, §. xxx as the default text; this text would then not need to be re-typed for each
entry. This example is illustrated in the figure below.

Confirm your entry by pressing [Enter]. The corresponding text field immediately appears in
the entry. If you activated one of the check boxes, a special character appears showing which
characteristics you selected. You will find a list of these special characters and their meanings
later in this chapter, in the section titled “Special Characters in Input Models.” If you also typed
in text, this appears in the input model as well.
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Figure 49: Input Model with Text Fields and Pre-Defined Source References

To add additional text fields to your input model, repeat the steps listed above. Note that text fields
that are already defined for an index field cannot be selected again for the same index field, and text
fields already defined for Entry Number cannot be selected again for Entry Number.

Y Mouse Method
1. Use the mouse to move the pointer to the field to which you want to assign the text field.

. If you want to make the text field subordinate to an index field, move the pointer to the
corresponding index field. The message line shows the name of the index field where the
pointer is currently located.

. If you want to make the text global to the whole entry, move the cursor to the very top of
the entry. When the pointer is at the top of the entry, the message line displays the name
of the Entry Number system field.

2. Press the right mouse button. The field type context menu appears on your screen.
3. Select the Insert Text Field command. The Insert Text Field dialog appears on your screen.
4. Double-click to select the desired text field. The corresponding input field opens. You can now

define the following characteristics for this text field in the input model:

. If the field can appear once in the current structure (either under the index field or the
Entry Number), but is not required, do not click on any check boxes.

. If the field must appear once and only once in the current structure, click on the Mandatory
check box.
. If the field must appear a7 least once in the current structure, click on both the Multiple and

Mandatory check boxes.

. If the field can be optionally selected once per language, click on the Once per Index
check box. This is useful, for example, if you want to specify that the text field Definition
can only appear under one term in a language, but not under the synonyms in the same
language.

. If the field can appear multiple times in the current structure, but is not required, click on
the Multiple check box.
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. If the field should be available solely on a read-only basis and not be changeable, click on
the Read-Only check box.

Besides these characteristics, you can also use the input model to specify default text for a text
field. When you use the input model, this text automatically appears when you create a new
entry. For example, in the text field Source attached to the Deutsch index field, you could specify
Duden 1995, §. xxx as the defaule text; this text would then not need to be re-typed for each
entry. This example is illustrated in the figure above.

5. Confirm your entry by clicking on OK. The corresponding text field immediately appears in the
entry. If you activated one of the check boxes, a special character appears showing which
characteristics you selected. You will find a list of these special characters and their meanings
later in this chapter, in the section titled “Special Characters in Input Models.” If you also typed
in text, this appears in the input model as well.

To add additional text fields to your input model, repeat the steps listed above. Note that text fields
that are already defined for an index field cannot be selected again for the same index field, and text
fields already defined for Entry Number cannot be selected again for Entry Number.

Adding Attribute Fields to an Input Model

MultiTerm’s hierarchical entry structure allows you to assign attribute fields to the Entry Number
(that is, to the entire entry), to one or more index fields, or to one or more text fields.

e Attributes like subject that apply to an entire entry are called global attributes.

e Atctributes specifying language level or grammatical information apply to individual terms and are
called zerm attributes.

e Attributes like text type that apply to text fields are called zexz attributes.

Follow these steps to assign an attribute to Entry Number, or to an index or text field, in an input
model:

Keyboard Method

1. Move the pointer to the field to which you want to assign the attribute by pressing the [2] and
[€] keys to jump from field to field.

. If you want to create a global attribute that applies to the whole entry, move the cursor to
the very top of the entry. When the pointer is at the top of the entry, the message line
displays the name of the Entry Number system field.

. If you want to make the attribute subordinate to a term, move the pointer to the
corresponding index field. The message line shows the name of the field where the
pointer is currently located.

. If you want to make the attribute subordinate to a text item, move the pointer to the
corresponding text field. The message line shows the name of the field where the pointer
is currently located.

2. Type an [A] to enter an attribute field. The Attribute Fields dialog opens. From this dialog,
you can select attribute fields and values from those defined for the current database.

3. By default, the focus (dotted border) is on the pick list of the first attribute field, as shown in the
illustration below. If you want to use another attribute field, press the key combination [Alt] +
[F] to move the focus to the Attribute Fields list. Use the cursor keys [\] and [M] to select the
desired attribute field. You can also type the first letter of the attribute field. The pick list
showing the corresponding attribute values appears. The dialog in the following illustration is
from the sample database SAMPLE. MTW As you can see, the title bar shows both the name of
the field to which you are assigning the attribute as well as the selected attribute field.
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Figure 50: The Subject Attribute Field with Attribute Values

You can now define the following characteristics for this attribute field in the input model:

If the field can appear once in the current structure, but is not required, do not activate any
check boxes.

If the field must appear once and only once in the current structure, press the key
combination [Alt] + [M] to activate the Mandatory check box.

If the field must appear ar Jeast once in the current structure, press the key combinations
[Alt] + [P] and [Alt] + [M] to activate the Multiple and Mandatory check boxes.

If the field can appear multiple times in the current structure, but is not required, press the
key combination [Alt] + [P] to activate the Multiple check box.

If the field should be available solely on a read-only basis and not be changeable, press the
key combination [Alt] + [R] to activate the Read-Only check box.

If the attribute field is a specially-defined administrative attribute field (that is, one
containing one or more of the reserved pick list values CrD, CrU, ChD, or ChU), you can
press the key combination [Alt] + [A] to activate the Automatic check box. (The reserved
values are described in the section titled “Customising Database Definitions for Input
Models” in the “Defining a Database” chapter.) Note that you can specify one and only one
pick list value for MultiTerm to automatically fill in at this position. If you want to create
several automatic attribute values at the same location, you must add an attribute field for
each automatic value. For further information on automatic attribute fields, please refer to
the section titled “Using Automatic Attribute Fields in Input Models” later in this chapter.

In addition to these characteristics, you can also use the input model to specify that only certain
attribute values should be available during data entry. For example, in the sample database
SAMPLE. MTW if you want to restrict the Subject attribute field to only allow the values Cereals,
Vegetables, and Fruit, you can select these values from the list and optionally specify the above-
mentioned options. Follow these steps if you want to only highlight a few selected items:

Begin by highlighting the first item, in our example Cereals. Hold down the [Ctrl] key and
click on the other attribute values you want to highlight, in our example Vegezables and
Fruir. (To select several adjacent items in a list at once, click on the first item, hold down
the [Shift] key, then click on the last item you want to select.)

To remove the highlight from an item that you inadvertently selected, hold down the
[Cerl] key and click on the item again. The highlight is removed.

Confirm the attribute field, its characteristics, and any attribute values you defined by pressing
[Enter] as usual. The corresponding attribute field immediately appears in the entry. If you
activated one of the check boxes, a special character appears showing which characteristics you
selected. You will find a list of these special characters and their meanings later in this chapter,
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in the section titled “Special Characters in Input Models.” If you also selected possible attribute
values, they appear in the input model as well.

Subject *Cerealz, VYegetables, Fruit ﬂ
English *
Source *Colling, p.
Definition *
Deutsch *

Source "Duden, =
Definition *

| |Entry Number -> Subject

Figure 51: Input Model with the Attribute Field Subject, the “Multiple” Characteristic

(Special Character “*”), and Pre-Defined Attribute Values

To add additional attribute fields to your input model, repeat the steps listed above. Note that
attribute fields that are already defined for an index field, text field, or the Entry Number cannot be
selected again for the same field.

B

Mouse Method

Move the mouse pointer to the field to which you want to assign the attribute field.

If you want to create a global attribute that applies to the whole entry, move the cursor to
the very top of the entry. When the pointer is at the top of the entry, the message line
displays the name of the Entry Number system field.

If you want to make the attribute subordinate to a term, move the pointer to the
corresponding index field. The message line shows the name of the field where the
pointer is currently located.

If you want to make the attribute subordinate to a text item, move the pointer to the
corresponding text field. The message line shows the name of the field where the pointer
is currently located.

Press the 7ight mouse button. The field type context menu appears on your screen.
Select the Insert Attribute Field command. The Attribute Fields dialog appears on your
screen. Click on the desired attribute field in the Attribute Fields list. The pick list showing

the corresponding attribute values appears.

You can now define the following characteristics for this attribute field in the input model:

If the field can appear once in the current structure, but is not required, do not click on any
check boxes.

If the field must appear once and only once in the current structure, click on the Mandatory
check box.
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. If the field must appear a7 least once in the current structure, click on both the Multiple and
Mandatory check boxes.

. If the field can appear multiple times in the current structure, but is not required, click on
the Multiple check box.

. If the field should be available solely on a read-only basis and not be changeable, click on

the Read-Only check box.

. If the attribute field is a specially-defined administrative attribute field (that is, one
containing one or more of the reserved pick list values CrD, CrU, ChD, or ChU), you can
click on the Automatic check box. (The reserved values are described in the section
titled “Customising Database Definitions for Input Models” in the “Defining a Database”
chapter.) Note that you can specify one and only one pick list value for MultiTerm to
automatically fill in at this position. If you want to create several automatic attribute values
at the same location, you must add an attribute field for each automatic value. For further
information on automatic attribute fields, please refer to the section titled “Using
Automatic Attribute Fields in Input Models” later in this chapter.

In addition to these characteristics, you can also use the input model to specify that only certain
attribute values should be available during data entry. For example, in the sample database
SAMPLE. MTW if you want to restrict the Swéject attribute field to only allow the values Cereals,
Vegetables, and Fruit, you can select these values from the list and optionally specify the above-
mentioned options. Follow these steps if you want to only highlight a few selected items:

. Begin by highlighting the first item, in our example Cereals. Hold down the [Ctrl] key and
click on the other attribute values you want to highlight, in our example Vegetables and
Fruit. (To select several adjacent items in a list at once, click on the first item, hold down
the [Shift] key, then click on the last item you want to select.)

. To remove the highlight from an item that you inadvertently selected, hold down the
[Ctrl] key and click on the item again. The highlight is removed.

Confirm the attribute field, its characteristics, and any attribute values you defined by clicking
on OK as usual. The corresponding attribute field immediately appears in the entry. If you
activated one of the check boxes, a special character appears showing which characteristics you
selected. You will find a list of these special characters and their meanings later in this chapter,
in the section titled “Special Characters in Input Models.” If you also selected possible attribute
values, they appear in the input model as well.

To add additional attribute fields to your input model, repeat the steps listed above. Note that
attribute fields that are already defined for an index field, text field, or the Entry Number cannot be
selected again for the same field.

Controlling Access Rights Using Attribute Fields

In addition to the functions described above, attribute fields can be used in input models to control
the access rights of the particular structure they are attached to.

What does this mean? To edit a structure containing an attribute, the active input model must contain
the same attribute in the same structure. “In the same structure” means attached to the same field,
whether it be the Entry Number, an index field, or a text field. In addition, the set of attribute values
in the input model must be a superset of the values used in the entry; if it is not, the structure cannot
be edited. Let’s look at some examples to illustrate this functionality.

Example 1:

Let’s assume that an entry begins with the following fields:

Entry Number 201 (system field)
Subject Vegetables (attribute field)
English bean (index field)
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For the user to be able to start edit mode for the above entry, the active input model must have the
following characteristics:

. The input model must have the Suéject attribute field defined as a global attribute. That is, the
Subject attribute field must be attached to Entry Number.

. The Swubject attribute field must either be empty, which means that all pick list values can be
selected, or it must at least have the value Vegerables selected.

If these conditions are not met, the entry cannot be edited using this input model. If the Subject
attribute value is defined in the active input model as “read-only,” the entry can be edited, but the
contents of the Subject attribute field cannot be changed.

Example 2:

Now let’s assume that an entry contains the following fields:

Deutsch Rad (index field)
Part of Speech noun (attribute field)
Gender n (attribute field)
Quality good (attribute field)
Definition: Ein Rad ist... (text field)

To be able to edit the Deursch index field as well as all the attribute and text fields assigned to it, the
active input model must have the following characteristics:

. The attribute fields Part of Speech, Gender, and Quality must be attached to the Deutsch index
field.

. The attribute fields Parr of Speech, Gender, and Quality in the input model must either be empty
or must at least contain the values noun, 1, and good, respectively.

If one of the at fields is missing from the input model, the Dewssch index field and the entire associated
structure of attribute and text fields cannot be edited. A missing attribute always affects the entire
structure it is missing from. Keeping with the above example, if the Quality attribute field is missing
from the input model, the fields Deutsch, Part of Speech, Gender and Definition cannot be edited. Also,
any additional text or attribute fields attached to the structure cannot be edited.

On the other hand, while a read-only attribute itself cannot be changed, the rest of the structure it is
attached to can be changed, assuming this is allowed by the input model. For the above example, you
might have the following scenario: if the input model contains the Deussch index field and the
attribute fields Part of Speech and Gender as “multiple” fields, but defines Quality as “read-only,” the
tields Deutsch, Part of Speech, and Gender can be edited at will, but the field Quality can neither be
edited or deleted.

In summary it can be said that attribute fields missing from input models can be used to prevent
editing of term structures. This could for example be desirable in cases where a term and its
associated information are considered finished and should not be edited, but the user should still be
allowed to add a new synonym in the same language.

Using Automatic Attribute Fields in Input Models

As described in earlier in the section “Customising Database Definitions for Input Models,” you can
use special attribute fields to have MultiTerm automatically maintain certain administrative data
anywhere in your entry. This allows you to determine at any time what field was last added or
changed in an entry and by whom.
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The following summarises once more how attribute fields must be configured in the database
definition in order for MultiT'erm to use them as automatic attribute fields:

. The attribute fields can have almost any name. For example, you could name the fields Initial
Date or Edited By. However, be sure not to use names that are already used by MultiTerm as system field
names. In the English version, the reserved field names are Creation Date, Created By, Change Date,
and Changed By. You should also avoid field names used in the German and French versions,
namely Anlagedatum, Angelegt von, A nderungsdatum, Gedindert von, Date de création, Cré¢ par, Date de
modification, and Modifi¢ par. If you use any of these names, you could encounter unforeseen
problems when importing data into or exporting data from MultiTerm ’95 Plus.

. The pick list of each automatic attribute field must contain one or more of the following
attribute values. (The same abbreviations are used as in the TRADOS Translator’s Workbench
export format.)

. CrD (stands for Creation Date)
. CrU (stands for Creation User)
. ChD (stands for Change Date)
. ChU (stands for Change User)

. In contrast to all other pick lists, when assigning an automatic attribute to a field, you can select
only one item from the pick list. If you want to assign several automatic attribute fields to a field
in an input model, you must first create just as many automatic attribute fields in the database
definition. Let’s assume that you want to track all four of the administrative fields listed above
for the index field English. This means that you must add fowr attribute fields to your database
definition, for example Initial Date, Initial User, Edit Date, and Edit User. The pick list of each
field should then contain only one item, namely the corresponding abbreviation from the above

list (CrD, CrU, ChD, and ChU, respectively).

Database Definition
Field Name Ilnitial Date | Add._. I | Network._. I | [1]'4 I
Default Font |F\ria| j| | Delete I | Help I | Cancel I
DECS Font [

Default Sort Order .
Index Fields | = I Text Fields
English i - Definition
Deutsch 1 Source
Francais 2 Context
E spanol 3 Related Words
4 Grammar
M Note
5 Project Code
Attribute Fields Pick List Path for Graphic Files
Style Label - C"DI - c:\trados\mtwplus
Client
Gender
Equivalence
Initial User
Edit D ate
Edit User & .
Figure 52: Database Definition with Four Automatic Attribute Fields,
Each with One Pick List Value
. If on the other hand you only want to use one of these administrative fields at any given position

in an entry, you only need to define a single automatic attribute field (for example with the
name Admin) with all four possible automatic attribute values:
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Database Definition
Field Name A dmin [ Add. ]| mewor.. || ok |
Default Font |Ptrial j| | Delete I | Help I | Cancel I
DBCS Font [

Default Sort Order .
Index Fields | — I Text Fields
English 0 - Definition
Eeulsc_h 1 gnu:cet
rancgais o ontex
E spafiol 3 Related Words
Grammar
g Mote
Project Code
5] -
Attribute Fields Pick List Path for Graphic Files
Type of Relation CrD - c:\trados\mtwplus
Uszage Label ol
Regional Label ChD |[]
Style Label ChUl
Client
Gender

Equivalence

Figure 53: Database Definition with a Single Automatic Attribute Field
Containing All Pick List Values

Follow these steps to position an automatic attribute field in your input model:

Keyboard Method

N

If the input model to which you want to add the automatic attribute field is not already open for
editing, open it now.

Use the [2] and [€] keys to move the mouse pointer to the field to which you want to attach an
automatic attribute field. You can place an automatic attribute field anywhere in an entry, that is,
you can attach it to any index, text, or attribute field. The name of the field where the mouse
pointer is currently located is displayed in the message line.

Type an [A] to enter an attribute field. The Insert Attribute Field dialog appears. Press [Ale] +
[F] to go to the Attribute Fields list. From the Attribute Fields list, select one of the attribute
fields that you defined with one or more automatic attribute values. The corresponding list of
Attribute Values is displayed.

From the Attribute Values list, select the one administrative item (CrD, CrU, ChD, or ChU) that
you want to assign to the current index, text, or attribute field.
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English -> Initial Date E

Attribute Fields Attribute ¥alues
Subject
Category
Type of Relation
Uszage Label [Eeee
Regional Label
Style Label
Client
Een_der [ Mandatory
Equivalence ™ Multigl
e
Imitial User [ Read-Only
Edit Date
Edit User

Figure 54: Assigning the Automatic Attribute Field

Initial Date to the English Index Field

Press the key combination [Alt] + [U] to activate the Automatic check box, and confirm by
pressing [Enter]. The automatic attribute field appears in your entry at the desired location. The
special character “@” indicates that it is an automatic attribute field. You will find a list of these
special characters and their meanings later in this chapter, in the section titled “Special
Characters in Input Models.”

Repeat steps 2-5 for all automatic attribute fields that you want to add to various positions in the

input model.

| TRADOS MultiTerm '35 Plus! - SAMPLE MTW <Design> My First Input Model

File  Edit “iew Seach Help

Cancel

= E3

[ eoyheoder | [ swe ]|

Subject *Cerealz, VYegetables, Fruit
English * fitial Date @CrD Bdit Date @GO Eoit User @CHU
Source Caolling, p.
Definition *
Deutsch *

Source Duden, 5.
Definition *

| |English -> Initial Date

Figure 55: Input Model with the Automatic Attribute Fields Initial Date,
Edit Date, and Edit User (Assigned to the English Index Field)

Keyboard Method

Changing Field Contents in an Input Model

Once you have created an input model, you can change the contents of individual fields or the field
characteristics (for example, from “mandatory” to “multiple”) as follows:

Move the pointer to the field you want to change by pressing the [2] and [€] keys to jump
from field to field. You can also use the [ and [V] keys to jump directly from index field to

index field.
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N

Press the [Enter] key to open the corresponding field. You can also press [E] (for “Edit”) twice
in a row. If you selected an index or text field, the corresponding input window opens. In the
case of text fields, any text you already entered appears. If you selected an attribute field, the
Attribute Fields dialog opens, showing any selected attribute values.

Make the desired changes and confirm by pressing [Enter]. You are returned to the input model,
which now contains the changes you made.

Mouse Method

Click on the field that you want to change. The field edit menu opens. Select the Edit Field
command. (You can also double-click on the field, skipping the field edit menu.) If you selected
an index or text field, the corresponding input window opens. In the case of text fields, any text
you already entered appears. If you selected an attribute field, the Attribute Fields dialog
opens, showing any selected attribute values.

Make the desired changes and confirm by clicking on OK. You are returned to the input model,
which now contains the changes you made.

Deleting Unnecessary Fields from an Input Model

Fields you no longer need can be easily deleted so that they don’t unnecessarily take up disk space.
Follow these steps:

Keyboard Method

1. Move the pointer to the field you want to delete by pressing the [>] and [€] keys to jump from
field to field. You can also use the [N and [\V/] keys to jump directly from index field to index
field.

2. Press the [Delete] key. You are asked whether you really want to delete the field.

3. Press [Y] for Yes. The field and any subordinate fields are deleted.

Y Mouse Method

1. Move the mouse pointer to the field you want to delete.

2. Press the left mouse button. A menu appears from which you can select either Edit Field or
Delete Field.

3. Select the Delete Field command. A submenu appears from which you can select either Don’t
delete or Delete....

4.  Select the Delete... command. You are asked whether you really want to delete the field.

5. Confirm by clicking on Yes. The field and any subordinate fields are deleted.

Note

MultiTerm’s hierarchical entry structure offers an advantage when deleting fields. If you delete the
highest-level field that you no longer need, all subordinate fields are automatically deleted. For
example, if you delete an index field, all text and attribute fields that are subordinate to that index
field in the hierarchy are also deleted. This means that you can delete an entire term structure in
one step.
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Saving a Completed Input Model

When you are satisfied with your input model, click on the Save button, or type an [S] for Save, or
press the [F4] function key. MultiTerm saves your input model entry and returns to the Input Model

dialog. The input model you just created remains visible in the background.

Special Characters in Input Models

The following table summarises the various option switches and their meanings:

Option Meaning Special
Char.
Mandatory The field must occur exactly one time in the =
corresponding structure.
Multiple The field is optional and can occur multiple times in *
the corresponding structure.
Mandatory + Multiple The field must occur at least one time in the +
corresponding structure.
Once per Index (text The corresponding text field is optional. It is up to ?
fields only) the user to add the field to the structure if desired;
the field can only occur one time for each language.
Read-Only The contents of the corresponding field is write- -
protected, that is, it cannot be changed while this
input model is active.
No Check Boxes The corresponding field is an optional field that can | (empty)
Selected occur only one time in an entry.
Automatic (specially- MultiTerm automatically maintains the @
configured attribute corresponding attribute field. It can occur one time in
fields only) the corresponding structure and is write-protected.

Creating Input Models as a “Normal” User

As mentioned earlier, “normal” MultiTerm users on a network can be set up to use input models in
one of two ways:

. If the system administrator has already defined input models, the “normal” user must use these
models. The “normal” user can also create private input models, but these must be based on
pre-defined input models. Mandatory fields cannot be deleted from the private input model,
and fields allowed to occur only once cannot be converted to fields allowing multiple
occurrences.

. If the system administrator has not defined any input models, the “normal” user can choose
whether to work with input models or not.

Otherwise, creating input models is accomplished in exactly the same manner as described in the
carlier section, “Creating Input Models as the MultiT'erm System Administrator (‘super’).”

Changing Input Models

If you want to modify an input model that has already been created—to add, change, or delete index,
text, or attribute fields—follow these steps to open the desired input model for editing:

1.  From the Edit menu, select the Input Models... command. The Input Models dialog appears
on your screen, listing all the input models currently available.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



Input Models

89

2.

Highlight the name of the input model you want to edit and click on the Edit button ([Alt] +
[E]). MultiTerm changes to edit mode.

You can now edit the input model using the functions described in the section “Creating Input
Models as the MultiT'erm System Administrator (‘super’)” earlier in this chapter.

Note

If you are working on a network and want to change an input model that you did not create
yourself, you will find that you will not be able to edit it; the Edit button is deactivated. If you
want to change an input model, please contact your MultiTerm system administrator.

Activating an Input Model

Once you have created or edited an input model, you must activate it in order to use it for creating
new entries. Follow these steps:

If the Input Models dialog is not currently displayed on your screen, from the Edit menu,
select the Input Models... command ([Ctrl] + [F3]). The list of input models available to you is
displayed. If a model is already active, the Input Models dialog tells you which input model is
active in the lines Current Model: Name.

Use the cursor keys [\] and [N, or the mouse, to select the desired input model and confirm by
clicking on OK. You can also click on the Activate button ([Alt] + [A]) and then confirm. In this
case, MultiTerm confirms your selection by displaying the message “Name is selected as input
model” in the message line (whereby Name stands for the name of the selected input model).

Using an Input Model to Create an Entry

Once you have created an input model, you can use it as a template for creating all new entries.
Follow these steps:

Keyboard Method

Press the [F3] function key to create a new entry. MultiTerm changes to edit mode, and the
active input model appears automatically on your screen. In addition, the mouse pointer is
automatically positioned at the first field.

You can now edit the entry as you would edit any entry, filling in the empty fields step by step.
The following colours are intended to simplify your work:

. Fields whose field names appear in blue are defined as “multiple” and “optional.” This
means that you can fill in information, but you are not required to. Note that when you save
an entry, MultiTerm automatically deletes optional fields that you leave empty, so there is no need
to delete them manually.

. Fields whose names appear in red are defined as “mandatory” or “mandatory” and
“multiple.” You must fill in at least one instance of the field with information; if it is
defined as “multiple,” you can optionally create additional instances within the same

structure.

. Since fields whose names appear in red are defined as “mandatory,” they cannot be
deleted.

. Fields whose names appear in gray are defined as “read-only.” You cannot edit or delete
them.

Note that MultiTerm always displays in the message line the characteristics of the field you are
currently editing.
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Move the pointer to the field you want to edit by pressing the [>] and [€] keys to jump from
field to field. You can also use the [V] and [M] keys to jump directly from index field to index
field.

. To fill in information in the fields already present in the input model, simply press the
[Enter] key. The corresponding input window opens, and you can edit the field.

. T'o add new blue fields (characteristics “optional” and “multiple”) that are not present at
the corresponding position in the input model, press [I] for index field, ['T] for text field, or
[A] for attribute field, and enter the information as usual. If an entry already contains a
term in a certain language and you add a synonym in the same language, MultiTerm
automatically inserts the entire structure of the corresponding index field at the new
location in the entry. This simplifies your work, as you do not have to recreate the term
structure for the synonym.

Once you've edited the entry to your satisfaction, save it as usual by pressing [S] for Save or by
pressing [F4].

Mouse Method

From the Edit menu, select the Add Entry command. MultiTerm changes to edit mode, and
the active input model appears automatically on your screen. In addition, the mouse pointer is
automatically positioned at the first field.

You can now edit the entry as you would edit any entry, filling in the empty fields step by step.
The following colours are intended to simplify your work:

. Fields whose field names appear in blue are defined as “multiple” and “optional.” This
means that you can fill in information, but you are not required to. Note that when you save
an entry, MultiTerm automatically deletes optional fields that you leave empty, so there is no need
to delete them manually.

. Fields whose names appear in red are defined as “mandatory” or “mandatory” and
“multiple.” You must fill in at least one instance of the field with information; if it is
defined as “multiple,” you can optionally create additional instances within the same

structure.

. Since fields whose names appear in red are defined as “mandatory,” they cannot be
deleted.

. Fields whose names appear in gray are defined as “read-only.” You cannot edit or delete
them.

Note that MultiTerm always displays in the message line the characteristics of the field you are
currently editing.

Move the pointer to the field you want to edit.

. To fill in information in the fields already present in the input model, click on the
corresponding field. The field edit menu appears. Select the Edit Field command. The
input window opens, and you can edit the field.

. T'o add new blue fields (characteristics “optional” and “multiple”) that are not present at
the corresponding position in the input model, click the 7ight mouse button as usual, select
the desired field type, and type the desired information into the input window that opens.
If an entry already contains a term in a certain language and you add a synonym in the
same language, MultiTerm automatically inserts the entire structure of the corresponding
index field at the new location in the entry. This simplifies your work, as you do not have
to recreate the term structure for the synonym.

Once you've edited the entry to your satisfaction, save it as usual by clicking on the Save
button.
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Note

When you try to save an entry, MultiTerm checks whether the entry contains any “mandatory”
fields that have not been filled in. If so, a message informs you that you must add information to
these fields. In addition, to simplify your work, the mouse pointer is automatically positioned on
the first mandatory field. Fill in all the mandatory fields and try again to save the entry as described
above.

Automatically Pasting the Last Search Term into the Current Source Language Index Field
when Adding Entries Using Input Models

Let’s assume you look for the term flar spray sprinkler in the English index of your database. You do
not find it, so you would like to add it to your database immediately. In this case, it would be useful if
MultiT'erm was able to automatically paste your last search term into the English index field once you
start edit mode using your current input model.

MultiTerm offers an option whereby it can indeed paste your last search term into the current source
language index field whenever you start adding an entry. To achieve this, modify the initialization file
of MultiTerm "95 Plus, MTWPLUS. | NI, found in the Windows main directory (C. \ W NDOAS by
default). You can open this file in any text editor (the Windows Notepad, for instance). Add the
following two lines to make the above functionality available:

[ Edit]
Past eSear ch=1

If the [ Edi t] section is already present in your copy of the MTWPLUS. | NI file, you do not need to
add it. The next time you start MultiTerm, the program will automatically paste the search term into
the current source language index field whenever you start edit mode with an input model.

Hiding Read-Only Indices in Edit Mode

In input models, index fields, among others, can be defined as read-only, that is, you are not allowed
to change their contents or delete them. For example, if you are an English-French translator, you
might be allowed to change the contents of the English or French index fields, but not those of the
German and Spanish ones. When editing entries with all these index fields, you can decide whether
you want to have MultiTerm display all index fields or only those that you are allowed to edit or add.
You achieve this by activating or de-activating the Hide Other Indices option from the Edit menu,
or by pressing [Cerl]+[H].

In our example, if the Hide Other Indices option is active (a check mark appears in front of the
menu item), only the index fields French and English will be displayed when editing the entry, even
if the entry contains other index fields. If the Hide Other Indices is turned off, however, all index
fields are displayed in edit mode.

Deactivating an Input Model

Follow these steps to deactivate an input model:

1. If the Input Models dialog is not currently displayed on your screen, from the Edit menu,
select the Input Models... command ([Ctrl] + [F3]). The current model is displayed in the lines
Current Model: Name as well as being highlighted in the list of available models.

2. To deactivate the model, first click on the Deactivate button. MultiTerm changes the colour of
the model in the background.

3. Confirm clicking on OK or pressing [Enter]. MultiTerm returns to display mode. You can now
create or edit entries without using input models.
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Note

If you are working with a protected database, for example on a network, and your system
administrator has defined one or more input models for you, you will not be able to deactivate
input models you did not create yourself; the Deactivate button will be grayed out. (You can,
however, activate a different private input model, thus deactivating the current model.) If you want
to change or delete an input model, please contact your MultiTerm system administrator.

Saving an Input Model

You can save any input models you like as files on your hard disk so that you can reuse them with
other databases as necessary. Follow these steps:

If the Input Models dialog is not currently displayed on your screen, from the Edit menu,
select the Input Models... command ([Ctrl] + [F3]). The list of input models available to you is
displayed.

Use the cursor keys [V] and [/, or the mouse, to select the input model you want to save, and
click on the Save... button ([Alt] + [S]). The standard Windows Save As file dialog appears on
your screen.

Save As
File: narne: Folders:
n = _D K
I chtradoshmbapluz
Cancel
Bl = — [ Coee ]
B MTWPLLS —

=

-]

Save file az lwpe:; Dirives:

IModeI Diefirition [rd J | o M5-DOS_6 j

Figure 56: The Save As File Dialog for Input Models

In the Save As dialog, select the drive and directory where the input model should be saved. In
the File Name field, type in a name for the file up to eight characters long (no special
characters). By default, MultiTerm input models have the file extension *. MDM as you can see
in the Save File As Type drop-down list. We recommend that you use this default file
extension. Confirm your entry by clicking on OK. You are returned to the Input Models dialog.

Deleting an Input Model

Finally, you can completely delete an input model, for example one that has become outdated, as

follows:

From the Edit menu, select the Input Models... command. The Input Models dialog appears
on your screen, listing all the input models currently available.

Use the cursor keys [¥] and [, or the mouse, to select the input model you want to delete,
and click on the Remove... button ([Alt] + [R]). MultiTerm asks if you are sure; answer Yes.
The corresponding input model is removed.
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Note

If you are working with a protected database, for example on a network, and your system
administrator has defined one or more input models for you, you will not be able to delete input
models you did not create yourself; the Remove button will be grayed out. If you want to remove
an input model, please contact your MultiTerm system administrator.
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Searching for Entries

Once you have built up the terminology in your database, you no doubt would like to know the best
way to access it. MultiTerm offers you several possibilities, including simple, global, and fuzzy
searching. This chapter explains these options in detail.

Setting the Source and Target Language

Before you search for terminology in your database, you need to set the desired source and target
languages if these are not already set. This is required so that MultiTerm will access the correct
source language index for the term you need. If you manage terminology in multiple languages,
setting the source and target languages also causes MultiTerm to display the information for these
languages at the top of the entry, followed by the information for other languages.

Using the Drop-Down Lists to Set the Source and Target Languages

You can use drop-down lists to set the source and target languages as follows. When you set the source
language in this manner, MultiTerm automatically goes to the first entry in the new index.

source language / button for opening the target drop-down
active index drop-down list language list

<] TRADOS MultiTerm "35 Plus! - SAMPLE MTW <View>

File Edit “iew Seach Help
Index |Deutsch j (l j| Target |Deutsch I =l

English
Apfel e

Frangais
Entry Humber 1 Espariol
Subject Fruit
Hote This is an entry containing terms in four languages and a
crogs-reference to a proverb.
Deutsch
Apfel
English apple
Hote see also: The apple never falls far from the tree.
Frangais pomme
Espariol manzana

Figure 57: Fields and Buttons for Changing the Source
and Target Language
1. To set the source language, click on the button with the arrow symbol next to the Index field. A

drop-down list opens showing the languages available in this database.

N

Select the desired source language from the drop-down list by clicking on the language or typing
the first character of the language. MultiTerm returns to the first entry in the alphabetical index
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of the corresponding language. MultiT'erm also dynamically reformats the entry according to
your new source language.

To change the target language, click on the button with the arrow symbol next to the Target
field. A drop-down list opens showing the languages available in this database.

Select the desired language as described above. MultiTerm reformats the current entry
according to the new target language.

Using the Mouse to Change the Source and Target Language

When you follow the method described above to change the source and target language using the
drop-down lists, MultiTerm automatically returns to the first alphabetical entry in the index of the
new target language. However, if you do not want to jump to the beginning of the index, you can also
change the source language of the current entry as follows:

Hold down the [Shift] key, and use the mouse to click on a term in the source language you want to
select. T'wo cases can be distinguished:

If while holding down the [Shift] key you click on the target term, the source and target
languages are exchanged. This allows you to invert the language direction with a mouse-click.

If while holding down the [Shift] key you click on a language other than the target language, the
language you click on becomes the new source language, and the target language remains
unchanged. If you would also like to change the target language, you can use the drop-down list
as described in the previous section; the current entry remains on your screen.

Browsing in the Database
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Figure 58: Buttons for Browsing

You can browse through your database just as in a normal dictionary:

*  To move to the next entry in your database, click on the “Browse Forward” button, or press the

[F5] function key. The “Browse Forward” button always displays the next alphabetical term.
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*  To move to the previous entry in the database, click on the “Browse Backward” button, or press
the [F4] function key. The “Browse Backward” button always displays the previous alphabetical
term.

Simple Searching

You can use a simple search to look up specific terms in your database as follows:

1. Use the mouse to click in the search field. The cursor starts blinking.

scarch field
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English
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Espafiol manzana
-
| |Sor‘[ Term

Figure 59: The Search Field

N

Type in your search term. You need not type in the entire term; it is more than adequate to type
in the first few characters.

3. Press [Enter] to begin the search.

e If the database contains an entry matching your search term, this entry appears on your
screen.

e If the same search term also appears in your “Browse Forward” button, you have a
homonym in your database. If you want to look at the homonym entry, browse forward by
clicking on the “Browse Forward” button or by pressing [F5].

e If the search term is not in your database, the entry for the next alphabetical term is
displayed on your screen, and the message line displays “Not found.” The next section
describes how you can add this search term to a list of unknown terminology using the log
function.
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Using the Log Function

If you do not have the time at the moment to research a term not found in your database, but you
would like to add it later, you can use the log function to add the search term to a list of unknown
terminology. Later, you can use this list as a basis for your terminology research.

If MultiTerm cannot find a search term, the message line reminds you that you can log the search
term in the list of unknown search terms.

. To log the search term, from the Edit menu, select the Log Search Term command, or press
the key combination [Ctrl]+[S]. MultiTerm appends the term that was not found to the list of
unknown terminology and displays the message “Search criterion logged” in the message line.

MultiTerm stores the list of unknown terminology in a special text file with the extension of *. M5L
(“MultiTerm Search Log”). The asterisk stands for the name of the database in which you could not
find the term(s). For example, the file SAMPLE. MSL contains the list of terms not found in the
sample database SAMPLE. MTW

The list of unknown terminology contains three items separated by tabs as follows:

1. The unknown search term.
2. The index selected when the term was searched for (English, for example).
3. The user ID of the user who searched for the term (“super”, for example).

A typical list might appear as follows:

souris Francais super
Haus Deutsch schmidt
tree English miiller

This file is in standard Windows text format (ANSI), so you can use any Windows text editor or word
processor to edit the list and print it out.

It is recommended that you or your network system administrator print out the log of unknown search
terms at regular intervals. Once you have printed the list, you should use the File Manager to either
delete or rename the log file. Otherwise, since MultiT'erm continues to add terms to the same file, it
will be difficult to know which terms have been added to the database and which have not.

Global Searching

A global search allows you to find all entries that contain a certain character string. If you do not know
exactly what you are looking for, or if you do not want to type in a long search term, MultiT'erm allows
you to use the asterisk (*) as a placeholder for any string of characters. You can insert the asterisk
before, after, or in between individual character strings.

For example, let’s assume that you would like to know what kind of beets are stored in the
SAVPLE. M'Wdatabase. To search for all entries that end in deet, open the SAMPLE. MI'Wdatabase and
select English as the source language. Then follow these steps:

1. Type *beet into the search field and confirm by pressing [Enter]. A so-called hit list appears
showing the entries that end with beer.
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Figure 60: Hit List and an Entry Found via the Hit List

2. Look at the individual entries by double-clicking on the corresponding search term in the hit
list. The hit list remains on the screen, and the selected entry is displayed behind the hit list. To
see more of the entries, you can move the hit list by clicking on its title bar, holding down the
left mouse button, and moving the hit list to the desired location.

3. You can also select the desired entry by clicking once on your selection and confirming it with
OK. This hides the hit list.

4. If you want to use the hit list again later, you can recall it by selecting the Show Hit List...
command from the Search menu or by pressing the [F12] function key. This allows you to
select a different entry from your most recent global search.

You can also use the asterisk (*) at several locations in the string you are searching for. For example, if
you enter *beet *, MultiTerm displays all entries that contain the string dees, whether it appears at
the beginning, in the middle, or at the end of the search term. In this case, the hit list also shows the
term beetroot.

A hit list can contain a maximum of S0 terms. If MultiTerm finds more than 50 matching index terms,
pressing the Next button or [Alt]+[N] causes MultiTerm to create a new hit list starting from the last
entry in the old hit list. Pressing the Previous button or [Alt]+[P] causes MultiTerm to create a new
hit list by searching backwards from the first entry in the old hit list.

Notes

e With large databases, you may notice that MultiT'erm performs global searches more quickly if
you have at least one character before the first asterisk. This is because MultiTerm only has to
read part of the index to complete the search. Another very good option to quickly search for
entries even in large databases is the fuzzy searching feature described below.

e If you have defined a filter, a global search only displays those entries that match the filter.
Please refer to the “Filtering Entries” chapter for instructions on setting a filter.
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Fuzzy Searching (Only in MultiTerm 95 Plus Professional Edition)

Fuzzy Index Files

Fuzzy searching allows you to find an entry even if you transpose or misspell the search term. Fuzzy
searching is therefore particularly useful when searching for multi-word terms and compound nouns.
For example, if your database contains an entry for Federal Ministry of the Interior, a fuzzy search will
find this entry even if you enter interior ministry or mnstry of te intror as the search term. Note that this
kind of search is only available in MultiT'erm Professional. T'o make this fault-tolerant fuzzy searching
possible, MultiTerm uses a so-called “neural network.” By storing your database in a neural network,
MultiTerm is able to find the desired entry even from an inexact or transposed search term. Follow
these steps to make full use of this feature:

1.  From the File menu, select the Create Fuzzy Index command, or press the [Ctrl]+[Z] key
combination. MultiTerm Professional reads through your entire database and creates “fuzzy”
images of all the terms in all languages. These images make up the neural network which is
stored separately from your database in several files on your hard disk. For this reason, please
make sure that you have enough space on your hard drive before starting this process (see the
next section, “Fuzzy Index Files”). When you start the process, MultiTerm displays a message
in the message line indicating that a fuzzy index is being created. This process may take some
time for large databases. Please wait until MultiTerm Professional is finished; otherwise, the
neural network will not be created or will be incomplete. Once the fuzzy index is complete, the
message “Fuzzy index successfully created” is displayed.

2. You can now perform a fuzzy search in any language by typing a pound sign (#) before the
search term and pressing [Enter]. MultiTerm Professional performs a fuzzy search and shows the
matching entries in a hit list. You can select the desired entry from this hit list in the same
manner as after a global search.

Assuming that you created a fuzzy index for the SAMPLE. MTW database as described above, a fuzzy
search in English for #black plum finds the entry black-skinned plum. Fuzzy searching’s fault tolerance
would also find the entry black-skinned plum if you enter #blak-skined plum as the search criterion.

Please note that MultiTerm also takes the length of your search term into account when performing a
fuzzy search. Thus, for example, you will not find the term installation main control valve set if you just
look for #sez. In this case, the search term is just too short. However, if you look for #controll instalation,
you will find the entry, since the similarity between the search term and the actual entry is high
enough—despite the spelling errors and change of word order. T'o sum things up, you can use the
fuzzy search as a useful and very fast complement to the global search described above.

Notes

e If you are using MultiTerm Professional on a network, please note that the fuzzy index can
only be created by the system manager, and only when the database was opened with
exclusive access. Please refer to the chapter “Using MultiTerm 95 Plus in a Network
Environment” for further information.

e The fuzzy index is a static index. This means that it is not updated every time you add an
entry to your database, but rather only when you create a new fuzzy index as described above.
It is therefore recommended that you keep your fuzzy index current by recreating it at regular
intervals, for example after every 100 or 500 new entries. You can see how many entries are in
your database at any time by selecting the Status Information... menu item from the Help
menu.

As mentioned above, when creating a fuzzy index, MultiTerm stores the neural network in several
files in addition to your actual database file, which has the extension *. MTW MultiTerm accesses
these additional files when performing a fuzzy search in a given language. For this reason, fuzzy index
files are created for each language or index. T'wo help files required by the neural network are also
created.
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Fuzzy index files have the same name as the database from which they were created, except with
different extensions. As for the size of these additional files, you can use the following rules of thumb:

. All the files combined require approximately half as much space as the original database. Smaller
databases (up to about 2 MB) require relatively larger neural networks than more comprehensive
databases.

. The two Help files for the neural network are smaller and require only a fraction of the space of

the original database.

You can use these estimates to make sure that you have enough space on your hard disk before
creating a fuzzy index. Since MultiT'erm also creates temporary files when building a fuzzy index, you
should have more room on your hard disk than the fuzzy index itself will occupy. For example, if your
database requires approximately 10 MB and you only have 5 MB of space left on your hard disk,
MultiTerm Professional will probably be unable to build the fuzzy index. Instead, it will abort with
the message “Could not create fuzzy index.” In this case, you may need to use the File Manager to
delete the fuzzy index files. (At press time, file extensions were *. AAT, *. AAN, *. BAT, *. BAN,
* . CAT, and so on, as well as *. MSX, and *. MTA.)

Caution

Never delete files ending in * . MTW—these are your original databases!

Jumping to Cross References

MultiTerm lets you jump to cross references to other entries with one mouse-click. Text from which
you can initiate a cross-reference jump appears in green in your entries. Follow these steps to access a
cross-reference entry:

1. Move the pointer to the cross-reference text highlighted in green. The mouse pointer changes
to a hand symbol.

2. Click on the cross-reference text. The cross-reference entry appears on your screen.

3. To return to the original entry, use the 77gkt mouse button to click on the message line. The
original entry reappears on your screen.

Notes

e MultiTerm lets you easily jump to a whole chain of cross-references. The program remembers
the last 10 cross references so that you can return to your original entry by repeatedly clicking
the right mouse button on the message line.

e If you accessed an inter-language cross reference, causing the source and perhaps the target
language to change, the original settings are automatically restored when you return to the
source entry.

For instructions on how to create cross references, refer to the section “Creating Cross References” in
the “Editing Entries” chapter.

Going to Entries via an Entry Number

MultiTerm also lets you access entries via their entry number. Follow these steps:

1. Type the desired Entry Number into the search field.
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2. From the Search menu, select the Go to Entry Number command, or press [Ctrl] + [G]. If
MultiTerm can find an entry with the number you specified in step 1, it displays the
corresponding entry on your screen; otherwise, the message “Could not find an entry with this
number” is displayed in the message line.

Note

If the entry has no term in the current source language, MultiTerm displays a corresponding
message in the message line.

Searching in Text, Attribute, and System Fields

The search functions described so far are for searching in index fields. You can also search for
information in text, attribute, and system fields. These kind of searches are performed using the filter
function, which is described in the next chapter, “Filtering Entries.”

Working with Multiple Databases

When you need to manage large amounts of terminology with MultiTerm Lite, it may be necessary
for you to work with several databases, since MultiT'erm Lite can store a maximum of 8192 entries per
database.

When you select the Open Database command from the File menu to open a new database, the
previously opened database is automatically closed. If you want to open several databases at the same
time, you must therefore start several copies of MultiTerm.

For example, to work with two databases simultaneously, you can follow these instructions to start
MultiTerm a second time and open the second database:

1. First, start MultiTerm as usual, opening one of the two databases if it is not already opened.

N

To start MultiTerm a second time, follow the procedure valid for your Windows version:

. Under Windows 3.1, hold down the [Alt] key and repeatedly press the [Tab] key until the
window that appears in the middle of your screen shows the Program Manager
application. Release the [Alt] key, and Program Manager appears on your screen.

. Under Windows 95 or NT 4.x, click the Start button ([Strg] + [Esc]).
3. Again, this step depends on your Windows version:
. Under Windows 3.x, start MultiTerm a second time by double-clicking on the MultiTerm
icon in the Trados fine translation tools program group.
. Under Windows 95 or NT 4.x, open the Programs menu and then the Trados fine
translation tools group. Click the desired MultiTerm program icon to start the program.

4.  Open the second database.

5. To switch back and forth between the two databases, move the two MultiTerm windows so that
they appear next to each other, or use the [Alt]+[Tab] key combination again to switch from
application to application (this is valid for all Windows versions). You will see that the name of
the currently open database appears next to the application name MultiTerm.
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MultiTerm’s filter function allows you to find all the entries in a database that match a certain
criterion. For example, you can find all the entries that were created after a certain date, or that
belong to a certain subject area. Or you can find all the entries that do not yet have a definition, or
those that do not have a term in a certain language. You can search for entries that match one criterion,
or you can find those that match several criteria. MultiTerm’s powerful filter function offers virtually
unlimited flexibility for retrieving any portion of the data in your database.

And there is more: you can also filter out selected fields from your entries. For example, you can
display only index terms with their sources, hiding all the other information in the entries; you can

also output this extracted data to a file, which can then be printed.

Filtering affects the following MultiTerm operations:

. The display of entries on your screen.
. Searching for specific entries.

. Exporting entries.

. Importing entries.

As you see, the filter function serves many purposes, which is why we have given it its own chapter.

To use the filter function, you must first tell MultiTerm which criteria you want to filter on, that is,
you must define a filter. Once you have defined the filter, you then activate it so you can use it in
your work. Later, when you deactivate the filter, the filter definition remains intact; you can reuse the
same filter any time until you delete the filter definition and set a new filter. In addition, you can save
any filter definition as an internal definition in your database or as an external file for future re-use.

Defining a Filter

In this chapter, we want to begin by explaining in an abstract manner the various possibilities that a
filter definition gives you. Then, using a series of examples, we will show you how to set a filter
according to your own needs.

. From the View menu, select the Define Filter... command, or press the [Ctrl]+[F] key
combination. The Filter Definition dialog appears on your screen.
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The Filter Definition Dialog

ISSS————————————_—_———_
Filter Definition 1]
Eield or Field Group Criterion
Delete
[” Only Use Matching Fields Criterion Or..

Figure 61: The Filter Definition Dialog

You use the Filter Definition dialog to specify the filter criteria you want to use. The following
commands are available:

By clicking on the Delete button ([Alt]+[D]), you can delete a field or field group with its filter
criterion from your filter definition.

By clicking on the Add... button ([Alt]+[A]), you can add a new field or field group to your filter
definition. The Select Field or Field Group dialog opens for you to select a field or field
group. For information on what these fields and field groups mean, refer to the next section,
“The Select Field or Field Group Dialog.” You then return to the Filter Definition dialog
where you can specify the desired criterion.

By repeatedly clicking on the Add... button ([Alt]+[A]), you can define additional filter criteria
which are implicitly joined to the preceding criteria by a logical AND. This means that an entry
must meet all the criteria to match the filter.

By clicking on the Or... button ([Alt]+[O]), you start a new OR-group of fields or field groups
with their filter criteria. An entry must only match one of the defined OR-groups in order to
match the filter.

By clicking on the Add... button ([Alt]+[A]) again, you can add additional filter criteria linked
with logical ANDs to an OR-group.

The Criterion input field is where you enter the criterion that your selected field or field group
should match. For information on which criteria are available, refer to the section “The Criterion
Input Field” later in this chapter.

In the Filter Definition dialog, if you activate the Only Use Matching Fields check box, or
select it with [Alt]+[M], only the fields that match the filter in each entry are selected. All other
fields are ignored, for example, when displaying or exporting entries. If you do not click on this
check box, all the fields in entries that match the filter are displayed or exported.

Finally, you can use the Load ([Alt] + [L]), Save ([Alt] + [S]), and Remove ([Alt] + [R])
buttons to store and manage any number of filter definitions within the database or as external
files. You will find more information on these functions in the sections entitled “Saving a Filter
Definition,” “Loading a Filter Definition”, and “Removing Filter Definitions” below.
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Note

A logical OR starts a new group of criteria. You can specify several OR-groups within a filter
definition. MultiTerm selects those entries that match all the criteria of at least one of these OR-
groups.

The Select Field or Field Group Dialog

The Select Field or Field Group dialog opens when you select the Add... or Or... command from
the Filter Definition dialog. This is where you select the fields or field groups to which your filter
criteria should apply.

Select Field or Field Group

System/Index Field  Text Field Attribute Field
[ Any Field [ Ang [X Mone [ Any [¥ Mone Cancel I
Creation Date Definition Subject -
Created By Source Category \ﬂl
Change Date Context Type of Aelation
Changed By Related Words Uszage Label
Entry Class Grammar Regional Label
Graphic Mote Style Label
Entry Number Project Code Clhent
Sort Term Gender i
-Explanation

| |Creati0n Date

Figure 62: The Select Field or Field Group Dialog with Index, Text,

and Attribute Fields from the Sample Database

From the System / Index Field list, you can select the desired system or index fields:

Creation Date The date on which the entry was created.

Created By The user ID of the person who created the entry.

Change Date The date on which the entry was last changed.

Changed By The user ID of the person who last changed the entry.

Entry Class Used for controlling read and write access on a network. For further
information, see the chapter “Using MultiTerm ’95 Plus in a Network
Environment.”

Graphic File name of the graphic file that is linked to the entry.

Entry Number A unique number, automatically generated by MultiTerm, that

represents the concept stored in an entry. For this reason, global
attributes and text fields are assigned to this system field.

Sort Term Search (index) term of the currently selected source language.

Synonym Synonyms to the search term in the currently selected source language.

Target Term First translation of the search term in the currently selected target
language.
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Target Synonym Synonyms of the target term in the currently selected target language.

Language X, Y, Z Languages that you or your system administrator define in the database
definition. Selecting this field accesses all terms in the corresponding
language.

The fields that appear in the Text Field and Attribute Field lists are those that you or your system
administrator created when defining your database. These are the same fields that are available to you
when creating an entry. For example, in the illustration for the SAMPLE. MI'Wdatabase above, the text
tields Definition, Source, Context and so on are available, as well as the attribute fields Swuéject, Caregory,
Type of Relation and so on.

When selecting fields or field groups in the Select Field or Field Group dialog, you should keep
MultiTerm’s hierarchical entry structure in mind. This means working from left to right, first
selecting the desired system or index field, then any desired text field, and finally any desired
attribute field.

The Criterion Input Field

In the Criterion input field, you enter the filter criterion that should be applied to the selected field
or field group. The following criteria are available:

Ciriterion Explanation

The field must be present and may contain zero or more characters.
! The field may 7oz be empty.

1* The field may 7ot be present.

(empty) If you leave the criterion empty, the field must also be empty to fulfill
the criterion.

text The field must contain oz/y the string t €xt as a single word.

*text® The field must contain the string t ext. It does not matter where in the
field this string appears or whether it is an independent word or only
part of a word.

> The field must contain a numerical value that is greater than the
criterion. This criterion can only be used with the system fields Creation
Date, Change Date, Entry Class, and Entry Number.

< The field must contain a numerical value that is less than the criterion.
This criterion can only be used with the system fields Creation Date,
Change Date, Entry Class, and Entry Number.

!(other criterion) When an exclamation point (!) precedes another criterion, it negates the
following criterion. For example, the criterion /* means that the
corresponding field may nof be present, and the criterion ! *t ext *
means that the string t ext may »or be present in the corresponding
field.

Note

You can define up to 20 criteria for fields or field groups in your filter definition. These criteria can
apply to 20 different fields or field groups, or they can be 20 criteria applying to the same field.
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Filter Principles

Once you have defined and activated a filter, MultiTerm tests each entry in your database according
to the following principles:

. MultiTerm begins with the first criterion and checks whether the corresponding field in the
entry matches the criterion. If this is the case, the second criterion is checked.

. If a criterion is not met, MultiTerm skips the following criteria until it finds a logical OR,
signaling the beginning of a new OR-group.

. Only when all the criteria in a list or all the criteria in a logical OR-group are met is the entry
considered to match the filter.

Example 1: Filter for All Entries that Belong to Several Specific Subject Areas

Let’s assume that you want to find all the entries in the SAMPLE. MTWdatabase that belong to the
subject area Fruits or the subject area Vegerables. Follow these steps:

1. Start a filter definition by selecting the Define Filter... option from the Display menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.

2. Iffilter definitions are already present in this dialog, delete them by clicking the New button or
by pressing [Alt]+[N].

3. Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

4.  As explained in the “Editing Entries” chapter, subject specifications are normally defined as
global attributes since they apply to the entire concept described by the entry. This means that
the Subject attribute is subordinate to the Entry Number system field, which represents the
concept of the entry. In the Select Field or Field Group dialog, you therefore need to choose
the fields Entry Number from the list of system/index fields and Sudject from the list of attribute
fields. The Explanation field as well as the message line show you that you have selected the
attribute field Swéject or the system field Entry Number.

5.  Confirm by pressing OK or [Enter]. You are returned to the Filter Definition dialog, and the
selected field Entry Number DSubject appears in the “Field or Field Group” list.

6.  In the Criterion input field, type in *Fruir*. This instructs MultiTerm to only use those entries
where the attribute field Subject with the attribute value Fruit is attached to the Entry Number
field. In other words, for all further operations, use only entries pertaining to the subject Fruit.

7. Now, to define the second subject area as an additional filter criterion, click on the Or... button
or press [Ale]+[O]. The Select Field or Field Group dialog appears again on your screen.

8. Select Entry Number from the list of system/index fields and Swéject from the list of attribute
fields again, and confirm by pressing OK or [Enter]. You are returned to the Filter Definition
dialog, where a second selected field Entry Number DSubject appears.

9.  Type in *Vegetables* as the criterion and confirm by clicking Close. This instructs MultiTerm
alternatively to use all entries with the subject area Vegetables.
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Filter Definition
Field or Field Group Criterion
Entry Number -> Subject “Yegetables™
OR
Entry Number -> Subject “Fruit*
Delete
[ Only Use Matching Fields Criterion I*Fruit*l Or...

Figure 63: Completed Filter Definition

Note

When entering a string as a filter criterion, you should always use an asterisk before and after the
string you are searching for, unless the selected field or field group should contain #is string and
nothing else. In the above example, if you specified Fruit or Vegetables instead of *Fruir* or
*Vegetables*, any entry containing a subject in addition to Fruit or Vegetables would not be found.
Thus, a subject specification of Fruit, General, or Food, Vegetables would not be found.

Example 2: Filter for All Entries that Do Not Have a Term in the Target Language

Let’s assume that you want to find all entries in the SAMPLE. MT'Wdatabase which have no translation
in the currently selected target language for the terms in the currently selected source language:

1. Start a filter definition by selecting the Define Filter... option from the Display menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.

2. Iffilter definitions are already present in this dialog, delete them by clicking the New button or
by pressing [Alt]+[N].

3. Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

4. Select the Target Term field from the list of system/index fields and confirm by pressing OK or
[Enter]. You are returned to the Filter Definition dialog where the Targer Term field now
appears in the “Field or Field Group” list.

5.  Typein “!*” as the criterion and confirm by clicking Close. This instructs MultiTerm from now
on to only consider entries in which the logical field 7arget Term is not present.

Note

In this example, when you change the source or target language of your database, the set of filtered
entries also changes automatically. If you want to find missing terms in a specific language, please
refer to the example in the “Searching for ‘Incomplete’ Entries” section of the “Editing Entries”
chapter. There you will also find an example of how you can use a filter to find all entries that do
not have a definition in a certain language.
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Example 3: Filter for All Entries that Were Created after a Certain Date

Let’s assume that you want to know which entries in the SAMPLE. MTWdatabase were created after a
certain date, for example 20. 10. 1994. (Note that MultiTerm requires that dates be specified in
European format, that is, dd.mm.yyyy.)

Start a filter definition by selecting the Define Filter... option from the Display menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.

If filter definitions are already present in this dialog, delete them by clicking the New button or
by pressing [Alt]+[N].

Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

Select the Creation Date system field from the list of system/index fields and confirm by pressing
OK or [Enter]. You are returned to the Filter Definition dialog where the Creation Date field
appears in the “Field or Field Group” list.

Type in >20. 10. 1994 as the search criterion. The message line shows an example to assist
you; as soon as you enter a valid value, the message line explains exactly what this value means.
Confirm the filter criterion by clicking Close.

Example 4: Filtering for a Certain String in All Text Fields

Let’s assume that you have a dim recollection of seeing the term beta vulgaris somewhere in the
SAVPLE. MW database, but you cannot find this term in any language using the standard search
functions. In this case, you can use a filter to search for this string in #// text fields.

N

Start a filter definition by selecting the Define Filter... option from the Display menu, or by
pressing [Ctrl]+[F]. The Filter Definition dialog appears on your screen.

If filter definitions are already present in this dialog, delete them by clicking the New button or
by pressing [Alt]+[N].

Now, to define a new filter, click on the Add... button or press [Alt]+[A]. The Select Field or
Field Group dialog appears on your screen.

Text fields can be global to entire entries or subordinate to individual terms. To search for text
fields that are global to entire entries, select Entry Number from the list of system/index fields
and activate the check box Any above the list of text fields. Confirm by pressing OK or [Enter].
You are returned to the Filter Definition dialog where the Entry Number 2Any Text field group
appears in the “Field or Field Group” list.

Type in the string *beta vulgaris* as the criterion.

Now, to search the text fields that are subordinate to individual terms, click on the Or... button
or press [Alt]+[O]. The Select Field or Field Group dialog appears again on your screen.

Activate the check box Any Field above the list of system/index fields and the check box Any
above the list of text fields. Confirm by pressing OK or [Enter]. You are returned to the Filter
Definition dialog where the Any Term >Any Text field group appears as an alternative (OR) item
in the “Field or Field Group” list.

Again type in the string *befa vulgaris* as the criterion and confirm by clicking Close or [Enter].
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Notes

*  You can use this method to search for any string in any text field. However, keep in mind that
this kind of search takes longer than a search in index fields, since text fields are not indexed
and therefore the entries must be read in their entirety for the search.

*  Whether you are looking for a specific string in one text field or in all text fields, remember to
type in an asterisk (¥*) before and after the string. Otherwise, MultiTerm will look for a field
that contains only the string and nothing else.

Using Filters

In the previous section, “Defining a Filter,” you learned how to define a filter with its criteria
according to your needs. We would now like to show you the many ways you can use filters in your
work.

Activating the Filter

Once you have defined a filter as described above, in order to actually use it, you must first activate it
as described below.

. To activate a filter, select the Filter Active option from the View menu, or press the key
combination [Ctrl]+[A]. A check mark (v') appears in front of the Filter Active option, and the
message line displays “Filter is active.” To deactivate the filter later, again select the Filter
Active option from the View menu, or press [Ctrl]+[A] again. The check mark in front of the
Filter Active option disappears, and the message line displays “Filter has been deactivated.”

. You can determine the filter status at any time by selecting the Status Information... option
from the Help menu ([Shift]+[F1]). The status information appears on your screen. Among
other things, this information dialog shows you whether the filter is active and how many filter
criteria you specified.

As soon as you have activated the filter, it is effective for the following operations:

. The display of entries on your screen.
. Searching for specific entries.

. Exporting entries.

. Importing entries.

Appearance of Entries with the Filter Activated

As soon as you activate the filter, only those entries that match the filter are displayed normally. All
other entries appear with a gray background so that you can quickly see whether or not an entry
matches the filter criteria.

If you activated the Only Use Matching Fields check box in the Filter Definition dialog, the only
fields shown are those that explicitly match the filter criteria. All other fields are hidden. If you
deactivate this check box, all fields are displayed in all entries.
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Note

By activating the Only Use Matching Fields check box in the Filter Definition dialog (see the
section “The Filter Definition Dialog” earlier in this chapter), you can instruct MultiTerm to only
display the fields currently needed for your work. If at some point you nonetheless need to see the
other information in the entry, simply deactivate the filter by pressing [Ctrl]+[A] to look at all the
information, then reactivate the filter when you are finished by again pressing [Crtrl]+[A].

Searching with the Filter Activated

Browsing with the Filter Activated

As already mentioned, when the filter is active, only those entries that match the filter appear
normally; entries that do not match the filter appear with a gray background. When browsing, to jump
directly to the previous or the next filtered entry in alphabetical order, select the Previous Filtered
Entry or the Next Filtered Entry command from the Search menu, or press the key combination
[Cerl]+[F4] or [Cerl]+[F5].

Global Searching with the Filter Activated

When the filter is active and you perform a global search with one or more asterisks (*), only the
entries matching the filter appear in the hit list. Example 1 above explains how to define a filter for
the SAMPLE. MI'Wdatabase to search for all entries with the subject areas Fruit or Vegetables. You can
display these entries in a hit list by typing an asterisk (*) into the search field and starting the search
by pressing [Enter]. In a moment, a hit list appears showing all entries for the subject areas Fruit or
Vegetables.

=] TRADDS MultiTerm *35 Plus! - SAMPLE MTW <View>

File Edit “iew Search Help

Index IEnglish jJ [ j| Target Ineutsch j

| black-skinned plum l brussels sprout | bunch of grapes l

Entry Humber 25

-
Subject “egetables Hit Lizt | j

English | ~ I | — I
brussels sprout L=
Definition & br| [apple =
cabbage which |apricot —
Definition A ty| [asparagus
stem in the fo Ee:} "
H el
Source Colling blackberry
Deutsch black-zskinned plum
Rosenkohl e br out
bunch of grapes

Definition Kohl - fcapyage
Fartm von kleinl |carrat
Source Duden| |cauliflower

celeriac _;l
chard .
cherry J
cucumber
currant
goosehetry

grape .;I

Figure 64: Global Search with the Filter Activated
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Note

A filtered search takes longer than an indexed search since the entries must be read in their
entirety to perform the search. Specifying a specific criterion in the main search field will speed up
the search. For example, specifying “c*” as the search criterion in the above example with English
as source language will immediately displays all the Fruits and Vegetables beginning with “c”.

Exporting with the Filter Activated

If you perform an export when the filter is activated, only entries matching the filter are exported.

If you activated the Only Use Matching Fields check box in the Filter Definition dialog, only the
fields that explicitly match the filter criteria are exported. If you did not activate this check box, all
fields for all entries matching the filter criteria are exported.

Since the export function is used, among other things, for printing word lists, you can use the export
function together with the filter function to compile a specialized “dictionary” customized according

to your requirements.

For more information on exporting, see the chapter “Exporting Entries.”

Importing with the Filter Activated

If you perform an import when the filter is activated, only entries matching the filter are imported.

If you activated the Only Use Matching Fields check box in the Filter Definition dialog, only the
fields that explicitly match the filter criteria are imported. If you did not activate this check box, all
fields for all entries matching the filter criteria are imported.

You can use the filter function together with the import function to copy a portion of a large database
into a small database containing only the information required for a specific application.

For more information on importing, see the chapter “Importing Entries.”

Saving a Filter Definition

Once you have defined a filter, it remains in effect until you change it again as described above. If you
want to be able to restore the current filter definition later, even after making changes, you must save
the filter definition. You can save your filter definition as a private, public, or external definition:

Private Definitions Private definitions are stored in the database and are linked to
your personal user ID.

Public Definitions The system administrator can make a definition available to all
network users. These public definitions are also stored in the
database.

External Definitions External definitions are stored outside the database in files with

the extension *. MDF (MultiTerm Definition for Filter). This
allows you to use definitions from one database in another, as
long as the two databases have compatible database definitions.

Follow these steps to save your filter definition:

1. If you are not already in the Filter Definition dialog, from the View menu, select the Define
Filter... command to open this dialog.
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2. To save the current filter definition, click on the Save... button. The Save Filter dialog

appears on your screen.

T |

Enter a name for the definition, or
select File to use external definitions.

My Filter 01 [ Public

Ok

LCancel

PR

File. ..

Figure 65: The Save Filter Dialog

. If you want to save your filter definition in the database as a private definition, type in the
desired name. You can use any name you like for this name, since it does 707 represent a
file name. Confirm by clicking on OK.

. If you are the system administrator and you want to save the filter definition as a public
definition available to all network users, activate the Public check box and type in the
desired name. You can use any name you like for this name, since it does 707 represent a
file name. Confirm by clicking on OK.

. If you want to save your filter definition externally so that it can also be used with other
databases, click on the File... button. The standard Windows Save As file dialog appears
on your screen. Select the desired drive and directory from this dialog and type in the
desired file name. MultiT'erm automatically adds the *. MDF extension to the file name if

necessary. Confirm by clicking on OK.

You are automatically returned to the Filter Definition dialog, and the message line displays “Filter
definition successfully saved.” Your filter definition has now been stored and you can access it at any
time.

Note

In order to save definitions, you cannot be logged on without a user ID, that is, as guest. To save a
definition for public use, you must be logged on as the system administrator with the super user ID.
For further information, refer to the chapter “Using MultiTerm 95 Plus in a Network
Environment.”
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Loading a Filter Definition

Once you have saved a filter definition, you can load it as follows:

1. If you are not already in the Filter Definition dialog, from the View menu, select the Define
Filter... command to open this dialog.

2. Click on the Load... button. The Load Filter dialog appears on your screen.

If you want to load a private filter definition, select the desired layout by clicking on it, and
confirm by clicking OK.

If you want to load a public filter definition, activate the Public check box. The list of
available public filter definitions is displayed. Select the desired definition and confirm by

clicking on OK.

Load Filter 1]

Enter a name for the definition. or
zelect File to uze external definitions.

>

U seful Filter 01

Uzeful Filter 01
Useful Filter 02

Cancel

File. ..

E
(]
c

=
=

Figure 66: Public Filter Definition

If you want to load an external filter definition, click on the File... button. The standard
Windows Open file dialog appears, from which you can load an external definition. Select
the desired drive and directory from this dialog and type in the desired file name.
MultiTerm automatically adds the * . MDF extension to the file name if necessary. Confirm

by clicking on OK.

You are automatically returned to the Filter Definition dialog, and the selected filter definition is
displayed. You can now make changes to it if desired. Then confirm by clicking on Close. To use the
filter, activate it by selecting the Filter Active command from the View menu.

Removing Filter Definitions

If you no longer need an internal filter definition (that is, a private or public definition stored in the
database), you can remove it at any time. Follow these steps:

1. If you are not already in the Filter Definition dialog, from the View menu, select the Define
Filter... command to open this dialog.

N

Click on the Remove... button. The Remove Filter dialog appears on your screen.

If you want to remove a private filter definition, highlight it with the mouse and confirm

by clicking on OK.

If you are the system administrator and you want to remove a public filter definition,
activate the Public check box. The list of public filter definitions is displayed. Select the
desired filter definition and confirm by clicking on OK.
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3. Answer Yes to the question of whether you really want to delete the definition. You are
automatically returned to the Filter Definition dialog, and the message line displays “Filter
definition removed.”

Note

In order to remove definitions, you cannot be logged on without a user ID, that is, as guest. To
remove a public filter definition, you must be logged on as the system administrator with the super
user ID. For further information, refer to the chapter “Using MultiTerm 95 Plus in a Network
Environment.”

Deleting the Filter Criteria List

If you want to completely delete the list of current filter criteria, for example to start creating a new
filter, follow these steps:

1. If you are not already in the Filter Definition dialog, from the View menu, select the Define
Filter... command to open this dialog.

2. Click on the New button. The list of filter criteria is deleted, and you can start defining a new
filter.

Note

As long as you are not logged on with the guest user ID, MultiTerm keeps track of the last filter
definition set for your user IDj; this definition is automatically restored the next time you start
MultiTerm. For more information on user IDs, as well as details about running MultiTerm on a
network, refer to the chapter “Using MultiTerm ’95 Plus in a Network Environment.”
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Is the font in your MultiTerm entry window too small? Would you like to highlight certain
information in your entry in a different color? Or would you like to display the creation date of your
entries? MultiTerm’s layout definition function lets you configure the display of your entries any way
you like. Follow these steps:

1.  From the View menu, select the Define Layout command, or press the key combination
[Cerl]+[L]. The Layout Definition dialog appears on your screen. This dialog contains a list of
the fields or field groups for which you can define a layout. You will learn in the appropriate
sections below what these fields and field groups mean and how you can add your own fields

and field groups.

2. Click on the field or field group for which you want to change the layout. The values that are
currently set for the selected field or field group appear at the bottom of the dialog.

Layout Definition

Field or Field Group Default Appearance
Created By Invisible E-
Change Date Invizible Help
Changed By Invisible = 4
Entry Class Invizible Load...
Entry Number ¥isible with name — 2
Entry Humber -> Any Attribute Vizible with name E Save...
Entry Number -> Any Text ¥Yisible with name Delete
Entry Humber -> Anp Text -> Any Attribute Vizible without name = I| Remove... |
Sort Term ¥Yisible with name ﬂ N
ew
Default Appearance I Invisible j —
| . Spacing/
Size Color i) (et Wi ] Break Margin Relative Para Line

Name (g8 ~|lGay o] ® [0 [ [T [gefore z[10 zfo =]o =]o =]
Hidden |8 ~|[Black =] ® [ X T [getore x10 o =flo z]o =]
Fiell [g =felack =] T T [ [None =f125zf0 =flo =fo =]

Figure 67:

The Layout Definition Dialog with Layout Values for
the Creation Date Field

3. Make the desired changes to the selected field or field group. You can change the default
appearance as well as the character and paragraph formatting for several fields or field groups
simultaneously. You will see later which individual layout settings can be made.

4. Confirm your changes by clicking on Close. You are returned to the currently displayed entry,
where the layout has been changed according to the new layout definition.

Note

Changes to the layout do 7ot influence exporting or any of the functions related to the printing of
word lists and dictionaries described in the chapter “Integrating MultiTerm 95 Plus with Other

Windows Applications.”
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Selecting a Field or Field Group

By default, you can select the following fields or field groups from the Layout Definition dialog in
order to change their appearance in your layout:

Field or Field
Group

Explanation

Creation Date

The date on which the entry was created.

Created By

T'he user ID of the person who created the entry.

Change Date

The date on which the entry was last changed.

Changed By

The user ID of the person who last changed the entry.

Entry Class

The Entry Class used to control read and write access on a network. See the chapter
“Using Multi'Term 95 Plus in a Network Environment” for turther information.

Entry Number

The unique Entry Number generated by Multi'T'erm that represents the concept
stored in an entry. Global attribute and text fields are therefore assigned to this
system field.

Entry Number ->
Any Attribute

All the attributes subordinate to the Entry Number, that is, all global attributes.

Entry Number ->
Any Text

All the text tields subordinate to the Entry Number, that is, all global text fields.

Entry Number ->
Any Text > Any
Attribute

All the attributes subordinate to a global text field.

Sort Term

The search term in the currently selected source language.

Synonym

All synonyms of the search term in the currently selected source language.

Target Term

The translation of the search term in the currently selected target language.

Target Synonym

All synonyms of the target term in the currently selected target language.

Any Term

All index fields not currently selected as the source or target language.

Any Term - Any
Attribute

All the attributes subordinate to a term, that is, all term attributes.

Any Term - Any
Text

All the text fields subordinate to a term.

Any Term - Any
Text 2> Any Attribute

All the attributes subordinate to a text field, that is, all text attributes.

Note

Keep in mind that the sequence and format of items in an entry always depends on the current
source and target language. The Sort Term is always the first term in an entry, followed by its
synonyms, then the Target T'erm and its synonyms.
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Adding a Field or Field Group

The Field or Field Group list initially contains a list of predefined fields and field groups, but you
can add your own fields and field groups to these defaults. This allows you to change the formatting
or default appearance of special index, text or attribute fields that you have added to your database
definition. For example, you can make all source references hidden or invisible if you only need them
infrequently. Conversely, if certain attributes are particularly important to your work, you can format
them in such a way that they stand out from other fields.

Follow these steps to add fields to the Field or Field Group list in the Layout Definition dialog:

1.  From the View menu, select the Define LLayout command to open the Layout Definition
dialog if this dialog is not already shown on your screen.

2. Click on the Add... button. The Select Field or Field Group dialog appears on your screen. In
this dialog, you can select from all the index, text, and attribute fields defined for your database.
We have already seen this dialog in the “Filtering Entries” chapter.

Select Field or Field Group E

System/Index Field  Text Field Attribute Field
[ Any Field [ Any X Mone [ Any [X Mone Cancel I
‘Creation Date Definition Subject -
Created By Source Category lﬂ'
Change Date Context Type of Relation
Changed By Related Words Usage Label
Entiy Class Grammar Regional Label
Graphic Mote Style Label
Entry Humber Project Code Client
Sort Term Gender 57
~Explanation

| |Creati0n Date

Figure 68: The Select Field or Field Group Dialog for the

SAMPLE. MTWDatabase.

3. Keeping MultiTerm’s hierarchical entry structure in mind, work from left to right to select the
desired fields. First select the desired system or index field, then any text field, and finally any
attribute field. For example, if you want to make the subject specification in SAMPLE. MTWSs
entry header stand out, select the Entry Number DSubject field by first choosing the Entry Number
system field and then the Subject attribute field.

4. Confirm your selection by clicking on OK. The selected field appears in the Field or Field
Group list in the Layout Definition dialog. You can now change the character and paragraph
formatting as well as the default appearance for this field.

Note

The Field or Field Group list in the Layout Definition dialog can contain up to 50 fields or field
groups.
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Deleting a Field or Field Group

Of course, you can also delete fields or field groups that you have added to the Field or Field Group
list when they are no longer needed. However, you cannot delete the default fields or field groups.
Follow these steps to delete fields or field groups that you have added:

1. Select the field or field group that you want to delete. As in the Windows File Manager, you can
highlight multiple fields simultaneously by holding down the [Ctrl] or [Shift] key while clicking
on the desired fields. Holding down the [Ctrl] key lets you select several fields or field groups
individually, while holding down the [Shift] key lets you select several fields or field groups that
are next to each other. If you highlight too many fields, you can remove the highlighting by
again holding down the [Ctrl] or [Shift] key and clicking on the corresponding fields or field
groups.

2. Click on the Delete button. The field or fields you selected are deleted from the Field or Field
Group list.

Changing the Default Appearance

Once you have selected one or more fields in the Layout Definition dialog, you can use the Default
Appearance drop-down list to assign a new default appearance to them. The default appearance
determines whether a field name and/or the field contents are visible, hidden, or invisible in display
mode. (The field name and its contents are always visible in edit mode.) “Hidden” means that the
field’s contents are not normally displayed, but that it can be made visible by clicking with the right
mouse button on the field’s name. You can choose from the following default appearances:

Visible with name The field name and field contents are displayed.
Visible without name The field contents are displayed, but not the field name.
Hidden with name The field name is displayed but not the field contents. The field’s name

remains displayed when you unhide the field. That is, if you unhide the
field using the right mouse button, the appearance is the same as the
Visible with name appearance.

Hidden without name The field name is displayed but not the field contents. Without name
here means that the field name is no longer displayed when the field is
unhidden. That is, if you unhide the filed using the right mouse button,
the appearance is the same as the Visible without name appearance.

Invisible Neither the field name nor the field contents are displayed. This
appearance cannot be changed in display mode, and is therefore useful
for completely removing selected fields from view.

Note

The Hidden or Invisible default appearance also applies to the sub-structures of a field. For example,
if the sort term is hidden, its attributes, its definitions with their attributes, and so on are also
invisible, regardless of their default appearances.

Example: Making the Entry Class Visible

Let’s assume that you want to use the Entry Classes in your database to assign read and write access
or to classify entries according to their quality. Since the Entry Class system field is part of the entry
header, this is not displayed in the default entry layout. Follow these steps to make this field visible:
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1.  From the View menu, select the Define Layout command, or press the [Ctrl]+[L] key
combination to open the Layout Definition dialog, if you are not already in this dialog.

2. Select the Entry Class tield by clicking on it. The current values for this field appear in the lower
portion of the dialog.
3. Inthe Default Appearance drop-down list, select the Visible with name appearance and confirm

by clicking on Close. The Entry Class field will now be displayed in the current entry.

Changing Character and Paragraph Formatting

Once you have selected a field or field group by clicking on it in the Layout Definition dialog, the
current settings for the field or field group’s character and paragraph formatting appear in the lower
portion of the dialog. Three horizontal rows let you individually set the character and paragraph
formatting for the field name, the field name when the field contents are hidden, as well as the field
contents. In particular, the three horizontal rows have the following meanings:

Name The character and paragraph formatting in this row determine the
appearance of the field name when the field is shown with the Visible
with name appearance.

Hidden The character and paragraph formatting in this row determine the
appearance of the field name when the field contents are hidden and
only the field name is displayed.

Field The character and paragraph formatting in this row determine the
appearance of the field contents when they are visible.

You can customize the character formatting for the three horizontal rows Name, Hidden, and Field
as follows:

Name Determines the font size (8—-24 points) of the field or field name.
Color Determines the color of the field or field name.
Bold Determines whether or not the field or field name should be displayed

in bold type.

Italic Determines whether or not the field or field name should be displayed
in italic type.

Undrl Determines whether or not the field or field name should be
underlined.

Strike Determines whether or not the field or field name should be struck
through.

You can customize the paragraph formatting for the three horizontal rows Name, Hidden, and Field

as follows:

Break Determines whether or not a line break should be inserted before
and/or after a field or field name.

Margin Determines the left margin (indent) of a field or field name.

Relative Determines the relative indent, that is, the distance from the previous
field or field name, if there is no line break between the fields or field
names.
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Para Spacing Determines the spacing between paragraphs within a field as well as the
space between this field and the previous field or field name.

Line Spacing Determines the line spacing within a field.

Copying Field Properties

Now that you have seen how to define field and field group properties in the layout definition, we
want to show you how to avoid repetitive work by copying the properties you have defined for one
tield to other fields.

1. Highlight the field or field group from which you want to copy the properties by clicking on it
with the mouse.

2. Highlight the field or field group to which you want to copy the properties by holding down the
[Ctrl] or [Shift] key and clicking on the desired field or field group with the mouse. As in the
Windows File Manager or Explorer, you can highlight multiple fields simultaneously by holding
down the [Ctrl] or [Shift] key while clicking on the desired fields. Holding down the [Ctrl] key
lets you select several fields or field groups individually, while holding down the [Shift] key lets
you select several fields or field groups that are next to each other. If you highlight too many
fields, you can remove the highlighting by again holding down the [Ctrl] or [Shift] key and
clicking on the corresponding fields or field groups.

As soon as you have highlighted more than one field, the message line in the Layout
Definition dialog tells you which field will be copied from if you select the Copy function.

3. Click on the Copy button ([Alt]+[C]). This copies the properties from the first field you
highlighted to all other highlighted fields.

Saving the Layout Definition

Once you have defined a layout, it remains in effect until you change it again as described above. If
you want to be able to restore the current layout definition later, even after making changes, you must
save the layout definition. You can save your layout definition as a private, public, or external

definition:

Private Definitions Private definitions are stored in the database and are linked to
your personal user ID.

Public Definitions The system administrator can make a definition available to all
network users. These public definitions are also stored in the
database.

External Definitions External definitions are stored outside the database in files with

the extension *. MDL (MultiTerm Definition for Layout). This
allows you to use definitions from one database in another, as
long as the structures of the two databases (that is, their database
definitions) are compatible.

Follow these steps to save your layout definition:

1. If you are not already in the Layout Definition dialog, from the View menu, select the Define
Layout... command to open this dialog.

2. To save the current layout definition, click on the Save... button. The Save Layout dialog
appears on your screen.
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Figure 69: The Save Layout Dialog

If you want to save your layout definition in the database as a private definition, type in
the desired name. You can use any name you like for this name, since it does 707 represent

a file name. Confirm by clicking on OK.

If you are the system administrator and you want to save the layout definition as a public
definition available to all network users, activate the Public check box and type in the
desired name. You can use any name you like for this name, since it does 707 represent a
file name. Confirm by clicking on OK.

If you want to save your layout definition externally so that it can also be used with other
databases, click on the File... button. The standard Windows Save As file dialog appears
on your screen. Select the desired drive and directory from this dialog and type in the
desired file name. MultiT'erm automatically adds the *. MDL extension to the file name if

necessary. Confirm by clicking on OK.

You are automatically returned to the Layout Definition dialog, and the message line displays
“Layout definition successfully saved.” Your layout definition has now been stored and you can
access it at any time.

In order to save definitions, you cannot be logged on without a user ID, that is, as guesz. To save a
definition for public use, you must be logged on as the system administrator with the super user ID.
For further information, refer to the chapter “Using MultiTerm 95 Plus in a Network

Environment.”

Loading a Layout Definition

Once you have saved a layout definition, you can load it as follows:

If you are not already in the Layout Definition dialog, from the View menu, select the Define
Layout... command to open this dialog.

Click on the Load... button. The Load Layout dialog appears on your screen.

If you want to load a private layout definition, select the desired layout by clicking on it,
and confirm by clicking OK.
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. If you want to load a public layout definition, activate the Public check box. The list of
available public layout definitions is displayed. Select the desired definition and confirm

by clicking on OK.

Load Layout [ %]

Enter a name for the definition, or
select File to use external definitions.

X Public

Our View 01
Our Yiew 02

LCancel

File. ..

Figure 70: Public Layout Definitions

. If you want to load an external layout definition, for example, one of the predefined
definitions described below, click on the File... button. The standard Windows Open file
dialog appears on your screen. Select the desired drive and directory from this dialog and
type in the desired file name. MultiTerm automatically adds the *. MDL extension to the
file name if necessary. Confirm by clicking on OK.

You are automatically returned to the Layout Definition dialog, and the message line displays
“Layout definition successfully loaded.” If you want, you can now change the definition you just
loaded. Then confirm by clicking on Close. You are returned to the currently displayed entry, which
now appears with the new layout.

Predefined Layout Definitions

To make your work somewhat easier, we have included the following predefined layout definitions:

File Name Explanation

TERMS. MDL This layout only displays index terms.

HI DDEN. MDL This layout displays text and attribute fields as hidden fields.
1- LANG MDL "This layout displays a monolingual glossary.

2- LANG. MDL This layout displays MultiTerm data like a bilingual dictionary.

These layout definitions are stored as external files, by default in the C:\ TRADOS\ MTWPLUS
directory. Follow the instructions above to load them.

Removing Layout Definitions

If you no longer need an internal layout definition (that is, a private or public definition stored in the
database), you can remove it at any time. Follow these steps:

1. If you are not already in the Layout Definition dialog, from the View menu, select the Define
Layout... command to open this dialog.

Click on the Remove... button. The Remove Layout dialog appears on your screen.

N

. If you want to remove a private layout definition, highlight it with the mouse and confirm

by clicking on OK.
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. If you are the system administrator and you want to remove a public layout definition,
activate the Public check box. The list of public layout definitions is displayed. Select the
desired layout definition and confirm by clicking on OK.

3. Answer Yes to the question of whether you really want to delete the definition. You are
automatically returned to the Layout Definition dialog and the message line displays “Layout
definition successfully removed.”

Note

In order to remove definitions, you cannot be logged on without a user ID, that is, as guest. To
remove a public layout definition, you must be logged on as the system administrator with the super
user ID. For further information, refer to the chapter “Using MultiTerm 95 Plus in a Network
Environment.”

Restoring the Default Layout

Follow these steps to restore the default layout after making changes to the layout definition:

1. If you are not already in the Layout Definition dialog, from the View menu, select the Define
Layout... command to open this dialog.

2. Click on the New button and confirm by clicking on Close. The default layout is restored.

Note

As long as you are not logged on with the gwest user ID, MultiTerm keeps track of the last layout
definition set for your user 1D; this definition is automatically restored the next time you start
MultiTerm. For more information on user IDs, as well as details about running MultiTerm on a
network, refer to the chapter “Using MultiTerm ’95 Plus in a Network Environment.”

Changing the Sequence of Fields in Display Mode

Sort All Fields

The Display Fields command in the View menu allows you to adjust the display of index fields
according to certain criteria. We will now describe the three available options: Sort All Fields, Don’t
Sort Synonyms, and Don’t Sort Any Field.

You use this option to have MultiTerm display the source and target terms in the default order:

. If you look for a term that has originally been stored as a synonym, MultiTerm makes this
synonym the sort term and re-formats the entry accordingly.

. The program respects any filters that you may have defined.

. The source language terms always appear at the top of the entry, with the target language terms
second.

Example

If you look for the term red beet in the MultiTerm sample database SAMPLE.MTW, this term will be
displayed as the first term (“sort term”) in the entry, even if the creator of the entry has originally
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stored this term as a synonym of the term beerroot. Thus you will always see the search term as the
topmost term in the entry. In some situations, however, this might not be desirable. Let’s assume that
you are currently working on a translation for a British company. So you will want to be able to look
for American English terms like 7ed beet, but you will certainly want to see the British variant beerroor
first, since this will be the term you’ll want to use in your translation. To achieve this, choose the
option Don’t Sort Synonyms (see below).

Don’t Sort Synonyms

You use this option to have MultiTerm display the source and target language terms according to their
original input sequence. This means:

. MultiTerm will always display the term first that has been stored in the first index field of the
current source language. As a result, the main source term will be located at the top of the entry
even if you search for one of its synonyms.

. Filters you may have defined do not have any effect on the order in which the source and target
language terms appear.

. Source language terms still always appear at the top of the entry, with the target language terms
second.
Example

If you look for the term 7ed beer in the MultiTerm sample database SAMPLE. MTW and if the creator of
the entry originally stored this term as a synonym of the term beetroot, the term beetroor will appear at
the top of the entry, followed by red beet.

tg] TRADOS MultiTerm *95 Plus! - SAMPLE MTW <View>

File Edit “iew Seach Help

Index IEninsh jJ || j| Target II]eutsch j

| raspberry I red heet | refrigerator I

Entry Humber ] (=

Subject ‘Yegetables —

Hote This is an entry containing several synonymous terms.

English

beetroot Britain
Definition A variety of the beet plant, Beta wulgaris, that has a
bulbous dark red root that may be eaten as a wegetable, in
salads, or pickled.
Source Collins Dictionary of the English Language, Londaon &
Glasgow, 1936

English

red beet usA
Source filr den arm. Begriff: Colling Dictionary of the English
Language, London & Glasgow, 1986

Deutsch

rote Bete 7 -

| |Snr‘[ Term

Figure 71: The Entry for Red Beet With the “Don’t Sort Synonyms” Option Activated

Don’t Sort Any Field

You use this option to have MultiTerm display all index fields according to their original input
sequence. This means:

. The current language direction does not at all affect the order in which the index fields are
displayed in the entry window (the source and target terms, however, are still formatted in the
usual fashion).
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. Filters you may have defined do not have any effect on the order in which the terms appear in
the entry.
Example

If you look for the German term Erdapfe/ in the sample database SAMPLE.MTW with the option
Don’t Sort Any Field checked, this term will only be shown as the third term in the entry.
However, it is still formatted in the current layout assigned to the logical field “sort term.” The option
Don’t Sort Any Field is useful for those databases that are not primarily geared towards
terminological, that is, language-oriented aims, but for those that store more free-structured
information. MultiTerm’s standard entry display, which is normally oriented towards the currently
selected language direction, may be undesirable in these cases.
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Exporting Entries

The export function allows you to output database information in ANSI or ASCII format (the
Windows and DOS standards, respectively). In this form, your database entries require less storage
space, which is an advantage if you want to back up your files or share them with colleagues. In
addition, database information in this form can be opened in other application programs, for example a
word processor, where the information can be edited or printed.

You can of course export your entire database, but you also have the option of exporting specific
portions of your database according to your needs. You can use the filter function to specify which
entries should be exported from your database, for example, to create an extract of all the entries for a
certain subject or project. With an export definition, you can additionally specify which fie/ds of the
filtered entries should and should not be exported. This allows you to create a “custom dictionary”
designed specifically according to your needs.

The export function also lets you customize the format of the exported data for a specific purpose. For
example, you can specify that certain strings or special characters be inserted at the beginning or end
of an entry, or before or after a certain field. You can specify where the administrative information
from the entry header should appear. You can globally change field names, insert line breaks and tabs,
and much more. You can thus prepare the entry structure of the exported entries in such a way that
they can be directly imported into another database, terminology management system, or other
application program, as long as the program can read ANSI or ASCII files. There are therefore no
technical restrictions on the exchange of terminology, whether on data media or on paper.

Exports are always carried out in two steps. You first define which fields should be exported. Then
you perform the actual export, either of the entire database, of filtered entries, or of a single entry.
You will notice that the Export This Entry and Export All Entries... commands are only available
after you have defined the export.

Note

You can also use the export function for the simple purpose of backing up your database. Specific
instructions on this operation are found later in this chapter in the section “Using the Export
Function to Create a Backup.”

Defining an Export

Note

If you are using the Professional Edition of MultiTerm ’95 Plus on a network, please note that the
export can only be defined by the system manager, and only when the database was opened with
exclusive access. Please refer to the chapter “Using MultiTerm 95 Plus in a Network
Environment” for further information and exceptions to this rule.

The first part of defining an export is to specify which fields should be exported and in what form:
1. Open the database from which you want to export entries.
2. From the File menu, select the Define Export... command, or press the key combination

[Cerl]+[E]. The Export Definition dialog appears on your screen. As shown here, this dialog is
initially empty.
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Figure 72: The Export Definition Dialog

To be able to define the export properties for the fields and field groups, you must first add the
desired fields and field groups to the “Fields and Field Groups” list. The simplest approach is to first
load one of the predefined export definitions as described below, and then to modify this definition
according to your own requirements.

Adding All Fields and Field Groups for a Complete Export

If you want to export your database entries completely in MultiTerm text format, either for use in
another application or to share with a colleague, it’s best to use the predefined export definition
prepared for this purpose, BACKUP. MDX. This is an external file and is by default located in the
C: \ TRADOS\ MTWPLUS directory. Follow these steps to load this export definition:

1. Click on the Load... button. The Load Export dialog appears.

2. Now click on the File... button to load the desired external export definition. The standard
Windows Open file dialog appears on your screen.

3. In the Open dialog, select the drive and directory where the external export definitions are
located. By default, this is the C: \ TRADOS\ MTWPLUS directory. Then select the BACKUP. MDX
file and confirm your selection by pressing OK or [Enter]. You are automatically returned to the
Export Definition dialog, where the “Fields and Field Groups” list now shows all the
predefined fields and field groups.
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Figure 73: The Predefined Export Definition BACKUP. MDX

If you want to export your entries in MultiTerm text format completely and without any changes,
click on Close to confirm the export definition. You can now start your export as explained in the
“Performing the Export” section later in this chapter.

If you want to modify the export definition for your specific requirements, continue with the export
definition as described in the following sections.

Predefined Export Definitions

Besides the predefined BACKUP. MDX export definition that you have just seen, we have created
several other export definitions to simplify your work. The following files contain predefined export

definitions:

File Name

BACKUP. VDX

VENTURA. MDX

TEIl . MDX

LI ST. MDX
RTF. MDX

Explanation

This definition exports all fields in MultiTerm text format. For details
on MultiT'erm text format, see the chapter “Importing Entries”.

This export prepares data for creating a printed dictionary with Corel
Ventura.

This definition creates an SGML export according to the suggestions of
the Text Encoding Initiative.

This definition creates a simple list of terms.

This Rich Text Format export definition prepares data for sophisticated
dictionary printing with word processors like Word for Windows 6.0, 7.0
or later. For further information, see the section “Creating Professional
Dictionaries” later in this chapter.

These export definitions are stored as external files, by default in the C.\ TRADOS\ MIT'WPLUS
directory. Follow the instructions above to load them.
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Selecting Fields and Field Groups

If you do not want to export your entries unchanged, but instead prefer to select individual fields for
exporting, you can modify a predefined export definition (in our case BACKUP. MDX) according to
your needs as described below.

If you are already familiar with the export function, you can, of course, select the desired fields and
field groups directly, without loading BACKUP. MDX. The following table gives you an overview of the

default fields and field groups available in MultiTerm:

Field or Field Group

Explanation

Creation Date

The date on which the entry was created.

Created By T'he user ID of the person who created the entry.

Change Date The date on which the entry was last changed.

Changed By T'he user ID of the person who last changed the entry.

Entry Class The Entry Class used to control read and write access on a network. See the chapter
“Using Multi'Term 95 Plus in a Network Environment” for turther information.

Graphic The name of the graphic file associated with an entry.

Entry Number T'he unique Entry Number generated by Multi'I'erm that represents the concept
stored in an entry. Global attribute and text fields are therefore assigned to this
system field.

Entry Number 2> All the attributes subordinate to the Entry Number, that is, all global attributes.

Any Attribute

Entry Number 2> All the text fields subordinate to the Entry Number, that is, all global text fields.

Any Text

Entry Number > All the attributes subordinate to a global text field.

Any Text > Any

Attribute

Sort Term T'he search term in the currently selected source language.

Synonym All synonyms of the search term in the currently selected source language.

Target Term T'he translation of the search term in the currently selected target language.

Target Synonym

All synonyms of the target term in the currently selected target language.

Any Term

All index fields, including the currently selected source or target languages. However,
if you add the logical tields Sorz Term, Sort Synonym, Target Term, and Target Synonym
to the export definition as described below, the meaning of the Any Term field is
restricted so as to no longer include the corresponding field.

Any Term > Any
Attribute

All the attributes subordinate to a term, that is, all term attributes.

Any Term - Any
Text

All the text fields subordinate to a term.

Any Term - Any
Text 2> Any Attribute

All the attributes subordinate to a text field, that is, all text attributes.
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There are two ways to modify the BACKUP. MDX predefined export definition to meet your individual
requirements. You can suppress fields or field groups that you do not want to export by simply
deleting them from the “Fields and Field Groups” list. You can also add individual fields from your
database definition to the “Fields and Field Groups” list.

. To delete fields or field groups that you do not want to export from the “Fields and Field
Groups” list, highlight them, and click on the Delete button ([Alt]+[D]). The selected fields are
removed from the “Fields and Field Groups” list. You can highlight several fields or field groups
simultaneously and delete them all at once.

. To add individual fields from your database definition, click on the Add... button ([Ale]+[A]).
The Select Field or Field Group dialog, which you know from the “Filtering Entries” chapter,
appears on your screen. Select the fields that you want to export in the same way as when
defining a filter. The selected fields are added to the “Fields and Field Groups” list.

. If you want to exclude specific fields in your database definition from the export, you must first
add these fields to the “Fields and Field Groups” list as described above. You can then exclude
them by deactivating the Export Field Name and Export Field Contents check boxes as
described below.

Defining Field Properties

Once you have selected the desired fields and field groups for exporting, you can define their
properties. You can specify separate properties for field names, field contents, or entire structures. A
structure is defined as a field with all of its subordinate fields. For example, if you define the
properties for the Any Term field, the structure encompasses all of the text and attribute fields
subordinate to a term.

The following input fields and check boxes are available to you in the lower portion of the Export
Definition dialog:

Before the Structure Input field for a string to be output before the structure of a term
or of a text field.

After the Structure Input field for a string to be output after the last field of a
structure.

Export Field Name Check box for outputting field names.

Before the Field Name Input field for a string to be output before a field name.

After the Field Name Input field for a string to be output after a field name.

Export Field Contents Check box for outputting field contents.

Before the Field Input field for a string to be output before the actual field
contents.

After the Field Input field for a string to be output after the actual field
contents.

Follow these steps to specify the properties for selected fields in your export definition, for example
to add a line break after a field:

1. Highlight the field or field group for which you want to define properties in the “Fields and
Field Groups” list. The currently defined properties for this field or field group appear in the
corresponding input fields and check boxes. If no properties have yet been defined for a field or
field group, the input fields are empty, while the check boxes are activated by default.

2. Into the corresponding input fields, type in the strings that you want to insert before or after a
field name, field contents, or structure, and activate or deactivate the desired check boxes.
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In addition to normal alphanumeric characters, you can use the following special characters in the
input fields:

\n Creates a line break.
\t Creates a tab character.
\l Is replaced with the field name of the current field.
\ Creates a backslash character (\).
Note

You can also use characters that are not shown on your keyboard. To do so, press and hold the [Alt]
key and on your numeric keypad type in the four-digit ANSI code of the desired character. To
determine the ANSI code, it’s best to use the program Character Map that you can find in the
Windows program group Accessories.

Copying Field Properties

Now that you have seen how to define field and field group properties in the export definition, we
want to show you how to avoid repetitive work by copying the properties you have defined for one
tield to other fields.

1. Highlight the field or field group from which you want to copy the properties by clicking on it
with the mouse.

2. Highlight the field or field group to which you want to copy the properties by holding down the
[Ctrl] or [Shift] key and clicking on the desired field or field group with the mouse. As in the
Windows File Manager, you can highlight multiple fields simultaneously by holding down the
[Ctrl] or [Shift] key while clicking on the desired fields. Holding down the [Ctrl] key lets you
select several fields or field groups individually, while holding down the [Shift] key lets you
select several fields or field groups that are next to each other. If you highlight too many fields,
you can remove the highlighting by again holding down the [Ctrl] or [Shift] key and clicking on
the corresponding fields or field groups.

As soon as you have highlighted more than one field, the message line in the Export Definition
dialog tells you which field will be copied from if you select the Copy function.

3. Click on the Copy button ([Alt]+[C]). This copies the properties from the first field you
highlighted to all other highlighted fields.

Example 1: Creating an Export Definition for a Multilingual Glossary

Let’s assume that you want to create a glossary that contains all terms with their definitions and source
references, but not other text fields like notes or context examples. Furthermore, you do not want to
export the system fields from the entry header, or any global text or attributes, but you do want to see
term and text attributes. This means first of all that the following entry header fields must be
suppressed: Creation Date, Created By, Change Date, Changed By, Entry Class, Graphic, Entry Number,
Entry Number DAny Attribute, Entry Number 2Any Text and Entry Number DAny Text DAny Attribute. Since
you only want to export definitions and source references and no other text fields, the Any Term 2Any
Text Field must be suppressed since it refers to all text fields. But this means that you must explicitly
add the fields in your database definition that refer to definitions and source references. We assume in
the following example that you have called these text fields Definition and Source.

The simplest approach is to load and modify the predefined export definition BACKUP. MDX as
follows:

1.  Open the database from which you want to export entries if it is not already open.
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11.

From the File menu, select the Define Export... command, or press the key combination
[Cerl]+[E] to open the Export Definition dialog if it is not already open.

Click on the Load... button. The Load Export dialog appears.

Now click on the File... button to load an external export definition. The Files dialog appears
on your screen.

In the Files... dialog, select the directory where the external export definitions are located. By
default, this is the C: \ TRADOS\ MITWPLUS directory. Then select the BACKUP. MDX file and
confirm your selection by pressing OK or [Enter]. You are automatically returned to the Export
Definition dialog, where the “Fields and Field Groups” list now shows all the default fields and
field groups.

Highlight the following fields: Creation Date, Created By, Change Date, Changed By, Entry Class,
Graphic, Entry Number, Entry Number DAny Attribute, Entry Number 2Any Text and Any Term >Any
Text. As in the Windows File Manager, you can highlight individual fields by holding down the
[Ctrl] key or consecutive fields by holding down the [Shift] key.

Click on the Delete button ([Ale]+[D]). The highlighted fields are deleted from the “Fields and
Field Groups” list.

To add the desired Any Term >Definition field to the export definition, click on the Add...
button ([Alt]+[A]). The Select Field or Field Group dialog, which you know from the
“Filtering Entries” chapter, appears on your screen.

Select the fields that you want to export using the same technique as when defining a filter. For
our example, activate the Any Field check box above the list of system/index fields, and
highlight the Definition text field in the list of text fields. Confirm your selection by clicking on
OK. You are returned to the Export Definition dialog, and the field Any Term 2Definition
appears in the “Fields and Field Groups” list.

Follow the procedure in steps 8 and 9 to add the field Any Term DSource to your export
definition.

To copy the default field properties to the fields you just added, Any Term 2Definition and Any
Term DSource, highlight one of the predefined fields, for example, the field Any Term 2Any
Attribute, and then hold down the [Ctrl] or [Shift] key while highlighting the two new fields to
which you want to copy the properties.

Click on the Copy button. The field properties are copied from the first field you selected to
the fields you selected afterwards. Your export definition is complete and should appear as
follows:
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Figure 74: Export Definition for a Multilingual Glossary

For information on selecting export options that apply to the entries as a whole or to the entire
database, refer to the section “Setting Export Options” later in this chapter.

If you do not want to set any additional options for your export definition, click on Close to confirm
your export definition. You can now begin your export as explained in the “Performing the Export”
section later in this chapter.

Example 2: Customising an Export Definition for Importing into Other MultiTerm Databases

If you want to export terminological data for importing into another MultiTerm database, you don’t
need to worry about the field and entry format as long as you use the predefined export definition
BACKUP. MDX as the basis for your export. However, you may need to change the field names,
because when importing data, MultiT'erm only recognises those fields that are defined for the
currently open database.

Let’s assume that the index fields in the database you are exporting are called Deursch, Englisch, and
Franziosisch. However, in the database where you will later import the data, these fields are called
German, English, and French. In this case, the index fields would not be recognised during an import;
their names must therefore be changed.

Follow these steps to define the export on the basis of the predefined export definition BACKUP. MDX
and to change the field names during the export:

1. Open the database from which you want to export entries.

N

From the File menu, select the Define Export... command, or press the key combination
[Cerl]+[E], to open the Export Definition dialog.

3. Click on the Load... button. The LLoad Export dialog appears on your screen.

4. Now click on the File... button to load an external export definition. The standard Windows
Open file dialog appears on your screen.

5. In the Open dialog, select the drive and directory where the external export definitions are
located. By defaul, this is the C: \ TRADOS\ MTWPLUS directory. Then select the BACKUP. MDX
file.
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Figure 75: The Open Dialog

Confirm your selection by pressing OK or [Enter]. You are automatically returned to the Export
Definition dialog, where the “Fields and Field Groups” list now shows all the predefined fields
and field groups. This list contains the field group Any Term representing all languages, but the
list does not contain the individually defined index fields for your database, for example,
Deutsch. To change the name of the index field from Deutsch to German, you must therefore first
of all add the index field Deutsch to the “Fields and Field Groups” list.

Click on the Add... button ([Alt]+[A]). The Select Field or Field Group dialog, which you
know from the “Filtering Entries” chapter, appears on your screen.

Select the index field Deutsch, using the same technique as when defining a filter, and confirm
by clicking on OK. You are automatically returned to the Export Definition dialog, and the
field Deutsch appears in the “Fields and Field Groups” list.

Follow the procedure in steps 7 and 8 to add the index fields Englisch and Franzisisch.

Highlight the field group Any Term. The default properties for all index fields are displayed, and
with Any Term highlighted, you will be able to copy these properties to the newly added fields.
The default field properties for the Any Term field group appear in the lower portion of the
Export Definition dialog. You can see that the check box for exporting the field’s contents is
activated and that the string \ N<\ | > is exported before the field. The \ n stand for a line break
(“new line”), and the \| stands for the field name (“label”) of the current field, which is
enclosed in angle brackets (< and >) according to the standard MultiTerm format.

Copy the field properties from the Any Term field group to the newly added fields Deutsch,
Eunglisch, and Franzisisch. To do so, leave Any Term highlighted, and extend the highlight to the
new fields by holding down the [Ctrl] or [Shift] key and clicking on the three new fields. Then
click on the Copy button. The properties of the Any Term field group are copied to the fields
Deutsch, Englisch, and Franzdsisch.

Highlight one of the fields, for example, the field Deutsch, for which you want to automatically
change the name during the export. In the Before the Field input field, replace the \ | symbol,
which stands for the name of the current field, with the new field name. That is, change
\ n<\ 1 > to\ n<Ger man>.
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Figure 76: Export Definition for Changing Field Names

13.  Follow the same approach for the field Englisch, changing the characters \ N<\ | > in the Before
the Field input field to \ n<Engl i sh>, and for the field Franzdisisch, changing \ n<\| > to
\ n<Fr ench>. This causes the current field names to be automatically replaced with the new

names when exporting.

You can of course use the same approach to change the field names of text and attribute fields if

necessary.

For information on selecting export options that apply to the entries as a whole or to the entire
database, refer to the section “Setting Export Options”.

If you do not want to set any additional options for your export definition, click on Close to confirm
your export definition. You can now start your export as explained in the “Performing the Export”
section later in this chapter.

Setting Export Options

In the preceding sections, you have seen how to select fields and field groups for exporting and how
to specify their export properties. This section describes how to make global settings that do not
apply to individual fields and field groups, but rather to entire entries or to the entire database. To set
these options, you must first open a new dialog:

. From the Export Definition dialog, click on the Options... button. The Export Options dialog
opens.
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Figure 77: The Export Options Dialog

We want first to present an overview of the options available in the Export Options dialog, and then
describe them in detail in the following sections:

Export Option

Explanation

Sort by Entry Number

Allows you to specify whether the exported entries should be sorted in order of
their Entry Numbers or alphabetically according to the current source language.

Position header information

Allows you to specify where to place any selected header information, such as
the fields Creation Date, Created By, Change Date, Changed By, Entry Class,
Graphic, and Entry Number, as well as any global attributes and global text tields.

Generate initial letters

Allows you to specify whether an initial letter should be output whenever the
first letter of the index term changes. Requires that entries be output sorted by
index term.

Enclose entry in

Allows you to output a string before and after each entry.

Enclose header information

Allows you to output a string before and after the group of entry header fields.

Replace “cross references”

Allows you to specify other strings in place of the default cross reference
delimiters (M),

Generate concept numbers

Allows you to specify whether multiple entries with successive homonyms
should be numbered or output as separate entries.

Do not re-export synonym
entries

Allows you to specify whether entries containing synonyms should be output
one time only, or once for each synonym. Requires that entries be output sorted
by index term.

Generate cross reference
instead of re-exporting

Allows you to specify that entries for which synonyms are suppressed should
automatically create a cross reference back to the previously exported entry.
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As with field properties, you can use the following special characters in addition to normal
alphanumeric characters:

\n Creates a line break.
\t Creates a tab character.
\l Is replaced with the field name of the current field.
\ Creates a backslash character (\).
Notes

*  You can also use characters that are not shown on your keyboard. To do so, press and hold the
[Alt] key and on your numeric keypad type in the four-digit ANSI code of the desired
character.

¢ The character strings before and after the item are only exported when the corresponding
check box is activated.

Sort by Entry Number or the current index

The check box for sorting by Entry Number allows you to determine the sequence of the exported
entries. There are two alternatives:

e If the check box is activated, entries are sorted according to their Entry Numbers, regardless of
the contents of the entries. Each entry is checked against the filter exactly one time; if the entry
matches the filter, it is exported.

e If the check box is deactivated, entries are exported alphabetically according to the currently
selected source language index. Entries that do not have any terms in the current language are
ignored. Entries that have several terms (synonyms) in the current language are checked against
the filter several times, and may be exported several times, depending on other options.

When you activate the check box for sorting by Entry Number, you ensure that each entry is only
exported once. This is recommended for exchanging data and for doing backups. On the other hand,
sorting by index term is recommended for exporting or printing sorted word lists.

Note

The options for handling initial letters, homonyms, and synonyms are only effective when you sort
alphabetically by index term.

Position header information

You use the drop-down list for positioning header information to determine where in the entries this
information should be output. The following fields comprise the header information:

Creation Date

Created By

Change Date

Changed By

Euntry Class

Graphic (file name without path)
Entry Number

global attributes

global text fields
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If these fields are selected for exporting, they can be positioned as follows:

At beginning of entry Positions the header information at the beginning of the entry.
You should use this setting for backing up or exchanging data.
This setting corresponds to the sequence in which the fields are
stored in the database.

After the sort term Allows you to position the header information immediately
following the index term of the source language. This and the
following options are particularly intended for printing data.

After the sort structure Allows you to position the header information after the last field
that is subordinate to the sort term.

At the end of the entry Positions the header information after the last field of the entry,
but before any string you specify for delimiting the entry.

Generate initial letters

The check box for generating initial letters allows you to export initial letters when you sort your
entries alphabetically by index term. This is useful for printing dictionaries, for example. Initial letters
are output according to the following rules:

. An initial letter is output before the first index term that has a different starting letter than the
previous index term.

. Initial letters are determined according to the sort table in the database definition. Only those
characters that are sorted differently produce initial letters. For example, if an index term begins
with the letter A, and the letter A is sorted at the same level as A, MultiTerm behaves as if the
term begins with A.

. Initial letters are generated as capitals.
. Initial letters are output before the entry and outside any delimiter strings defined for entries.
Note

As with the other options, you can specify two strings for delimiting or formatting the item. One is
output before the item—here the initial letter—and the other after the item. Of course, the strings
are only exported if the “Generate initial letters” check box is actually activated.

Enclose entry in

The option for delimiting entries allows you to output any string of characters before or after an entry.
Note that the strings are only exported if the “Enclose entry in” check box is actually activated. The
following strings could be used when exporting in MultiT'erm text format or in SGML format:

\n#%* Used when exporting for the purpose of backing up or exchanging data in
MultiTerm text format to output a line break and two asterisks before each entry.

\n<entry> An SGML export might insert this tag at the beginning of each entry.

\n</entry> An SGML export might insert this tag after each entry.

Enclose header information

The option for delimiting header information allows you to insert a character string at the beginning
and at the end of the group of exported header information fields. Header information fields are listed
in the “Position header information” section above. Note that the strings are only exported if the
“Enclose header information” check box is actually activated.
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Replace cross references

The option for replacing cross references allows you to substitute your own character strings for the
default caret characters (A) normally used to delimit cross references. Note that the strings are only
exported if the “Replace cross references” check box is actually activated.

. When printing dictionaries, you could add formatting instructions for italic text, or specify a
small arrow - >,

. When exporting in SGML format, you could for example specify the tags <seeal so> and
</ seeal so>.

Generate concept numbers in place of homonyms

The option of generating concept numbers instead of homonyms allows you to determine whether
each homonym entry should be exported separately or whether a sequential #umber should be
generated for each homonym meaning.

In a concept-oriented terminology database like MultiTerm, index terms that are spelled the same
but have different meanings are kept in separate entries. This can mean that when performing an
export sorted by index term, one index term may be output several times. However, this is not
necessarily desirable in a printed dictionary.

When you activate the check box “Generate concept numbers in place of homonyms”, MultiT'erm
combines homonyms into a single entry as in a dictionary, automatically inserting a sequential number
for each meaning. You can also specify strings to be output before and after the number, for example
to add a period and a tab after the number. Note that the strings are only exported if the “Generate
concept numbers in place of homonyms” check box is actually activated.

Example 1: Multiple Output of Homonyms
plane
Definition: winged machine that can fly
German: Flugzeug
plane

Definition: tool for smoothing the surface of wood
German: Hobel

Example 2: Concept Numbers for Homonyms

plane
1. Definition: winged machine that can fly
German: Flugzeug
2. Definition: tool for smoothing the surface of wood

German: Hobel

Do not re-export synonym entries

If you sort entries alphabetically by index term, some entries are exported several times, namely those
containing more than one index term in the current source language.

This is not necessarily desirable in a printed dictionary. The “Do not re-export synonym entries”
option means that once an entry is exported (for the main term in the entry, that is, the term that has
been entered into the first index field of the current source language), that entry is not re-exported for
any further terms. Therefore, if the synonym comes first alphabetically, MultiTerm won’t export the
entry. The program will only export it once the main term is the sort term at the same time.
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Generate cross-reference instead of re-exporting

If you do not output multiple entries for synonyms, you may prefer instead to create a cross reference
forward or back to the main term, that is, to the term where the entry can be found. This is the
purpose of the “Generate cross reference instead of re-exporting” option. You can optionally insert
strings before and after the cross reference, for example to add the word See before the cross
reference. Note that the strings are only exported if the “Generate cross reference instead of re-
exporting” check box is actually activated.

Example. In this example, flat is the main (topmost) English term in the entry. The dictionary output
appears as follows:

apartment
See flat

flat
Definition: a room or suite of rooms to live in
Synonym: apartment
Synonym: pad
German: Wohnung

pad
See flat

Saving the Export Definition

Once you have defined an export, it only exists for the duration of your MultiTerm session. If you
want to be able to keep the export definition for later use, you must save it. You can save your export
definition as a private, public, or external definition:

Private Definitions Private definitions are stored in the database and are linked to
your personal user ID.

Public Definitions The system administrator can make a definition available to all
network users. These public definitions are also stored in the
database.

External Definitions External definitions are stored outside the database in files with

the extension *. MDX (MultiTerm Definition for Export). This
allows you to use definitions from one database in another, as
long as the structures of the two databases (that is, their database
definitions) are compatible.

Follow these steps to save your export definition:

1. If you are not already in the Export Definition dialog, from the File menu, select the Define
Export command to open this dialog.

2. To save the current export definition, click on the Save... button. The Save Export dialog
appears on your screen.

. If you want to save your export definition in the database as a private definition, type in
the desired name. You can use any name you like for this name, since it does 707 represent
a file name. Confirm by clicking on OK.

. If you are the system administrator and you want to save the export definition as a public
definition available to all network users, activate the Public check box and type in the
desired name. You can use any name you like for this name, since it does 707 represent a
file name. Confirm by clicking on OK.
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If you want to save your export definition externally so that it can also be used with other
databases, click on the File... button. The standard Windows Save As file dialog appears
on your screen. Select the desired drive and directory from this dialog and type in the
desired file name. MultiT'erm automatically adds the *. MDX extension to the file name if
necessary. Confirm by clicking on OK.

You are automatically returned to the Export Definition dialog and the message line displays
“Export definition saved.” Your export definition has now been stored and you can access it at any

time.

In order to save definitions, you cannot be logged on without a user ID, that is, as gwesz. To save a
definition for public use, you must be logged on as the system administrator with the super user ID.

Loading an Export Definition

Once you have saved an export definition, you can load it as follows:

N

If you are not already in the Export Definition dialog, from the File menu, select the Define
Export command to open this dialog.

Click on the Load... button. The LLoad Export dialog appears on your screen.

If you want to load a private export definition, select the desired definition by clicking on
it, and confirm by clicking OK.

If you want to load a public export definition, activate the Public check box. The list of
available public export definitions is displayed. Select the desired definition and confirm

by clicking on OK.

If you want to load an external export definition, for example, one of the definitions listed
in the “Predefined Export Definitions” section earlier in this chapter, click on the File...
button. The standard Windows Open file dialog appears, from which you can load an
external definition. Select the desired drive and directory, type in the desired file name,
and confirm by clicking on OK.

You are automatically returned to the Export Definition dialog, and the message line displays
“Export definition loaded.” If you want, you can change the definition you just loaded according to
your requirements.

Then confirm by clicking on Close. You are returned to the currently displayed entry. How to start
the export is described in the “Performing the Export” section below.
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Removing Export Definitions

If you no longer need an internal export definition (that is, a private or public definition stored in the
database), you can remove it at any time. Follow these steps:

If you are not already in the Export Definition dialog, from the File menu, select the Define
Export command to open this dialog.

Click on the Remove... button. The Remove Export dialog appears on your screen.

. If you want to remove a private export definition, highlight it with the mouse and confirm
by clicking on OK.

. If you are the system administrator and you want to remove a public export definition,
activate the Public check box. The list of public export definitions is displayed. Select the
desired export definition and confirm by clicking on OK.

Answer Yes to the question of whether you really want to delete the definition. You are
automatically returned to the Export Definition dialog and the message line displays “Export
definition deleted.”

Note

In order to remove definitions, you cannot be logged on without a user ID, that is, as guest. To
remove a public export definition, you must be logged on as the system administrator with the
super user ID. For further information, refer to the chapter “Using MultiTerm 95 Plus in a
Network Environment.”

Performing the Export

Once you have specified the content and format of your export in the export definition, you are ready
for the next step of starting the actual export. You have three options: you can export individual
entries, a filtered portion of your database, or your entire database.

Exporting the Entire Database

If you want to export your entire database, make sure that any filter that has been defined is
deactivated. Otherwise, only those entries that match the filter will be exported. Follow these steps to
export your entire database:

Look at the View menu to make sure that the filter is deactivated. If necessary, select the
Filter Active option to remove the check mark (v').

If you used the fields Sort Term, Synonym, Target Term, or Target Synonym in your export
definition, make sure that the desired source and target languages are selected; change them if
necessary.

From the File menu, select the Export All Entries... option. The Export without filter dialog
opens, and the standard Windows Save As file dialog opens on top of it.

By default, MultiTerm exports your database in ANSI format, that is, the standard Windows text
format. The default file extension for ANSI format files is *. TXT. However, if you prefer to
export your database in DOS text format (ASCII), select ASCII file (*.tx8) from the Save file
as type drop-down list. DOS text files are given the file extension *. TX8.
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Figure 79: Selecting a File Format (Here DOS Text Format)

Now decide into which file your entries should be exported. You have three options: you can
create a new file, overwrite an existing file, or append your database entries to an existing file.

To create a new file, select the desired drive and directory in the Save As dialog, and type
in the desired name. The name can be up to eight characters long and may not contain any
special characters. The *. TXT or *. TX8 file extension is added automatically. Confirm by
clicking on OK.

To overwrite an existing file, in the Save As dialog, first select the drive and directory
containing the file, then click on the name of the file you want to overwrite. Confirm your
selection by clicking on OK. You are now asked whether you want to overwrite the
selected file. If in fact you do, answer Yes.

To append your database entries to an existing file, in the Save As dialog, first select the
drive and directory containing the file, then click on the name of the file to which you
want to append the entries. Confirm your selection by clicking on OK. MultiTerm first
asks whether you want to overwrite the selected file. Be sure to answer this question with
No. Now MultiTerm asks whether the entries should be appended to this file. Answer
this question with Yes.

The Save As dialog is closed and the actual export begins. You can see MultiTerm go through
your entries in the Export without filter dialog. When the export finishes, you are
automatically returned to the currently displayed entry of your database. The message line tells
you that the export was completed and how many entries were exported. All the data in your

database is now in the exported text file.

Export without Fiter 1]

Entries: 34 rice

Figure 80: Progress Display in the Export without Filter Dialog

You can now use another application program to edit or print out the export file if desired.

Exporting a Filtered Subset of the Database

If you only want to export a portion of your database, MultiTerm allows you to filter for the desired

entries. Follow these steps:

1. First follow the instructions in the “Filtering Entries” chapter to define a filter with the desired
filter criteria. If you activate the Only Use Matching Fields option, only the fields that match
the filter will be exported; export definitions for non-matching fields will have no effect.
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From the File menu, activate the filter so that a check mark (v') appears in front of the Filter
Active option.

If you used the fields Sort Term, Synonym, Target Term, or Target Synonym in your export
definition, make sure that the desired source and target languages are selected; change them if
necessary.

From the File menu, select the Export All Entries... command. The Export with filter dialog
opens, and the standard Windows Save As file dialog opens on top of it.

By default, MultiTerm exports your database in ANSI format, that is, the standard Windows text
format. The default file extension for ANSI format files is *. TXT. However, if you prefer to
export your database in DOS text format (ASCII), select ASCII file (*.tx8) from the Save file
as type drop-down list. DOS text files are given the file extension *. TX8.

Now decide into which file your entries should be exported. You have three options: you can
create a new file, overwrite an existing file, or append your database entries to an existing file.

. To create a new file, select the desired drive and directory in the Save As dialog, and type
in the desired name. The name can be up to eight characters long and may not contain any
special characters. The *. TXT or *. TX8 file extension is added automatically. Confirm by
clicking on OK.

. To overwrite an existing file, in the Save As dialog, first select the drive and directory
containing the file, then click on the name of the file you want to overwrite. Confirm your
selection by clicking on OK. You are now asked whether you want to overwrite the
selected file. If in fact you do, answer Yes.

. To append your database entries to an existing file, in the Save As dialog, first select the
drive and directory containing the file, then click on the name of the file to which you
want to append the entries. Confirm your selection by clicking on OK. MultiTerm first
asks whether you want to overwrite the selected file. Be sure to answer this question with
No. Now MultiTerm asks whether the entries should be appended to this file. Answer
this question with Yes.

The Save As dialog is closed and the actual export begins. You can see MultiTerm going
through your entries in the Export with filter dialog. When the export finishes, you are
automatically returned to the currently displayed entry of your database. The message line tells
you that the export was completed and how many entries were exported. All the entries in your
database that match the filter are now in the exported text file.

You can now use another application program to edit or print out the export file if desired.

Exporting Individual Database Entries

Follow these steps to export individual entries after you have created an export definition:

Search for the entry that you want to export. When exporting individual entries, it does not
matter whether the filter is active, except that the Only Use Matching Fields filter option is
taken into account. If you selected the fields Sort Term, Synonym, Target Term, or Target Synonym
in your export definition, make sure that you have selected the desired source and target
languages.

From the File Menu, select the Export This Entry command, or press the key combination
[Cerl]+[X]. The Export without filter or Export with filter dialog appears on your screen, and
the standard Windows Save As file dialog opens on top of it.

By default, MultiTerm exports your database in ANSI format, that is, the standard Windows text
format. The default file extension for ANSI format files is *. TXT. However, if you prefer to
export your database in DOS text format (ASCII), select ASCII file (*.tx8) from the Save file
as type drop-down list. DOS text files are given the file extension *. TX8.
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4. Now decide into which file the entry should be exported. You have three options: you can
create a new file, overwrite an existing file, or append your database entries to an existing file.

. To create a new file, select the desired drive and directory in the Save As dialog, and type
in the desired name. The name can be up to eight characters long and may not contain any
special characters. The *. TXT or *. TX8 file extension is added automatically if necessary.

Confirm by clicking on OK.

. To overwrite an existing file, in the Save As dialog, first select the drive and directory
containing the file, then click on the name of the file you want to overwrite. Confirm your
selection by clicking on OK. You are now asked whether you want to overwrite the
selected file. If in fact you do, answer Yes.

. To append your database entries to an existing file, in the Save As dialog, first select the
drive and directory containing the file, then click on the name of the file to which you
want to append the entries. Confirm your selection by clicking on OK. MultiTerm first
asks whether you want to overwrite the selected file. Be sure to answer this question with
No. Now MultiTerm asks whether the entries should be appended to this file. Answer
this question with Yes.

5. MultiTerm exports the entry. Afterwards, you are automatically returned to the currentl
P y s Y Yy Y
displayed entry, and the message line shows “Current entry exported.”

6.  If you want to export additional entries, search for the next one so that it is currently displayed
on your screen, and from the File menu, again select the Export This Entry command
([Cerl]+[X]). MultiTerm informs you that an export file has already been selected and asks
whether you want to append this entry to this file. If you want to export the individual entries to
a common file, answer Yes. This allows you to quickly export a series of entries to a text file.
However, if you want to put the entries in separate files, answer No. The Export without filter
or Export with filter dialog appears on your screen along with the standard Windows Save As
file dialog, where you can again specify another file, and if necessary another path, as described
above. Confirm by clicking on OK. The entry is exported as usual, and you are automatically
returned to the current entry.

You can now use another application program to open the export file and edit or print the individual
entries if desired.

Using the Export Function to Create a Backup

The most secure method to create a backup of your database is to completely export the data in your
database to a text file, and to save the database structure in a separate, empty database. This saves
space on your data media.

MultiTerm includes a predefined export definition that you can use to completely export your data.
The definition is stored as an external export definition in the BACKUP. MDX file, which by default is
located in the C:\ TRADOS\ MTWPLUS directory. Follow these steps to load this predefined export

definition:
1. Open the database for which you want to create a backup, if it is not already open.
2. From the File menu, select the Define Export... command, or press the key combination

[Cerl]+[E]. The Export Definition dialog appears on your screen.
3. Click on the Load... button. The Load Export dialog appears on your screen.

4. Now click on the File... button to load the desired external export definition. The standard
Windows Open file dialog appears on your screen.

5. In the Open dialog, select the drive and directory where the external export definitions are
located. By default, this is the C: \ TRADOS\ MTWPLUS directory. Then select the BACKUP. MDX
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file. Confirm your selection by pressing OK or [Enter]. You are automatically returned to the
Export Definition dialog, where the “Fields and Field Groups” list now shows all the
predefined fields and field groups. Since you normally want to save all data in a backup, do not
make any changes here.

6.  Confirm the export definition by clicking on Close. You are automatically returned to the
currently displayed entry in your database.

7.  Since you normally want to save all entries in a backup, look at the View menu to make sure
that the filter is #or active. If necessary, select the Filter Active option to deactivate the filter
and remove the check mark (v') in front of the option.

8. To start the actual export, from the File menu, select the Export All Entries... command. The
Export without filter dialog appears on your screen, and the standard Windows Save As file
dialog opens on top of it. Select the desired drive and directory, and type in the desired file
name. The file name can be up to eight characters long and may not contain any special
characters. For example, you could name your file BACKUP so that you will later know
immediately which file contains your database backup. MultiTerm automatically adds the
* . TXT extension to the file name.

9.  Confirm by clicking on OK. The export is now performed. When the export finishes, you are
automatically returned to the currently displayed entry in your database. The message line tells
you that the export finished successfully and how many entries were exported. All the data in
your database is now in the exported text file.

To save the database structure, you need to create a new database on the basis of the database you are
backing up, and then, without making any changes, save the new, empty database under a new name.

Follow these steps:

1. From the File menu, select the Create New Database... option ([Alt]+[F], [C]). The
Database Definition dialog opens. Since you want to save the structure of your database as is,
do not make any changes in this dialog.

2. Click on the OK button. The standard Windows Save As file dialog appears on your screen.
Select the drive and directory (folder) where you want to save your database structure, and type
in a new file name for the database structure. Be absolutely sure to use a name that is different from
the name of the current database; otherwise, the current database will be overwritten. For example, you
can name this database STRUCT so that you can immediately tell that this file contains the
database structure of the database you backed up.

If you do not make any changes to your database structure between backup exports, you do not need
to repeat these last two steps for every backup export. As long as you have an empty database with the
same structure as your working database, you only need to export all entries as described in steps 1-9
above.

If you should need to restore from the backup sometime, open the empty database (STRUCT. MTWin
our example) and import the data from the text file (BACKUP. TXT in our example) as described in the
“Importing Entries” chapter. Of course, before importing, you can create a copy of the structure
database, for example using the File Manager or Explorer, and then import the entries there. This
allows you to always keep an “empty” copy of your database structure.

Creating Professional Dictionaries

MultiTerm includes a predefined export definition that allows you to create professional-looking
dictionaries in “Rich Text Format” (RTF). All popular word processors can read RTF files and
convert them to their own internal format. The predefined export definition, which you can of course
change according to your own requirements, is saved as an external export definition in the RTF. MDX
file. By default, this file is located in the C: \ TRADOS\ MI'WPLUS directory. If you are a WordPerfect

or Ami Pro user, please see the notes at the end of this section.
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Before you can use this predefined export definition, one preparatory step is required. In order for the
export file to be understood later as Rich Text Format, you need another file containing the “header
information” required in Rich Text Format files. This file has already been prepared and is included
with MultiTerm. It is also stored by default in the C:\ TRADOS\ MTWPLUS directory and is called
MI4W N. RTX. Important: for MultiTerm to be able to find and use this file during the export, the
file must be copied and renamed so that it has the same name as the database, but with the file
extension * . RTX.

Let’s assume that you want to export the SAMPLE. MWdatabase in Rich Text Format and call the
export file SAMDI CT. RTF. In this case, you must first copy the MT4W N. RTX file to a new file called
SAVPLE. RTX, for example using the File Manager or Explorer. This allows MultiTerm to find the
header information file when exporting SAMPLE. MTW

Follow these steps to load the predefined export definition RTF. MDX and use it as the basis for
exporting your entries:

1. Open the database that you want to export in Rich Text Format if it is not already open.

N

From the File menu, select the Define Export... command, or press the key combination
[Cerl]+[E]. The Export Definition dialog appears on your screen.

3. Click on the Load... button. The LLoad Export dialog appears on your screen.

4. Now click on the File... button to load the desired predefined export definition. The standard
Windows Open file dialog appears on your screen.

5. In this dialog, select the drive and directory where the predefined export definitions are located.
By default, this is the C:\ TRADOS\ MTWPLUS directory. Then select the RTF. VDX file and
confirm your selection by pressing OK or [Enter]. You are automatically returned to the Export
Definition dialog, where all the predefined fields and field groups are shown with formatting
instructions for Rich Text Format.

6.  Change the predefined export definition according to your own requirements if desired. If you
need further information on RTF, you can request the current documentation from Microsoft.
TRADOS also offers services in this area; please contact us if you need a bid for a custom RTF
solution.

7.  Confirm your export definition by clicking on Close. You are automatically returned to the
currently displayed entry in your database.

8.  If desired, define a filter as described in the “Filtering Entries” chapter, and activate it so that a
check mark (v') appears in front of the Filter Active option in the View menu. Otherwise, look
at the View menu to see if the filter is active and deactivate it if necessary so that no check
mark (¥) appears in front of the Filter Active option.

9.  To start the actual export, from the File menu, select the Export All Entries... command. (For
technical reasons, you cannot use the Export This Entry command for an RTF export.) The
Export with filter or Export without filter dialog appears on your screen, and the standard
Windows Save As file dialog opens on top of it.

10. Select the desired drive and folder/directory for your export file. Then select the RTF file
(*.rtf) entry from the Save file as type drop-down list. This is very important to ensure that the
file is created correctly. Type in the desired file name. MultiT'erm automatically adds the
* . RTF extension to the file name if necessary.

11.  Confirm by clicking on OK. The export is now performed. When the export finishes, you are
automatically returned to the currently displayed entry in your database. The message line tells
you that the export finished successfully and how many entries were exported.

You can now open the exported file in your word processor. You may need to specify Rich Text
Format as the file format so that your word processor can correctly read the file.
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Figure 81: Example of a Dictionary Created by MultiTerm in Rich Text Format

Notes for WordPerfect and Ami Pro Users

Unfortunately, WordPerfect and Ami Pro can only handle a fraction of the RTF formats offered by
Microsoft Word. This means that you cannot simply use the RTF. MDX (export definition) and
MIWAW N. RTX (RTF header) files described above with these programs. Instead, you will need to
use the “slimmed down” versions of these files, which are included on the “Macros and Tools”
diskette included with MultiTerm. In particular, these files are as follows:

e WordPerfect: WPRTF. MDX (export definition) and WPRTF. RTX (RTF header), in the \ WPW N
directory.

e Ami Pro: APRTF. MDX (export definition) and APRTF. RTX (RTF header), in the \ AM PRO
directory.

Copy the appropriate files to your MultiTerm installation directory (C: \ TRADOS\ MTWPLUS by
default), and use them instead of the RTF. MDX and MI'4W N. RTX files mentioned above. Also
note that both of these word processors can take some time to open RTF files (Ami Pro is
approximately four times slower and WordPerfect is approximately 30 times slower than Microsoft
Word). In any case, it is recommended that Microsoft Word be used for creating professional-
looking dictionaries whenever possible.
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Importing

Entries

MultiTerm ’95 Plus’s import function is the flip side of the export function described in the previous
chapter. This part of the program allows you to import data from another application program, for
example your word processor. You can add any number of new entries, or you can make specific
modifications to existing entries. Of course this can only work properly when you prepare the file to
be imported (“the import file”) in such a manner that MultiTerm can “understand” it.

Let’s first look at the general prerequisites for performing a successful import into a MultiTerm
database, and then work through some concrete examples of how to prepare and perform an import:

. The import file must be in ANSI or ASCII format. ANSI is the default Windows text format;
ASCII is the standard DOS text format.

. The entries to be imported must follow the conventions of the “MultiTerm text format.” This
format will be explained in detail in this chapter.

. The hierarchical structure of MultiT'erm entries must also be reflected in the import file so that
the new entries are consistent with the existing entries. We will briefly review the structure of a
MultiTerm entry in this chapter. For further information, see the section titled “The Entry
Structure” in the “Creating a Database” chapter.

. The field names that you specified in the MultiTerm database definition must exactly match
the field names used in the import file.

. If the database into which you want to import entries is protected by a password, you must be
the system manager and have the database open exclusively. For instructions on opening a
database exclusively, see the chapter “Using MultiTerm ’95 Plus in a Network Environment.”

Preparing a File for

Importing into MultiTerm

The conditions listed above for a successful import are explained in detail in the following sections.

Adapting Entries to MultiTerm Text Format

To import entries from a file created in another application into your MultiTerm database, you must
first make the entries conform to MultiT'erm text format. We will therefore first of all explain exactly
what MultiTerm text format looks like. The principle is simple:

. The individual entries in an import file are separated from one another by two asterisks (¥*) on
one line.
. Each field in an entry, for example a term, definition, or gender specification, appears on a

separate line. The field contents are preceded by the field name in angle brackets.

This means that the import file must appear as follows for MultiTerm to be able to understand it:

**ﬂ
<Field Name>Field Contentsq
<Field Name>Field Contents

;'Field Name>Field Contents{
**ﬂ
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<Field Name>Field Contentsq
<Field Name>Field Contents

;'Field Name>Field Contentsq
**ﬂ
etc.

The following is an example of an entry in MultiTerm text format exported from the SAMPLE.MTW
database. We created this example by exporting the database using the predefined BACKUP.MDX
export definition described in detail in the previous chapter. For simplicity’s sake, we did not export
any system fields except the Entry Number. The result of the export appears as follows:

*%

<Entry Number>58]

<Subject>Fruit]

<English>quincef

<Definition>The acid tasting fruit of the ~quince tree”, much used
in preserves.{

<Source>The Collins Dictionary of the English Language,
London & Glasgow 19861

<Deutsch>Quitte

<Gender>f{

<Definition>Frucht des *Quittenbaum”sq

<Source>Duden, Deutsches Universalworterbuch, Mannheim 19891

Conforming Entries to the MultiTerm Entry Structure

In order for imported entries to be consistent with the entries in the MultiTerm database, you must
conform the structure of the entries being imported to the MultiTerm entry structure. Here we will
briefly review MultiTerm’s hierarchical entry structure and explain the meaning of the sequence of
fields in an entry. For more information, see particularly the section titled “The Entry Structure” in
the “Creating a Database” chapter, as well as the “Editing Entries” chapter:

. Entry Header: The entry header contains system fields for general administrative information
like Creation Date and Entry Class. If these fields are missing from your import file, MultiTerm
will generate them automatically during the import. The example above contains the Entry
Number system field.

. Global Attributes: Global attributes contain classifying information that applies to the entire
entry and therefore appears directly below the Entry Number and before the terms in the
various languages. The example above contains the global attribute Swdject with the contents
Fruit. Of course, a global attribute is not required in order for MultiTerm to be able to import an
entry. However, if you want to import subject specifications, for example, they should appear at
the beginning of each entry being imported.

. Global Text Fields: Global text fields contain free-format text that applies to the entire entry
and therefore, like global attributes, appear before the actual terms. The example above does
not contain any global text fields.

. Index Fields: Index fields contain the terms in the various languages. The example above
contains the index fields Ewglish and Deutsch. The names of these fields depend on your
individual database definition.

. Term Attributes: Term attributes contain classifying information about individual terms. In
the example above, the specification <Gender>fis a term attribute for the German term Quitte.

. Text Fields: Text fields contain additional free-format information about individual terms.
The example above contains two text fields, Definition and Source, used for both the English and
the German terms. Of course, the same applies here as with other fields: text fields are not
required below each term; they can even be completely omitted.

. Text Attributes: Text attributes contain classifying information about the individual text field
to which they apply. The example above does not contain any text attributes.

Multdi'Term ’95 Plus, © 1995-97 by TRADOS GmbH



w

Preparing a File for Importing into Multi' Term 15

When preparing an import file, keep in mind that MultiTerm can only read it correctly when the
following conditions are met at the entry and file level:

. Your import file may not use more than 20 different index fields for a maximum of 20 different
languages.

. Your import file may not use more than 62 different text fields.

. Your import file may not use more than 30 different attribute fields.

. Each entry may contain exactly one entry header with system fields like Creation Date or Entry
Class.

. All non-system fields may occur multiple times in one entry. For example, the index fields

<English> and <Deutsch> may be used any number of times to represent synonyms.
. An entry may contain no more than 32,000 characters in a maximum of S00 fields.

When reading entries from an ANSI or ASCII file into a database, MultiT'erm uses the implicit
hierarchy described above to order the fields in each entry. Text fields and attribute fields that appear
at the beginning of the import entry are interpreted as global attributes and global text fields. Text
fields and attribute fields that follow an index field are assigned to that index field. This means that
your import file must contain information in the correct sequence so that MultiTerm can correctly
recreate the structure of the entries. We would like to illustrate this concept with an example.

Let’s assume that you want to import a text file that also contains subject specifications. As explained
earlier, this kind of information is best contained in an attribute field. Since subject specifications
normally apply to the entire entry, this attribute field should be attached to the Entry Number, which
MultiTerm uses to represent the entry and which is automatically created during the import if
necessary. That is, a subject specification is a classical global attribute. Let us further assume that a
typical entry from your import file appears as follows:

* %

<Engl i sh>strawberry
<Subj ect >Frui t

<Deut sch>Er dbeer e

* %

<Engl i sh>car

<Subj ect >Mechani cal Engi neeri ng
<Deut sch>Aut o

In this example, the subject specification does not appear at the beginning of the entry, that is,
immediately following the two asterisks, but rather after the field English. This means that MultiTerm
would not import it as a global attribute, but rather, subordinate to the Eng/ish field as a term attribute.
To import the above entries as desired, the subject specifications would have to appear immediately
after the line containing the two asterisks.

Conforming Field Names to the Database Definition

As a final step in preparing a file for importing, you must conform the field names in the import file to
the field names in the database into which you are importing the file. As described in the “Creating a
Database” chapter, field names are individually specified in the database definition. If you want to
import a file into an existing database, you must adapt the field names in the import file to match the
field names in the database definition. If, on the other hand, you want to create a new database on the
basis of the import file, you must specity the corresponding field names in a new database definition
as described in the “Creating a Database” chapter.

One exception are the system fields that MultiTerm automatically generates: Creation Date, Created
By, Change Date, Changed By, Entry Class, and Entry Number. If your import file includes administrative
data that you would like to put in one of these system fields, you must conform the field name in the
import file to the corresponding MultiTerm field name. For example, MultiT'erm could not recognize
a field named Changed On; this field must be called Change Date.
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To illustrate this with an example, let’s assume that you want to import a text file into an existing
database. In the definition of the MultiTerm database into which you want to import the text, you
have defined the index field Frangais. However, in the text file, you’ve used the field name French. In
this case, MultiTerm will not be able to correctly import the text file, since there is no way for it to
“know” that these are actually the same field. MultiT'erm would not recognize the French terms since
the field name in the database is different from the field name in the import file. In this case, the field
name and its contents would be interpreted as a continuation of the text in the most recent correct
field. After the import, a sample entry would appear as follows:

car
Source The Collins Dictionary of the English Language, London & Glasgow 1986
<French>bagnole

Automobil long form
Source Duden, Deutsches Universalwérterbuch, Mannheim 1989
<French>voiture

In this example, MultiT'erm ignored the fields in the import file with the field name <French> and
simply attached them as normal text to the preceding Source fields. To avoid this kind of situation,
you must ensure that the field names in the database definition are one hundred percent identical to
the field names in the import file. Note that field names are case-sensitive.

Example: Conforming a Word List to the MultiTerm Text Format

We would now like to use a simple example to show you how you can adapt an existing file to
conform to the MultiTerm text format described above. Let’s assume that you have thus far managed
your terminology as word lists in your word processor. The word list has the following format:

1

book > Buch-[ODBI1
card-index-box > Karteikasten-[ODB]1
wastepaper-basket > Papierkorb-[ODB]
desk > Schreibtisch-[ODB]
dictionary -> Worterbuch-[Martha]q

So the word list consists of English terms and their German translations separated into two columns
by a tab character (=). Each German translation is followed by a space (-) and the source of the
translation in square brackets. A paragraph mark () follows each word pair.

Each line in the above word list therefore theoretically corresponds to one entry in a MultiTerm
database. However, the file cannot be imported as is, since it is not in MultiT'erm text format.

We would therefore like to show you how you can convert the above word list so that it can be
imported. Follow these steps:

1.  If you have not yet defined a database into which you can import the above word list, you
should do so now. Since the word list has three different data categories, you must define at least
three corresponding fields in your database, for example the index fields Ewnglish and German, as
well as a text field Sowurce.

2. To import the word list, you must convert it to the MultiTerm text format. The goal is to change
the word list so that it looks like the following:

**ﬂ'
<English>Term{
<German>Term¢
<Source>Text(
*%
<English>Term{
<German>Term¢
<Source>Text(
**ﬂ'
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You can carry out this conversion in most word processors by clever use of the Replace...
command in the Edit menu. Let’s look at how such a conversion might be accomplished.

3. As a first step, you could replace the carriage return () at the end of each line with the string
**Yi<English> . This has two effects: each line in your list will be interpreted by MultiTerm
as a separate entry, and each item in the left column of your table will be assigned to the English
index field, which we added to the database above. If you are not yet familiar with searching for
and replacing special characters, please refer to your word processor’s documentation or online
Help. Once you have completed the replace, you will see the following intermediate results:

**ﬂ

<English>book > Buch-[ODBIY

**ﬂ

<English>card-index-box > Karteikasten:[ODB]T

4. The tab character (=) separates the left column with the English terms from the right column
with the German translations. If you now replace the tab character with the string <German>,
the German term will be on a line by itself and will be assigned to the German index field. The
results of this second replace look like this:

**

<English>book{
<German>Buch:[ODB]Y

**ﬂ

<English>card-index-box{
<German>Karteikasten:[ODB]1

5. Now you can replace the space and left square bracket (“ [”) with the string f<Source> . This
causes the source reference to appear on a line by itself and to be assigned to the Sowrce text
field, just as the MultiTerm text format requires. The results look like this:

**ﬂ
<English>book{
<German>Buchf
<Source>0ODB]1
*%

<English>card-index-box{
<German>Karteikasten
<Source>ODB]1

6.  Finally, you can replace the closing square bracket (“]”) with nothing, effectively deleting this
character from your text. The MultiTerm text format is now complete: each item from your
word list now appears in a separate paragraph as a field name in angle brackets followed by the
corresponding field contents. So your text now looks like this:

**ﬂ
<English>book
<German>Buchf
<Source>0DBf
*%

<English>card-index-box{
<German>Karteikasten
<Source>0DBf

7. Save this file as ANSI text, often called Windows text or “T'ext Only”, with the * TXT file
extension. This ensures that MultiT'erm can read your text file correctly.
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Note

The key to successful data conversion is consistent formatting of the original document. A missing
carriage return or an extra tab character can cause the data to be incorrectly converted and
imported. It is therefore recommended that you review your data for inconsistencies before and
after the conversion.

Now that you have converted your word list, you are ready to import it into MultiTerm.

Setting the Import Options

The prerequisite for performing an import is that the import file must be in MultiTerm text format.
This was explained in detail in the previous section. In order to start an import in MultiTerm, the
database into which you want to import the text file must be opened exclusively by the system
administrator; otherwise, the Import... command will be grayed out in the File menu. How to open a
database exclusively is described in the chapter “Using MultiTerm 95 Plus in a Network
Environment.” You also have the option, before starting the import, of setting a filter to control the
import. You can set a filter using the Define Filter... and Filter Active commands in the View
menu. The “Filtering Entries” chapter includes several detailed examples of filters.

.
Import Dptions

~Step 1: Read entry from import file——— | Help I I 1] I

MultiT erm reads one entry from the import

file after each occurrence of the string
==

rStep 4: Synchronize on Entry Number

The helds <Creation Date> and <Change
Date> are generated automatically
depending on whether the entry being
imported already containg date fields.
and whether it i1s replacing an entry or
being inserted as a new entry.

When there is no entry with thizs number,

I Synchronize on index field J
When databaze entry matches Filter,

I Replace database entry with new entry jJ

When databaze entry does not match Filter,

‘Step 2: Fill Missing System Fields II]mil entry J
Created By:
Changed By: rStep 5. Synchronize on Index Term
Entry Class Synchronize on index: English j

When a new term is found,

When entry does not match Filter,

[Omitenty

~Step 3: Filter the Import Entry IAdd entry as a new entry J
When entry matches filter, When databaze entry matches Filter,
[Contine with database ety 2

When databasze entry does not match filter,

I Omit entrp jJ

Figure 82: The Import Options Dialog

Note

Before starting the actual import, we recommend that you make a backup copy of the database into
which you are importing. Then, if the import does not yield the desired results, you can always
revert to the original database and try again. The text file you are importing is not changed by
MultiTerm, so you do not need to make a backup copy of it.

Once you have made all the necessary preparations, you are ready to begin. Select the Import...
command from the File menu. The Import Options dialog appears.
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Let’s go through this dialog step by step. You see that MultiTerm performs up to five steps, labeled
“Step 1” to “Step 57, during an import. Let’s use an entry from the import file we created in the last
section as an example to illustrate Steps 1 and 2:

*k
<English>book
<German>Buch{
<Source>0DBY

As you can see, this entry has no entry header containing administrative information; the entry
contains only terms and a source reference. Step 1 of MultiTerm’s import function therefore
automatically creates the system fields Creation Date and Change Date, since these fields are missing
from the entry being imported. Today’s date is used for both dates. If this administrative data were
preset in the import file, MultiTerm would of course use the imported dates instead.

Step 2 adds the system fields Creazed By, Changed By, and Entry Class, which are also missing from the
above example. While only the system administrator can perform an import, the entries being
imported may well come from another colleague. The second step of the import therefore lets you
specify any valid user ID and Entry Class for the entries being imported. For more information on
these system fields, see the chapter “Using MultiTerm 95 Plus in a Network Environment.” To
change a value, open the corresponding drop-down list and select the desired user ID or Entry Class.
If the fields Created By, Changed By, and Entry Class are already present in the entry being imported,
they are used as is, unless a filter is set that prevents this.

Note

It you have not yet defined any network options for your database, only the super user ID is
available for automatic filling of the Created By and Changed By fields.

Step 3 lets you specify exactly what happens to the individual entries during the import. You
determine the following:

. Whether all the entries in the import file should be imported.

. Whether the entries in the import file should be filtered so that they are not added to your
database unexamined.

. Whether the entries being imported should be “synchronized” with existing database entries in
Step 4 or Step S. Synchronized entries can be combined, or existing entries can be replaced
with entries from the import file.

We will explain just how the different import options work together using four concrete case studies.
Each case begins with a discussion of a typical set of requirements that might occur before an import.
The import options to meet these requirements are then specified. We assume in all cases that you
have already made the settings required by Steps 1 and 2 of the Import Options dialog, as described
above. After the case studies, we present an overview of the individual import options and their
meanings.

Case 1: Import All Entries without Filtering

Let’s assume that you have just created a new database in MultiTerm. In this case, you may want to
import the file into this new database without a detailed examination of the entries being imported.

Follow these simple steps to completely import a file into your database:
1. Open the database into which you want to import the entries if it is not already open.

2. Look at the Filter Active option in the View menu to determine whether the filter is active. If
necessary, deactivate the filter so that no check mark (v') appears in front of this option.
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3. From the File menu, select the Import... command. The Import options dialog appears on
your screen. As you see, MultiTerm divides the import into as many as five steps. Steps 1 and 2
were described above; in our case, only Step 3 is relevant. From the “When entry matches
filter” drop-down list in Step 3, select the Add entry as a new entry option. Since you just
deactivated the filter, all import entries are considered to match the filter, so this will import all
entries into your database. Confirm this setting and leave the Import Options dialog by clicking

on OK.

4. Now refer to the “Starting the Import” section later in this chapter.

Case 2: Importing Filtered Entries

Let’s assume that you have created a new database, but that you only want to import those entries
from your import file that are relevant to your work. You do not want to import information that you
will not need into your new database.

If you do not want to import all the fields contained in your import file into your database, you can use
a filter to control which fields are imported and which are not. You can also use a filter to specify that
only entries from a specific subject area be imported into your database. Similarly, a filter definition
can also exclude entries from certain subject areas or certain projects from being imported into your
database.

Follow these steps to perform an import using a filter:
1. Open the database into which you want to import the entries if it is not already open.

2. Define the filter you want to use. If you are not yet familiar with MultiTerm’s filter function,
refer to the “Filtering Entries” chapter. If you only want to import certain fields from the import
file, make sure that you activate the Only Use Matching Fields check box in the filter
definition.

3. Remember to activate the filter by selecting the Filter Active command from the View menu
([Ctrl]+[A]). When the filter is active, a check mark (v') appears in front of this option, and a
corresponding message is displayed in the message line.

If your filter includes the logical fields Sorr Term, Synonym, Target Term, or Target Synonym, make
sure that you have set the desired source and target languages before performing the import.

4. Now select the Import... command from the File menu. The Import Options dialog appears
on your screen.

5. As you see, MultiTerm divides the import into as many as five steps. Steps 1 and 2 were
described above; in our case, only Step 3 is relevant. In Step 3, from the “When entry matches
filter” drop-down list, select the Add entry as a new entry option, and from the “When entry
does not match filter” drop-down list, select the Omit entry option. This means that all entries
matching the filter will be imported into your database, and all non-matching entries will be
excluded. Confirm this setting and leave the Import Options dialog by clicking on OK.

6. Now refer to the “Starting the Import” section later in this chapter.

Note

You can combine setting a filter with other import options. To do so, in Step 3 of the Import
Options dialog, you would select one of the settings that will now be described in detail.

Case 3: Synchronizing on Index Term

Let’s assume that you have a fairly comprehensive database that you want to modify with an import.
Since terms in your database may also be in the import file, you would like to check the entries being
imported before they are added to your database. MultiTerm gives you an option for this purpose that
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lets you “synchronize” entries based on a language that you select. What does this mean? MultiTerm
can check each entry in your import file to determine whether the terms being imported are already
present in the database for the language you select. If so, MultiTerm automatically performs a
duplicate handling routine to prevent any duplicate entries from getting into your database.

With this kind of an import, you can specify exactly what MultiTerm should do when it finds a term
in the import file that already exists in your database. We will explain the options available below.
You can also specify what MultiT'erm should do with entries that contain no duplicates, that is, that
contain only new terms.

Let’s illustrate this on the basis of a concrete example. You want to import a terminology database on
the subject of agricultural crops into your database. Your database already contains entries on this
subject. There is therefore a high probability that both your database and the import file already
contain the English term pozaro.

If you import all entries without any checking, after the import, you will wind up with two entries in
your database for the term potato. However, as explained in the “Creating a Database” chapter,
MultiTerm is a concept-oriented database; there should be only one entry in your database for each
concept. You therefore need to avoid this duplication of entries.

For exactly this reason, MultiTerm offers you the option of “synchronizing on an index field” when
importing. “Synchronizing” here means that two entries containing the same term can be combined
(merged). It may be that the entry being imported for pozato contains valuable terminological
information that the entry in the database does not contain. Once combined, all this information will
appear in one entry. MultiTerm simply orients itself on the term pozato and adds all new information
from the entry being imported to the existing database entry. Information that is identical in both
entries, for example the term pofato, remains unchanged, that is, it is not duplicated. This way, no
information is lost, which could happen if you were to filter out (not import) entries for which a term
already exists in your database. Also, after the import, all the information for one concept appears in
one entry; undesired duplicates are avoided.

Potato Potato
Irish potato white potato

Potato
Irish potato
white potato

Figure 83: Synchronizing Two Entries on Index Term

This figure illustrates the process we just described. Let’s assume that your database entry contains
the terms potato and Irish potato as synonyms for a single concept. The entry being imported contains
the terms porato and white potato. These are synonyms of the same language-independent concept. It
is therefore desirable that both these entries be combined during the import rather than creating two
separate entries that duplicate each other.

Follow these steps to combine database and import entries:
1. Open the database into which you want to import the entries if it is not already open.
2. From the File menu, select the Import... command. The Import Options dialog appears on

your screen. From the “When entry matches filter” drop-down list in Step 3, select the
Synchronize on index field command. If you set a filter—see Case 2 above—select the option
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you want from the “When entry does not match filter” drop-down list. The various options are
summarized in the overview later in this chapter. If no filter is set, every entry matches the filter.

3. Once you select the Synchronize on index field command in Step 3, the options under “Step
5: Synchronize on index term” become active. This is where you select the language that
MultiTerm should use as the basis for its duplicate recognition. Select the desired language
from the Synchronize on index drop-down list. Then, in the “When database entry matches
filter” drop-down list, select the Combine with database entry option. Now, when MultiTerm
finds a duplicate in an import entry, it will combine this entry as desired with the corresponding
database entry. The options in the other drop-down lists, “When a new term is found” and
“When database entry does not match filter”, are described in the overview later in this chapter.
Finally, confirm your settings for the import by clicking on OK to leave the Import Options
dialog.

4. Now refer to the “Starting the Import” section later in this chapter.

Case 4: Synchronizing on Entry Number

Let’s assume that you work at the headquarters of a large multinational company that is constantly
creating new terms for new products, functions, and parts. You compile the terms in your mother
tongue in a MultiTerm database, and export the new entries with their Entry Numbers at regular
intervals. (To export only new entries, you filter on Creation Date as described in the “Filtering
Entries” chapter.) You then send this export file to your company’s branches in other countries with
the request that your colleagues there add the corresponding terms, definitions and other important
information in the local language.

After a while, your colleagues send back the edited export files. You can now update your existing
monolingual database with the information that you have received from your foreign offices in the
various languages. To do so, when importing, you synchronize the entries on Entry Number, since
you originally exported your entries with this system field and can therefore let MultiTerm use it as a
basis for synchronization. The result is a multilingual dictionary that is a collection of some of your
company’s most valuable knowledge.

You can use the following approach to coordinate your company’s terminological efforts at multiple
locations:

1. At regular intervals, perhaps once a month, export all entries that have been added to your
database by filtering on Creation Date as described in the “Filtering Entries” chapter. Use the
predefined export definition BACKUP. MDX for the export as described in the “Exporting
Entries” chapter. Using the BACKUP. MDX export definition ensures two things:

. Your colleagues will be able to easily import the entries into their databases.

. You automatically export the Entry Number system field which will later be used as the
basis for combining the entries from your branch offices with your own entries.

2. Send the exported data to your branch offices, asking them to translate the terms and perhaps
add definitions in their local language. When finished, they should also export the file using the
predefined export definition BACKUP. MDX and send it back to you.

3. If your colleagues followed your instructions, the entries that they returned to you will contain
the Entry Number system field which you can now use for synchronizing the import into your
database. The entries should also contain translations and definitions in the corresponding
languages.

4.  Import these files into your existing database. To do so, open the database into which you want
to import the entries if it is not already open.

5. Check whether a filter is activated by looking at the Filter Active option in the View menu. If
necessary, deactivate the filter so that no check mark (v') appears in front of this option.

6.  From the File menu, select the Import... command. In the Import Options dialog, from the
“When entry matches filter” drop-down list in Step 3, select the Synchronize on Entry
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Number option. This activates the options under “Step 4: Synchronize on Entry Number”.
Here, from the “When database entry matches filter” drop-down list, select the Combine with
database entry command. The other drop-down lists have no effect in our example.

7. Now refer to the “Starting the import” section later in this chapter.

Follow this procedure for the files from all the branch offices, and you will have a multilingual
database that efficiently represents a collection of your company’s most valuable terminological
knowledge.

Notes

e This approach only works when your branch offices do not add any new entries with new
Entry Numbers to this database. If this cannot be ensured, it may be better to synchronize on
index term (see Case 3) or to use a combination of both approaches.

e The last three cases, “Importing Filtered Entries,” “Synchronizing on Index Term,” and
“Synchronizing on Entry Number,” can be combined with all their options in any way. A
summary of the individual options appears in the next section.

An Overview of Import Conditions and Options

You no doubt would like to know what the various import conditions (for example, “When entry
matches filter”) and options (for example, “Combine with database entry” or “Omit entry”) mean. In
the Import Options dialog shown earlier in this chapter, the individual steps are divided into groups
and appear inside a border. As has already been hinted at, starting with Step 3, each of the import
options represents a switch that determines which further options are available after this step. If you
want to synchronize on the Entry Number or on index term, you must therefore specify this in the
third step. When synchronizing on Entry Number, both Steps 4 and 5 of the dialog become active.
When synchronizing on an index term, only Step 5 becomes active. Try it out: in Step 3, click on the
various options in the “When entry matches filter” drop-down list and notice which options activate
Step 4 and/or Step 5.

The following table explains what the individual conditions and options mean. Note that the table
first lists all the conditions from Steps 3 through 5 of the import dialog, that is, all the items beginning
with Wihen. Then we explain the options from the drop-down lists that appear under the corresponding
conditions.

Conditions ... and what they mean

When entry matches filter First possibility: you defined and activated a filter before the import. The
following options apply to all entries in the import file that fulfill the filter

criteria.

Second possibility: you did not set a filter. In this case, MultiTerm treats all
the entries being imported as if they match the fileer.

When entry does not match | You defined and activated a filter. The following options apply to all entries in
filter the import tile that do #or tulfill the filter criteria. It you did not define and
activate a filter, this condition has no effect.

When there is no entry with
this number (under “Step 4:
Synchronize on Entry
Number”)

The Entry Number in the entry being imported is not in the database being
updated, or the entry being imported does not contain an Entry Number field.
The entry being imported could therefore not be synchronized on Entry
Number. This condition only appears in Step 4 of the Import Options dialog, so
it can only be selected when you try to synchronize on Entry Number.

When database entry
matches filter (under “Step
4: Synchronize on Entry
Number”)

The entry being imported was successtully synchronized on Entry Number,
and the database entry fulfills the previously detined filter criteria. It you did
not define and activate a filter, MultiT'erm treats all entries that it can
successfully synchronize on Entry Number as it they match the filter.

When the database entry
does not match filter (under
“Step 4: Synchronize on
Entry Number”)

The entry being imported was successtully synchronized on Entry Number, but
the database entry does nor tultill the previously defined filter criteria. If you did
not define and activate a filter, this condition has no effect.
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Conditions

... and what they mean

Synchronize on index
(under “Step 5:
Synchronize on index
Term”)

T'his is where you select the index field (language) that should be used as the
basis for synchronizing terms between the database and the import file. This
setting is only available if you selected the “Synchronize on index tield” option
in Step 3 and/or Step 4.

When a new term is found
(under “Step 5:
Synchronize on index
Term”)

Based on the selected index, no term in a certain language in the entry being
imported was found in the corresponding index in the database. The entry
being imported could therefore not be synchronized on index term. This
condition only appears in Step 5 of the Import Options dialog, so it can only be
selected when you try to synchronize on index term.

When database entry
matches filter (under “Step
5: Synchronize on Index
Term’)

The entry being imported was successtully synchronized on an index term, and
the database entry tultills the previously defined filter criteria. If you did not
define and activate a filter, MultiTerm treats all entries that it can successtully
synchronize on an index term as it they match the filter.

When the database entry
does not match filter (under
“Step 5: Synchronize on
Index Term”)

The entry being imported was successtully synchronized on an index term, but
the database entry does nor tultill the previously defined filter criteria. If you did
not define and activate a filter, this condition has no effect.

Options

... and what they mean

Synchronize on Entry
Number

It the Entry Number of an entry being imported is also in use as the Entry
Number of a database entry, the two entries can be combined, or the database
entry can be replaced by the entry being imported. See “Case 4: Synchronizing
on Entry Number” above, and the last two options described in this table.

Synchronize on index field

If a term in the entry being imported also exists in the index of a certain
language in the database, the two entries with the same term can be combined,
or the database entry can be replaced by the entry being imported. See “Case 3:
Synchronizing on Index Term” above, and the last tow options described in
this table.

Add entry as a new entry

It this option is selected, MultiT'erm adds the entry from the import file to the
database.

Omit entry

If this option is selected, MultiTerm does #of add the entry from the import file
to the database; the entry is simply ignored.

Write entry to the export
file

It this option is selected, MultiTerm does not import the entry. Instead, it is
written unaltered to a special export file. "T'he export file has the file extension
* MI'X and is described in the section titled “The Export File” later in this
chapter.

Combine with database

entry

If this option is selected, Multi'T'erm adds to the database entry any fields from
the import file that are not yet present in the database entry. The Entry
Number remains unchanged. A graphic is only added if none was yet present in
the database entry. The fields Creation Date and Created By remain
unchanged. The fields Change Date, Changed By, and Entry Class are copied
from the entry being imported or are generated according to the values
specified in “Step 2: Fill Missing System Fields”.

Replace database entry
with new entry

If this option is selected, the database entry is completely replaced by the entry
being imported. Only the Entry Number remains unchanged.

Starting the Import

Once you have selected the desired import options, you are ready to begin the actual import. To do
so, from the Import Options dialog, click on OK. Two dialogs appear on your screen. One tells you
whether you have set a filter or not; the other asks you to specify the name of the file to be imported.

. The first dialog is called Import without filter if you have not defined and activated a filter;
otherwise, it is called Import with filter (see “Case 1” and “Case 2” above). This gives you
another chance to check whether a filter should be set for the import. If necessary, you can abort
the import with the Cancel button, thus closing the Open file and Import without filter or
Import with filter dialogs, and then activate or deactivate the filcer as desired.
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o Now determine whether the import file is in ANSI (Windows text) or ASCII (DOS text) format.

If the file is in ANSI format, you must select the ANSI file (*.txt) option from the List files of
type drop-down list. If the file is in ASCII (DOS text) format, select the ASCII file (*.tx8)
option from the List files of type drop-down list, and MultiTerm will by default show all files
with the *. TX8 extension. If you choose the incorrect format here, language-specific special
characters like umlauts or accented characters contained in the imported entries will not be
displayed properly in MultiT'erm.

Open
File: narne: Folders:
1 = _D K
I“-W chtradoshmbapluz
_Cancel
impart bt ;I = ch ;I -
B MTWPLLS —

=

-]

List files of bype; Dirives:

lANSI file [+ k] J | o M5-DOS_6 j

Figure 84: File Type Options for Windows ( = ANSI) Text Files

. Now you can select the desired drive and directory and the desired file name and confirm by
clicking on OK. MultiTerm asks you whether you want it to create a log of actions taken during
the import. If you want a log of the import, answer Yes; otherwise answer No. The following
section describes the contents of this log file.

MultiTerm starts the import and displays a count of the entries being imported. When the import
finishes, you are returned to display mode, where MultiTerm shows you the first entry in alphabetical
order in the current source language.

Creating a Log of Import Actions

The Export File

MultiTerm gives you the option of creating a log that provides detailed information about what
happened to the import entries as well as to the database during the import. This log file is in the
same directory and has the same file name as the import file, but with the file extension *. ML
MultiTerm Log). If you want MultiTerm to create a log file, simply answer Yes to the
corresponding question when starting the import.

If the import file is called MYTERMS. TXT, for example, then after the import, you will find the log file
in the same directory under the name MYTERMS. MIL. This file tells you which settings you made
before the import, and then what happened to the individual entries during the import. If the results
of the import are not exactly what you expected, the log file may help you to determine what
happened to any information or entries that you cannot find.

If you selected the Write entry to the export file option for one or more of the import conditions,
entries from the import file that meet these condition(s) are not imported, but rather are written to the
so-called “export file.” These entries are copied unchanged from the import file to the export file.
That is, no system fields are added to the entry header, and no fields are filtered out.
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The export file has the same file name as the import file, but with the file extension *. MI'X
(MultiTerm eXport). In the previous example, the entries not imported from the MYTERMS. TXT
import file would be saved in a file named MYTERMS. MI'X.

Note

This export file is not to be confused with files created by the export function, which have file
extensions of *. TXT or *. TX8.
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Tips & Tricks

In this chapter, we want to give you a few ideas about how to get the most out of the possibilities that
MultiTerm offers you. In particular, we want to show you the following:

. How to make global changes to your database. The examples include globally deleting fields
with their contents from your database, globally adding constant fields to certain entries of your
database, and changing field names in an existing database.

. How to specify parameters for database name, user ID, and password when starting MultiTerm.

. How to work with special characters in MultiTerm so that you can manage terminology in
languages containing non-Latin characters.

Global Changes

We consider global changes to be changes that affect the entire database. For example, such a global
change would be to delete a field that you no longer need, together with its contents, from the entire
database. Another example would be if you would like to add a constant field to selected entries in
your database, perhaps inserting a subject specification after the entries have been created. Or you
might want to globally change the field name or field contents of a certain field.

All of these operations can be accomplished by combining the filter, export, and import functions that
you have already seen in preceding chapters. You use the filter function to select all the entries that
you want to change or all the fields that you want to delete. The export function allows you to add
fields and change field names. Finally, the import function allows you to combine entries and to fill in
missing system fields.

We recommended in all cases that you make a backup copy of your original database before making
any global changes. If for some reason the global changes do not give the desired results, it is often
casier to start over with the unchanged database than to try to reverse undesired changes.

We will now use a few examples to show you how to make global changes. We assume that you are a
fairly experienced MultiTerm user, in particular that you are familiar with the filter, export, and
import functions. For information on these functions, see the corresponding chapters: “Filtering
Entries,” “Exporting Entries,” and “Importing Entries.”

Example 1: Globally Deleting Fields from a Database

If you want to delete fields from your database definition and select the Change Database
Definition... option from the File menu, you will find that index, text, and attribute fields can be
added at any time, but not deleted. MultiTerm does not allow you to delete field names from the
database definition because otherwise the field contents would still be present in your entries, but
MultiTerm would no longer be able to associate the contents with field names. To ensure that fields
are only deleted when their corresponding field contents are also deleted, you must perform an export
in which you suppress the fields that you want to remove from your database. Afterwards, you re-
import the entries, replacing the existing entries with the entries in which the fields were suppressed.
We will now use an example to illustrate this procedure step-by-step.

Let’s assume that you want to delete the text field Noze from your database. Follow these steps:
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1.  From the View menu, use the Define Filter... command to set a filter that matches all entries
from which you want to delete the Noze field. In our case, the filter definition should appear as
follows:

Filter D efinition
Close
Field or Field Group Criterion
Entry Number -> Note =

[0R]

Any Term -> Mote Load...

Bemove. ..

Delete

ddafdladag

[ Only Use Matching Fields Criterion |x|

Figure 85: Filter Definition for Step 1

This filter matches all entries that contain the text field Noze either as header information or
subordinate to any term. Make sure that you have #of activated the Only Use Matching Fields
filter option, and confirm your filter definition by clicking on Close.

2. If the filter is not yet active, activate it so that a check mark (v') appears in front of the Filter
Active option.

3. To define the export, select the Define Export... command from the File menu. The Export
Definition dialog opens. You want to export the filtered entries in MultiTerm text format so
that you can easily re-import them later. To do so, load the predefined export definition
BACKUP. MDX as described in the “Exporting Entries” chapter.

To prevent MultiTerm from exporting the Noze field, this field must first be added to the export
definition so that it can then be suppressed. This means that the export definition must contain
the following fields in addition to the default fields:

Entry Nunber -> Note
Entry Nunber -> Note -> Any Attribute

Any Term -> Note
Any Term-> Note -> Any Attribute

You can add these fields as usual from the Select Field or Field Group dialog, which you reach
via the Add... button in the Export Definition dialog.

In the above example, we also included the field type Any Attribute so that any attribute fields
are subordinate to a Nofe field will also be omitted during the export.

Now, turn off the Export Field Name and Export Field Contents options for these four
fields by deactivating the corresponding check boxes in the Export Definition dialog. Then,
confirm your export definition by clicking on Close.

4. Start the export by selecting the Export All Entries... command from the File menu. This
opens the Export with filter and Save As dialogs. Specify a file name for the export file as
usual. This file will contain all filtered entries; each entry will contain all fields except the Noze
field and its attributes.
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5.  After the export completes, deactivate the filter so that there is no longer a check mark (v) in
front of the Filter Active option in the View menu. The import in the next step assumes that
the filter always matches.

6.  Re-import the text file. From the File menu, select the Import... command. The Import
Options dialog appears on your screen. In Step 3 of this dialog, under the “When entry matches
filter” condition, select the Synchronize on entry number import option. This gives you
access to Step 4 of the dialog.

7. In Step 4, under the “When database entry matches filter” condition, select the Replace
database entry with new entry import option. This causes the entries from the import file,
which no longer contain the Nose field, to overwrite the database entries which do still contain
this field. Under the other two import conditions, “When there is no entry with this number”
and “When database entry does not match filter”, select the Omit entry option.

8.  Start the import by first clicking on OK to confirm the settings you made in the Import
Options dialog, then selecting the previously created export file as the import file, and then
once again clicking on OK. MultiTerm now starts the import and replaces all the database
entries that have the Noz field with entries from the import file that no longer contain this field.

Note

The approach outlined in this example quickly deletes all occurrences of a field from your
database, but it does not change the database definition. If you want to remove the field from the
database definition as well, you must first export #// database entries (without a filter), suppressing
any fields you want to delete. Then, create a new database based on the existing database but
deleting fields from the definition as desired. Finally, re-import the export file into the new, empty
database. See also the similar Example 3 later in this chapter.

Example 2: Globally Adding Fields to a Database

You can add a new field to a database definition at any time as described in the “Changing a Database
Definition” section of “Creating a Database” chapter. This field is then available when creating new
entries. However, if you want to add a field to a series of entries that already have been created, you
can use the following procedure.

Let’s assume that during a certain time frame you only created terminology for a specific customer
and you would now like to add a corresponding attribute field. The basic approach is this: use a filter
to select all the entries to which the field should be added. Use the export function to add the field to
these entries. Re-import the entries, combining the modified entries with the original entries.
Combining the entries will add the new fields to the original entries as desired. Follow these steps:

1.  From the View menu, select the Define Filter... command. Set a filter that matches all the
entries to which you want to add the field. In our case, the filter definition might appear as
follows:

Entry Nunber -> Custoner 1*XYZ | nc*
Change Date >21.11. 1994

This tells MultiTerm to look for all entries that do #of have a customer of XYZ Inc as a global
attribute and that were changed after 21 November 1994. Of course, you can make the filter
more specific if necessary.

Ensure that the Only Use Matching Fields filter option is 7oz activated and confirm your filter
definition by clicking on Close.

2. If the filter is not yet active, activate it so that a check mark (v') appears in front of the Filter
Active option of the View menu.

3. Define the export by selecting the Define Export... command from the File menu. The
Export Definition dialog opens. Click on the New button to get an empty export list.
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4.  Add the Entry Number system field to the “Fields and Field Groups” list. First click on the
Add... button to get to the Select Field or Field Group dialog, then select the Entry Number
field from the list of system/index fields and confirm your selection by clicking on OK. You are
returned to the Export Definition dialog and the following field appears in the “Fields and
Field Groups” list:

Entry Nunber

For this field, turn off the Export Field Name option and turn on the Export Field Contents
option by clicking on the corresponding check boxes. Under the Export Field Contents
option, type the following string into the Before the Field input field:

\n<\| >
This causes a line break (\ N = new line) and the field name in angle brackets (\ | = label) to be
output in front of the Entry Number field. Type in the following string in the After the Field
input field:

\ n<Cust oner >XYZ | nc

This causes a line break (\ n = new line) after the Entry Number, and also generates the field
that we want to add, with its contents.

5.  Now click on the Options... button. The Export Options dialog appears on your screen.
Activate the Sort by Entry Number check box if it is not already activated. This causes
MultiTerm to export all the entries that match the filter without regard to the currently selected
source language. Now activate the Enclose entry in check box and type the following string
into the Before the Item input field:

\ n**

This ensures that the import function will later be able to determine where a new entry begins.
Leave the Export Options by clicking on Close. You are returned to the Export Definition
dialog. Confirm your export definition by clicking on Close.

6.  Start the export by selecting the Export All Entries... command from the File menu. This
opens the Export with filter and Save As dialogs. Specify a file name for the export file as
usual. This file will contain the entry numbers and customer attributes of all entries that match
the filter. The file might look something like this:

<Entry Number>12
<Cust oner >XYZ | nc
* %

<Entry Nunber>267
<Cust oner >XYZ | nc
* %

<Entry Nunber>399
<Cust oner >XYZ | nc
* %

7.  After the export completes, deactivate the filter so that there is no longer a check mark (v) in
front of the Filter Active option in the View menu. The import in the next step assumes that
the filter always matches.

8.  Re-import the text file. From the File menu, select the Import... command. The Import
Options dialog appears on your screen. In Step 3 of this dialog, under the “When entry matches
filter” condition, select the Synchronize on entry number import option. This gives you
access to Step 4 of the dialog.

9. In Step 4, under the “When database entry matches filter” condition, select the Combine with
database entry import option. This ensures that the imported entries will be combined with
those entries in the database that have the same Entry Number. The desired Customer field will
automatically be added under the Entry Number. Under the two other import conditions,
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“When there is no entry with this number” and “When database entry does not match filter”,
select the Omit entry option.

10. Start the import by first clicking on OK to confirm the settings you made in the Import
Options dialog, then selecting the previously created export file as the import file, and then
once again clicking on OK. MultiTerm starts the import and adds the Cuszomer field containing
XYZ Inc to all the entries that were changed after 21 November 1994 and that do not yet have
this Customer field.

Example 3: Changing Field Names in an Existing Database

Let’s assume that you have just added the first entries to your database. You frequently used the text
field CON, which you added to your database definition to hold the context examples for the various
terms. However, in a conversation with your supervisor, it becomes clear that this field name does not
contribute to the transparency of your data. You also plan to exchange data with colleagues who have
called this field Context in their database definitions and prefer not to change it. So you want to
rename your CON text field to Context. You first try to do so by selecting the Change Database
Definition... command from the File menu, but here you can only change the default font for the
CON field. The Field Name input field is blocked, so you cannot specify a new name.

To be able to change the field’s name, several steps are required. You must first export all the entries
you have created so far, then use a word processor on the export file to rename the field <CON> to
<Context>, and finally import the text file into a new database in which you have defined the text field
with its new name. Follow these steps:

1. Load the existing database if it is not already open.

2. If a filter is set, deactivate it so that no check mark (¥') appears in front of the Filter Active
option in the View menu. No filter may be active because in the following steps we want to
export all entries.

3. Define an export by selecting the Define Export... command from the File menu. The Export
Definition dialog opens. From this dialog, load the BACKUP. MDX predefined export definition
as described in the “Exporting Entries” chapter. This predefined export definition completely
exports all entries in MultiTerm text format so that they can later be re-imported without
difficulty.

4. Confirm the export definition without making any changes by clicking on Close. From the File
menu, select the Export All Entries... command. This opens the Export without filter and
Save As dialogs. Specify a file name for the export file as usual. This file will contain all the
entries from your database in MultiTerm text format. After the export, you are returned to
MultiTerm’s display mode, and the program tells you in the message line how many entries
were exported.

5. Now create a new database in which you include the Conzext text field instead of the CON text
field. From the File menu, select the Create New Database... command. The Database
Definition dialog opens. The configuration of your existing database is automatically copied as
the basis for the new database. You can now click on the CON field name in the list of text fields,
and then change the name in the Field Name input field to Context.

6.  Once you have made this change, confirm your new database definition by clicking on OK. The
Save As dialog appears for you to specify a file name for your new database. Choose a name
that is up to eight characters long and contains no special characters, and be careful that you do
not (yet) overwrite your existing database. Now click on the OK button. The dialog is closed,
and your new database appears with an empty entry. This concludes our work in MultiTerm for
now, but we will need it again later, so it is best to leave it active with your new database.

7. Now you must edit the export file you just created. To do so, start your word processor. From its
File menu, select the Open... command. Before loading the file, be sure to select “Windows
Text” as the file type, often called “ANSI Text”, “Text Only”, or “Text Files”, and be sure to
look for files with the extension *. TXT. You will find the text file in the directory (Windows
95/NT 4.x: folder) where your old database was stored.
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8. Once the text file is loaded, you can replace all occurrences of the string <CON> with the string
<Cont ext >. From your word processor’s Edit menu, select the Replace... or Search and
Replace... command. The corresponding dialog opens. Type in <CON> as the text to be
searched for and <Cont ext > as the text to be replaced with. Select the Replace All option.
Your word processor now goes through the text file, replacing all <CON> field names with
<Cont ext >.

9.  Review two or three of the entries to make sure that the desired replacements occurred. If so,
save the file as “Windows Text” (or “ANSI Text” or “Text Only”), leave your word processor,
and switch back to MultiTerm.

10.  Your new, empty database should still be open in MultiTerm. You now import the edited text
file into this database. From the File menu, select the Import... command. The Import
Options dialog appears on your screen. In Step 3, under the conditions “When entry matches
filter” and “When entry does not match filter”, select the Add entry as a new entry option.
This ensures that all entries from your edited text file will be read into your new MultiTerm
database. Confirm the import options by clicking on OK. The Import without filter and Open
dialogs appear on your screen.

11.  In the Open dialog, click on the directory/folder where your edited text file is located, click on
its file name, and click on OK to confirm your selection. The edited entries are read into your
database, and MultiTerm shows you how many entries are imported. This number should be
the same as the number of entries exported earlier.

12.  Make sure that your new database contains the desired changes, that is, that the Conrext tield
now appears wherever the CON field used to be. If so, you can use the File Manager or Explorer
to delete your old database and, if desired, rename the new database to the original name.

Example 4: Globally Changing System Field Values

In this section, we want to show you how to make global changes to system field values. The basic
approach is to export the desired entries, suppressing the corresponding system field. The entries are
then re-imported and new values are inserted by Step 2 of the import options, Fill Missing System
Fields.

For example, let’s assume that you want to change all entries in Entry Class 7 to Entry Class 6, thus
releasing entries from the Entry Class you have designated as “review status” to the one designated as
“general access.” Follow these steps:

1. From the View menu, select the Define Filter... command. Set a filter that matches all the
entries in which you want to change the Entry Class. In our example, the completed filter
definition would appear as follows:

Entry d ass 7

"This filter matches all entries that have an Entry Class of 7. If necessary, you can further refine
this filter to specify a certain time frame, subject area, or project.

Make sure that the Only Use Matching Fields filter option is #of activated, and confirm your
filter definition by clicking on Close.

2. If the filter is not yet active, activate it so that a check mark (¥') appears in front of the Filter
Active option in the View menu.

3. Define an export by selecting the Define Export... command from the File menu. The Export
Definition dialog opens. From this dialog, load the BACKUP. MDX predefined export definition
as described in the “Exporting Entries” chapter. This predefined export definition completely
exports all entries in MultiTerm text format so that they can later be re-imported without
difficulty.

4.  Delete the Entry Class field from the default list of fields and field groups so that it will not be
exported. To do so, highlight the Ensry Class field and click on the Delete button.
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10.

11.

Export all the entries to a text file. Click on Close to leave the Export Definition dialog, and
select the Export All Entries... command from he File menu. This opens the Export with
filter and Save As dialogs. Give the export file a file name and start the export as usual. This
file will contain all filtered entries with all fields except for Entry Class. After the export, you are
returned to MultiTerm’s display mode, and the program tells you in the message line how many
entries were exported.

After the export completes, deactivate the filter so that there is no check mark (v') in front of the
Filter Active option in the View menu. The import in the next step assumes that the filter
always matches.

Re-import the export file you just created. From the File menu, select the Import... command.
The Import Options dialog appears on your screen.

In Step 2 of the import options, Fill Missing System Fields, select the new Entry Class, in our
example Entry Class 6, from the corresponding drop-down list.

In Step 3 of the import options, under the “When entry matches filter” condition, select the
Synchronize on entry number import option. You now have access to Step 4 of the dialog.

In Step 4, under the “When database entry matches filter” condition, select the Replace
database entry with new entry import option. To be safe, under all other conditions, select
the Omit entry import option.

Now start the import. Confirm your settings in the Import Options dialog by clicking on OK.
Then select the file name of the previously created export file as the import file. MultiTerm
imports the file, inserting an Entry Class of 6 into all entries that formerly had an Entry Class
of 7.

Import Options 1]

rStep 1: Read entry from impont file———— | Help I I OK I

MultiTerm reads one entry from the import

file after each occumrence of the string

~Step 4: Synchromze on Entry Humber

The hields <Creation Date> and <Change : : )
Date> are generated automatically When there iz no entry with this number.

depending on whether the eniy beng || | P

imported already contains date fields, By
and whether it is replacing an entry or When database entry matches filter.

being inserted as a new entry. Heplace databasze entry with new entry -

When databasze entry does not match Filter.

Step 2: Fill Missing System Fields
Created By: Iﬁ
Changed By: Iﬁ‘ rStep 5: Synchronize on Index Term———
Entry Class m Synchromze on index: English j

‘When a new term iz found.

-Step 3: Filter the Import Entry—————————— IAdd enliy as a new entiy jJ
When entry matches filter, When database entry matches filter,
Synchronize on entiy number b I[anhine with databaze entry J
When entry does not match Filter. When databasze entiy does not match filter.

T —] [ . 5

Figure 86: The Import Options for Example 4
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Using Parameters When Starting MultiTerm '95 Plus

Once you have become familiar with MultiTerm, it is very likely that you will want to access the same
databases repeatedly. MultiTerm automatically simplifies this by remembering the name of the
previously opened database as well as the previous window position in an .INT file.

Nonetheless, especially with password-protected databases, it may seem tedious to have to tell
MultiTerm who you are and what your password is every time you start the program.

To automate this task, MultiT'erm allows you to specify parameters when loading the program. The
following three types of parameters are available:

Database Name The complete name of the database to be opened, including the drive name
and path.

User ID The user ID under which you want to log on.

Password The password for this user ID.

All parameters are optional. For example, you can omit the password so that no one else using your
PC can access the database with your privileges.

Note

If you omit the password and the database is password-protected, you will be prompted for a
password when you start the program.

When you open the database as the system administrator, you are normally asked whether you want
exclusive access to the database. However, when opening the database via parameters, it is assumed
that you want to open the database exclusively. If exclusive access is not available, MultiTerm
assumes that you still want to open the database in normal multi-user mode.

There are two alternatives for starting MultiTerm with parameters. Each of these alternatives depend
on the Windows version you are using, that is, Windows 3.1 on the one hand or Windows 95/N'T" 4.x
on the other. Follow the steps for your Windows version.

Defining MultiTerm Startup Parameters under Windows 3.1

The first alternative is to create a separate icon in a program group for the desired database, following
these steps:

1. In Program Manager, select the program group where you want the new icon to go.

2. Inthe Program Manger’s File menu, select the New... menu item. The New Program Object
dialog appears on your screen.

3. Select the Program Item option here, and confirm by clicking OK. The Program Item
Properties dialog appears. Fill it in as follows:

Program Item Properties [ %]

ok |

Command Line; Iu::\trados'\mtwplus\mtwpe.exe =3 Car] |

Wiarking Directary: Ic:\llados'\mtwplus{

Shartcut Key: INDne Browse... |
[ Bun Minimized Change |con.. |
Help |

Description: |Sample Database

Figure 87: Program Item Properties for Starting
MultiTerm with Parameters
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The entire contents of the Command Line input field are not visible due to their length. The
full command line appears as follows:

C: \ TRADOS\ MT'WPLUS\ MTWPE. EXE C: \ TRADOS\ MTWPLUS\ SAMPLE. MTW super , pi ano

This example loads the SAMPLE. MTW database included with MultiTerm from the
C: \ TRADOS\ MTWPLUS default directory, automatically logging on with a user ID of super and a
password of piano.

Note that there is a comma between the user ID and password arguments. This delimiter is
required because both the user ID and the password can contain multiple words. Without the
comma, MultiT'erm would not be able to determine with certainty what is the user ID and what
is the password.

The second option is to use the Associate... command in the File Manager’s File menu. Follow
these steps:

1. Start File Manager, if it’s not running already.
2. Select a directory where a MultiTerm database (*. MTW extension) is located. By default,

MultiTerm sample databases are located in the C: \ TRADOS\ MTWPLUS directory. When you see
a file name with the *. M Wextension, highlight its file name.

3. From the File menu, select Associate. The Associate dialog opens. Since the MTWextension
has never been associated with any program, the Associate With drop-down list shows
“(None).”

4.  Now you can specify that all files with the *. MTWextension belong to MultiTerm. To achieve
this, click the Browse... button. The Browse dialog opens.

5.  In the Browse dialog, select the directory where MultiTerm’s program files are installed
(C: \ TRADOS\ MTWPLUS by default), and double-click the MultiTerm executable file of your
choice. At press time, three different language versions of MultiTerm were available:

MIWPE. EXE for the English version, MTWPG, EXE for German, and MTWPF. EXE for French.

6.  Once you have double-clicked the desired MultiTerm executable, all files with the * . MTWfile
extension open with MultiTerm once you double-click their file name. The only disadvantage
with this method is that you cannot specify a user name and password since this association
applies to all MultiT'erm databases.

Defining MultiTerm Startup Parameters under Windows 95 or NT 4.x

The first alternative is to create a separate icon in any folder for the desired database, following these

steps:
1. Using the Explorer, select the folder where you want the new icon to go.
2. Click the right mouse button somewhere on a white spot inside the folder; do not click any icon

the folder may contain. Windows will open a popup menu.

3. Select the New... menu item from the popup menu, and Shortcut from the submenu that
opens. The Create Shortcut dialog appears on your screen.

4. Fill in the Command Line input field as follows:
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Type the location and name of the item pou want to create
a shortcut ta, O, gearch for the item by clicking Browse.

LCommand line:
IE:\THADDS\MTW’F’LUS\MTWF‘E.EXE CATRADOS M

Browse. .. |

< Each I Mest > I Cancel |

Figure 88: Program Item Properties for Starting
MultiTerm with Parameters

The entire contents of the Command Line input field are not visible due to their length. The
full command line appears as follows:

C: \ TRADOS\ MT'WPLUS\ MTWPE. EXE C: \ TRADOS\ MTWPLUS\ SAMPLE. MTW super , pi ano

This example loads the SAMPLE. MTW database included with MultiTerm from the
C: \ TRADOS\ MTWPLUS default directory, automatically logging on with a user ID of super and a
password of piano.

Note that there is a comma between the user ID and password arguments. This delimiter is
required because both the user ID and the password can contain multiple words. Without the
comma, MultiTerm would not be able to determine with certainty what is the user ID and what
is the password.

5. Click Next to confirm your command line. Windows now asks you to select a name for the new
shortcut. Enter any name here, for instance Sample Database, and click Finish to confirm.
The Create Shortcut dialog closes, and your new shortcut appears in the specified folder.

& MultiTerm Databaszes M=l 3
Ele Edit “ew Help
#|B(@| o] X

Ia MultiTerm D atabases j BE

|1 obiect(z] | 807 bytes v

Figure 89: Finished Shortcut Definition
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The second option is to define a new file type in the Windows Explorer for * . MT'Wfiles. Follow these
steps:

N

Start the Windows Explorer, if it’s not running already.

Select a folder where a MultiTerm database (*. MTW extension) is located. By default,
MultiTerm sample databases are located in the C: \ TRADOS\ MTWPLUS folder. When you see a
file name with the *. MTWextension, double-click its file name. Since Windows does not yet
“know” this file type, it opens the Open With dialog.

Open With

Click the pragram you want to use to open the file
'SAMPLE MTw".
If the program wou weant iz nat in the list, click Other.

Choose the program pou want to uze:

|

[ &lways use this program ta open thiz type of file

[of I Cancel | Other... |

Figure 90: The Open With Dialog

In this dialog, you are asked to specify the program you want to use to open the specified file
with the * . MTWextension. Since MultiTerm is not in the list of program files, click the Other...
button to locate it yourself. The Open With... dialog opens.

In the Open With... dialog, select the directory where MultiTerm’s program files are installed
(C: \ TRADOS\ MTWPLUS by default), and double-click the MultiTerm executable file of your
choice. At press time, three different language versions of MultiTerm were available:

MIWPE. EXE for the English version, MTWPG, EXE for German, and MTWPF. EXE for French.

Open With. .

Lockin: | (3 Mhwplus =] =
= Mz-dosz_E [C:) -
Mbyape, ex 3 Trados
b bwpf. exe
Mbapg, e = D]
= [E) b
=3 Data[F:]
=1 Bemovable Dizk [G:]
&= H -
File narme: IMtwpe. =] Open I
Files af bype: IPrograms j Cancel |

Figure 91: Locating MultiTerm’s Program Files

Once you have double-clicked the desired MultiTerm executable, you are returned to the
original Open With dialog, where the item M wpe (or any other MultiTerm language version
you may have chosen under step 4) has been added to the list of program files. Make sure that
the Always use this program to open the file check box is activated, and click OK to confirm
your settings.
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Open With

Click the pragram pou want to uze to open the file
‘SAMPLE MTw"
IF the pragram wou watk iz not in the lizt, click Other.
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7w/ NWORD

A wite
i M bwpe j

[V i&lways use this program to open this type of file
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Figure 92: Finished File Type Association

6.  From now on, all files with the *. MTWfile extension open with MultiTerm once you double-
click their file name in Explorer. The only disadvantage with this method is that you cannot
specify a user name and password since this association applies to all MultiTerm databases.

Defining Databases Containing Special Characters

Note

If you would like to work with languages like Japanese or Chinese that require a so-called double-
byte character set, please follow the instructions in the “Adding Index Fields for Double Byte
Languages” section of the “Creating a Database” chapter.

As long as a// the characters required by the languages in your database are contained in oze character
set, for example a character set containing both Greek and Latin characters, you can specify this single
character set as the default font for all the fields in your database definition. You can change between
languages as usual by pressing a particular key or key combination. (How you change languages
depends on the keyboard driver and software that you use with your special character set.)

Matters become more complicated when the characters are 7oz all contained in one character set. This
is for example the case if you want to work with Russian, German, and French. You then must specify
at least two fields in your database definition for the two different characters sets. For example, you
could specity Definition for the Latin character set languages and Russian Definition for the Cyrillic
character set language.

The sort order for the Western European languages is predefined. However, in order for characters in
other languages to appear in the correct alphabetic sequence, you must define the sort order yourself
in the database definition. We assume in the following example that you are creating a database on
the basis of an existing database as described in the “Creating a Database” chapter. Follow these
steps to add an index field with a non-standard sort order to this database:

1.  From the File menu, select the Create New Database... option.

2. Inthe Index Fields list box, click on the index field after which you want to add the new index
field with the non-standard sort order. The field name is highlighted.

3. Click on the Add button or press the key combination [Alt]+[A]. The cursor starts blinking in
the Field Name input field.

4. Inthe Field Name input field, type in the name of the new index field, for example Russian.
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5. To specify the font that will be used for displaying this index field in your entries, click on the
arrow to the right of the Default Font field. A drop-down list opens showing the available fonts.

6. From the Default Font drop-down list, select a character set containing the desired special
characters, for example, CyrillicH/v for Russian.

7. If you want to use the default sort order as the basis for your own sort sequence, click on the
Default Sort Order button.

8.  Click in the sort table with the mouse. The cursor starts blinking, and you can now enter your
own sort sequence. Please keep the following rules in mind:

. The sort sequence is determined by the sequence of lines in the table, that is, everything
on the first line is sorted to the beginning, and the characters on the last line are sorted to
the end of the index.

. All the characters in one line are sorted at the same level, so upper- and lowercase letters
and accented characters are normally placed on the same line. For example, in the default
sort order, the characters aA4AaA4A all appear on the same line.

. All characters not appearing in the table are ignored for sort purposes.

. Since one character cannot be sorted at different places, each character may occur only
once in the table. The editing field checks each character as you enter it; if the character
already exists at another position, it is removed from the other position.

o Press the key combination [Ctrl]+[Enter] to insert a new line.

Database Definition 1]

Field Name [Russian [ Add.. || mework. || ok |
Default Font ||Cyri||icHIv j| | Delete I | Help I | Cancel I
DBCS Font [
Default Sort Order .
Index Fields | = Text Fields
English Lu - Definition
Eeutsc_h Uy gl:hu:t:el
rangais i ontexl
E spafiol W Related Words
m —LLJ'.ELH Grammar
[=17] Note
bhl - Project Code
Attribute Fields Fick List Path for Graphic Files
Subject - - c:itradosimtwplus
Category
Type of Relation |l]
Usage Label
Regional Label
Style Label
Client
Gender hd ¥

Figure 93: Database Definition Using the CyrillicHIv
Character Set and a Special Sort Order for Russian

When you have finished specifying the sort sequence, continue your database definition as described
in the “Creating a New Database” chapter. Conclude the definition by clicking on OK.
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Notes

e When you are changing the definition of an existing database and an old index field is
currently highlighted, the sort table can only be displayed, not changed. Sort tables can only
be defined for new fields.

e Ifyou accidentally enter a character into the sort table a second time, it is deleted from its first
position since a character can only occur once in an alphabetic sequence. You should therefore
double-check your sort sequence before confirming the database definition with OK.
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Integrating MultiTerm 95 Plus with Other
Windows Applications

In many cases, you will want to use MultiTerm 95 Plus together with another Windows application.
MultiTerm allows you to do this by providing a very flexible DDE interface. DDE stands for
Dynamic Data Exchange and is a Windows standard for exchanging data among Windows
applications. In practice, the DDE interface allows you to access MultiTerm data from other Windows
applications without MultiTerm even being visible on your screen.

Since you usually need terminology when writing or translating text, you will most often want to use
MultiTerm together with a word processor. We have therefore created DDE macros for the most
popular Windows word processors, namely Word for Windows (also called “WinWord”), Ami Pro 3.x,
and WordPerfect 6.1. These macros are designed to make the integration between MultiTerm and
your word processor as user-friendly as possible. You can use the macros, for example, to search for
terms that appear in your word processor and to paste their translations with a mouse click, or you can
create a professional-looking dictionary from your MultiT'erm data. Of course, you can also change and
enhance the predefined DDE macros according to your own requirements. The possibilities are
limitless!

At press time, many desktop publishing applications (FrameMaker, PageMaker, and so on) did not
support DDE. But even if you work with such applications, MultiTerm allows you to quickly locate
and transfer data. In this chapter, we first explain how to install the DDE interfaces to WinWord 2.0-
7.0, Ami Pro 3.x and WordPerfect 6.1. Then we show you how to best use the DDE functions. The
use of the DDE interface is very similar among all of these programs. We will point out any
differences at the appropriate place. The last section of this chapter explains how you can use
MultiTerm’s open architecture even if your program does not support data exchange via DDE.

Installing the DDE Interface for WinWord 2.0-7.0

All the files that WinWord needs for communicating with MultiTerm via the DDE interface are
contained on the “Macros & Tools” diskette included with MultiTerm. There are three

subdirectories on this diskette: W NWORD, AM PRQO and WPW N.

For you as a WinWord user, only the W NWORD directory is relevant. This directory contains the
following files:

MI4W N20. DOT - Document template for WinWord 2.0; Dialog language: English
MI4W N_D. DOT - Document template for WinWord 6.0/7.0; Dialog language: German
MI4W N_E. DOT - Document template for WinWord 6.0/7.0; Dialog language: English
MI4W N_F. DOT - Document template for WinWord 6.0/7.0; Dialog language: French

el

To make the WinWord 2.0 document template available in WinWord 2.0, you must copy the
MT4W N20. DOT file into the WinWord 2.0 program directory (C: \ W NWORD by default). To make
the WinWord 6.0/7.0 document template available in WinWord 6.0/7.0, you must copy the
corresponding document template file to the WinWord 6.0/7.0 template directory

(C:\ W NWORD\ TEMPLATE or C: \ MSOFFI CE\ TEMPLATES by default).
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Using the Document Template in Word for Windows 2.0

If you want to create a new document using the MT4W N20. DOT document template, follow these
steps to activate the template:

1. Start WinWord 2.0. From the File menu, select the New... command. The New dialog appears
on your screen.

2. If you copied the MT4W N20. DOT file into the WinWord directory as described above, you can
now select the Mt4win20 item from the Use Template list and confirm by clicking on OK.
Word now displays the MultiTerm button bar described in the “Using the DDE Interface”
section later in this chapter.

On the other hand, if you want to translate an existing document and still have access to the
MIr'4W N20. DOT document template, follow these steps:

1. After starting WinWord and loading your document, select the Document Template...
command from the File menu. The Document Template dialog appears on your screen.

2. If you copied the MT4W N20. DOT file to the WinWord directory as described above, you can
now select the Mt4win20 item from the Attach Document To list and confirm by clicking on
OK. Word now displays the MultiTerm button bar described in the “Using the DDE Interface”
section later in this chapter.

Using the Document Template in Word for Windows 6.0/7.0

Word for Windows 6.0/7.0 includes improvements to document template management. Once you
have copied the file MTAW N_E. DOT (or MT4AW N_D. DOT or MT4W N_F. DOT) to WinWord 6.0/7.0’s
TEMPLATE directory, we recommend that you attach the document template in WinWord as follows:

1. Start WinWord and select the Document Template... menu item from the WinWord File
menu. The Document Template dialog pictured below appears on your screen. As the dialog
shows, WinWord 6.0 lets you attach document templates as Global Templates and Add-ins.
We recommend that you attach the document template delivered with MultiTerm as such a
global template as described in the following steps.

Templates and Add-ins

Document Template

|N0rmal Aftach... | :
[~ &utomatically Update Document Styles &l

~Global Templates and Add-in M

Checked itemsz are currently loaded.
[=| Agdd...

Femame |

Full Path:

Figure 94: The Templates and Add-ins Dialog in Word for Windows 7.0

2. Click on the Add... button in this dialog. A list of all available document templates appears, by
default those stored in the C: \ W NWORD\ TEMPLATE or C: \ MSOFFI CE\ TEMPLATES directory.

3. If you copied the MultiTerm document template MT4W N_E. DOT (or MT4W N_D. DOT or
MI4W N_F. DOT) into this directory as described above, you can now select it from the list.
Click on the desired document template in the list and confirm by clicking on OK.
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4. You now return to the dialog pictured above, and WinWord automatically adds the selected
document template to the list of Global Templates and Add-ins and activates its check box.
In the future, when you start WinWord, you need only open this dialog and activate the check
box next to the desired document template. Leave this dialog by clicking on OK.

Templates and Add-ins

~Daocument T emplate
ak
|Normal Altach.. | |
[T Automatically Update Document Styles ﬂl
~Global Templates and Add-in Organizer... |

Checked items are cunrently loaded.

"] -

Bemove |

[

Full Path: B\ ATEMPLATEMAT #/IN_E.DOT

Figure 95: MT4WIN_E.DOT has been Added

5. A new toolbar should now appear in addition to those already activated. The new toolbar
contains a magnifying glass p, a smiling face @, and various arrows. If this toolbar is not shown,
you need to activate it. To do so, from the View menu, select the Toolbars... menu item and
activate the MultiTerm for Windows check box. The MultiTerm toolbar appears. The
MultiTerm buttons and all other functions are explained in the “Using the DDE Interface”
section later in this chapter.

Note

If you want the MultiTerm template to be active whenever you start WinWord, you can copy the
MI4W N_E. DOT  file to WinWord’s startup directory  (C: \ W NWORD\ STARTUP  or
C:. \ MBOFFI CE\ W NWORD\ STARTUP by default). In this case, the template is automatically
attached as a global template, so you do not need to attach it manually as described in steps 1-4
above. You can deactivate the template temporarily by selecting Templates... from the File menu
and clearing the check box next to MT4WIN_E.DOT. To permanently deactivate the template,
delete the MTAW N_E. DOT file from the startup directory and re-start WinWord.

Installing the DDE Interface for WordPerfect 6.1

All the files that WordPerfect 6.1 needs to communicate with MultiTerm via the DDE interface are
contained on the “Macros & Tools” diskette included with MultiTerm. There are three directories
on this diskette: W NWORD, AM PRO, and WPW N. The directory that is relevant for WordPerfect 6.1
is called WPW N. This directory contains the following files:

1.  MI4W N_D. WPT - Document template containing the German-language version of the DDE
interface.

2. MI4W N_E. WPT - Document template containing the English-language version of the DDE
interface.

3. MI4W N_F. WPT - Document template containing the French-language version of the DDE
interface.

The MTAW N_E. WPT template, as well as the other two templates, make a new toolbar available in
WordPerfect. You can use this toolbar to call several MultiTerm functions directly from WordPerfect.
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In addition, several new menu items are created. The new toolbar and menu items are described in
detail later in this chapter.

Follow these steps to install the DDE interface:
1.  Copy the MI4W N_E. WPT template—and/or the other two templates—from the WPW N

directory on the diskette to the TEMPLATE directory of your WordPerfect installation
(\ WPW N\ TEMPLATE by default).

N

Start WordPerfect. To enable the interface with MultiTerm, we will install the above template
as an “additional objects template.” To achieve this, from WordPerfect’s Edit menu, choose
Preferences.... The Preferences dialog appears.

1 Preferences E3

Preferences

5
Summary

4

Toolbar Faower Bar  Status Bar Kepboard

B 0 =

MenuBar  MWriting Taoals Frint Convert

Figure 96: The Preferences Dialog in WordPerfect 6.1

3. This dialog is used to change various settings in WordPerfect. We will use it to install all
MultiTerm-relevant objects, that is, the MultiTerm button bar and menu items. To first of all
specify the MultiTerm template MT4W N_E. WPT as additional objects template, double-click
the File icon. The File Preferences dialog appears. For our purposes, select the Templates
radio button as shown.

File Preferences

() Documents/Backup I Printers/Labels
) Hyphenation
_[Zancel
) Spreadsheets ' Graphics -
C! Databases O Macios | Wiew AL
M
Templates

Default Directory: |c:\ul[ice\wpwin\template |

Default Template: |standald.wpt |

Additional Directory: | |

Additional Objects Template: | |

Template File Extenzion: wpt
[~ Update Default Template from Additional Objects Template
[¥ Update QuickList with Changes

Figure 97: The File Preferences Dialog in WordPerfect 6.1

4.  In the Additional Objects Template input field, specify the path and filename of the

MI4W N_E. WPT template. It’s easiest to use the button to the right of the input field to

achieve this. After specifying the path and filename, your screen could for example look like
this:
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File Preferences
) Documents/Backup ) Printers/Labels
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= _Eancel
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Templates
Default Directory: |c:\u[[ice\wpwin\template |
Default Template: |standald.wpt |
Additional Directory: | |

Additional Dbjects Template: |c::\u[[ic:e\wpwin\template\mt4win_e.wpﬂl

Template File Extenzion: wpt
[ Update Default Template from Additional Objects Template
[X Update QuickList with Changes

Figure 98: Specifying MTAW N_E. WPT as Additional Objects Template

5. Click OK to confirm these settings. You return to the Preferences dialog. In the next steps, we
will specify the special button bar and menu settings needed for interaction with MultiTerm.

6. To specify the toolbar, double-click the Toolbar icon. The Toolbar Preferences dialog
appears. Select the item MultiTerm for Windows from the list of available toolbars.

Toolbar Preferences

Available Toolbars

) tions.__
Template: mtdwin_e

6.1 WordPerfect “

Design Tools i—

Equation Editor

Font Create...

Format

Generate

Graphics

Legal Copy...

Macro Tools

MultiT erm for Windows

Page — =

Tables _D elete...

twdwin ﬂ _
_Qp

Figure 99: The Toolbar Preferences Dialog in WordPerfect 6.1

7.  Click Select to confirm your choice. You return to the Preferences dialog. Now double-click
the Menu Bar icon. The Menu Bar Preferences dialog appears. Again, select the item
MultiTerm for Windows from the list of available menu bars.
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Menu Bar Preferences
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Figure 100: The Menu Bar Preferences Dialog

8. Again, click Select to confirm. You return to the Preferences dialog. If you now click Close,
you accept all the new settings and return to WordPerfect’s standard document screen. A new
button bar should appear. Also, the Insert and View menus should now include MultiTerm
specific commands. These functions are described in the “Using the DDE Interface” section
later in this chapter.

You can also instruct WordPerfect to use the MultiTerm interface as the default template, not as
additional objects template. To do so, follow these two steps:

1. After starting WordPerfect, select the Preferences... menu item from the Edit menu. Then
double-click on the File icon. The File Preferences dialog opens where you can adjust various
defaults. For our purposes, select the Templates radio button as shown.

File Preferences
() Documents/Backup I Printers/Labels
) Hyphenation
’ _[Zancel
) Spreadsheets ' Graphics -
C! Databases O Macios | Wiew AL
M
Templates
Default Directory: |c:\ul[ice\wpwin\template |

Additional Directory: | |

Default Template: |standald.wpt |

Additional Objects Template: | |

Template File Extenzion: wpt
[~ Update Default Template from Additional Objects Template
[¥ Update QuickList with Changes

Figure 101: The File Preferences Dialog in WordPerfect 6.1

2. Inthe Default Template input field, type in MT4AW N_E. WPT. This instructs WordPerfect from
now on to automatically load the MultiTerm template whenever you start WordPerfect or create
a new document.

This completes the installation of the interface. The functions that the DDE interface offers you are
described in the “Using the DDE Interface” section later in this chapter.
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Temporarily De-Activating the MultiTerm Button Bar and/or Menu ltems

If you would like to temporarily de-activate the special MultiTerm button bar and/or menu items at a
later stage, you can do so simply by clicking with the right mouse button inside the desired bar, and
choose another bar of your choice. You can re-activate the MultiTerm bars (all labelled MultiTerm
for Windows) in the same way. This functionality is available at any time, always allowing you to
switch between different working environments in WordPerfect, according to your needs.

Important General Notes on WordPerfect 6.1

After comprehensive testing, it has unfortunately been determined that even WordPerfect 6.1 is not
completely stable. In particular, the macro language and its implementation are still problematic. This
means that some of the more complex MultiTerm functions described below, especially MultiTerm
Print, sometimes abort with an error message. This is caused not by an error in the macro itself, but
rather by problems in WordPerfect 6.1.

We very much hope that future versions of WordPerfect will work more smoothly even with
MultiTerm’s more complex macros. There are no problems with day-to-day functions like “Lookup”
or “Paste”.

Installing the DDE Interface for Ami Pro 3.x

All the files that Ami Pro 3.0/3.1 needs for communicating with MultiTerm via the DDE interface are
located on the “Macros & Tools” diskette included with MultiTerm. This directory contains three
subdirectories: AM PRO, W NWORD, and WPW N61. The directory that is relevant for Ami Pro users
is called AM PRO. This directory has two subdirectories, ENGLI SH and GERMAN. The ENGLI SH
directory contains the interface for the English-language version of Ami Pro, and the GERVAN
directory contains the directory for the German-language Ami Pro. The following instructions are for
installing the macros for the English Ami Pro, but they apply analogously to the German version as
well.

The AM PRO\ ENGLI SH directory contains the following subdirectories:

MACRGOS: This directory contains the macro files that the TRADOS developers created for exchanging
data between MultiTerm and Ami Pro 3.0/3.1.

| CONS: This directory contains the Smartlcon bar as well as the Smartlcons themselves that Ami Pro
uses to communicate with MultiTerm.

Follow these steps to enable the interface to Ami Pro:

1. Copy all the files from the MACRCS directory on the diskette to Ami Pro’s MACROS subdirectory
on your hard drive (C: \ AM PRO\ MACRGCS by default.)

2. Copy all the files from the | CONS directory on the diskette to Ami Pro’s | CONS subdirectory
on your hard drive (C: \ AM PRO\ | CONS by default.)

3. When you start MultiTerm and Ami Pro, a new Smartlcon bar appears in addition to your
existing Smartlcon bar. The new Smartlcon bar is called “MultiTerm” and can be selected via
the Smartlcon symbol (EET]) in the status line at the lower right.

This concludes the installation of the interface. The functions available from the DDE interface are
described in the next section, “Using the DDE Interface.”
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Using the DDE Interface

Buttons in Your Word Processor’s Icon Bar

Once you have installed the DDE interface as described above and have started your word processor,
you will find the following new buttons in your word processor’s icon bar:

Lle]+ S 2]+

Figure 102: Toolbar in Word for Windows

p++©“ﬁ'f+‘.‘.>ﬂf_l

Figure 103: Smartlcons in AmiPro 3.x

L] =)@ 1] 1]

Figure 104: Toolbar in WordPerfect 6.1

Below are descriptions of the individual buttons, followed by an example of how you might use them
in your day-to-day work. Note that MultiTerm must be running for these buttons to have an effect.

/O Look Up a Term (“Lookup”)

This button gives you two options for looking up a term in the current MultiT'erm database. Follow
these steps:

Case 1: You want to look up a term that is already in your document.

1. Highlight the term.

2. Click on the £2 button to start the search. If the term is found in the current database, it appears
with its translation in your word processor’s status line. If the term is not found, the next
alphabetical entry appears.

Case 2: You want to look up a term without highlighting it in your document.

1. With no text highlighted, click on the £ button. The Search in TRADOS MultiTerm dialog
appears on your screen.

2. Type in the term you want to look up and confirm by clicking on OK. If the term is found in the
current database, it appears with its translation in your word processor’s status line. If the term is
not found, the next alphabetical entry appears.

Tips and Notes

*  You can also use the Lookup function to start a global (*) or fuzzy (#) search. In WinWord 6.0
or later, to start a fuzzy search, simply activate the Fuzzy Search check box in the Search in
TRADOS MultiTerm dialog. In other word processors, type the “#” before the search
criterion. In all cases, after the fuzzy or global search, MultiTerm displays a hit list of matching
terms as soon as the search is finished. For more information on global and fuzzy searching,
refer to the chapters “Getting Started” and “Searching for Entries.”
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e After a fuzzy search from within Word 6.0 or higher, the hit list is displayed iz Word itself,
rather than in MultiTerm. This allows you to stay within Word even after a fuzzy search.

e In Word 6.0 or higher, the MultiTerm Lookup function does not only display the target term
but also its synonyms, if any, in the status bar. All synonyms are separated by a semicolon (). If
a homonym is found, a corresponding message (“Homonym found”) is displayed in the status
bar. To browse all homonyms, use the “Next Entry” button described below.

+ Display Previous Entry (“PrevEntry”)

This button allows you to browse backward to the previous alphabetical entry in the MultiT'erm
database. Proceed as follows:

. Click on the * button to browse to the previous entry. The preceding term in alphabetical
sequence and the term’s translation appear in the status line.

-+ Display Next Entry (“NextEntry”)

This button allows you to browse forward to the next alphabetical entry in the MultiTerm database.
Proceed as follows:

. Click on the ? button to browse to the next entry. The next term in alphabetical sequence and
the term’s translation appear in the status line.

@ Paste (“Paste”)

This button allows you to paste the current field from your MultiT'erm database into your document.
This function is particularly useful when you have looked up a term using the £ butron and then
want to paste the translation. Proceed as follows.

. Click on the & button. The contents of the current field are pasted into the document at the
cursor location. If text is highlighted in your document, the highlighted text is replaced by the
paste. This allows you, for example, to highlight a term, look it up with the o button, and then
automatically replace the term with its translation by clicking on 2,

Tips and Notes

* In WinWord 6.0 or higher, if there are several target synonyms for the term you last looked up,
the program opens the Select Target Term dialog. Here you can decide which synonym you
want to paste. Alternatively, you can directly activate the MultiT'erm window by clicking the
Popup... button.

«  You can use the & button to copy the contents of any field, for example an entire definition or
context note, into your document. To browse to the other fields in the entry, use the + and
¥ buttons described later in this section. The status line shows the corresponding field. As
soon as the field you want appears, you can paste it into your document as described above.

® Show Current Field (“ShowCurField”)

This button allows you to display the current field in the MultiTerm database in your word
processor’s status line. This is useful, for example, if the most recently displayed word pair is no
longer visible in the status line and you want to review the translation again. Proceed as follows:

. Click on the & button. The contents of the current field are displayed in your word processor’s
status line.
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Note

If you activated or restarted MultiTerm since the last time you looked up a term, you must look up
a term again so MultiTerm can reposition its internal field pointer. The status line displays a
message indicating that MultiTerm has been activated in the meantime.

1+ Show Previous Field (“ShowPrevField”)
This button allows you to move up one field in the current MultiTerm entry and display the field in

your word processor’s status line. Proceed as follows:

. Click on the ® button. Your word processor’s status line displays the previous field in the
current entry.

Note

If you are already at the beginning of the entry, a corresponding message appears in the message
line.

¥+ Show Next Field (“ShowNextField")
This button allows you to move down one field in the current MultiTerm entry and display the field

in your word processor’s status line. Proceed as follows:

. Click on the ¥ button. Your word processor’s status line displays the next field in the current
entry.

Note

If you are already at the end of the entry, a corresponding message appears in the message line.

Ly Call MultiTerm (“Popup”)

This button allows you make MultiTerm the foreground application under Windows. Proceed as
tollows:

. Click on the %% button whenever you want to look at the MultiTerm window. This can be
useful, for example, if you want to see additional information on a translation you have found.

*. Show Default Status Line (Only in Ami Pro 3.x)

Every time you search or browse for MultiTerm information from Ami Pro, the MultiTerm message
stays in Ami Pro’s status line until you start a new search or start some other operation that overwrites
the status line. This means that Ami Pro’s default status line remains hidden. If you want to make the
default status line visible again, for example to select another paragraph format or font size, simply
click on the #| button. This restores Ami Pro’s default status line.

Example of Using the Buttons

Let’s assume that you are translating a text from English to German, and that you have already set the
appropriate language direction in the SAMPLE. MTWdatabase. You now want to translate the sentence
I dreamt about a big juicy strawberry milkshake last night into German. However, you don’t know the
German translation for strawberry milkshake, so you want to look up this term from within your word
processor and then paste the German translation into your document. Follow these steps, depending
on the word processor version you use:
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Ami Pro, WordPerfect, or WinWord 2.0

1. Highlight the term strawberry milkshake in your document.

2. Click on the #2 button. The status line of your word processor displays the message “[English]
strawberry milkshake -> [Deutsch] Erdbeer-Milchmixgetrink.”

3. If you want to make sure that there are no homonyms, that is, that there are no further English
terms spelled the same way, you can click on the = button to browse forward to the next entry
in the MultiTerm database.

4. Once you have seen that there is only one entry in the current database for strawberry milkshatke,
browse back to that entry by clicking on the * buteon.

5. To check whether there are perhaps synonyms to the German term, you can click on the +
button to move down in the entry looking for any synonyms. Click on the 4 button when you
want to move back up to the first term.

6.  Once you have selected the translation you want to use, click on the & butron. The source
language term, strawberry milkshake, which is still highlighted in your document, is now
overwritten by the translation you selected. Since the translation’s is copied from the database,
you may need adjust the font to match the surrounding text. For information on defining the
default font in the database, see the section “Changing a Database Definition” in the “Creating
a Database” chapter.

Word 6.0 or Higher

1. Highlight the term strawberry milkshake in your document.

2. Click on the & button. Since Word additionally displays target synonyms, the message reads
“[English] strawberry milkshake -> [Deutsch] Erdbeer-Milchmixgetrink; Erdbeer-Milchshake.”

3. Click on the & button. Since Word has found two target language synonyms under step 2, it
opens the Select Target Term dialog, giving you the option to choose between the two
translations Erdbeer-Milchmixgetrank and Erdbeer-Milchshake. Once you highlight the translation
you want to use and confirm by clicking Insert, the source language term, strawberry milkshake,
which is still highlighted in your document, is replaced by the translation you selected.

Using DDE to Copy Larger Amounts of Data into Your Word Processor

Creating Word Lists, Glossaries, and Dictionaries

MultiTerm’s comprehensive and easy-to-use DDE interface allows you to simply select a menu item
to copy all or part of your database into your word processor and automatically apply special
formatting. You can choose from bilingual word lists, monolingual glossaries, and even professional
dictionary printouts. These functions allow you to transform your database into professional-looking
documents. Of course, you can use your word processor’s formatting capabilities to further enhance
the documents’ appearance before sharing the documents with others. If you are familiar with macro
programming in your word processor, you can also modify these macros according to your own
requirements. For a description of the DDE commands available with MultiT'erm, see the next
chapter, “DDE Interface Reference.”

These functions are found in your word processor’s Insert menu (or the Tools menu in Ami Pro), and
in the Table menu.

Note for Ami Pro Users

Before you can use these commands, you must first click once on the ™ buccon (“Install Multi-
Term Menu Items”) in the MultiTerm Smartlcon bar. This adds these three commands to the cor-
responding menus in Ami Pro. A message appears telling you that the menus have been changed.
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The following commands are found in these menus:

MultiTerm Table Inserts a three-column table into the current document. The table
includes source-language terms, their synonyms (if any), and target-
language equivalents. At press time, in Word 6.0 or higher, you could
also choose a two-column table layout. In this case, source terms and
synonyms all go in the left column.

MultiTerm Glossary Inserts a monolingual glossary into the current document. The glossary
consists of the source-language terms and any corresponding text fields.

MultiTerm Print... Inserts a complete dictionary with all corresponding information into
your document. You can specify what the dictionary should look like
(one to three columns) and whether or not it should include global
attributes and text fields (like subject specifications found under the
Entry Number). This function is only available from the Insert menu.

MultiTerm Print Entry ~ This function, at press time only available in Word 6.0 or higher, inserts
the current MultiTerm entry in a “WYSIWYG” (what-you-see-is-what-
you-get) manner into your document. All fields are included, starting
from the Entry Number system field.

As with the other commands, you can invoke all of these functions from within your word processor.
Keep in mind that the functions use the language direction currently defined in MultiTerm and that
they respect any filter that is set. This means, for example, that if you have English set as the source
language and Deutsch as the target language, and a filter activated on the Swéject Fruit (as described in
the “Filtering Entries” chapter), MultiTerm Table creates a table containing all the English terms,
their synonyms, and their German translations for this subject area.

If you want to interrupt the creation of a table or dictionary, simply press the [Esc] key. The function
is aborted, and the portion of the table or dictionary created so far appears on your screen.

Tips and Notes

*  We recommend that you execute the functions described above while your word processor is
set to normal view, not page layout view. This speeds up the execution. In WinWord, select
Normal from the View menu. In WordPerfect, the command is called Draft, and is also in the
View menu. In Ami Pro, normal view is selected via the Draft Mode command in the View
menu.

* Another very interesting option for creating professional dictionaries from MultiTerm data is
described in the “Creating Professional Dictionaries” section in the “Exporting Entries”
chapter. This approach uses MultiTerm’s flexible export function to create a Rich Text Format
(RTF) file, which can be read by all popular word processing programs. Since direct exporting
is faster and more flexible than DDE, this approach is recommended for larger databases.

Using DDE to Import the Current Entry or All Entries into Your Word Processor

In addition to the functions described above, your word processor’s Insert menu includes two
additional commands for importing individual entries or all database entries in MultiTerm text format.
MultiTerm text format is described in detail in the chapters “Importing Entries” and “Exporting
Entries.” The two commands have the following functions:

Import Current Entry The Import Current Entry command inserts all data from the current
MultiTerm entry into your word processor in MultiTerm text format. It
has the same effect as if you were to export an entry from MultiTerm
using the predefined export definition BACKUP. MDX. See the

“Exporting Entries” chapter for more information.

Import All Entries The Import All Entries command works like the Import Current
Entry command except that it imports @// MultiTerm entries found iz
the current index into your word processor. This also creates a document
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that is compatible with MultiTerm’s backup text format. If a filter is set,
Import All Entries takes it into account, so you can use this function to
extract portions of your database. Caution: since this import is based on
the currently selected source language and not on the Entry Number, it
does not perform a complete backup of all your MultiTerm data. For
instructions on backing up your data, see the section “Using the Export
Function to Create a Backup” in the “Exporting Entries” chapter.

The Import Current Entry and Import All Entries commands can be used, for example, to

quickly create a list of all the entries created today, without having to use MultiTerm’s export
function.

Carrying On a Dialog with MultiTerm

You can “try out” the DDE commands listed above, and most others, by selecting the MultiTerm
Dialog... command from the View menu. The following dialog appears:

DDE with MultiTerm

I Search |

FrevEntm MextEntm | Sort I
Target Date Entpyp
tatch Info LCurField

PrevField MextField Popup |

Hide Granh e

Figure 10S: The DDE with MultiTerm Dialog

As you can see, this dialog lets you type in a search term and start a search, but it also lets you execute
all the other commands, for example browsing from entry to entry or moving from field to field.
MultiTerm’s answer appears in its own dialog box, where you can click on OK to return to the above
dialog. To close the above dialog and return to your word processor, click on the OK button.

Copying Fields from MultiTerm to Other Applications

If your application does not support Dynamic Data Exchange as described above (at press time, this
included several desktop publishing applications like FrameMaker and PageMaker), you can still
quickly copy the contents of MultiTerm fields into your application. MultiTerm helps by providing
special features for copying fields to the clipboard and for instructing MultiTerm to remain in the
foreground. Of course, foreground operation and pasting via the clipboard can also be used with the
word processors described in the previous section. This is particularly worth considering if you use
Word for Windows 2.0 or higher, since MultiTerm can paste directly into this application.

Follow these steps to copy data from MultiT'erm into your application:

1. As a preparatory step, we recommend that you arrange your application’s program window and
MultiTerm’s window in such a way that both applications are visible on your screen. For
example, you can move the MultiT'erm window to the lower right corner so that you can see
most of the document window in the other application. You can use the target application in
full-screen mode as usual.

2. Activate the MultiTerm window and select the Pin on Top command from the View menu.
This instructs MultiTerm to remain visible on your screen even when you switch back to your
target application.
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3. Now search for the information in MultiT'erm that you want to copy into your target application.
In most cases, this will be the translation of a term, but you can also use the same technique to
copy any other field, for example a definition or context note, into your target application. If you
are not yet familiar with searching in MultiTerm, please refer to the “Searching for Entries”
chapter. Note that you can copy a search criterion from your application, usually by highlighting
it and pressing [Ctrl]+[C], and paste it into MultiTerm’s search field by pressing [Cerl]+[V].

4. Once the entry containing the information you want is on your screen, move the mouse cursor to
the field that you want to copy into your target application. A reminder:as long as no message is
currently displayed, MultiTerm always tells you in the message line the name of the field to
which the mouse cursor is pointing.

5. Double-click on the field you want to copy. MultiTerm copies the field’s contents to the
Windows clipboard and confirms the copy with a corresponding message in the message line
(“The current field has been copied to the clipboard”).
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Figure 106: MultiTerm on Top of Another Application

6. Now switch to the target application and move the cursor to the position where you want to
paste the field you just copied from MultiTerm to the clipboard.

7.  Select the Insert command from your target application’s Edit menu, or press the key
combination [Ctrl]+[V] or [Shift]+[Ins]. The desired field contents appear in your application at
the current cursor position.

This approach lets you easily switch back and forth between your application and MultiTerm and
copy any fields you need from MultiTerm to your application.

“Double-Clicking” to Paste into Word for Windows 2.0 or Higher

If you use Word for Windows 2.0 or higher, double-clicking on a MultiTerm field can not only copy
the field to the clipboard; it can also immediately paste the field into your WinWord document at the
cursor position. This means that you can skip steps 6 and 7 of the previous instructions. If you are
using the English (or, incidentally, Japanese) version of Word for Windows, this function works
without any change to the program. However, if you are using non-English version of Word, double-
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clicking causes the message “WordBasic Error 124: Unknown Command, Subroutine, or Function.”
Don’t worry; your WinWord is not broken—it just needs to be adapted to recognize the double-click.
This can be accomplished in a few short steps, described below.

When you do a double-click on a MultiTerm field, MultiTerm copies the contents of the field into
the Windows clipboard as described above. At the same time, MultiTerm checks whether Word for
Windows is running. If so, MultiTerm sends an additional command to Word, the “EditPaste”
command. That is, MultiTerm tells WinWord to immediately paste the current field contents at the
current cursor position. However, in non-English versions of WinWord, the command is not called
“EditPaste”, but has rather been localized into the corresponding language. This is why the above
error message appears when you double-click on a field in a MultiTerm database entry. A minor
modification is required to “force” non-English versions of WinWord to understand the “EditPaste”
command. Follow these steps:

1.  In WinWord, select the Macro... command from the Tools menu. The Macro dialog appears
on your screen.

2. From the Macros Available In drop-down list, select the Normal.dot (Global Template)
item.

3. In the Macro Name input field, type in the name of the command that MultiTerm sends to
WinWord when it wants to paste the contents of a field, namely “EditPaste”. Your screen should
now appear as follows:

Macro EE

Macio Mame: Fiecord |
[EdiPasid —
=

Bun

Create |
Welete |

Orgarizer... |

Macros Available In:
Mormal. dot [Global Template] j

Description:

=
[

Figure 107: The Macro Dialog in Word for Windows

4. Click on the Create button. WinWord now opens a special document window used for creating
macros. Don’t worry—you can’t do any harm here! The cursor is blinking between the Sub
MAI N and End Sub lines. If you are using the German version of WinWord, simply type in the

» 2

string “BearbeitenEinfiigen”.” The following text will be visible in your window:

Sub MAIN
BearbeitenEinfligen
End Sub

Be sure to read the text under “Tip for Users of Word 6.0 or Higher” below for a useful
additional command in this macro text.

5. Select the Close command from the File menu. Be sure to answer Yes to the question of
whether the changes to “Global:EditPaste” should be saved.

2 Inthe French version, the command is “EditionInsérer,” in the Spanish version, its “EdiciénPegar.” For other
localized versions of WinWord, please look for the corresponding macro command in the Help for WordBasic.
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Your copy of WinWord has now “learned” how to interpret the MultiTerm command “EditPaste” and
will therefore be able to correctly insert the desired field contents at the current cursor position.

Tip for Users of Word 6.0 or Higher

In most cases, you may want to not only paste the field contents but to directly activate Word’s
program window after the insertion. To achieve this, add the following line to the above macro

after the BearbeitenEinfligen line, depending on the localized version you use®:
English Word: AppActivate "Microsoft Word", 1

German Word: AnwAktivieren "Microsoft Word", 1

French Word: AppActiver "Microsoft Word", 1

Spanish Word: ApActivar "Microsoft Word", 1

With this instruction, after double-clicking on the desired field in MultiTerm, the Word window
will be activated after the insertion of the current field contents. This allows you to go on typing
your text without having to switch back manually.

Deactivating the Automatic Pasting of Field Contents into WinWord

In some cases, it may be desirable to deactivate the automatic pasting of field contents into Word
temporarily or permanently. To achieve this, you can modify the initialization file of
MultiTerm ’95 Plus, MTWPLUS.INI, found in the main Windows directory (C:\WINDOWS by
default). You can open this file in any text editor (the Windows Notepad, for instance). Add the
following two lines to prevent MultiTerm from pasting field contents into your Word document after
the double-click:

[Winword]
EditPaste=0

If the [Winword] section is already present in your copy of the MTWPLUS.INI file, you do not need
to add it. The next time you start MultiTerm, it will no longer paste any field contents to your Word
document. It will, however, still transfer the contents to the Windows clipboard.

3 Although users of the English version of Word do not need to write a macro just to paste from Word, they will
need to write an EditPaste macro to achieve this paste-and-activate behavior. The macro should contain the
Edi t Past e command and the AppAct i vat e command.
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The previous chapter explained MultiTerm’s DDE interface from an end-user perspective. In this
chapter, we will look at the programming side of the DDE interface. As mentioned earlier, DDE
stands for Dynamic Data Exchange. Dynamic Data Exchange between two Windows applications
takes place via a standard interface that Windows makes available. The interface is basically a
protocol, a type of agreement on the vocabulary that programs can use to communicate with each
other. In addition, the interface determines the “etiquette” of the communication: how a
conversation is started, who can be asked what questions, when they can be answered, and how the
conversation is ended—almost like in real life.

There are two participants in a DDE conversation: the ¢/ienr who wants to “buy”
case, data), and the server who can supply the item.

something (in this

MultiTerm always takes the role of server in a DDE conversation. This simplifies using the DDE
interface, since there is only one party who is asking questions (for example, your word processor) and
one who is answering (MultiTerm). Of course, it also means that data can only be exchanged in one
direction, toward the client.

The DDE interface allows another application, for example Word for Windows, to access and copy all
the fields in all the entries of a MultiT'erm database without MultiTerm even being visible on the
screen. This functionality was explained in detail in the last chapter. In this chapter, we’ll describe
the interface from MultiTerm’s point of view, thus giving you the information you need to create your
own macros for accessing MultiTerm from your word processor or another application. We will begin
be describing the general framework of a DDE conversation, and then go into the individual DDE
commands offered by MultiTerm.

Structure of a DDE Conversation

In this section, we will describe the basic structure of a DDE conversation. The examples are in
WordBasic, the programming language included in Word for Windows version 2.0 and, in greatly
expanded form, in version 6.0 or higher. The syntax in other word processing programs and in the
new Microsoft programming language for Office 97, that is, Visual Basic for Applications (VBA), may
be somewhat different, but if they support DDE, corresponding commands should be available. If
you have never recorded or programmed macros in your word processor, we recommend that you
study the Word for Windows Help section entitled “Programming with Microsoft Word” before
working through the following material.
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As already mentioned, MultiTerm always acts as the server in a DDE conversation. This means that
the client (the other application) must perform the following steps:

1. Begin the conversation:
hwhd = DDEInitiate("MI4WN',"nt_init")

This example is a program line in WordBasic with the following meaning: WinWord sends a
message to MultiTerm that it wants to start a conversation. If MultiTerm is ready for a
conversation, it answers with the “telephone number” (channel number) hWhd, via which the
two programs can then communicate.

2. Ask questions:
ntwé = DDERequest $( hWhd, Topi c$)

This example is a program line in WordBasic with the following meaning: WinWord “calls the
number” hWhd and asks MultiTerm for information about Topi ¢$. MultiTerm puts its answer
in the string variable m w$. The client can ask as many questions as it wants as long as the line
(channel) to MultiTerm is open. The topics that are available are described in the next section,
“DDE Commands.”

3. End the conversation:

DDETer m nat e hWwhd

This example is a program line in WordBasic with the following meaning: WinWord calls
MultiTerm at the number hWAd and informs MultiTerm that it is ending the conversation.

Every DDE conversation must have this structure. Among other things, it allows the memory
temporarily reserved for the exchanged data to be released. These three WordBasic commands are the
only ones you will need to conduct a DDE conversation with MultiTerm. You can then take the
information that MultiT'erm returns to you, for example a term’s translation or its definition, and
manipulate it with the other commands in your macro language.

Note

A DDE conversation with MultiTerm is only possible when MultiTerm is loaded, a database is
open, and MultiTerm is in display mode.
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DDE Commands

MultiTerm accepts DDE commands in the form of so-called topics. Except for nmt_init, all
commands are issued by the client using the DDERequest $ function. MultiTerm supports the

following topics:

Topic Explanation

mt_init Begins a DDE conversation with Multi'I'erm.
mt_popup Puts the MultiTerm window in the foreground.
mt_hide Hides the Multi'T'erm window in the background.

mt_open#filename

Opens a Multi'T'erm database via the DDE interface.

mt_getfilename

Returns the name of the current database as a file name.

Search Term

Starts a search in the current source language index.

mt_prev_entry

Browses backwards to the previous entry.

mt_next_entry

Browses tforwards to the next entry.

mt_match_entry

Checks whether the current entry matches the filter.

mt_sort Returns the sort term of the current entry.
mt_target Returns the target term of the current entry.
mt_date Returns the Creation Date of the current entry.

mt_graph_name

Returns the Graphic file name.

mt_entry

Returns the current Entry Number as a string.

mt_cur_field

Returns the contents of the current field.

mt_prev_field

Returns the contents of the previous field.

mt_next_field

Returns the contents of the next field.

mt_field_info

Returns information on the current tield.

mt_getindexname

Returns the name of the currently selected source language (index) as text.

mt_gettargetname

Returns the name of the currently selected target language as text.

mt_getindex

Determines the currently selected source language (index), but does not return the
name as text. Instead, a number is returned corresponding to the language’s position
in the list of index fields defined for this database.

mt_gettarget

Determines the currently selected target language, but does not return the name as
text. Instead, a number is returned corresponding to the language’s position in the list
of index tields detfined for this database.

mt_setindex#number

Sets the Multi'T'erm index to the desired language. This function’s parameter value
must be a number between 1 and 20 that specifies the language’s position in the list
of index tields defined for this database.

mt_settarget#number

Sets the target language in MultiTerm to the desired language. This function’s
parameter must be a number between 1 and 20 that specities the language’s position
in the list of index tields defined for this database.

mt_hitlist_off

T'urns off Multi'T'erm’s hit list so that it does 7oz come to the foreground after a global
or fuzzy search, which would make MultiTerm the active application.

mt_hitlist_done

Checks whether a hit list search is finished yet. 'T'he function returns nt _ok if the
search is finished.

mt_hitlist_get

Returns the last hit list as a string with the hits separated by paragraph marks

(Chr$ (13)).

mt_hitlist_on

T'urns on the visible hit list again so that Multi'T'erm will display the hit list after the
next global or fuzzy search. Displaying the hit list also makes Multi'T'erm the active
application.

The commands are described briefly on the following pages and illustrated with WordBasic examples.
For more extensive examples, use your macro editor to look at the macros described in the previous
chapter, “Integrating MultiTerm 95 Plus with Other Windows Applications.”
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Tips

e To process all the entries in a database, use a search term of “0” (zero) to go to the first entry
in alphabetical sequence, then use nt_next_entry to go to succeeding entries until
nmt _next _entry returns nt _no.

*  To process all the fields in an entry, use Mt _dat € to set the internal field pointer to the first
field in the entry (Creation Date), then use nt _next _fi el d to go through the fields until
nt _next _fiel d returns Nt _no. (If you want to skip the header fields, start at mt _entry
instead of nt _dat e.) Use mt _fi el d_i nf 0 to retrieve information on the current field.

mt_init

Description: T'he topic mt_init is the only one sent with the DDEInitiate function. This command
starts a DDE conversation and must precede all other commands.

Syntax: hWid=DDEl ni ti ate("MI4AWN',"nt _init")

Parameter Explanation

MI4W N . - . L .
This identifies MultiTerm as the name of the application for this DDE
session.

m_init .. C e

- The topic is the initialization of a channel.
h . . .
wd The numeric value returned is the channel number that will be used for the

conversation. It corresponds to the MultiTerm window. This number is
required for all remaining commands.

Result: If MultiTerm is loaded, a database is open, and MultiTerm is in display
mode, the command tells the client to what window it should direct future
questions. The value returned must be greater than 0. A value of 0 indicates
that MultiTerm is not ready for a DDE conversation.

Example:

hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello Multi Term

If hwhd > 0 Then "If it worked

nmw$ = DDERequest $(hwd, .. .) "Tell me ...
DDETer mi nat e hWhd " And good- bye
El se "t herw se
Print "Milti Termnot responding" "Qutput an error nessage
End |f
mt_popup

Description: "T'his topic is sent with the DDERequest $ command. It places the Multi'T'erm
window in the foreground. If Multi'T'erm was minimized to an icon, it is expanded to
its previous size.

Syntax: mt wg=DDERequest $( hwad, " nt _popup")

Parameter Explanation

hwWhd The channel number used for communicating with Multi' T'erm.
m _popup Multi'Term should place the window in the foreground.
mt we The returned string reports the result of the command.

Result: MultiTerm places the open window in the foreground, displays the current entry, and
returns the string nt _ok.

Example:

hwid = DDEInitiate("MM4AWN',"nt _init") "Hello Multi Term

If hwd > 0 Then "If it worked

ntw$ = DDERequest $( hwad, "nt _popup”) ' Show yoursel f!

DDETer mi nat e hWhd " And good- bye
El se "t herw se

Print "Milti Termnot responding" "Qutput an error nessage
End |f
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mt_hide
Description: T'his topic is sent with the DDERequest $ command. It places the Multi'T'erm
window in the background and minimizes it to an icon.
Syntax: m w$=DDERequest $( hwd, "nt _hi de")
Parameter Explanation
hwhd The channel number used for communicating with Multi'T'erm.
mt _hi de MultiTerm should minimize the window and place it in the background.
m w The returned string reports the result of the command.
Result: Multi'T'erm places the window in the background and returns the string mt _ok.
Example:
hwid = DDElnitiate("MM4AWN',"nt _init") Hel lo Multi Term

If hwhd > 0 Then "If it worked
nt w$é = DDERequest $( hwid, "nt _hi de") ' Hi de yoursel f!

DDETer mi nat e hWhd And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_open#filename
Description: T'his topic is sent with the DDERequest $ command. It allows you to tell Multi''erm
to open an existing database.
Syntax: nm w$=DDERequest $( hwd, "nt _open#fi | ename")
Parameter Explanation
hwhd I'he channel number used for communicating with Multi'l'erm.
m _open Multi'l'erm should open a database.
#fil ename T'he file name of the file, including the path.
m w T'he returned string reports the result of the command.
Result: Multi'T'erm opens the database named in f i | enanme and returns the string nt _ok.
Example:
hwid = DDEInitiate("MM4AWN',"nt _init") "Hello Multi Term
If hwd > 0 Then "If MultiTerm answers

"Load the sanpl e database
ntw$ = DDERequest $( hwad, "nt _open#c: \t rados\ nt wpl us\ SAMPLE. MTW )

If mws = "nmt_ok" Then "If it worked
Print "It worked!" " Qut put a success nessage
El se 'Ot herw se
Print "Database not found!"
Endl f
DDETer m nat e hwWwid " And good- bye
El se " Ot herw se
Print "Multi Term not responding" "Qutput an error nessage
End If
mt_getfilename
Description: This topic is sent with the DDERequest $ command. It allows you to ask
MultiTerm the name of the currently open database.
Syntax: mt wé=DDERequest $( hwid, "nt _get fi | enane")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.
m _getfil ename Multi'Term should return the name of the current database, including the path.
m wé The returned string reports the result of the command, that is, the file name of the
database including the path.
Result: Multi'T'erm returns the file name of the database including the path in the nt w$

string variable.
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Example:

hwd = DDElnitiate("MM4AWN',"nt _init")
If hwd > 0 Then

"Hello Multi Term
"If MiltiTerm answers

"Determne the nane of the current database
ntw$ = DDERequest $( hwid, "nt _getfil enanme")

Print "Database nane:

"+ mws "Qutput the file nanme

DDETer mi nat e hWhd " And good- bye
El se 'Ot herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
Search Term
Description: A topic that does not begin with mt _ is interpreted as a search term. These topics
are sent with the DDERequest $ function, and the function returns the source-
language term of the entry it finds. If the search term contains one or more wildcard
characters (¥), or if the search term begins with a pound sign (#), MultiT'erm instead
initiates a global or fuzzy search, respectively. If you want to prevent the hit list from
appearing and Multi T'erm from becoming the active application—that is, if you only
want to use the hit list internally in your macro—you can use the nt _hi t1i st
commands described later in this section.
Syntax: nt wé=DDERequest $( hwd, " Sear chTer ni')
Parameter Explanation
hwhd I'he channel number used for communicating with Multi'l'erm.
Sear chTer m Multi'T'erm should find the entry for this search term.
m w "T'he returned string reports the result of the command.
Result: For a simple search, Multi'T'erm finds the entry and returns the sort term in the

Return Value
Field contents
nt _ok

nt_access_
deni ed

Example:

hWwhd = DDEInitiate("MI4WN',"mt _init")
If hwd > 0 Then
ntw$é = DDERequest $( hwad, "*i ng")
Print ntwé

nmt W$ string variable. For global and fuzzy searches, Multi'Term collects the
matching entries in its hit list and displays the hit list when the search is complete.
If you want to prevent Multi'T'erm from answering, and if you perhaps want to use
the hit list only internally in your macro, you can use the mt _hi t| i st commands
described later in this section.

Explanation

Multdi'T'erm found an entry. 'T'he sort (index) term is returned as a string.

A global search was started. While Multi'l'erm searches in the background, the
macro can continue working.

An entry was tfound, but you do not have read rights for its Entry Class.

"Hello MultiTerm

"If it worked

"Search for terms ending in -ing
"The result is nt_ok

DDETer mi nat e hWhd " And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
Endl f
mt_prev_entry
Description: "T'his topic is sent with the DDERequest $ function. It browses backwards in the
current index to the previous entry.
Syntax: m w=DDERequest $( hWhd, "nt _prev_entry")
Parameter Explanation
hwhd T'he channel number used for communicating with Multi'T'erm.
m_prev_entry Multi'l'erm should browse backwards to the previous entry.
m w T'he returned string reports the result of the command.
Result: Multi'T'erm browses backwards one entry and places the return value in the mt w$

Return Value
Term

string variable.
Explanation

MultiTerm was able to browse backwards. T'he sort term of the entry is returned as
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nt _access_
deni ed

m _no

Example:

hwd = DDElnitiate("MM4AWN',"nt _init")
If hwd > 0 Then

a string. T'he internal field pointer is on the sort term.

Muldi'T'erm was able to browse, but you do not have read rights for the Entry Class
of the entry it browsed to.

MultiTerm is at the beginning of the index and therefore cannot browse
backwards.

"Hello Multi Term
"If it worked

' Browse backwar ds
ntw$ = DDERequest $(hwad, "nt _prev_entry")

Print ntws "Display the result
DDETer mi nat e hWhd " And good- bye

El se "t herw se
Print "Milti Termnot responding" "Qutput an error nessage

End |f

mt_next_entry
Description: "T'his topic is sent with the DDERequest $ function. It browses forwards in the current
index to the next entry in alphabetical sequence.

Syntax: m wé=DDERequest $( hWhd, "nt _next _entry")

Parameter Explanation

hwd

m _next_entry
m wé

Result:

Return Value
Term

nt _access_
deni ed

nt_no

Example:

hwid = DDEInitiate("MM4AWN',"nt _init")
If hwad > 0 Then

T'he channel number used for communicating with Multi''erm.
Multi'T'erm should browse forwards to the next entry.
T'he returned string reports the result of the command.

Multi'T'erm browses forwards one entry and places the return value in the nt w§ string
variable.

Explanation

Multi'Term was able to browse forwards. The sort term of the entry is returned as a
string. 'I'he internal field pointer is on the sort term.

Multi'T'erm was able to browse, but you do not have read rights for the Entry Class of
the entry it browsed to.

MultiT'erm is at the end of the index and therefore cannot browse forwards.

"Hello Multi Term
"If it worked

' Browse forwards
ntw$é = DDERequest $( hwid, "nt _next _entry")

Print nmw$

"Display the result

DDETer mi nat e hWwid " And good- bye
El se 'Ot herw se
Print "Ml ti Term not responding" "Qutput an error message
End If
mt_match_entry
Description: "T'his topic is sent with the DDERequest $ function. It checks whether the current
entry matches the filter.
Syntax: m w$=DDERequest $( hWid, "nt _mat ch_entry")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.
m _match_entry Multi'Term should say whether the entry matches the filter.
mt we The returned string reports the result of the command.
Result: MultiTerm checks whether the entry matches the filter and places the return value in

Return Value
nmt _ok
nt _no

the mt w8 string variable.
Explanation
T'he entry matches the detined filter criteria, or the filter is not active.

T'he entry does not match the currently defined filter criteria.
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Example:

hwd = DDElnitiate("MM4AWN',"nt _init")
If hwd > 0 Then

"Hello Multi Term
"If it worked

"Does the entry match the current filter?
ntw$é = DDERequest $( hwid, "nt _mat ch_entry")

Print ntw$

"Display the result

DDETer mi nat e hWhd " And good- bye
El se 'Ot herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_sort
Description: T'his topic is sent with the DDERequest $ function. It returns the current sort term,
that is, the search term in the currently selected source language.
Syntax: nt ws=DDERequest $( hWwd, "nt _sort")
Parameter Explanation
hwhd The channel number used for communicating with Multi' T'erm.
M _sort MultiTerm should return the sort term.
M w$ The returned string reports the result of the command.
Result: Muldi'T'erm places the internal tield pointer on the sort term and returns the result in
the nt wW$ string variable.
Return Value Explanation
Term Everything is okay. The entry contains a term in the current source language; the term
is stored in Mt wé.
M _access_ You do not have read rights for the current Entry Class.
deni ed
M _no T'he entry does not contain a sort term. T'his can happen when you access entries via
Entry Number.
Example:
hwid = DDEInitiate("MM4AWN',"nt _init") "Hello Multi Term
If hwd > 0 Then "If it worked
ntw$é = DDERequest $( hwWid, "nt _sort") "Get the sort term
Print ntws "Display the result
DDETer mi nat e hwWwid " And good- bye
El se "Qtherw se
Print "Multi Term not responding" "Qutput an error nessage
End If
mt_target
Description: This topic is sent with the DDERequest $ function. It returns the current target term,
that is, the first term in the currently selected target language.
Syntax: mt wé=DDERequest $( hWid, "nt _target")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.
M _target MultiTerm should return the target term.
M ws The returned string reports the result of the command.
Result: MultiTerm places the internal field pointer on the target term and returns the result in

Return Value
Term

nt_access_
deni ed
m_no

the mt w8 string variable.
Explanation

Everything is okay. 'T'he entry contains a term in the current target language; the term
is stored in it wé.
You do not have read rights for the current Entry Class.

The entry does not have a target term, that is, there is no term in the currently
selected target language.
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Example:
hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello MultiTerm
If hwid > 0 Then "If it worked
nmw$ = DDERequest $(hWid, "nt _target") ’'Get the target term
Print ntws "Display the result
DDETer mi nat e hWhd " And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_date
Description: ‘T'his topic is sent with the DDERequest $ command. It returns a string containing the
Creation Date of the current entry.
Syntax: nt ws=DDERequest $( hWd, "nt _date")
Parameter Explanation
hwhd The channel number used for communicating with Multi' T'erm.
m _date MultiTerm should return the Creation Date.
m w The returned string reports the result of the command, that is, the Creation Date of
the current entry.
Result: MultiTerm places the internal field pointer on the Creation Date tield, which is the first
field in each entry, and returns the result in the nt w$ string variable.
Return Value Explanation
Creation Date T'he Creation Date is returned in the format DD.MM.YYYY - HH:MM:SS.
m_access_ You do not have read rights for the current Entry Class.
deni ed
Example:
hwid = DDEInitiate("MM4AWN',"nt _init") "Hello Multi Term
If hwd > 0 Then "If it worked
nt w$é = DDERequest $( hwid, "nt _date") "Get the Creation Date
Print ntws "Display the result
DDETer mi nat e hwid " And good- bye
El se "Qtherw se
Print "Multi Term not responding" "Qutput an error nessage
End If
mt_graph_name
Description: This topic is sent with the DDERequest $ command. It returns the full file name,
including drive and path, of the current graphic file.
Syntax: mt wé=DDERequest $( hWd, " nt _gr aph_nane")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.
mt _gr aph_nane Multi'Term should return the graphic file name.
mt we The returned string reports the result of the command, that is, the name of the graphic
file of the current entry.
Result: Muldi'T'erm places the internal tield pointer on the Graplic tield and returns the result
inthe nt W string variable.
Return Value Explanation
Graphic file The graphic file name is returned with the path name, for example
c:\data\pictures\photo.tif.
mt_access_ You do not have read rights for the current Entry Class.
deni ed
nt _no T'here is no graphic file linked to the current entry.
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Example:

hwd = DDElnitiate("MM4AWN',"nt _init")
If hwd > 0 Then

"Hello Multi Term
"If it worked

"Get the name of the graphic
ntw$é = DDERequest $( hwid, "nt _graph_nane")

Print ntw$

"Display the result

DDETer mi nat e hWhd " And good- bye
El se 'Ot herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_entry
Description: ‘T'his topic is sent with the DDERequest $ command. It returns a string containing the
Entry Number of the current entry.
Syntax: m wé=DDERequest $( hWid, "nt _entry")
Parameter Explanation
hwhd The channel number used for communicating with Multi' T'erm.
m_entry MultiTerm should return the Entry Number.
m w The returned string reports the result of the command, that is, the Entry Number of
the current entry.
Result: MultiTerm places the internal field pointer on the Enzry Number tield and returns the

Return Value
Entry Nunber

nt_access_
deni ed

Example:

hWwhd = DDEInitiate("MI4WN',"mt _init")

If hwhd > 0 Then
ntw$ = DDERequest $( hwid, "nt _entry")
Print ntwé

result in the nt W$ string variable. Entry Number is the last field in the entry header
and immediately precedes any global attributes and/or global text fields.
Explanation

The current Entry Number is returned as a string.

You do not have read rights for the current Entry Class.

"Hello MultiTerm

"If it worked

"Get the Entry Number
"Display the result

DDETer mi nat e hWhd " And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_cur_field
Description: "T'his topic is sent with the DDERequest $ command. It returns the contents of the
current field, that is, the field pointed to by Multi'T'erm’s internal field pointer.
Syntax: m wé=DDERequest $( hwad, "nt _cur _fiel d")
Parameter Explanation
hwhd T'he channel number used for communicating with Multi'Tl'erm.
m _cur_field Multi'T'erm should return the contents of the current tield.
m w T'he returned string reports the result of the command, that is, the contents of the
current field.
Result: MultiTerm returns the contents of the field pointed to by the ficld pointer as a string

Return Value
Field contents

nt _read
nt _access_
deni ed

in the nt w8 string variable.

Explanation
T'he contents of the current tield are returned as a string.

Multi'T'erm has been directly activated in the meantime; the internal field pointer is
no longer current. In this case, first position the internal pointer with one of the other
topics, for example nt _dat e, nt _entry, ornt _sort, and then return the
corresponding result.

You do not have read rights for the current Entry Class.
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Example:

hwd = DDElnitiate("MM4AWN',"nt _init")
If hwd > 0 Then

"Hello Multi Term
"If it worked

"Retrieve the contents of the current field
ntw$é = DDERequest $( hwad, "nt _cur_field")

Print ntw$

"Display the result

DDETer mi nat e hWhd " And good- bye

El se "t herw se
Print "Milti Termnot responding" "Qutput an error nessage

End |f

mt_prev_field
Description: ‘T'his topic is sent with the DDERequest $ command. It returns the contents of the
previous field.
Syntax: m wé=DDERequest $( hWad, "nt _prev_fiel d")
Parameter Explanation
hwhd The channel number used for communicating with Multi' T'erm.

nt_prev_field
nt wé

Result:
Return Value

Field contents
nt _read

nt_access_
deni ed

nt _no

Example:

hwd = DDElnitiate("MM4WN',"nt _init")
If hwd > 0 Then

MultiTerm should return the contents of the previous field.

The returned string reports the result of the command, that is, the contents of the
previous field.

Multi'T'erm moves up one field in the current entry, positions its internal field pointer
there, and returns the contents of the field in the nt w8 string variable.
Explanation

I'he contents of the previous field are returned as a string.

MultiTerm has been directly activated in the meantime; the internal field pointer is no
longer current. In this case, first position the internal pointer with one of the other
topics, for example nt _dat e, nt _entry, ornt _sort, and then return the
corresponding result.

You do not have read rights for the current Entry Class.
There is no previous field. The field pointer already points to the first field in the

entry, Creation Date.

"Hello Multi Term
"If it worked

"Retrieve the contents of the previous field
ntw$ = DDERequest $(hwad, "nt _prev_field")

Print ntw$

"Display the result

DDETer mi nat e hWhd " And good- bye

El se 'Ot herw se
Print "Milti Termnot responding" "Qutput an error nessage

End If

mt_next_field
Description: This topic is sent with the DDERequest $ command. It returns the contents of the
next field.
Syntax: m wé=DDERequest $( hwd, "nt _next _fi el d")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.

nt_next_field
nm wé

Result:
Return Value

Field contents
nt _read

Multi'Term should return the contents of the next field.

The returned string reports the result of the command, that is, the contents of the next
field.

Muldi'T'erm moves down one field in the current entry, positions its internal field
pointer there, and returns the contents of the field in the nt w$ string variable.
Explanation

The contents of the next tield are returned as a string.

MultiTerm has been directly activated in the meantime; the internal field pointer is
no longer current. In this case, first position the internal pointer with one of the other
topics, for example nt _dat e, nt _entry, ornt _sort, and then return the
corresponding result.
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m_access_ You do not have read rights for the current Entry Class.

deni ed

nt_no There is no next field. The field pointer is already on the last field in the entry.

Example:
hwid = DDElnitiate("MM4AWN',"nt _init") "Hello Multi Term
If hwd > 0 Then "If it worked
"Retrieve the contents of the next field
nt w$é = DDERequest $(hwad, "nt _next _fiel d")
Print ntws "Display the result
DDETer mi nat e hwWid " And good- bye
El se "Qtherw se
Print "Milti Term not responding" "Qut put an error nessage
End If
mt_field_info
Description: This topic is sent with the DDERequest $ command. It returns information
on the current field, in particular the field type, default font, and field name.
Syntax: mt wé=DDERequest $( hwd, "nt _fi el d_i nf o")
Parameter Explanation

hwWhd The channel number used for communicating with Multi T'erm.

m_field_info Multi'T'erm should return additional information on the current field.

m wé The returned string reports the result of the command.

Result: MultiTerm returns additional information on the field pointed to by the field pointer
in the nt w8 string variable.
Return Value Explanation

Field info T'he field information on the current tield is returned as a string in the format
type:font:field nane.

m _read Multi'T'erm has been directly activated in the meantime; the internal field pointer is
no longer current. In this case, first position the internal pointer with one of the other
topics, for example nt _dat e, nt _entry, ornt _sort, and then return the
corresponding result.

m_access_ You do not have read rights for the current Entry Class.

deni ed

The values for font and field name depend on your Windows installation and the database definition;
they are self-explanatory. The values returned for field type have the following meaning:

Type Explanation
H Header field - 'T'he current field belongs to the entry header. 'T'his includes all fields
trom Creation Date to Entry Number.
S Sort term and synonyms - The field is a term in the currently selected source
language.
T . . .
Target term and synonyms - The field is a term in the currently selected
target language.
: Index term - The field is a term in a language other than the currently
selected source and target languages.
D . . . .
Description - The field is a text field. (We would have preferred to use the
letter "I, but it is already in use.)
A Acttribute field - The field is an attribute field.
Example:
hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello MultiTerm
If hwid > 0 Then "If it worked

El se

End If

"Get the current field info
ntw$ = DDERequest $(hwad, "nt _fiel d_i nfo")

Print ntws "Display the result
DDETer mi nat e hWhd " And good- bye

"t herw se
Print "Milti Termnot responding" "Qutput an error nessage
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mt_getindexname
Description: T'his topic is sent with the DDERequest $ command. It returns the name of the
currently selected source language.
Syntax: nt wb=DDERequest $( hWhd, " nt _get i ndexnane")
Parameter Explanation
hwhd The channel number used for communicating with Multi'T'erm.
nt _geti ndexnane MultiTerm should return the name of the currently selected source language.
m w The returned string reports the result of the command.
Result: Muldi'T'erm returns the name of the currently selected source language as a text string
in the nt W string variable.
Example:
hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello Multi Term
If hwid > 0 Then "I'f Multi Term answers
"Determ ne the name of the source | anguage
ntw$ = DDERequest $( hwid, "nt _geti ndexnane")
Print "Current source |language: " + mw$ "Display the result
DDETer m nat e hWwhd " And good- bye
El se 'Ot herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_gettargetname
Description: T'his topic is sent with the DDERequest $ command. It returns the name of the
currently selected target language.
Syntax: nt wd=DDERequest $( hwhd, "nt _get t ar get name")
Parameter Explanation
hwhd T'he channel number used for communicating with Multi'l'erm.
nt_gettarget-nane Multi'l'erm should return the name of the currently selected target language.
m w "T'he returned string reports the result of the command.
Result: Muldi'T'erm returns the name of the currently selected target language as a text string
in the nt W string variable.
Example:
hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello Multi Term
If hwid > 0 Then "I'f Multi Term answers
"Determne the name of the target |anguage
ntw$ = DDERequest $( hwid, "nt _get t ar get name")
Print "Current target |anguage: " + mw$ "Display the result
DDETer mi nat e hWwhd " And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_getindex
Description: "T'his topic is sent with the DDERequest $ command. It determines the currently
selected source language (index), but does not return the name as text. Instead, a
number is returned corresponding to the language’s position in the list of index fields
defined for this database.
Syntax: m wé=DDERequest $( hwWid, "nt _get i ndex")
Parameter Explanation
hwhd T'he channel number used for communicating with Multi'T'erm.
m _getindex Multi'T'erm should return a number corresponding to the position of the current source
language in the list of index tields.
mt we The returned string reports the result of the command.
Result: MultiTerm returns the position of the currently selected source language in the list of

index fields in the nt Wé string variable. 'T'he value is a number between 1 and 20.
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Example:
hwWwd = DDEInitiate("MI4AWN',"nt _init") "Hello MultiTerm
If hwd > 0 Then "If MiltiTerm answers

"Determne the position nunber of the current source | anguage
ntw$ = DDERequest $( hwhd, "nt _geti ndex")
"Display the result

Print "Current source |anguage: " + mw$
DDETer m nat e hWhd " And good- bye
El se "Qtherw se
Print "MiltiTerm not respondi ng" "Qutput an error nessage
End If
mt_gettarget
Description: This topic is sent with the DDERequest $ command. It determines the currently
selected target language, but does not return the name as text. Instead, a number is
returned corresponding to the language’s position in the list of index tields defined for
this database.
Syntax: nmt we=DDERequest $( hWhd, "nt _gettarget")
Parameter Explanation
hWhd The channel number used for communicating with Multi T'erm.
mt _gettarget Multi'T'erm should return a number corresponding to the position of the current target
language in the list of index fields.
m w The returned string reports the result of the command.
Result: Muldi'T'erm returns the position of the currently selected target language in the list of
index fields in the mt w8 string variable. T'he value is a number between 1 and 20.
Example:
hWwd = DDEInitiate("MI4AWN',"nt _init") "Hello MultiTerm
If hwid > 0 Then "If Multi Term answers

"Determne the position nunber of the current target |anguage
ntw$é = DDERequest $( hwid, "nt _gettarget")

Print "Current target |anguage: " + mw$ "Display the result
DDETer mi nat e hWwhd " And good- bye
El se "t herw se
Print "Milti Termnot responding" "Qutput an error nessage
End | f
mt_setindex#number
Description: "T'his topic is sent with the DDERequest $ command. It sets the Multi'T'erm index to

the desired language. T'his function’s parameter value must be a number between 1
and 20 that specities the language’s position in the list of index tields defined for this

database.
Syntax: nm w$=DDERequest $( hwd, "nt _set i ndex#nunber ")
Parameter Explanation
hwhd T'he channel number used for communicating with Multi'Tl'erm.

m _seti ndex Multi'l'erm should set the index to the position number that you specify in #nunber .
#nunber The number specitying the position of the language in the list of index tields defined
for this database. 'I'he number must be between 1 and 20.

m w T'he returned string reports the result of the command.
Result: Muldi'T'erm sets the index to the number specified, thus setting the source language to
the desired language.
Return Value Explanation
m _ok Everything is fine. Multi'T'erm was able to set the index to the desired new source
language.
m_no Something didn’t work. Multi'T'erm could not set the new index because the value

specified in #nunber is invalid. T'his happens, for instance, when your database only
has 3 languages and you try to set the index to number 4.
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Example:
hWwd = DDElInitiate("MI4WN', "nt_init") "Hello MultiTerm
If hwd > 0 Then "If Multi Term answers
"Set the index to | anguage nunber 1 on the list of index fields
ntw$ = DDERequest $( hwid, "nt_setindex#1")
"Determ ne the name of the new source | anguage
nane$ = DDERequest $( hWhd, "nt_geti ndexname")
"Display the result
Print "It worked. New source |anguage: " + name$
DDETer m nat e hwWwid " And good- bye
El se "G herw se
Print "Milti Term not responding" "Qutput an error nessage
End | f
mt_settarget#number
Description: This topic is sent with the DDERequest $ command. It sets the target language in

MultiTerm to the desired language. This function’s parameter value must be a
number between 1 and 20 that specities the language’s position in the list of index
fields detined for this database.

Syntax: nt wb=DDERequest $( hWhd, " nt _set t ar get #nunber ")
Parameter Explanation
hwWhd The channel number used for communicating with Multi T'erm.
nt_settarget Multi'T'erm should set the target language to the position number that you specify in
#nunber.
#nunber The number specifying the position of the language in the list of index fields defined
for this database. 'I'he number must be between 1 and 20.
m w T'he returned string reports the result of the command.
Result: Muldi'T'erm sets the target language to the number specified, thus setting the target
language to the desired language.
Return Value Explanation
m _ok Everything is fine. Multi'I'erm was able to set the target language as desired.
nt _no Something didn’t work. Multi'T'erm could not set the new target language because the

value specified in #nunber is invalid. Thhis happens, for instance, when your database
only has 3 languages and you try to set the target language to number 4.

Example:
hwid = DDEInitiate("MM4AWN', "nt_init") "Hello Multi Term
If hwhd > 0 Then "If MultiTerm answers

Set the target |anguage to | anguage nunber 2 on the list of index fields
ntw$é = DDERequest $(hwid, "nt_settarget #2")

"Determ ne the name of the new target |anguage

nanme$ = DDERequest $( hWhd, "nt_gettarget nane")

"Display the result

Print "It worked. New target |anguage: " + name$
DDETer mi nat e hWhd " And good- bye
El se 'O herw se
Print "Milti Termnot responding" "Qutput an error nessage
End If
mt_hitlist_off
Description: "T'his topic is sent with the DDERequest $ command. It turns off Multi'T'erm’s hit list
so that it does not come to the foreground after a global or fuzzy search, which would
make Multi'T'erm the active application. This command is usually used in combination
with the other hit list commands. See the example under nt _hi tli st_on.
Syntax: m w$=DDERequest $( hWid, "nt _hi tlist_of f")
Parameter Explanation
hwWhd The channel number used for communicating with Multi' T'erm.
m_hitlist_off MultiTerm should deactivate its external hit list.
mt we The returned string reports the result of the command.
Result: MultiTerm hides the hit list. T'his means that no hit list will be displayed after the

next global or fuzzy search, and Multi'T'erm will not become the active application.
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Return Value
nmt _ok

Example:

Explanation

Everything is fine. Multi'T'erm was able to deactivate the hit list.

An example of all the hit list commands appears under the mt _hi t| i st _on command.

mt_hitlist_done

Description:

Syntax:

Parameter
hwhd
nt_hitlist_done
m wé

Result:

Return Value

nt _ok
m _no
Example:

"T'his topic is sent with the DDERequest $ command. It checks whether a hit list
search is finished yet. If so, it returns the value nt _ok to the client. 'T'his command is
particularly usetul in a program loop that repeats until the hit list search is finished.
This command is usually used in combination with the other hit list commands. See
the example undernt _hi tlist_on.

nt wd=DDERequest $( hWd, "nt _hitlist_done")

Explanation

The channel number used for communicating with Multi T'erm.

Multi'Term should check whether the hit list search is finished.

The returned string reports the result of the command.

MultiTerm checks whether the current hit list search is finished yet. If so, it returns
the string mt _ok to the clieng; if not, it returns nt _no.

Explanation

Everything is tine. 'T'he hit list search is tinished. Multi'I'erm is ready again.

Multi'T'erm is still processing the hit list search.

An example of all the hit list commands appears under the mt _hi t| i st _on command.

mt_hitlist_get

Description:

Syntax:

Parameter
hwhd
nt_hitlist_get
mt wé

Result:

Return Value
Ht list contents

nt _no

Example:

"T'his topic is sent with the DDERequest $ command. It returns the result of the last
hit list search (that is, global or fuzzy search) as a string to the client. The individual
hits are separated by paragraph marks. 'T'his command is usually used in combination
with the other hit list commands. See the example under nt _hi tli st _on.

nt wd=DDERequest $( hwid, "nt _hitlist_get")

Explanation

T'he channel number used for communicating with Multi'l'erm.

Multi'T'erm should return the result of the hit list search as a string to the client.

T'he returned string reports the result of the command.

Muldi'T'erm returns the contents of the hit list as a string to your application, where you
can manipulate it as desired. The individual hits in the list are separated by paragraph
marks.

Explanation

The result of the last hit list scarch is returned in the mt W string variable.

T'he hit list is empty. T'his means that no global or fuzzy search has been performed
since Multi'T'erm was started, or that no matching entries were found by the last global
or tuzzy search.

An example of all the hit list commands appears under the mt _hi t| i st _on command.
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mt_hitlist_on

Description:

Syntax:

Parameter
hwhd
nt_hitlist_on
m wé

Result:

Return Value
nt _ok

Example:

"T'his topic is sent with the DDERequest $ command. It reactivates Multi'l'erm’s
external hit list. "This means that Multi'T'erm will display the hit list after the next global
or fuzzy search. Displaying the hit list also makes Multi'T'erm the active application. This
command is usually used in combination with the other hit list commands. See the
example below.

m w=DDERequest $(hwid, "nt _hi tlist_on")

Explanation

T'he channel number used for communicating with MultiT'erm.

Multi'T'erm should reactive its external hit list.

T'he returned string reports the result of the command.

MultiTerm reactivates its external hit list. This means that after the next global or fuzzy
search, the hit list will be displayed as usual and Multi'T'erm will become the active
application.

Explanation

Everything is fine. Multi'T'erm was able to reactivate the hit list.

hWwd = DDEInitiate("MI4WN', "nt_init") "Hello MultiTerm

If hwd > 0 Then

"If it worked

"Deactivate the external hit Iist

hi dehitlist$ = DDERequest $(hwid, "nt_hitlist_off")
"Search for everything beginning with the letter a
terns$ = DDERequest $(hwad, "a*")

"Don’t interrupt the hit list search

Whi | e DDERequest $(hWhd, "nt_hitlist_done") <> "nt_ok"

Wend

" And what

is the result of the search?

resul t$ = DDERequest $(hWhd, "mt_hitlist_get")

"Insert the results at the cursor position

Insert result$

"Reactivate the external hit list for future searches
showhi tlist$ = DDERequest $(hWad, "nt_hitlist_on")
DDETer mi nat e hWwhd

El se

'O herwi se

Print "Ml tiTerm not responding" "Qutput an error nessage

EndlI f
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Using MultiTerm 95 Plus in a Network
Environment

In this chapter, we want to explain the use of the Professional Edition of MultiTerm ’95 Plus on a
LAN (Local Area Network). MultiTerm’s support for network operation is exemplary in that it
allows several users to read the same entry simultaneously. Edit access for adding new entries or
changing existing entries is controlled by a locking mechanism. This means that only one user at a
time can edit an existing entry. If another user tries to change the same entry at the same time, a
message appears indicating that this is not possible at the moment. If you have assigned user IDs,
MultiTerm also tells you which user is currently editing the entry. Once the user completes the edit,
the autorefresh feature immediately updates all users on the network. This means that if an entry
appearing on a user’s screen is changed by another user, the changed version automatically appears on
this user’s screen along with a message that user XYZ just changed the entry.

MultiTerm allows you to protect your database from unauthorized access through the use of
passwords. You can use passwords to assign individual read and write access rights for up to eight
Entry Classes. This allows you to ensure, for example, that certain entries are only edited by qualified
users and that sensitive terminology cannot be accessed by all users. Users must specify passwords
each time a database is opened; of course, the password is not displayed as the user types it in.

In addition, the MultiTerm system administrator can create so-called “input models” for himself or
herself and for other users. Input models are special entries that enable consistent and controlled yet
flexible entry of terminological data. On a network, the system administrator therefore functions as
the “architect” of input models, defining the templates that others are required to follow when
creating entries. Among other things, input models let you

. specify one or more basic structures for all your terminological entries
. pre-define default values for fields
o determine whether, how often, and in what sequence index, text, and attribute fields may or

must occur in new or changed entries
. determine who can edit which fields and which fields can only be read

. have MultiTerm automatically record when a field was last changed and by whom

It goes without saying that this functionality is especially useful on a network. Since input models are
closely related to the edit mode of MultiTerm, input models are not further described in this chapter;
please refer to the detailed description in the “Input Models” section of the “Editing Entries”
chapter.

Since user IDs are stored in the database definition, it is possible to associate filter and layout
definitions with user IDs so that each user can fashion filters and layouts according to individual
preferences. At the same time, it is also possible for the system administrator to create several
predefined layout definitions and to make them available to all users as so-called “public” layout
definitions. For further information, refer to the “Defining Layouts” chapter. Finally, the user ID also
allows MultiTerm to automatically register in the entry header which user created and last changed
each entry.

This chapter begins by explaining your functions as the system administrator, in particular how to
create user IDs in your database definition, and how to assign passwords and read and write access.
The chapter concludes with an explanation of how working on a network affects “normal” users and
guests.
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Note

MultiTerm Lite is designed as a single-user system and does not support network access.
MultiTerm Lite users who require network functionality can upgrade to the Professional Edition of
MultiTerm ’95 Plus; no data conversion is required.

Network Use and the System Administrator

Your user ID as the system administrator is super. This stands for super-user and is simply another term
for system administrator.

Opening the Database in Exclusive Mode

You must open the database in exclusive mode to perform the following system administrator

functions:
. Changing the database definition.
. Creating a fuzzy index.
. Releasing locked entries.
. Exporting data.
. Importing data.
Note

Exporting data is also possible in non-exclusive, that is, shared mode. However, during exports in
shared mode, it is neither possible to add new entries nor to change existing entries. For
information on how to make export operations in shared mode possible, see the instructions under
“Allowing Export in Shared Mode” in the “Tuning the Network Performance of
MultiTerm 95 Plus” section later in this chapter.

To have a database open in exclusive mode means that you are the only one who has the database
open. You can only open the database in exclusive mode when no one else is currently using it. Also,
no other user can access the database as long as you, the system administrator, have the database open
in exclusive mode.

Until you add passwords and perhaps additional users to the database definition, any user can open
the database as the system administrator in exclusive mode. This is because MultiTerm assumes that
a database that is not password-protected is being opened by the system administrator.

Once you have assigned passwords, only you as the system administrator can open the database
exclusively and change the database definition, create a fuzzy index, release locked entries, export
data, or import data.

Follow these steps to open a database in exclusive mode:

1.  From the File menu, select the Open Database... command. If you have already assigned
passwords, the Password dialog appears.

2. In the Password dialog, type in the user ID swper and your password, and confirm by clicking
on Close. MultiTerm asks whether you want exclusive access to the database. (If you have not
yet assigned passwords, this question appears as soon as you select the Open Database
command.) Answer this question with Yes. If no one else is using the database, the database
opens and you have exclusive access. If someone else has the database open, a message appears
telling you that the database could not be opened exclusively and that you will therefore only
have shared access to the database.
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MuluiTerm Access Ermor

The databaze could not be opened.
The adminiztrator has it in use excluzsively.

Figure 108: Exclusive Access is Currently Unavailable.

Planning Network Options and Specifying Them in the Database Definition

Planning Network Options

Before you as the system administrator specify the network options, there are several things to be
considered. First, you should clarify whether the database needs to be protected at all. If not, then
only the predefined users guest and super are registered; you do not have to assign passwords for these
users. However, if you decide to protect your database, follow these steps:

1. Create a list of users, noting all the users who want to access the database. Divide the list into
groups of users who should receive the same access rights, and assign passwords (up to 9
characters). It is recommended that you assign a different password to each user.

2. Determine how many Entry Classes are required. You can use Entry Classes to assign different
read and write access to users or user groups. The most difficult task is to determine how many
Entry Classes are required. To simplify this task, we would like to give you and example of
assigning Entry Classes and distributing read and write privileges:

Example of Assigning Entry Classes

Let’s assume that your organization has the following user groups:

. Documentation Department - This is where the documentation for new products is written.
In the process, new technical terms are created, for example new product names, part names,
and so on. This is where the experts who can explain the meaning and source of individual
technical terms are located.

. Translation Department - This is where texts are translated from and to various languages. In
the process, translators come across technical terms for which translations or at least explanations
already exist. They may also encounter new technical terminology for which they make
translation suggestions.

. Terminology Department - This department collects technical terms, enters definitions, and
verifies, edits, and completes suggestions from other departments. It releases vetted entries for
general use.

o Other Departments - Other departments, for example, marketing, sales, public relations, and
customer service, all have a need for terminology and additional explanatory information.
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In this case, the simplest classification would be strictly hierarchical and could look like this:

Entries in class 1 | could be read by all departments and edited by the documentation, trans-
lation, and terminology departments. The access rights for Entry Class 1
would therefore be assigned as follows:

Read access e all users

Write access * documentation department users
e translation department users
* terminology department users

Entries in class 2 | could be read by all departments but only edited by the translation or
terminology department. The access rights for Entry Class 2 would therefore
be assigned as follows:

Read access e all users

Write access e translation department users
* terminology department users

Entries in class 3 | could be read by all departments but edited solely by the terminology
department. The access rights for Entry Class 3 would therefore be assigned
as follows:

Read access e all users

Write access * terminology department users

However, in some circumstances, it may make sense to restrict the access even more. Assuming the
entries should be available to the general public only after the terminology department has checked
and blessed them, the classification would look like this:

Entries in class 1 | could be read and edited by the documentation, translation, and terminology
departments. The access rights for Entry Class 1 would therefore be assigned
as follows:

Read access * documentation department users
e translation department users
e terminology department users

Write access * documentation department users
e translation department users
* terminology department users

Entries in class 2 | could be read by the documentation, translation, and terminology
departments, but only edited by the translation and terminology departments.
The access rights for Entry Class 2 would therefore be assigned as follows:

Read access * documentation department users
e translation department users
e terminology department users

Write access e translation department users
e terminology department users
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Entries in class 3

could be read by all departments but edited solely by the terminology
department. The access rights for Entry Class 3 would therefore be assigned
as follows:

Read access

e all users

Write access

e terminology department users
Y

In addition, it is also conceivable that you may want to assign private Entry Classes for particularly
sensitive areas. For example, to protect the terminology of a research project that his still highly
classified, the research department could be assigned its own Entry Class to which only the research
department has access:

Entries in class 4

could only be read and edited by the research department. The access rights
for Entry Class 4 would therefore be assigned as follows:

Read access

e research department

Write access

e research department

It is up to you to determine exactly how to distribute the read and write access rights and how many
Entry Classes you will need to meet your organization’s unique requirements. You have up to 8 Entry
Classes to work with. See “Appendix IV: Entry Class Grid” for a chart to help you plan your Entry

Class assignments.

Specifying Network Options

Once you have completed the preparations described above, creating a user list and assigning access
rights to Entry Classes, follow these steps to specify them in the database definition:

1. Open the database in exclusive made as described earlier in this chapter.

2. From the File menu, select the Create New Database... command if you want to create a new
database definition or the Change Database Definition... command if you want to specify or
change network options for an existing database. You can update the network options for an
existing database at any time.

Click on the Network... button near the top of the Database Definition dialog. The

Network Options dialog appears on your screen. The middle of this dialog contains a user list.
"This list always includes the users guest and super.

Network Options

Uszer List Access Hights
Add uest Clazz HRead Write
= 1 K B
— L F
Peter -
super [x x
4 [x [
5 r r
5 K [
Uszer ID
T K E
ar
d g8 [
Password
Flower | Help I | Cloze I

Figure 109: The Network Options Dialog
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4. To add a new user to the user list, click on the Add button. The cursor starts blinking in the
User ID input field.

5.  Type the desired user ID into the User ID input field. The user ID can be up to 19 characters
long. Since this user ID will later appear in the Created By and Changed By system fields to
document who worked on an entry, the user ID should be as meaningful as possible. Confirm
your input by pressing [Enter]. The cursor starts blinking in the Password input field.

6. Type the desired password for this user into the Password input field. It can be up to 9
characters long.

7. On the right side of the dialog, activate or deactivate the check boxes to give this user read
and/or write access to the various Entry Classes. Assigning write access to an Entry Class
automatically includes read access.

8.  To add another user to the user list, highlight the user before which you want to insert a new
user ID. By default, the new user is assigned the same rights as the highlighted user. Click again
on the Add button and type in a user ID and password for the new user as described above.
Change the access rights if they are different from those of the previous user.

9.  To change the password of an existing user, highlight the corresponding user ID in the user list.
The password appears in the Password input field. Click in the Password input field and
make the desired changes.

10. To change the read and write access of an existing user, highlight the corresponding user 1D.
You can highlight several user IDs simultaneously if you want to change the read and write
access for a group of users. However, the IDs super and guest cannot be highlighted as part of a
group. Now make the desired changes to the read and write access.

11. To delete an existing user ID and password from the user list, thus removing its read and write
access, click on the desired user ID to highlight it in the user list, and then click on the Delete
button.

12. Once you have input all the user IDs and passwords, confirm your input by clicking on Close. If
you have not yet entered a password for the user ID super, or for any user ID except guest, you
are now asked to do so. Otherwise, you are automatically returned to the Database Definition
dialog. You can make additional changes here if you want. When you are finished, again click on
OK and answer Yes to the question of whether the database definition should be saved.

Notes
e The user IDs guest and super cannot be deleted.

e The access rights of the system administrator, s#per, cannot be changed. The user ID super
always has all access rights.

*  Only read access can be activated or deactivated for the user ID guesz. Write access can never
be assigned to guest.

e To protect your database even from unauthorized reading, either assign a password to the user
ID guest or deactivate guest’s read access to all Entry Classes.

User List

This list shows all registered users. The following applies to the user list:

. The list contains at least the users guest and super.

. You can add a maximum of 100 user IDs per database to the user list.
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. You can highlight several users simultaneously to modify access rights for the highlighted group.
However, changes to the password and user ID only apply to the first user in the group. The
highlighted group cannot include the users guest or super.

User ID

Keep the following rules in mind when you want to add a new user ID or change an existing user ID:

. User IDs must always be unique, that is, a user ID may appear only once in the user list.
. The user ID can be up to 19 characters long.
. The user IDs guest and super cannot be changed.

. Since user IDs are used among other things in the Created By and Changed By fields for
documenting who worked on entries, we recommend using a meaningful ID, for example the
user’s first and/or last name.

. User IDs are also meaningful when it comes to input models. Input models whose name start
with the same letters as an existing User ID are reserved for that user only. For more
information, please refer to the “Creating Input Models as the MultiTerm System Administrator
(‘super’)” section in the “Input Models” chapter.

Password

Please keep the following rules in mind when assigning passwords:

. If only the user IDs guest and super are defined for this database, the passwords for these two
user IDs are optional. If no passwords are specified, the database is not password-protected. All
users can open the database for reading and writing, including making changes.

. If users other than guest and super are registered, a password must be assigned to each user,
except that no password is required for the user guest. If no password is assigned to the user guest,
all users can open the database with read access as guest.

. Passwords can be up to 9 characters long.

Access Rights

The read and write access that you specify in the database definition determines who can read and
edit which entries. The Entry Class is stored in each entry for this purpose. To be able to add new
entries, the user must have write access to at least one Entry Class. Keep the following points in mind
when assigning access rights:

. When assigning access rights for users, up to 8 Entry Classes are available; for each user, you can
assign separate read and/or write access to each Entry Class.

. Write access to an Entry Class automatically includes read access.
. You can highlight several users and then assign access rights for the highlighted group.
. The access rights of the system administrator, super, cannot be changed. The user ID super

always has all access rights.

. Only read access can be activated or deactivated for the user ID guest. You cannot assign write
access to guest. To fully protect your database, either assign a password to the user ID guest or
deactivate its read access to all Entry Classes.

Releasing Locked Entries

As the system administrator, you can release entries that were not saved in an orderly manner and are
therefore still marked as locked.

Since several users can work on a database simultaneously, a locking mechanism ensures that only one
user at a time can edit an entry. Whenever an entry is edited, an entry lock is set for this entry. When
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edit mode is ended normally, the entry lock is released. However, sometimes a lock is not released,
for example, when the user turns off the computer while an entry is in edit mode, or if another
program aborts and hangs the system. In order to be able to edit these entries again, their entry locks
must be released. Follow these steps:

1. Open the database in exclusive mode as described earlier in this chapter.

2. From the File menu, select the Release LLocked Entries command. If there were entries to
release in your database, a corresponding message appears in the message line. Otherwise, you
receive the message “There were no locked entries to release.”

Note

The Release Locked Entries command in the File menu is only available when you as the
system administrator have the database open in exclusive mode.

Creating a Fuzzy Index

The fuzzy index is the basis for fuzzy searching. It is, however, a static index; it is not updated every
time you add an entry to your database, but rather only when you create a new fuzzy index. As the
system administrator, you should therefore recreate the fuzzy index at regular intervals so that it
remains up to date. Follow these steps:

1. Open the database in exclusive mode as described earlier in this chapter.

2. From the File menu, select the Create Fuzzy Index command, or press the [Ctrl]+[Z] key
combination. MultiTerm Professional reads through your entire database and creates “fuzzy”
images of all the terms in all languages. These images make up the neural network which is
stored separately from your database in several files on your hard disk. For this reason, please
make sure that you have enough space on your hard drive before starting this process. When you
start the process, MultiTerm displays a message in the message line indicating that a fuzzy index
is being created. This process may take some time for large databases. Please wait until
MultiTerm Professional is finished; otherwise, the neural network will not be created or will be
incomplete. Once the fuzzy index is complete, the message “Fuzzy index successfully created”
is displayed.

For information on the size of fuzzy index files, see the “Fuzzy Searching” section in the “Searching
for Entries” chapter.

Note

The Create Fuzzy Index command in the File menu is only available when you as the system
administrator have the database open in exclusive mode.

“Normal” Users on the Network

For “normal” users, the system administrator assigns a user ID and password as described earlier in
this chapter. When opening a database on the network, you are therefore asked to specity your user
ID and your password. Note that in the Password dialog, you can use the [Tab] key to move from
the User ID input field to the Password field.

As a “normal” network user, you have access to all terminological functions. Depending on your read
and write access, you can view and change existing entries as well as create new entries. However, you
cannot change the database definition, release locked entries, create a fuzzy index, export data, or
import data. Only the system administrator can perform these functions.
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A special mechanism prevents more than one user from editing the same entry simultaneously. It may
happen that you want to change an entry that another user already has open in edit mode. When this
occurs, you receive a message telling you which user is currently editing the entry. Simply try making
your change again later. If you are looking at an entry on your screen that another user just changed,
the changed entry automatically appears on your screen, and the message line tells you that the entry
was changed by user XYZ. If you are looking at an entry on your screen and another user deletes the
entry, the entry disappears from your screen, and the message line tells you that the entry was deleted
by user XYZ. So MultiTerm always keeps your view of the database up to date. This function is
called autorefresh.

Any filter you set, as well as your current layout definition, are stored in the database with your user
ID. This means that you can adjust these settings according to your own preferences and that you will
not have to reset them every time you start MultiT'erm.

Guests on the Network

If you want to open a password-protected database on a network, you are asked for your user ID and
your password.

If you do not have a user ID, type in guest as the user ID and the guest password if one has been given
to you. Confirm by clicking on OK. You can now search for and browse through the terminology in
the database that the system administrator has made accessible to guests. However, you cannot add or
change entries.

Tuning the Network Performance of MultiTerm '95 Plus

Locking

The information contained in this section is useful for larger network environments. It has been
included to help technical personnel modify the network performance of MultiTerm *95 Plus via its
INT file, MTWPLUS. | NI, located in the Windows directory of each MultiTerm user (C: \ W NDOAS by
default). Before taking a look at the available items in the MTWPLUS. | NI file, however, let’s describe
how MultiTerm 95 Plus uses locking mechanisms to manage multi-user access to one and the same
database.

In order to enhance the security and integrity of index and record (entry) data in a multi-user or
single-user multiple-instances operation, MultiTerm uses the following locking mechanisms:

Login to Database

When logging in to a database, MultiTerm needs to check whether the user can access the database in
“exclusive,” “shared,” or “read-only” mode. This is done by opening the lock file (*. | ok) and
leaving the file open as long as the respective database is in use. Thus, as long as the lock file is in use
by someone, the system administrator cannot open the database in exclusive mode. The database
itself, that is, the file with the *. nt wextension, remains closed as long as it is not needed for reading
or writing of any kind.

Write Locking

During write operations in the database, MultiTerm requires an exclusive lock. This is achieved by
opening the database file in “exclusive” mode for the short period of writing, then closing the file
again. Experience with previous MultiTerm versions has shown that accessing the file in sharable
mode, then leaving it open until session end, and performing traditional operating system locks,
increases the risk of data corruption in some operating system environments (especially where
flushing buffers is a time-critical issue).
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Read Locking

During read operations, MultiTerm opens the database file for reading, then performs a search or gets
a data record, and closes the file again. During read locks other users may read as well. Writing,
however, is not possible while others read. This is why read locks are kept as short as possible, and
global (maybe filtered) searches are interrupted to let other users perform write operations. In order to
control the time slices, that is, to optimize performance for each single user and the overall
accessibility of MultiTerm 95 Plus databases, there are three parameters that you can configure
separately for each workstation. All of them can be modified in the MTWPLUS. | NI file. Please refer to
the “Creating and Modifying INI File Settings for Network Use” section below for details.

Edit Locking

When a user edits an entry, MultiTerm adds a key to a designated index, containing the entry
number plus the user name. This action requires a quick write lock. During the edit session itself,
however, no further write locks are needed. When adding index terms, MultiTerm requires read locks
to search for homonyms (see the “Recognising Duplicates” section in the “Editing Entries” chapter
for details). When saving the entry or cancelling edit mode, a further write lock is needed to change
the index and data record or at least remove the edit lock from that entry.

Allowing Export in Shared Mode

As mentioned at the beginning of this chapter, the system administrator needs exclusive access to a
database in order to be able to export data. This is the default setting. However, this might not be
desirable in some cases, for example, if you would like all users or a certain group of users to be able
to create professional-looking dictionaries via the RTF export function whenever they would like to.
This is why you can add the following line to the MTWPLUS. | NI file to allow several users to do
export operations even if the database is open in shared, and not exclusive, mode:

Excl usi veExport = 0

This line must be added to the [ Net wor k] section of the MTWPLUS. | NI file. If this section is not
yet present, you must add it to the MTWPLUS. | NI file as well. Now, if a user starts MultiTerm with
this setting in his or her MTWPLUS. | NI file, MultiTerm will activate the Define Export... menu
item of the File menu, thus allowing the user to export all entries or a filtered subset of entries.

Notes

*  Since the Excl usi veExport option can be set in the MTWPLUS. | NI file on each individual
user’s workstation, you can limit the export functionality to a restricted group of users.

*  During exports in shared mode, database access is limited to read-only, that is, no update
operations can be done (adding new entries, changing existing entries). This is to ensure the
integrity of the database. A warning message will be displayed before the export is actually
started via the Export This Entry or, more significantly, the Export All Entries command
of the File menu.
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Creating and Modifying INI File Settings for Network Use

Now that you have seen how MultiTerm 95 Plus works in multi-user mode, let’s describe the entries
in the MTWPLUS. | NI file that are relevant for tuning the network performance of the program and for
allowing users to export data in shared mode.

The following table lists each relevant item, its meaning, and its default value. Note that all entries
are read-only, that is, MultiTerm does not write any of them into the | NI file on exiting the program.
As a consequence, they have to be entered manually.

[ Net wor K] Section name in MTWPLUS. | NI file. If this section name is not yet present,
add it to the I NI file for the network-specific entries to take effect.

LockRetries = Specifies how often Multi'T'erm tries a specific lock (read or write) before it
prompts the user with a time-out message. Depending on the network and
workstation performance, this value may be adjusted (probably lowered, if
running on a slow or many-users network). The default value is 500.

Al'l owLocks = Specities how many index keys are scanned in global searches before an
interrupt is forced. This interrupt allows other users to write to the database.
The default value is 10.

All owTime = Specities how much time is given to each interrupt before Multi'l'erm tries to
regain a read-lock. Note that this value is not measured in seconds, but rather
in number of Windows Messages to be “pecked” and “dispatched” in
between. The default value is 500.

Aut oRefresh = Specities how often Multi'T'erm will check whether the current entry has been
changed by other users. The interval is given in seconds between each lookup.
The default value is 30. Reducing this value will increase network traffic.
Setting it to 0 will disable the AutoRefresh feature entirely.

Excl usi veExport = 0 Specities whether exports can be done even if the database is open in shared,
and not exclusive, mode. For more details, see the “Allowing Export in Shared
Mode” section above.
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MultiTerm 95 Plus in Display Mode

Keyboard Functions

[F2] Starts edit mode to edit the currently displayed entry.

[F3] Adds a new entry. If an input model is active, the input model is pasted
into the new entry.

[F4] Browses backwards to the previous entry.

[F5] Browses forwards to the next entry.

[F12] Re-displays the most recent hit list.

[Ctrl] + [F4]

Browses backwards to the previous entry that matches the filter, if a filter is
set.

[Ctrl] + [F5]

Browses forwards to the next entry that matches the filter, if a filter is set.

[Page Upl and [Page Downl]

Browses up and down in the current entry one page at a time.

[ and [V]

Browses up and down in the current entry one line at a time.

[Ctrl] + [Home]

Jumps to the beginning of the entry.

[Ctrl] + [End]

Jumps to the end of the entry.

[Tab] and [Shift] + [Tab]

Moves back and forth between the index (source language) field, the search
field, and the target language field.

[Ctrl] + [ and [Ctrl] + [V]

In the index and target language fields, allows changing the source and
target languages. In the search field, allows access to previous search
arguments.

[Ctrl] + [F]

Opens the Filter Definition dialog where you can specify a filtered search
based on certain search criteria.

[Ctrl] + [A]

Activates or deactivates a previously detined filter.

[Ctrl] + [G]

Interprets the search term as an Entry Number and goes to this entry.

[Ctrl] + [L]

Opens the Layout Definition dialog for changing the appearance of
displayed entries.

[Ctrl] + [S]

Logs the current search term, adding it to the list of not-found search terms
(file name = database name + *. nsl )

[Ctrl] + [E]

Opens the Export Definition dialog.

[Ctrl] + [P]

Pins the Multi'Term window in the foreground on top of all other
applications, or deactivates this state.

[Ctrl] + [X]

Exports the currently displayed entry to a text file.

[Ctrl] + [Z]

Creates a fuzzy index for the current database.

[Ctrl] + [Insert]

Copies the current entry into the entry buffer. From there, it can be pasted
into other entries in edit mode (see “MultiT'erm ’95 Plus in Edit Mode”
below).

[Ctrl] + [F3]

Opens the Input Models dialog from which you can activate, deactivate,
and edit input models.
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Mouse Functions

General Mouse Pointer

Note: Mouse pointer movements are only effective when no (red) message

Movements is currently displayed in the message line. Clicking on a message with the
mouse will make the message go away.

Field Names The message line always shows the name of the field on which the mouse
pointer is located. This is particularly helpful when the layout definition
specifies that this tield name not be displayed.

Hidden If the field or graphic under the mouse pointer is hidden (that is, only

shown with its name), a corresponding message appears in the message
line.

Cross Reference

When the mouse pointer is on a cross reference (green text), a
corresponding message appears and the mouse pointer is shown as a hand.

Graphic

Gives the status of the graphic and how you can change its appearance.

Left Mouse Button

Hold the [Shift] key and click
on an index field

If the mouse pointer is on an index field other than the source language,
MultiTerm makes this the new source language. If the language clicked on
was the target language, the source language now becomes the target
language; otherwise, the target language remains unchanged.

Click on a cross reference

If the mouse pointer is on a cross reterence, Multi'l'erm searches for and
displays the referenced entry. MultiTerm remembers the old entry and
allows returning from up to 10 cross references.

Click on a graphic

Toggles the display of the graphic from original size to full size and back.
T'his allows expanding small graphics to see them in greater detail.

Click on the message line

Removes the current message from the message line.

Double-click on any field

Copies the contents of the currently displayed field to the Windows
clipboard. From there, it can be pasted into another Windows application,
usually a word processor. It Word for Windows is running, double-clicking
on a tield also pastes it into Word.

Double-click on the current
search term

Starts edit mode to edit the currently displayed entry.

Right Mouse Button

Click on any field If the mouse pointer is on a field, MultiTerm toggles the field between
hidden and visible display. If you hide an index field, all associated
attributes and text tields are also hidden.

Click on a graphic Toggles between normal and hidden display of the graphic. That is, the

graphic can easily be hidden or re-displayed via the right mouse button.

Click on the message line

Jumps back to the source of a cross reference. Multi'T'erm can “remember”
up to 10 cross references.
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MultiTerm '95 Plus in Edit Mode

Keyboard Functions

[Page Upl and [Page Downl] Browses up and down in the current entry one page at a time.

[€]and [=] Moves back and forth among the various fields (index, text, and attribute
tields).

[N and [V] Moves back and forth among the various index fields.

[Ctrl] + [Home]

Scrolls to the beginning of the entry.

[Ctrl] + [End]

Scrolls to the end of the entry.

[Ctrl] + [Insert]

Copies the current entry into the entry buftfer. From there, it can later be
pasted into a new entry.

[Ctrl] + [H]

When using an input model, hides indices other than the indices you are
allowed to edit according to the currently active input model.

[Shift] + [Ins]

Pastes an entry from the entry buttfer into the entry currently being edited.

[Ins] Displays a menu from which the user can select whether to insert an index,
text, or attribute field at the current position.

[Dell Deletes the current field after confirmation.

[Enter] Pressing | Enter] allows editing the current field.

[i] Allows inserting an index (language) field.

[t] Allows “attaching” a text tield (definition, context, and so on) to the current
field, or to the Entry Number at the top of the entry.

[a] Allows “attaching” an attribute tield to the current field or to the Entry
Number at the top of the entry.

[e] Pressing |e] twice in a row allows editing the current field.

[d] Pressing [d] once causes Multi'T'erm to ask the user whether the
corresponding tield should be edited or deleted. Pressing [d] three times in
a row immediately deletes the current field and any associated text and
attribute fields.

[h] Opens a dialog box for viewing/editing the entry header.

[s] or [F4] Saves the current entry and returns to display mode.

[Esc] Aborts edit mode without saving any changes to the entry.
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Appendix I: MultiTerm ’95 Plus Reference

Mouse Functions

General Mouse Pointer
Movements

Note: Mouse pointer movements are only effective when no (red) message
is currently displayed in the message line. Clicking on a message with the
mouse will make the message go away.

Field Names

The message line always shows the name of the field on which the mouse
pointer is located. This is particularly helptul when the layout definition
specifies that this tield name not be displayed.

Graphic

Gives the status of the graphic and how you can change its appearance.

Left Mouse Button

Click on any field

Opens a menu for editing or deleting the current field (corresponds to [¢]
on the keyboard). Double-clicking on the field immediately opens the field
for editing.

Click on a graphic

Toggles the display of the graphic from original size to tull size and back.
This allows expanding small graphics to see them in greater detail.

Click on the message line

Removes the current message from the message line.

Right Mouse Button

Click on any field or in an
empty entry

Displays a menu for inserting an index, text, or attribute field. You then
select the desired tield type with the left mouse button, or press [Esc] to
abort inserting a field.

Click on a graphic

Toggles between normal and hidden display of the graphic. That is, the
graphic can easily be hidden or re-displayed via the right mouse button.
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Appendix Il: Sample Databases
Included with MultiTerm

This appendix briefly describes the sample databases included with MultiTerm. We recommend that
you take some time to study these databases yourself by simply browsing around and searching in the
various languages. The purpose of the sample databases is to give you suggestions and ideas for your
own databases.

Note

The composition and appearance of the sample databases is subject to change.

SAMPLE.MTW

This database contains the examples referred to in this User’s Guide. If you select English as the
source language and Dewrsch as the target language and simply browse through the database, you will
see that the entries become increasingly complex. The database begins with simple word pairs and
entries with short text fields, and leads to a highly complex entry for the English term car. The
terminologically interesting entries for beetroot and chard are also worth detailed study. Also notice the
many uses of text and attribute fields for effective management of all kinds of additional
terminological information.

GUIDEMO.MTW

This database contains an extract of Microsoft Corporation terminology on the topic of Graphical
User Interfaces. The database is interesting for two reasons: it contains terms in no fewer than 11
languages, and several graphics are used to illustrate the concepts of the corresponding entries. The
English and some German terms contain definitions, and the German, French, Spanish, and Italian
terms include a gender specification to illustrate the use of term attributes.

FIREEXT.MTW

This sample database represents a terminological project on the topic of fire extinguishers. It was
created as part of a thesis written for the Department of Translation, Interpretation, and Related
Linguistic Sciences at the University of Saarland, Saarbriicken, Germany. We are very grateful to Frau
Katrin Ohse who kindly made this database available to us. This English-German/German-English
database has several special characteristics:

. Highly complex entries with carefully researched and differentiated terminology.

. A notation system that illustrates how hierarchical relationships in terminology systems can be
represented in MultiTerm. (Tip: Select the Nozation tield as the source language and browse
through the database.)
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Sample Databases Included with Multi' T'erm

. Very flexible use of text fields.

Source abbreviations as cross references, illustrating how MultiTerm can be used as a source
management system.

ECOLOT.MTW

This empty database can be used as a reference for input models. It contains four input models as
used at the European Commission. For more information on input models, please refer to the “Input
Models” section in the “Editing Entries” chapter.
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Appendix Ill: Examples of Index, Text, and
Attribute Fields

Index Fields: Term Category
German ¢ Abbreviation
English ¢ International Term
French ¢ Short Form
Notation . Long Form
(up to 20 index fields) e Lexeme

e Orthographic Variant
Text fields: ¢ Phraseologism
Con.text Related Terms
Definition
Explanation +  Antonym
Formula

e Parallel
Grammar . S
Note Quasi-Synonym

¢ Superordinate
e Subordinate

Pronunciation
Related Terms

Source
(up to 62 text fields) Customer
Attribute Fields: « GM

* Honda
Subject « VW
* Biology Project
* Botany
* Business Management e 1
*  Economics e 2
* Electrical Engineering e 3
* Electronic Data Processing ¢ Order4711
* Electronics e Order 5399
* Mechanical Engineering * Internal

¢ Medicine
¢ Motor Vehicles
(here 153 of a maximum of 1024 characters)
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Usage Status Author

e Archaic ¢ Dickens

e Avoid ¢ Dostoyevski
* Neologism e Pascal

e Preferred e Twain

* Prescribed by Law

e  Recommended Equivalence
* Seldom

e Standardized ¢  Complete
¢ Unacceptable ¢ Inclusion
¢  Widespread e Partial
Language Level Quality

¢ Colloquial e 01

* Poetic e 02

¢ Scholarly e 03

e Slang e 04

¢ Sophisticated e 05

e Technical Jargon e 06

e Vulgar

Text Category

e Catalog

* Expert Opinion

* Instructions

*  Marketing Material
e Package Insert

¢ Repair Manual

e Scientific Report

¢ Technical Report

Language Area
e Africa

e Austria

e (Canada

e France

e Great Britain

e Ireland

¢ Latin America

¢ Mexico

e Northern Germany
e South America

e Southern Germany

* Spain
e Switzerland
¢ USA
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Appendix IV: Entry Class Grid

Entry
Class 1

Entry
Class 2

Entry
Class 3

Entry
Class 4

Entry
Class 5

Entry
Class 6

Entry
Class 7

Entry
Class 8

User | Read | Read  Write | Write  Read | Write | Read | Write | Read | Read  Write | Read | Write
guest
super X X X X X X X X X X X X X X X X
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Appendix V. Summary of MTWPLUS.INI File
Settings

The following table lists the sections (enclosed in square brackets “[” and “]”) and entries in the
MIWPLUS. | NI file, their meaning, and their default values. All entries in italic characters are read-
only, that is, MultiTerm does not write any of them on exiting the program. These read-only values
must be manually entered in the MTWPLUS. | NI file.

Section Name or Option

Meaning

[ Dat abase]

Section name in MTWPLUS. | NI file.

Name = C\..\...

Multi'T'erm keeps track of the last database used in this entry.

CreateFrom= X 1...1...

A file name in this section will force MultiT'erm to copy the setup of the
specified database file instead of the current database when a user
selects the “Create New Database...” command from the File menu.

[ W ndow Section name in MTWPLUS. | NI file.

X= MultiTerm keeps track of the last screen position of its program window

Y= before exit. It restores the window position and size when started the

W next time. Note that MultiTerm does #or change these values if its
program window is minimized or maximized on exit.

H=

[ W nwor d] Section name in MTWPLUS. | NI file.

Edi t Paste = 0

Disables the function calling Winword’s “EditPaste” command after
double-clicking on a field in a MultiTerm entry. For further
information, refer to the “‘Double-Clicking’ to Paste into Word for
Windows 2.0 or Higher” section in the “Integrating Multi'T'erm *95 Plus
with Other Windows Applications” chapter.

[Edit]

Section name in MTWPLUS. | NI file.

I}
~

Past eSear ch

When using input models, this setting causes Multi'T'erm to paste the
last search term into the index field of the current source language as
soon as the user selects the Add Entry command from the Edit menu.
T'he active input model must contain an item for the current index field.

[ Net vor k]

Section name in MTWPLUS. | NI file.

LockRetries

Specifies how often MultiTerm tries a specific lock (read or write)
before it prompts the user with a time-out message. Depending on the
network and workstation performance, this value may be adjusted
(probably lowered, if running in a slow or many-users network). T'he
detault value is 500.

Al l owlocks =

Specities how many index keys are scanned in global searches before an
interrupt is forced. This interrupt allows other users to write to the
database. The default value is 10.

Al l owTi ne =

Specifies how much time is given to each interrupt before Multi'T'erm
tries to regain a read-lock. Note that this value is not measured in
seconds, but rather in number of Windows Messages to be “peeked”
and “dispatched” in between. The default value is 500.

Aut oRefresh =

Specities how often Multi' T'erm will check whether the current entry has
been changed by other users. T'he interval is given in seconds between
cach lookup. The default value is 30. Reducing this value will increase
network traffic. Setting it to 0 will disable the AutoRefresh feature
entirely.

Excl usi veExport = 0

Specities whether exports can be done even if the database is open in
shared, and not exclusive, mode. For more details, see the “Allowing
Export in Shared Mode” section in the “Using Multi'T'erm "95 Plus in a
Network Environment” chapter.
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Index

A

access rights
assigning in Network Options dialog 221
controlling using attribute fields in input models 82
adding
a field to selected entries 169
a line to a pick list 46
Ami Pro
integrating with MultiTerm 187
Show Default Status Line button 190
Smartlcons in 188
application
closing the 22
switching to another 22
Asian languages 44, 46
attribute fields 41
adding 58
controlling access rights using ~ in input models 82
examples of 233
free-format text input in 46, 59, 60
maximum number of 41, 155
using automatic ~ in input models 83
attribute values 41
adding, changing, or deleting 53
AUTOEXEC.BAT 14
automatic attribute fields
using in input models 83

clipboard 194
command line parameters, using when starting MultiTerm
174
concept, definition of a 40
concept-oriented terminology management 9
converting a word list to MultiTerm text format 156
copying
an entry 65
field contents 64
field properties within a layout definition 122
Copyrights 11
Corel Ventura 131
creating
a database 39
a fuzzy index 26, 100
entries 55
using an input model 89
criterion 106
cross references
creating 61
creating in DBCS text fields 62
export options for 142
generated by export for synonyms 143
jumping to 27,101
cross-referenced entry 27

B

backing up a database 131, 148
backup.mdx predefined export definition 130
BMP files (Ami Pro Smartlcons) 187
browsing in a database 24, 96

with the filter activated 29
buffer 65
button bar in WordPerfect 188

C

categories of data 39
changing
a database definition 52
a field name 171
entries 69
field contents 60
the default font of a field 53
the sequence of fields 125
Chinese 44, 46

D

data categories 39
database
backup 148
creating a 39
defining a 42
planning network options 217
specifying network options 219
exporting 129
a filtered subset 146
an entire 145
importing into a 153
opening a 21
opening in exclusive mode 216
structure of a 39
database definition
add fields 53
adding DBCS fields 44
changing a 52
creating a 42
customising for input models 48
defining field names 43
special characters ina 178
DBCS See double-byte character set
DDE conversation, structure of a 197
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Index

DDE interface
commands
mt_cur_field 206
mt_date 205
mt_entry 206
mt_field_info 208
mt_getfilename 201
mt_getindex 209
mt_getindexname 209
mt_gettarget 210
mt_gettargetname 209
mt_graph_name 205
mt_hide 201
mt_hitlist_done 212
mt_hitlist_get 212
mt_hitlist_off 211
mt_hitlist_on 213
mt_init 200
mt_match_entry 203
mt_next_entry 203
mt_next_field 207
mt_open#filename 201
mt_popup 200
mt_prev_entry 202
mt_prev_field 207
mt_setindex#number 210
mt_settarget#number 211
mt_sort 204
mt_target 204
Search Term 202
commands, list of 199
copying larger amounts of data 191
Lookup button 188
NextEntry button 189
Paste button 189
Popup button 190
PrevEntry button 189
reference chapter 197
Show Standard Status Line button, in Ami Pro 190
ShowCurField button 189
ShowNextField button 190
ShowPrevField button 190
using the 188
default font of a field
and special characters 178
changing the 53
default layout, restoring the 32
default sort order, and special characters 178
defining
a database 42
a filter 103
alayout 117
field names 43
deleting
a field from an entire database 167
entries 72
fields in an entry 61
desktop publishing applications and MultiTerm 193
dialog bar 23
dictionary
creating a printed
using a word processor macro 192
using the export function 131, 149
disk space requirements, for fuzzy index 100
DLL files 13, 16

do not re-export synonym entries export option 142

document templates
WinWord 181
WordPerfect 183
Don’t Sort Any Field (View menu, Display Fields submenu
item) 126
Don’t Sort Synonyms (View menu, Display Fields submenu
item) 126
double byte character set
creating cross-references in DBCS text fields 62
using to add text and attribute fields 46
double-byte character set 62
using to add index fields for DBCS languages 44
duplicate recognition 66

E

ecolot.mtw sample database 232
enclose entry in export option 141
enclose header information export option 141
entries
changing 69
deleting 72
exporting 129
going to via Entry Number 101
maximum number of, in MultiTerm Lite 9
searching for 95
entry
adding an 32
changing an
deleting an entire term structure 61
deleting fields 61
copying 65
creating an 55
adding attribute fields 58
adding index fields 56
adding text fields 57
attaching a graphic file 63
using an input model 89
exporting an 147
maximum size of an 9, 155
requesting the number of entries 100
saving an 64
entry buffer 65
entry class
specifying 62
Entry Classes, assigning network access rights using 217
entry header fields 41
Entry Number, going to entries via 101
entry structure 39
representing in an import file 154
entry window 23
European Commission, ecolot.mtw sample database 232
examples of index, text, and attribute fields 233
exchanging data with other MultiTerm users 136
exclusive mode, opening database in 216
exiting MultiTerm 37
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export
changing fields names using an 136
defining an 129
creating a multilingual glossary 134
defining field properties for an 133
copying properties 134
inserting special characters 134
loading a definition 144
options
do not re-export synonym entries 142
enclose entry in 141
enclose header information 141
generate concept numbers in place of homonyms 142
generate cross reference instead of re-exporting 143
generate initial letters 141
position header information 140
replace cross references 142
sort by Entry Number 140
sort by index term 140
performing an 145
predefined export definitions 131
removing a definition 145
saving a definition 143
selecting fields for an 132
setting options 138
export file, created by an import 165
exporting
a filtered subset of a database 146
a word list 131
all fields 130
an entire database 130, 145
for a backup 131, 148
entries 129
for Corel Ventura 131
for dictionary printing 131
in Rich Text Format 131
in Text Encoding Initative (SGML) format 131
individual entries 147

F

features, list of MultiTerm 95 Plus 9
field
adding to selected entries 169
changing character and paragraph formatting of a 121
deleting from an entire database 167
globally changing values of a system 172
making visible, hidden, or invisible 120
field contents
changing 60
field contents
copying 64
moving 64
field name, globally changing a 171
field properties
defining for a layout 118
copying properties when 122
defining for an export 133
copying properties when 134

tields
attribute 41
entry header 41
index 41
list of standard 132
list of types 30
system 30
text 41
filter
activating the 110
criterion 106
deactivating the 110
defining a 103
deleting the criteria list 115
determining the filter status 110
loading a definition 114
only use matching fields 104, 110
removing a definition 114
saving a definition 112
using 110
filter criteria, maximum number of 106
filtering 103
controlling appearance of entries via 110
during an import 160
effect on browsing, searching, exporting, and importing
111
examples of
filter for all entries that belong to several specific
subject areas 107
filter for all entries that do not have a term in the target
language 108
filter for all entries that were created after a certain date
109
filtering for a certain string in all text fields 109
principles of 107
when viewing entries 28
FIREEXT.MTW sample database 231
FrameMaker and MultiTerm 193
free-format text input in attribute fields 46, 59, 60
fuzzy index files, disk space requirements for 100
fuzzy index, creating a 26, 100, 222
fuzzy search, performing a 26, 100

G

generate concept numbers in place of homonyms export
option 142
generate cross reference instead of re-exporting export
option 143
generate initial letters export option 141
global changes 167
adding a field to your database 169
changing a field name 171
changing system field values 172
deleting a field from an entire database 167
global search 25, 98
graphic files
attaching to an entry 63
specifying path for 50
Greek, representing in MultiTerm 178
guest
access to a database 223
user ID, access rights of the 221
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GUIDEMO.MTW sample database 231 input models 72
activating 89
automatic pasting of search terms into the current source
language index field 91
H basic rules 72
changing 88
changing fields 86
creating
adding attribute fields 79
adding index fields 74

Help, online 37
hiding a field 120
hiding read-only indices 91

hit list . .
maximum number of terms in 99 adding cext flC}dF 76
hit list 25. 98 as system administrator 73

controlling access rights using attribute fields 82
creating as a "'normal" user 88
deactivating 91
definition 72
deleting 92
| deleting fields from 87
meaning of special characters 88

homonyms 69
export options for 142

saving 92
idiomatic expressions 68 saving completed 88
Import All Entries, word processor menu item 192 using automatic attribute fields in 83
Import Current Entry, word processor menu item 192 using to create entries 89
importing insert buffer 65, 66
all entries without filtering 159 inserting text
conditions and options, table of 163 from a word processor into MultiTerm 65
converting a word list to MultiT'erm text format 156 installation 13
creating a log file during 165 network 16
creating an export file during 165 upgrade 14
entries 153 inverting the language direction 95
MultiTerm text format required for 153 invisible, making a field 120
only filtered entries 160
options
Step 1 159
Step 2 159 J
Step 3 159
gzzg : igg Japanese 44, 46

setting options 158 jumping to cross references 27, 101

synchronized on Entry Number 162
synchronized on index term 160
index fields 41 K
examples of 233
maximum number of 41, 155
indices keyboard and mouse shortcuts 227
hiding read-only 91
INTI file
automatic pasting of search terms into the current source
language index field 91
database name and program window position 174
deactivating the automatic pasting of field contents into
WinWord 196
summary of settings 237
tuning network performance of MultiTerm *95 Plus 223
input models
customising the database definition for ~ 48

language direction, changing the 95
languages, setting the source and target 27
Latin vs. non-Latin characters 178
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layout
changing the 31
changing the order of fields in display mode 125
defining a 117
changing character and paragraph formatting 121
changing default field appearance 120
copying field properties 122
restoring the default 32
selecting fields 118
loading a definition 123
predefined layout definitions 124
removing a definition 124
restoring the default 125
saving a definition 122
line break
inserting in a pick list 46
inserting in a text field 57
inserting in sort table 179
linguistic constructions 68
locked entries, releasing 221
log file
created by an import 165
logging unknown terminology 98
Lookup button, in word processor 188

N

network
assigning read/write access to users 217
guest access 223
installing MultiTerm ona 16
normal access 222
opening database in exclusive mode 216
options
planning of 217
specifying 219
system administrator functions 216
using MultiTerm ona 215
NextEntry button, in word processor 189
non-Latin vs. Latin characters 178
number of entries 100

M

Macros and Tools diskette 181
maximum number of

attribute fields 41, 155

characters in an entry 155

entries in MultiTerm Lite 9

fields in an entry 155

fields or field groups in a layout definition 119

filter criteria 106

index fields 41, 155

terms in hit list 99

text fields 41, 155
maximum size of

a pick list 41

an entry 9, 155
menu bar 23
message line 23
message, removing from message line 23
mouse and keyboard shortcuts 227
MSL file (MultiTerm Search Log) 98
MT4WIN*.DOT files (WinWord document templates) 181
MTWPLUS.INI See INI file
multiple databases, working with 102
MultiTerm Glossary, word processor menu item 192
MultiTerm Lite

limitations of

maximum number of entries 9
no network access 216

working with multiple databases in 102
MultiTerm Print, word processor menu item 192
MultiTerm Table, word processor menu item 192
MultiTerm text format 153

converting a word list to 156
MultiTerm *95 Plus

list of features 9

what’s new in 10
multi-word terms 68

@)

online Help 37

only use matching fields 104, 110
opening a database 21

order of fields 125

P

PageMaker and MultiTerm 193
parameters, using when starting MultiTerm 174
password
assigning in Network Options dialog
for network use 221
for stand-alone use 51
entering when opening database 222
Paste button, in word processor 189
phraseological expressions 68
pick list 41
adding a line to a 46
adding, changing, or deleting values in a 53
defining attribute values using a 46
maximum size of a 41
Pin on Top command 193
Popup button, in word processor 190
position header information export option 140
preferred term 68
PrevEntry button, in word processor 189
printing
a single entry
via a word processor macro 192
dictionary
via a word processor macro 192
via the export function 149
glossary 192
word list 192

Q

quitting MultiTerm 37
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Index

R

releasing locked entries 221

renaming a field 171

replace cross references export option 142

Rich Text Format (RTF), creating printed dictionaries using
149

Russian, representing in MultiTerm 178

S

sample databases, description of the 231
SAMPLE.MTW sample database 231
saving
an entry 64
scroll bar 23
search field 24
searching 24, 95
browsing forward and backward 24, 96
fuzzy search 26, 100
global search 25, 98
logging unknown terminology 98
simple search 24, 97
Select Field or Field Group dialog
for defining exports 133
for defining filters 105
for defining layouts 118
selecting fields for an export 132
sequence of fields 125
setting
source language 95
target language 95
SGML
exporting in Text Encoding Initiative format 131
SHARE 14
shortcuts, keyboard and mouse 227
Show Default Status Line button, in Ami Pro 190
ShowCurField button, in word processor 189
ShowNextField button, in word processor 190
ShowPrevField button, in word processor 190
simple search 24, 97
Smartlcons in Ami Pro 188
SMM files (Ami Pro macros) 187
Sort All Fields (View menu, Display Fields submenu item)
125
sort by Entry Number export option 140
sort by index term export option 140
sorting non-Latin alphabets 178
source language, setting the 27, 95
special characters, representing and sorting in MultiTerm
178
starting MultiTerm 19
status bar See message line
status information
determining the filter status 110
number of entries 100
structure
of a database 39
of an entry 39
super user ID 216
access rights of the 221

support

contract 12

telephone 11
synonyms 67

export options for 142, 143

specifying the preferred term 68
system administrator functions 216
system fields 30

globally changing values of a 172
system hang, releasing locked entries after a 221
system requirements 11

disk space for fuzzy index 100

T

target language, setting the 27, 95
technical support 11
template
using existing database definition as a 42
term, definition of a 40
terminological data categories 39
text
inserting ~ from a word processor into MultiTerm 65
Text Encoding Initiative 131
text fields 41
adding to an entry 57
examples of 233
inserting line breaks in 57
maximum number of 41, 155
text format, MultiTerm standard 153
text input in attribute fields 59
tips
adding a field to selected entries 169
automatic pasting of search terms into the current source
language index field 91
changing fields names using an export 136
converting a word list to MultiTerm Text format 156
creating an export definition for a multilingual glossary
134
deactivating the automatic pasting of field contents into
WinWord 196
deleting a field from an entire database 167
enhancing network performance of MultiTerm *95 Plus
223
filter for a certain string in all text fields 109
filter for all entries that belong to several specific subject
areas 107
filter for all entries that do not have a term in the target
language 108
filter for all entries that were created after a certain date
109
globally changing a field name 171
globally changing values of a system field 172
making Entry Class visible 120
Tips & Tricks chapter 167
using parameters when starting MultiTerm 174
title bar 22
toolbar in WinWord 188
tools and macros 181
TXT file extension for ANSI files
when saving in a word processor 157
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U W
unknown terminology, logging 98 window

upgrade installation 14
user ID
assigning in Network Options dialog 221
entering when opening database 222
user list, in Network Options dialog 220

\%

VBA 197

Ventura Publisher 131

visible, making a field 120
Visual Basic for Applications 197

changing the size of the 22
closing the 22
maximizing the 22
minimizing the 22
moving the 22
Windows applications, integrating with MultiTerm 181
Windows clipboard 194
WinWord
deactivating the MultiTerm double-click functionality
196
double-clicking to paste into 194
integrating with MultiTerm 181
toolbar in 188
word processor
buttons 188
import all entries 192
import current entry 192
integrating with MultiTerm 181
menu items 191
WordBasic
examples of programming the MultiTerm DDE interface
197
WordPerfect
button bar in 188
integrating with MultiTerm 183
note on reliability 187
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